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Welcome
1

-I:is guide describes how to use the THINK Class Library and Visual
Architect to program on the Macintosh with Symantec C++. The
THINK Class Library is a collection of classes that define a generic
Macintosh application. Visual Architect is a tool that can assist you
in designing and assembling the user interface portion of an
application using the THINK Class Library.

Contents

What's in This Guide .
Getting Started . . .
Using the THINK Class L|brary .
Using Visual Architect . . .
The THINK Class Library Reference

How to Use This Guide .

~N ~Noo ool
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What’s in This Guide

This guide has four parts: “Getting Started,” “Using the THINK Class
Library,” “Using Visual Architect,” and “The THINK Class Library
Reference.”

Getting Started

This first section presents background information about the THINK
Class Library and Visual Architect and the basic concepts of their
usage. It also includes two introductory tutorials.

About the THINK This chapter provides a brief

Class Library and introduction to the THINK Class

Visual Architect Library and Visual Architect and
describes the benefits of using them
in programming with Symantec
C++.

THINK Class Library  This chapter gives you an overview

Basic Concepts of the THINK Class Library and
describes how the different parts of
the THINK Class Library fit together.

Visual Architect Basic This chapter gives you an overview

Concepts of how Visual Architect works to
assist in the design and construction
of a user interface.

Tutorial: Beeper This chapter presents a basic
tutorial for Visual Architect.

Tutorial: Process This chapter presents a more

Monitor elaborate tutorial demonstrating
many of the features and
techniques involved in
programming with Visual Architect
and the THINK Project Manager.
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Welcome

Using the THINK Class Library
This section describes how to use the THINK Class Library to

construct your application.
Programming with

the THINK Class
Library

Using Object I/0

Exception Handling
and RTTI

Using Visual Architect

This chapter provides detailed
information on how to use the
THINK Class Library.

This chapter describes Object I/0, a
set of features built into the THINK
Class Library that help you store
and retrieve objects on disk as
documents and resources.

This chapter describes the
exception handling and Run-Time
Type ldentification (RTTI)
mechanisms used in the THINK
Class Library. The exception
handling mechanism lets you
handle errors in a consistent and
graceful way. RTTI allows you to
test the class of objects at run-time.

This section describes how to use Visual Architect to design and
construct your application’s user interface.

Creating and Editing
Views

Creating and Editing
Menus and
Commands

Visual Architect and THINK Class Library Guide

This chapter explains how to create
and edit views. Views are the
visible objects that make up an
application’s user interface.

This chapter describes how menus
and commands are created and
edited. Menus are the standard
menus used in an application.
Commands link user actions with
user interface objects.



How to Use This Guide .

Editing Classes This chapter explains how to create
and define classes derived from the
THINK Class Library.

Generating Code This chapter tells how to generate
the code with Visual Architect for a
complete application as well as
how to incorporate your own code.

The THINK Class Library Reference
This section describes each class in the THINK Class Library and the
global variables and library routines used by these classes.

Chapter 14— These chapters describe each class
Chapter 125 in the THINK Class Library.
Global Variables This chapter lists all of the global

variables that the THINK Class
Library uses.

Library Routines This chapter describes library
routines used throughout the
THINK Class Library.

How to Use This Guide

If you are new to programming using the THINK Class Library, you
should read all the chapters in the “Getting Started” section and try
the two tutorials. Then read the “Using the THINK Class Library” and
“Using Visual Architect” sections to obtain more detailed information.

If you have already programmed using the THINK Class Library,
you should still read the chapters on Visual Architect in the “Getting
Started” section and try the two tutorials. To acquaint yourself

with features new to programming with the THINK Class Library,
read the “Using the THINK Class Library” and “Using Visual
Architect” sections.

Visual Architect makes exploring the THINK Class Library easy and
fun, so don'’t be afraid to experiment while you are learning.
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Library and Visual

Architect 4

2

Ihis chapter provides a brief introduction to the THINK Class Library

and Visual Architect and describes the benefits of using them in
writing applications for the Macintosh with Symantec C++.

Contents

Introduction . .
What you should know

What Is the THINK Class Library?.

What Is Visual Architect?. .
Visual Architect as an interface prototyper .
Visual Architect as a code generator
Visual Architect as a resource editor . .
Visual Architect as an explicator of the THINK Class L|brary

Conclusion
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Introduction

This chapter introduces two of the most powerful components of
Macintosh programming with Symantec C++: the THINK Class
Library and Visual Architect. It describes what they are and what
they’re good for.

What you should know

Before reading any of the chapters following this one, you should be
familiar with the fundamentals of Macintosh programming. In
particular, you should understand QuickDraw, the Window Manager,
and the Memory Manager. You should also be familiar with
Symantec C++. As you go through subsequent chapters, remember
that there is a lot of new material. Don’t be discouraged if it takes a
while to understand the relationships among all the components.

What Is the THINK Class Library?

The THINK Class Library is a collection of C++ classes that
implement a standard Macintosh application. These classes take care
of basic Macintosh functions, such as handling menu commands,
updating windows, dispatching events, dealing with the operating
system, managing memory, maintaining the Clipboard, printing, and
so on. Using the THINK Class Library frees you from most of the
responsibility for establishing the core operations common to
Macintosh applications. Rather than developing your code from
scratch with Macintosh Toolbox and Operating System calls, you can
implement existing classes in the THINK Class Library in which these
lower-level interfaces have already been established. This lets you
concentrate on the essential pieces of your program. Of course,
when using the THINK Class Library, you still have full access to all
Macintosh routines.

What Is Visual Architect?

Visual Architect is a development tool you use in conjunction with
the THINK Class Library to construct the user interface portion of
your application’s code. It lets you define classes derived from the
THINK Class Library by using interactive, visual tools, rather than by
writing C++ code. You can use Visual Architect at any stage during
the development of your application: to begin your design, or to
fine-tune the application’s user interface when the project is nearly
complete. Most likely, you will find it helpful to work with Visual
Architect throughout the development of your application, and to

Visual Architect and THINK Class Library Guide 11



2 About the THINK Class Library and Visual Architect

build your application incrementally by going back and forth
between Visual Architect and the THINK Project Manager.

Visual Architect is a flexible and powerful tool. It can serve as:
= An interface prototyper
« A code generator
= A resource editor
= An explicator of the THINK Class Library

Visual Architect as an interface prototyper

Visual Architect helps you develop your application’s user interface:
windows, dialog boxes, buttons, menus, and so on. Using the
familiar Macintosh interactive, graphical tools, you can easily create,
modify, and test these elements completely separate from the
THINK Project Manager.

Visual Architect as a code generator

By using its own macro files, Visual Architect creates from your
interface design a set of source files that are automatically
incorporated into your Symantec C++ project. These source files let
you perform hand-coded modifications that remain in place through
subsequent development cycles using Visual Architect. Furthermore,
the macro files are written in a scripting language that allows easy
customization.

Visual Architect as a resource editor

Like ResEdit0] and Resorcerer(], Visual Architect deals with
resources and creates resource files for incorporation into your
project. However, Visual Architect works at a higher level than do
other resource editors, and lets you construct visual structures called
views rather than just the individual elements such as buttons and
scroll bars.

Visual Architect as an explicator of the THINK Class Library

By studying the commented code generated by Visual Architect, you
can learn about the structure and implementation of classes in the
THINK Class Library. Visual Architect uses the THINK Class Library
in a standard way, and encourages you to experiment with the code
it generates as a means of understanding the THINK Class Library.

12 Visual Architect and THINK Class Library Guide
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Conclusion

Programming in Symantec C++ with the THINK Class Library and
Visual Architect lets you implement the standard Macintosh core of
your application much faster and more easily than if you had to code
by hand and from scratch. Furthermore, Visual Architect can facilitate
the design of your user interface by providing you instant feedback
on the look and feel of your application’s visual elements.
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THINK Class Library

Basic Concepts
3

-I-he THINK Class Library is a collection of C++ classes that implement
a standard Macintosh application. It encapsulates many routine
aspects of Macintosh programming, such as handling menu
commands, updating windows, dispatching events, dealing with the
operating system, maintaining the Clipboard, and so on.

Contents
Introduction. . . . . . . . . . . . . . . . . . .17
Overview. . . . . . . . . . . . LT
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Creating an Application . . . . . . . . . . . . . . .24
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Introduction

This chapter introduces you to the THINK Class Library and the
fundamental abstractions that it implements. It presents the
conceptual shape of a Macintosh application written using the
Library. In addition, it gives you a sense of how the THINK Class
Library encapsulates the more routine aspects of Macintosh
programming, allowing you to concentrate your development efforts
on inventing new forms instead of reinventing old ones.

Overview

The THINK Class Library is organized into three distinct, interacting
structures: the class hierarchy, the visual hierarchy, and the chain of
command. The class hierarchy is the set of all the classes that make
up the THINK Class Library. The visual hierarchy describes the
organization of all visible entities, such as windows and buttons, in a
given application. The chain of command specifies which objects in
an application get to handle commands (such as menu item choices)
and in what order. The class hierarchy is static; the relationship of
derivation between classes is fixed for all applications and does not
change during execution. In contrast, both the visual hierarchy and
the chain of command are dynamic structures. They are composed
of objects that exist only during the execution of individual
programs.

The THINK Class Library converts Macintosh events into calls to
member functions defined by the classes of the class hierarchy.
Some member functions handle events that affect the visual
hierarchy; these visual events include mouse clicks, activate events,
and update events. Other member functions handle direct
commands—requests that an object perform an action. Direct
commands are usually the result of menu choices or their keyboard
equivalents.

To convert Macintosh events into calls to appropriate member
functions, the THINK Class Library uses an object called a
switchboard. The switchboard calls the Macintosh Toolbox functions
Wi t Next Event (or Get Next Event ) repeatedly and, depending
on the kind of event, calls a member function of the appropriate
object. Each application has only one instance of a switchboard
object. Another object, called the bartender, converts menu choices
into direct commands.
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The Class Hierarchy

The class hierarchy describes the relationships among all the classes
in the THINK Class Library. It can be thought of as a family tree.
Indeed, the derivation relationship is referred to as inheritance. Each
class inherits all of the behavior (member functions) and all of the
attributes (data members) of its base classes. Thus the CButton class,
being derived from the CControl class, is a control. It has all the
attributes and exhibits all the behaviors characteristic of a control.

Some of the classes in the class hierarchy are abstract classes. The
THINK Class Library never creates instances of these classes. Abstract
classes are used to give common behaviors to a family of objects—
that is, to their derived classes.

Note
The class hierarchy is not, strictly speaking, a tree; it
does not have a unique root class from which all
other classes in the library are directly or indirectly
derived. In fact, because some classes in the THINK
Class Library have more than one base class, it is
not even a forest (a set of disjoint trees). It is a
directed, acyclic graph.

The Visual Hierarchy

The visual hierarchy describes all the visible objects, or views, that
the THINK Class Library contains. A view is an object of a class
descended from the abstract class CView. The visual hierarchy is
based on the concept of enclosure. Everything that you see on the
screen belongs to—is enclosed by—another visual entity. When a
view is created, its enclosure is specified as an argument to its
constructor.

The desktop, windows, and panes
The class CView has three important derived classes: CDesktop,
CWindow, and CPane.

At the top of the visual hierarchy is the desktop, an object of class
CDesktop. Every THINK Class Library application has a unique
desktop object. It is the only view that is not enclosed within another
view.
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The desktop encloses all of the windows in an application. In the
THINK Class Library, a window is an object of class CWindow. This
class encapsulates the properties and behavior of Macintosh
windows.

Each window encloses one or more panes, and those panes may
enclose other panes. A pane is an object of class CPane. Panes are
the most important kinds of views. All drawing takes place in a
pane. The THINK Class Library defines different kinds of panes for
displaying various standard visual interface elements. Every pane has
its own drawing environment (coordinate system, font, line width,
and so on), so you can draw in a pane without worrying about
where it is on the screen. The THINK Class Library has classes that
make it easy to implement scrollable panes that have logical
dimensions which exceed the size of the enclosures in which they
are displayed.

Figure 3-1 illustrates a typical visual hierarchy. The desktop encloses
windows, each of which encloses at least one pane; each pane, in
turn, may enclose one or more nested panes; and so on, recursively.
Although the three derived classes—CDesktop, CWindow, and
CPane—are siblings in the class hierarchy, objects of these classes
are typically not at the same level in the visual hierarchy.

Desktop
Window Window Window
\ \ \
Pane Pane Pane
\
Pane
\
Pane Pane Pane

Figure 3-1 Typical visual hierarchy

Unlike the class hierarchy, the visual hierarchy is dynamic. It
changes as your program runs. When you open a new document,
you add another window to the desktop; and you add another set of
panes to the new window.
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The visual hierarchy and events

Visual events—mouse events, window activation and update
events—work their way down the visual hierarchy. Since Macintosh
update and activate events always have a window associated with
them, the appropriate member function of a window object is always
called directly to notify that window of such an event. Mouse clicks
and cursor adjustment notifications always work their way down
from the desktop to the active window and from there to the
appropriate pane.

Because they are descendants of CBureaucrat (discussed next),
views can be in the chain of command, and thus can respond to
direct commands.

The Chain of Command

The chain of command specifies which objects handle direct
commands, and in what order.

Bureaucrats, supervisors, and the application object

A bureaucrat is an object capable of handling direct commands. A
bureaucrat gets to handle a command when its DoConmrand member
function is called with that command as its argument. It is said to
handle the command if its DoConmmand function responds by doing
more than merely passing the command to another bureaucrat.
Technically, a bureaucrat is an instance of a class derived from
CBureaucrat. Derived classes of CBureaucrat can override
DoConmand to handle commands specific to an application.

The supervisor of a bureaucrat is itself a bureaucrat. The supervisor
of a bureaucrat is the object to which the bureaucrat passes direct
commands that it doesn’t handle itself. More precisely, when a
bureaucrat does not know how to handle a particular command, it
defers to its supervisor by calling the supervisor’'s DoConmmrand
function with that command as its argument. The default
DoComand function, as implemented in class CBureaucrat, calls the
DoConmand function of its supervisor. Thus a generic bureaucrat
takes no responsibility for anything.

When a bureaucrat is constructed, its supervisor is specified as an
argument to the CBureaucrat constructor.
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Every THINK Class Library program has a unique application object,
an instance of class CApplication. The application object is the only
bureaucrat that does not have a supervisor. Every bureaucrat is either
directly or indirectly supervised by the application object.

The supervision relation is, in fact, a tree—a hierarchy governing
how objects communicate among themselves. At the root of the tree
is the application object. The collection of bureaucrats, related by
supervision, is like an organization chart. Every bureaucrat has at
most one supervisor, and the head of the organization is the
application object. Whereas visual events work their way down the
visual hierarchy, direct commands work their way up through the
organization.

The gopher and the chain of command

The first object that has the chance to handle a direct command is
called the gopher. Your application is responsible for appointing the
bureaucrats that act as the gopher. The identity of the gopher is
dynamic, changing during execution in response to events.

Usually, the gopher is a pane in the active window. For instance, an
edit pane must be made the gopher in order to receive the
commands generated by keystrokes and by menu choices. Objects
further up in the visual hierarchy are seldom the gopher. Windows
are not made the gopher by THINK Class Library objects, and you
are unlikely to find a reason to do so yourself. The application object
is made the gopher only when no documents or windows are open.

If the gopher can't handle a command, it passes the command on to
its supervisor. Its supervisor can handle the command and return, or
defer to its own supervisor. Eventually, either some bureaucrat takes
action, or each one defers to its supervisor—until ultimately the
command reaches the application object. If the application object
doesn’t handle the command, no object does.

The chain of command is the list of bureaucrats starting with the
gopher and ending with the application object. The chain of
command contains all intermediary supervisors. It is a path in the
supervision tree. By definition, every object in the chain of command
is a bureaucrat.

Figure 3-2 shows a sample chain of command and visual hierarchy.
The gopher is a pane. The gopher’s supervisor is a document, which
also supervises the other pane and the window. A document is a
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kind of bureaucrat that manages the communication between
windows, files, and menu commands. If the pane can’t handle a
direct command, it passes the command on to the document. If the
document can’t handle the command, it passes the command to the
application. Note that the desktop’s supervisor is the application; this
is always the case in THINK Class Library programs.

The Chain of Command The Visual Hierarchy

| Application
|—>

>

Document

Window
Pane
[ Pane | The Gopher

Figure 3-2 The gopher, chain of command (black lines), and visual
hierarchy (gray line)

The enclosure relationships of the visual hierarchy are drawn in
gray; the supervisory relationship is drawn in black. Notice that
although the chain of command and the visual hierarchy overlap,
they are nevertheless distinct. In the example, the panes and the
window have the same supervisor—the document.

The Flow of Control

The chain of command and the visual hierarchy get their direction
from the switchboard. The switchboard gets events from the
Macintosh Event Manager and converts the events to member
function calls affecting either the chain of command or the visual
hierarchy.

Functions that affect the chain of command are usually called
through the gopher, the first bureaucrat in the chain. Functions
affecting the visual hierarchy are called by the active window or the
desktop. Update and activate events affect the visual hierarchy.
Mouse clicks can affect the visual hierarchy (if the click is in a
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window) or the chain of command (if it's in the menu bar).
Keyboard events are dispatched to the gopher as keystroke-related
function calls, or in the case of keyboard equivalents for menu items,
as commands.

Working with Menus

The THINK Class Library lets you work with your menu commands
at a higher level than does the Macintosh Toolbox. Instead of
identifying a menu command by its menu ID and item number, the
THINK Class Library lets you assign unique command numbers to
each item of the menu. With command numbers, you can reassign
functions to different menu items without having to rebuild the
application. Command numbers represent all direct commands; the
DoConmmand member function of class CBureaucrat takes a
command number as its argument.

The THINK Class Library reserves command numbers for the most
common Macintosh application commands, such as New, Open,
Save, Quit, Page Setup, and others.

When you choose a command from a menu, the desktop uses the
bartender to translate the menu choice into a direct command, which
it then passes to the gopher.

Menus need not be, and sometimes cannot be, completely specified
when you build your application. For instance, menu items like Cut
and Copy must be enabled and disabled at run-time depending
upon whether there is or is not a selection. The THINK Class Library
makes it easy to do this. You also can check and uncheck items to
reflect whether or not an item is in force. For instance, some items
represent toggles; for example, Bold might be checked only when
newly entered text is in boldface. Or a set of menu items can form
an exhaustive and mutually exclusive group; for example, the font in
use at the insertion point might be checked on a menu.

A better example is the Font menu. It consists of a set of items
whose totality cannot be determined at the time that the application
is designed. The fonts listed in the menu should be those installed
on the machine running the application. Using the THINK Class
Library, you can create menus while your program is running to
reflect the environment. Choices from menus built at run-time are
also converted into direct commands.
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The THINK Class Library lets you add menu items to existing menus.
For instance, you might want to add the Font menu to a general
text-handling menu, or you might want to append it to a menu with
the names of all the documents your application has opened.

Creating an Application

To create an application that uses the THINK Class Library, you
derive new classes from existing classes that the Library provides.
Your new classes implement the unique parts of your application;
generic application behavior is already taken care of by the base
classes in the Library. Generally, you need to derive the following:
one class for your unique application object; one or more classes for
documents—one for each type of document that your application
deals with; and various pane classes, which provide the user
interface.

In addition, you need to define your menu structure containing the
commands that your application implements, and the linkage
between menu items and commands (that is, which command is
performed in response to which item). Finally, you may need to
define other resources, such as strings of various sorts (for
changeable menu item text, error messages, and so on).

Visual Architect streamlines the process of creating, editing, and
connecting the classes, menus, commands, and other resources
needed by your application. The next chapter introduces you to this
powerful tool.
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Basic Concepts
4

-I-his chapter explains the basic concepts of Visual Architect. It helps
you understand how Visual Architect works and how it can aid in
the development of your application’s user interface. Part Three in
this guide, “Using Visual Architect,” discusses Visual Architect in
greater detail. If you are not familiar with the THINK Class Library,
read the previous chapter, “THINK Class Library Basic Concepts,”
before proceeding with this chapter.
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How Visual Architect and the THINK Project Manager Cooperate 27
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How Visual Architect and the THINK Project
Manager Cooperate

Visual Architect is designed for use with the THINK Project Manager.
Although it is possible to run Visual Architect by itself, usually you
launch it from the THINK Project Manager and alternate between the
two while constructing your application’s user interface. Also, if you
are running System 7 (recommended), you can control some of the
THINK Project Manager’s functions from Visual Architect using built-
in Apple events.

Visual Architect generates source code files that are added
automatically to your Symantec C++ project. It also edits a single
resource file, which is a part of your project as well.

Source code files created by Visual Architect

The source code files generated by Visual Architect contain
definitions and declarations for the classes created while designing
your user interface. These files are standard C++ . cp and . h files
and can be opened and edited using the THINK Project Manager. In
fact, you usually modify a subset of these files during the
development cycle, as discussed later in this chapter. The Visual
Architect source code files reside in the Application segment of your
project and are compiled and linked with the other files in your
project, such as the THINK Class Library files and the files you write
yourself.

Note
By inspecting the source code files Visual Architect
creates, you can learn the function and
implementation of many of the THINK Class Library
classes. Visual Architect comments the code it
generates to aid in interpretation.

Visual Architect uses special files called macro files to generate
source code. A macro file is an ordinary text file that contains C++
source code and macro expressions, which Visual Architect
interprets to produce one or more source code files as output. The
macro files supplied with Visual Architect can generate the source
code for a complete, running THINK Class Library application.
Because macro files are ordinary text files, you can modify them to
suit your programming style or extend them with new capabilities.
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Note
One particular macro file, Gener at e TCLApp,
contains only macro statements that control the
other macro files that are used by Visual Architect.

The resource file edited by Visual Architect

In addition to generating source code files, Visual Architect edits a
resource file named Vi sual Ar chi t ect. r src. This file contains
many of the standard user-interface resource types, such as' W ND
and ' CNTL' , as well as some of its own types.

Note
You do not need to modify the resources created by
Vi sual Archi t ect. rsrc using any other
resource editors.

Visual Architect defines one particular resource type, ' CVue' , that is
used to describe each view or subview, and all the subordinate
objects pointed to by the view and subview, such as borders and
controls. You will learn more about views later in this chapter.

The source code files generated by Visual Architect, along with

Vi sual Archi t ect. rsrc, are incorporated automatically into
your Symantec C++ project, if the THINK Project Manager is running
concurrently.

Creating and Modifying Classes

One of Visual Architect’s most powerful features is its interactive,
graphical environment for deriving classes from the THINK Class
Library and defining their data members and member functions.

Although the classes you create are generally derived from the set of
base THINK Class Library classes that Visual Architect knows about,
you can specify that your classes be derived from other classes you
previously created. This allows you greater flexibility and control.

In general, the classes you construct fall into one of three categories
of user interface design:

« Views

e Commands
< Menus
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Working with Views

Visual Architect provides several predefined views for implementing
common graphical representations, such as document windows and
floating tool palettes. Each view is implemented by means of a
particular class. When you add a view to your project, Visual
Architect generates the class necessary for proper functioning of the
view, as well as the associated resources. You need not be
concerned with the details of the class hierarchy. This frees you to
concentrate on developing your application’s user interface and
visual hierarchy.

The most important view defined by Visual Architect is the main
window view. Main window views typically are displayed in an
application when the user chooses New or Open from the File
menu. They display the contents of an associated file.

Visual Architect also defines views for implementing, for example,
dialog boxes, alerts, splash screens, and floating windows, as shown
in Figure 4-1.

Please name the new view

Name: | MyDialog |

View Kind: piTEINT|
Floating Window
Main Window
Modal Dialog
MNew... Dialog
Splash Screen
Subview
Tearoff Menu
Window

Figure 4-1 The New View dialog box, showing predefined view types

Visual Architect lets you change the attributes of a view, such as
whether it has a scroll pane and whether its window has a close box.
Instead of writing the code by hand, you can change these attributes
through dialog boxes in Visual Architect.
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Adding graphical elements to views is also easy. Visual Architect’s
Tool Palette, shown in Figure 4-2, is used in much the same way as
Resedit is used: You can add view elements—buttons, check boxes,
static and editable text fields, scrollable text fields, and pictures—as
well as more complex and user-definable elements. Visual Architect
then generates the necessary classes.

— Static Text

Radio Button

Edit Text

Check Box
Select Icon
Button

Picture
Pop-up Menu

p-up | Icon Button
Scroll Bar —— EE [@\*Picture Button
ListTable —| E
Q — Panorama

Straight Line | q Q¥Subview
Unconstrained Line — " '::;' ﬂk L Rounded Rectangle

— Polygon
Rectangle

Oval
Figure 4-2 The Tool Palette

Visual Architect provides a convenient way to change important data
member values in each class in an object’s class hierarchy through
CView. For example, if you are constructing a dialog box and want
to define its OK button, you can access data members in CButton,
CControl, CPane, and CView.
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In Figure 4-3, the left window shows the dialog box MyDialog
under construction. The right window shows access to data
members for classes in the OK button’s class hierarchy.

MyDialog =] My0KButton —m0e—=——
Identifier: |MyoKButton |
Enter some text: Left- Top:
> Width: Height:
~ CButton
| Command: | cmddk |

~ CControl

contrlTitle:

|k

contrlalue: I:I

contrlMin: D

contr] Max: |:|
[ CPane

Figure 4-3 Accessing the OK button’s class hierarchy

Defining the Commands

Commands link user actions with classes’ member functions.
Through commands, objects communicate with each other the action
a user desires. The THINK Class Library predefines many such
commands, such as closing a window, changing text attributes,
saving a file, and quitting the application. These pre-existing
commands significantly reduce the amount of coding you need to
do. However, you have to define commands for those functions
unique to your program.

When you define a new command using Visual Architect, you indicate
those classes you would like to respond to the command. Visual
Architect generates skeleton code for the appropriate classes, into
which you later insert your code to handle the command. Because
one of the most common results of a user action is the opening of a
window, you can specify that a command cause a window to be
opened, and Visual Architect generates the necessary code.
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For example, in Figure 4-4 you want to add a new command,
cnmdOpenMyDi al og, to class CMain. When cndCpenMyDi al og is
sent to CMain, CMain opens a view as defined by the class
CMyDialog. Notice some of the predefined commands available in

the scrolling list.

Commands

LImaLopyg

ir |cmdl]penMgI]ialug

cmdCut

cmdDoubleSpace Number: 512

cmdExtend Actions:

cmdltalic | !n Class: | CMain |

cmdNew None
cmdNull m

cmd0
cmdOpe
cmdOpenMyDialog [

CMain
C™yDialog

Figure 4-4 Adding a command using the Commands dialog box

Visual Architect also lets you associate commands with the elements
that send them, such as buttons and menu items.

Constructing Menus

Visual Architect lets you assemble menus and link menu items with
their associated commands. The interface with which you build
menus is similar to that of ResEdit. In addition to constructing the
menu resources, Visual Architect adds the command number that
each menu item sends when the user selects the item. All you have
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to do is specify the command from the list of available commands, as
shown in Figure 4-5.

Menu ltems

File

New it| | Close |
Open...

- Cluac siyhmenu

Other... PR TH I EEN
2232 As... cmd1HalfSpace EH:IEI
Revert to { C¢MdAbout
_ cmdAlignCenter Mo _
Page Setyy tmdRlignLeft on | MATK _None v
Print... cmdAlignRight
- cmdBold
Quit cmdCancel
cmdClear
Command:
cmdCondense
cmdCopy
cmdCut
cmdDoubleSpace
cmdEdtend
cmdltalic
w

Figure 4-5 Linking commands via the Menu Items dialog box

Visual Architect’s menu editor supports menu item marks and icons,
as well as hierarchical, pop-up, and tear-off menus. In addition, you
can specify the menus you want to appear in the menu bar.

Adding Balloon Help

Balloon Help can be added to panes, menus, and menu items with a
simple menu choice, followed by typing the text you want to appear
in the balloon. Because user interface elements can be in different
states—such as enabled and disabled—when the application is
running, you can define up to four different balloons for each
element.
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Previewing Your Views

Visual Architect lets you see how your view works before you
complete a development cycle of generating source code, compiling
it, and running the application. When you preview, or try out, a
view, it appears exactly as it would in your running application.
Furthermore, you can interact with the view just as if the application
were running. For example, you can scroll, resize, and reposition the
view’s windows. All the view’s elements—such as pop-up and tear-
off menus, edit text fields with type constraints, scrolling edit text,
custom buttons, and button groupings—are active as well.

Previewing your views lets you glimpse the final product of your
work quickly and conveniently. This enables the design process to
proceed more rapidly.

Modifying the Code Generated by Visual
Architect

Programming is rarely accomplished in one step. Most often, you
design some user interface elements in Visual Architect, do some
hand coding in the THINK Project Manager, compile, run, and
inspect your project, then return to Visual Architect to make changes
and start the cycle again. Therefore, Visual Architect does not force
you to live with the code it generates “as is.” Much of the standard,
commented C++ code it generates is skeleton code, a user-interface
framework to which you add the source code that makes your
application unique. Furthermore, due to the structure of the source
code files, Visual Architect does not, in subsequent code-generation
steps, overwrite changes you make to your code by hand.

Split-level classes

Visual Architect facilitates and protects hand-coding with a technique
known as split-level classes. Most classes defined in Visual Architect
are implemented as two classes: a lower-level class, reserved for
Visual Architect, and a higher-level class, reserved for your custom
programming. The first time Visual Architect generates source code
for a graphical element, it generates both classes, each in a separate
file.

The lower-level class contains code that Visual Architect generates
from scratch each time the element it defines is modified. Most of
Visual Architect’s generated code appears here. Generally, there is
no reason for you to modify this code.
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The upper-level class is derived from the lower-level class. It
contains code, such as added and deleted member functions, that
you hand-write on top of the skeleton functions generated by Visual
Architect. The upper-level class lets you override lower-level class
member functions and add additional data members. Visual Architect
writes to this file only once, when it generates the class files after
you first define the class. After that, you are responsible for
maintaining the upper-level class file.

Visual Architect employs a specific naming convention to distinguish
levels. If you create a class named MyDi al og in Visual Architect,
Visual Architect creates four files: x_MyDi al og. cp,

MyDi al og. cp, x_MyDi al og. h, and MyDi al og. h. Files with the
x_ prefix contain the lower-level class; those without the prefix
contain the higher-level class.

Where to Go Next

You should now have a basic understanding of both the THINK
Class Library and Visual Architect. The THINK Class Library gives
you the classes necessary to specify fully and organize the visual
entities that make up your application. Visual Architect is a powerful
environment for developing your user interface with the THINK
Class Library.

The two tutorials in Chapters 5 and 6 give you the opportunity to try
out the THINK Class Library and Visual Architect. The first
demonstrates the concepts you've just learned; the second reinforces
them and presents some additional features and techniques. After
performing the tutorials, read Part Two, “Using the THINK Class
Library,” and Part Three, “Using Visual Architect,” for more detailed
information.
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Tutorial:

Beeper
S5

-I-his tutorial demonstrates some of the basic properties of Visual
Architect. It shows you how to create a simple application called
Beeper using the THINK Class Library. Visual Architect helps you
build the user interface portion of Beeper.
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2
About the Tutorial

The tutorial gets you started with Visual Architect and builds your
confidence using it as a development tool. The Beeper application
you will build is simple. It allows you to call up a dialog box
containing an edit text field into which you enter a number
representing the number of times your Macintosh will beep. The
dialog box also contains a push button that starts the beeping.

This tutorial contains a lot of information. You should plan to spend
about one hour completing it.

Getting Started

Creating the Beeper project

Because you are creating this application from scratch, you first need
to create a Beeper project:

1. From the Finder, launch THINK Project Manager, which
resides in the Symant ec C++ for Maci nt osh folder.

A File Open dialog box appears.
2. Choose New from the File Open dialog box.

The New Project dialog box appears, similar to the one
shown in Figure 5-1.

New Project

Select type of project to create:

Uisual Architect Project
C++ 10Streams Project
C++ Project

Empty Project

[<] Create folder

Figure 5-1 The New Project dialog box
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3. Select Visual Architect Project from the list, make sure
Create folder is checked, and click Create.

A File Save dialog box appears.

4. In the File Save dialog box, name the new project
beeper, place it somewhere outside the Symant ec C++
for Maci nt osh folder, and click Save.

A folder named beeper f is created automatically, and the
beeper . Tt project is created inside it. A window titled beeper.1t
appears.

Designing the User Interface

You now run Visual Architect to design Beeper’s user interface. This
process involves creating dialog boxes, push buttons, and menus.

Starting Visual Architect
Visual Architect is launched directly from the THINK Project
Manager:

1. In the beeper .m project window, shown in Figure 5-2,
locate the segment titled Visual Architect.

IE=—— beeper.m
# Hame

= Yisual Architect
% READ ME.cp

Wisual drchitect rere

=~ TCL Core 1
+ CClipboard.cp
+ CPane.cp
% CSorollBar.cp
% CScrollPane.cp
% CSizeBox.cp
4 Chiew .cp

=~ TCL Core 2
%
%
%
%
%
&
%

[x)
2
S
L]

) =

Chrray .cp
CBartender.cp
CBureauctat.cp
CChore .cp
CCoMNaboratar .cp
CColection.cp
Chirector.cp

o Y e e T Y o Y e T TR e e e T R T 1

Figure 5-2 The beeper.Tt project window
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2. Double-click the Vi sual Architect.rsrc file to
launch Visual Architect with this file.

The Views List window appears, showing a list of defined views in
Vi sual Architect.rsrc. See Figure 5-3.

S1= Disual Architect.rsrc
Main

ail

]
o

Figure 5-3 The Visual Architect.rsrc Views List window

Creating the view for the Beeper dialog box
At present, Main is the only view defined in Vi sual
Archi tect.rsrc. To add a new view, the Beeper dialog box:

1. Choose New View from the View menu.

A New View dialog box appears, in which you specify a
view’s name and kind, as shown in Figure 5-4 .

Please name the new view

O untitied |

View Kind: | Dialog |

Figure 5-4 The New View dialog box

2. In the New View dialog box, type Beeper Di al og in the
field Name, leave Dialog chosen for View Kind, and click
OK.
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A new window titled BeeperDialog appears. This is the Beeper

Dialog view edit window, in which you construct the BeeperDialog
view.

Adding pane elements to the dialog box

To add pane elements to the Beeper dialog box, first add a static
text pane:

1. Click the Tools menu and tear off the Tool Palette shown
in Figure 5-5 by dragging beyond the edge of the Palette.
Put the Tool Palette off to the side of the screen and out
of the way.

Static Text

h‘::

Select —>h~

Push Button 7

——— Edit Text

NENsE R

=
P
=!I
_I_
T

Figure 5-5 The Tool Palette

Note
At this point, you may want to look ahead to Figure
5-10, which shows how the finished dialog box
appears.

2. Click the Static Text tool on the Tool Palette.

Note that the cursor changes to an I-beam when it is over
the BeeperDialog window.
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3. Click the cursor near the left side of the dialog box to

position the static text pane.

A blinking insertion point appears, indicating that you
should enter the text for the item.

4. Type Nunber of beeps: and either click elsewhere in

the window or press Enter to end the typing task.

*

Note

You can reposition any panes you add to a view by
dragging them within the window.

Next, add an edit text pane:

1. Choose the Edit Text tool from the Tool Palette. Note that

the cursor changes to a cross hair when it is over the
dialog box. Click the cursor to the right of the static text
pane you just added, to position the edit text pane.

An edit text box appears. You can constrain the type of
text the user is allowed to enter into the edit text pane by
selecting a special THINK Class Library class, as shown in
the next step. The edit text pane then becomes an
instance of this class.
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2. Choose Class from the Pane menu and choose
CintegerText from the pop-up menu, as shown in
Figure 5-6.

_Pane I

Pane Info... #L
snraiifans ot

4 CDialogText
CintegerText

Font 2
Size 2
Style b
Color...

Align »

Bring To Front
Send To Back

Seh Babion broup

Identifier... #d

Figure 5-6 Setting the class of the edit text pane

The next item to add to the dialog box is an OK button:
1. Choose the Push Button tool from the Tool Palette.
2. Click below the edit text pane you just added.

A push button named OK appears. By default, the first
push button added to a view is named OK.

The last item to add to the dialog box is the button that calls the
beep function:

1. Once again, choose the Push Button tool from the Tool
Palette.
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2. Click to the right of the edit text pane you added
previously.

A push button named Cancel appears. By default, the
second push button added to a view is named Cancel. In
this dialog, you must rename it.

3. Type Beep to rename it.

Creating the command to execute the beep function

By default, a cnrdOK command is sent by the OK button when the
button is clicked. The cndOK command is a predefined THINK Class
Library command for closing dialog boxes in response to clicks on
the OK button. However, the command that the Beep button sends
when it is clicked has not yet been defined. This command will call
the beep function, and you must define it yourself:

1. Choose Commands from the Edit menu.

The Commands dialog box opens, similar to the one
shown in Figure 5-7. The Commands dialog box lets you
add your own commands to those already defined in the
THINK Class Library.

2. Choose New Command from the Edit Menu
(Command-K) or press Return to activate the edit text
field. Type cndBeep to name the command.

This step adds a new command item named cndBeep.
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3. Choose CBeeperDialog from the In Class pop-up menu,
as shown in Figure 5-7, to indicate that the cntBeep
command should be handled by the class CBeeperDialog.

Commands
cmd1HalfSpace [emdgeep ]
cmdAbout Mumber: 512

cmdAlignCenter
cmdAlignLert
cmdAlignRight
cmdBeep
cmdBeeperDialog
cmdBold
cmdCancel
cmdClear

cmdlClnco

MNone

CApp
CBeeperDbialog

Bhaager |

Figure 5-7 Using the Commands dialog box to choose classes that
handle a command

4. Choose Call from the Do pop-up menu to indicate that
cmdBeep calls a function, namely the one that causes the
beeps.

Visual Architect later generates skeleton code for the member
function, into which you hand-code your CBeeperDialog class. Note
that a command number (512, in this case) is generated
automatically for this command. This is the number that THINK Class
Library routines use to identify the command.

5. Click OK to close the Commands dialog box.

Associating the cmdBeep command with the Beep button

To have the Beep button send a cnmdBeep command when it is
clicked:

1. Choose Pane Info from the Pane menu (Command-L).
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The Pane Info window for the push button opens, which
allows you to manipulate the values of many of the class
variables in the selected pane’s class and in its base
classes up through CVi ew.

2. Click the small triangle next to CButton to access the data
members of the CButton class, as shown in Figure 5-8.

[E=———————————— Butnl VFF——————|
Identifier: | T
"l'l"idth: Height:

= CButton
3

Command: | emdCance |

[+ CControl
[ CPane

Figure 5-8 Opening the CButton class in the Pane Info window

3. Choose cmdBeep from the Command pop-up menu,
which lists available commands.

4. Close the Pane Info window by clicking its close box.

Now a cndBeep command is sent when the Beep button
is clicked.

Setting the default command

Next, you should specify that cndBeep is the default command for
the Beeper dialog box. The default command is the one sent when
the user presses Return or Enter.

1. Choose Set Default Command from the View menu.
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This brings up a dialog box titled Default Command, as
shown in Figure 5-9. As you can see, cndOK is currently
defined as the default command.

Default Command

Command: | cmdOK ]

Figure 5-9 The Default Command dialog box

2. In the Default Command dialog box, choose cmdBeep
from the Command pop-up menu and click OK.

Note that the Beep button has now been outlined in the
BeeperDialog view edit window and that the OK button
has lost its outline. The Beeper dialog box should
resemble the one shown in Figure 5-10.

E§[I=——~————— BeeperDialog §E§|
ita

Mumber of beeps:
[ oK

o

B
Figure 5-10 The completed Beeper dialog box

3. Close the BeeperDialog view edit window by clicking its
close box; you have now finished constructing the Beeper
dialog box.
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Adding a push button to the Main view to open the Beeper dialog box
The Vi sual Architect.rsrc file has a default view defined
called Main, as you saw when you first started Visual Architect. To
add a push button to this view that, when clicked, brings up the
Beeper dialog box:

1. Double-click Main in the Views List window.

The Main view edit window opens. The Main view
already contains two panes, a picture of class CPicture
(the group of circles) and a static text panes of class
CStaticText (“hello, world!"). You can better visualize
these items by displaying their item numbers, as shown in
the next step.

2. Choose Show Item Numbers from the Options menu to
display the item numbers in the Main view edit window.

Right now, the Main window has a default size too small
to display a new button without the user having to scroll.
Increase the size of the window with the next step.

3. Using the size box in the Main view editing window,
extend the window'’s size downward by approximately
one inch.
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4. Resize the gray rectangle (the window’s por t Rect ) to fit
snugly within the window using the sizing handle at its
lower right corner, as shown in Figure 5-11.

= I==————— Main

ol

0,0 z0S, 290 =] I

Figure 5-11 Resizing the Main view window’s portRect

5. Now add the push button that brings up the Beeper
dialog box. Choose the Push Button tool from the Tool
Palette.
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6. Click just below the bottom of the circles to position the
button and type Beeper ...to name it, as shown in
Figure 5-12.

= 1EBD—————= Main

mEs

10Z, 240 181, 260 lal

Figure 5-12 Creating the Beeper button in the Main view edit
window

Creating the command to call up the Beeper dialog box

As with the Beep button in the Beeper dialog box, you need to
create a command to call up the Beeper dialog box. This time, you
do it in a slightly different way.

1. Choose Pane Info from the Pane menu (Command-L) to
bring up the Pane Info window for the push button.

2. Click the small triangle next to CBut t on to access its data
members.
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3.

Choose Other from the top of the Commands pop-up
menu.

The Commands dialog box opens, in which you can
now create a new command.

. Choose New Command from the Edit Menu

(Command-K) or press Return to activate the edit text
field. Type cndBeeperDialog to name the field.

. Choose CMain from the In class: pop-up menu to indicate

that this is the class that will handle the command.

. Choose Open from the Do pop-up menu to indicate that

the command should open a view.

Now indicate that you want this command to open the
CBeeperDialog view.
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7. Choose CBeeperDialog from the View pop-up menu, as
shown in Figure 5-13, to indicate that the command
should open a view of class CBeeperDialog (in other
words, the Beeper dialog). Visual Architect will later
generate the code to open the Beeper dialog.
Commands
cmd1HalfSpace ity c:rndBeepernialng |
-::deh_uut Mumber: 513
cmdAlignCenter Acti .
cmdAlignLeft ctions: :
cmdAlignRight In Class: | CMain |
cmdBeep Do:
cmdBeeperDialog MJNDHE
cmdBold
cmdCancel CBeeperDialog
CMain
cmdClear
Figure 5-13 Setting the view that the cmdBeeperDialog command
will open
8. Close the Commands dialog by clicking OK.
As you can see in the Pane Info window,
cndBeeper Di al og is now set as the command the
Beeper button sends when it is clicked.
9. Close the Pane Info window.
You are now finished designing the user interface using Visual
Architect.
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Previewing your view
Visual Architect lets you try out how the view will look and feel in
your application. All the graphical elements in a preview are active.

1. Choose Try Out from the View menu (Command-Y).

The Main view window opens exactly as it opens in the
running application.

2. Verify that the Beeper button is highlighted when clicked,
and that the scroll bars and size box function properly.

3. Close the Main preview window by clicking in its close
box.

You should now save your work.

< Choose Save from the File menu (Command-S).

Generating the Code and Updating the
Symantec C++ Project

Visual Architect must now generate the code to implement all the
classes associated with the user interface you designed. To have it do
this:

1. Choose Generate All from the THINK Project Manager
menu, which looks like the THINK Project Manager
application icon, as shown in Figure 5-14.

Generate...
Generate All...
Bring Up To Date U
Run *R

Figure 5-14 Choosing Generate All from the THINK Project Manager
menu
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Note

Because you're using Visual Architect for the first
time to generate code for this project, you need to
choose Generate All. For any subsequent code
generation for this project, you can choose
Generate, so code is generated only for those
classes that have changed since the last code
generation.

A dialog opens, showing the progress of the code generation. See
Figure 5-15.

Writing...
H_CBeeperDialog.cp

Figure 5-15 The code generation progress dialog

By default, Visual Architect uses the macro file

Gener at eTCLApp to generate code to the Sour ce
folder, which is in the Beeper [ folder. After Visual
Architect generates the files, it automatically adds them to
your project.

. Switch to THINK Project Manager and scroll to the end of

the beeper . 1 project window.
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Visual Architect has added the new source files to your
project in the Application segment, as shown in Figure
5-16.

beeper.m =——1

¥ Name
= Precompiled Symbols

% TCL 10 *includes cpp
= Application

# Chpp.cp
CBeeperlialog.cp
CHain.cp
CSaver_clazs.cpp
rmain.cp
PLACEHOLDER .cpp
References.cp
#_Cdpp.cp
w_CBeeperDialog.cp
“_CMain.cp
E Totals 1358 [{F

o o E o e o 8 @

|

Figure 5-16 The beeper.tt project window showing the Application
segment

Modifying the Generated Code

To modify code generated by Visual Architect so you can write the
beep function:

1. Open the x_CBeeper Di al og.cp file in the Application
segment by double-clicking its name.

Note
Because the x_CBeeper Di al og.cp file has an
x_ prefix, it is identifiable as containing the lower-level
class description for the Beeper dialog view. This file
has an associated header file x_CBeeper Di al og. h.
The lower-level files are regenerated from scratch each
time you make changes to the BeeperDialog view and
generate code in Visual Architect.

2. Find the member function
X_CBeeper Di al og: : DoCndBeep() and copy it in its
entirety to the Clipboard.

56  Visual Architect and THINK Class Library Guide



Modifying the Generated Code

3. Open the file CBeeper Di al og. cp.

*

Note

Because the CBeeper Di al og. cp file has no
prefix, it is identifiable as containing the upper-level
class description for the BeeperDialog view. This
file has an associated header file

CBeeper Di al og. h. Because Visual Architect does
not generate these two files again, your hand-
coding will not be overwritten.

4. Paste the copied function at the end of

CBeeper Di al og. cp and rename it
CBeeper Di al og: : DoCndBeep() .

Because the class CBeeper Di al og is derived from
X_CBeeper Di al og, the member function
DoCndBeep() in CBeeper Di al og. cp overrides the
one in x_CBeeper Di al og. cp.

As is, CBeeper Di al og: : DoCrdBeep() doesn’t do
anything, so you need to modify it to look like this:

/*********************************************

DoCndBeep { OVERRI DE}

Respond to cndBeep conmand.

*********************************************/

voi d CBeeper Di al og: : DoCdBeep()
{

| ong n;

n = fBeeperDi al og_Edi t 2->Get | nt Val ue();

for (longi =0; i <n; i++)
SysBeep(1);
}

The expression:

f Beeper Di al og_Edi t 2- >CGet | nt Val ue()

calls the function Get | nt Val ue() , which is a member

of the class CintegerText from which f Beeper Di al og is

derived. The function returns the value in the edit text
field as an integer.
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5. Near the top of the CBeeper Di al og. cp file, remove
the // comment characters from the line:

/'l #include "AppConmands. h"

This step is necessary because cndBeep is defined in
AppComands. h.

Note
By default, the inclusion of the AppCommands. h
header file is commented out to prevent
unnecessary compilation of files whenever the
AppComands. h file is changed.

6. Open the file CBeeper Di al og. h by selecting its name
in CBeeper Di al og. ¢ and choosing Open Selection
from the File menu (Command-D). As a public member
function of the CBeeper Di al og class, add the
definition:

voi d DoCndBeep() ;
You have now completed the necessary code modifications.

Updating and Running the Application

With the design and coding of the Beeper application complete, you
can compile and link the beeper .1t project:

1. Choose Bring Up To Date from the Project menu
(Command-U) in THINK Project Manager.

Allow time for the compilation to occur, because the
project contains many files.

If you receive any compile or link errors, be sure that the
code was entered exactly as written in the previous
section.

2. Choose Run from the Project menu.

When Beeper starts, the Main view window opens with the Beeper
button. Clicking this button makes the Beeper dialog box appear.
You can enter an integer value into the edit text field and click Beep,
and your Macintosh beeps that number of times.
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2
Where to Go Next

This tutorial demonstrated some of the basic techniques used in
working with Visual Architect. Now that you have a good idea of
what the THINK Class Library and Visual Architect can do for you,
you should proceed with the tutorial in the next chapter. The
Process Monitor tutorial covers Visual Architect and the THINK Class
Library in greater depth. You should also read Part Two, “Using the
THINK Class Library,” and Part Three, “Using Visual Architect” for
more information.

For now, you can try adding more items to the Beeper dialog box
and more views to the application. Doing so will help you get a feel
for how Visual Architect’s code generation scheme works in
incremental development.
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Tutorial:

Process Monitor .
6

In this tutorial, you graphically create the user interface for a simple
application with Visual Architect and generate code for it. The
application contains many of the basic user interface elements: two
main windows, a subview, a New... Dialog, push buttons, check
boxes, scroll bars, text fields, and menus.
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2
About the Tutorial

The application you will build is called Process Monitor. It displays a
list of all processes currently running on your Macintosh and lets you
arrange the list by name, process serial number, or signature. The
application presents two views of this information: one shows only
the list of processes; the other not only shows the list of processes
but also displays additional related information, including controls
that may be manipulated by the user. Three push buttons are
displayed that let the user:

= Enter the debugger
= Kill the selected process
« Bring the selected process to the front

In addition, a group of check boxes is displayed that show the
current settings of the ' SI ZE' resource flags for the selected
process.

The application has a New... Dialog, which comes up when New
command is chosen from the File menu and lets the users choose
the view they want to look at. The choices are Process List and
Information, and Process Only.

You may have noticed that the key piece of information displayed by
these views is the same, that is, the list of running processes. Rather
than create this component twice, you need to set it up only once
and use the same component in both views. The creation of a
subview is what gives you the ability to perform this time-saving
action.

A considerable amount of information is contained in this tutorial,
and you shouldn’t worry if you don’t understand everything. Most of
it will become clear to you as you proceed through the tutorial. All
will become apparent as you use and become more familiar with
Visual Architect. You should spend a few hours completing the
tutorial.

Getting Started

What's special about Process Monitor.Tt
The Process Mbni t or.mtproject is the same as a project created
with the Visual Architect project model, with the following additions:
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« Added to the Vi sual Architect.rsrc file were icon
resources that you will use later for custom buttons.

= Added to the project were the source files from the folder
Sour ce, that are pre-edited versions of files created by
Visual Architect.

= Added to the project were the source files from the folder
Extra Sources.

The use of these files will become apparent as you progress through
the tutorial.

Starting with the Process Monitor.Tt project

Normally when you start a Visual Architect project, you use the
Visual Architect project model supplied with Symantec C++. But a
project has been created to make working with this tutorial easier.
To get started, open the project.

= Double-click the Process Moni t or . 1t project, which

can be found in Process Mni tor f, inside the TCL
Denos folder.
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*

At this point, the THINK Project Manager is launched, and the
Pr ocess Moni t or .1 project window appears on the right side of
your screen, as shown in Figure 6-1.

Process Monitor.mw
ﬁ Name
=~ Wisual Architect e
Visual Architect rsrc
TCL Core 1
TCL Core 2
TCL Core 3
TCL Core 4
TCL Core 35
Controls 1

x)
o
-
L]

Binary Streams
Dialogs

Files

Floating
Bitmaps

Tables

TCL Libs 2

o
el

Figure 6-1 The Process Monitor.Tt project window
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You now need to start Visual Architect.

« Double-click the Vi sual Architect.rsrc file at the
top of the project window.

You see a Visual Architect Views List window like the one shown in
Figure 6-2. As you create new views in the project, their names are
displayed in this window. A view can be a dialog, a window, or a
subview. Every Visual Architect project you create with the Think
Project Manager has its own folder and unique version of the
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Vi sual Architect.rsrc file within that folder, to maintain the
special view resources for the project.

Uisual Architect.rsrc

O

Main

[

2[4

Figure 6-2 The Visual Architect project window

The Views List window contains a sample view called Main, which
displays a “Hello, World!” message. You will change the
characteristics of this view to create the Process Monitor application.

A note about resources in the Visual Architect.rsrc file

Some of the user interface elements that Visual Architect helps you
create are icons and icon buttons. To be available for your selection,
however, the resources for the icons you want to use must be in the
form of compiled ' ci cn' sand ' | CON s resident in the Vi sual
Archi tect. rsrc file. In general, you can use ResEdit or
Resorcerer to cut and paste icons from a resource file into any

Vi sual Architect.rsrc file.

This tutorial uses special icons for some of its controls. To save time,
aVisual Architect.rsrc fileis provided, with these resources
already copied into it.
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Setting the application information
You should now specify the top-level characteristics of your
application.

1. Choose Application from the Edit menu to bring up the
Application Info dialog box similar to the one shown in
Figure 6-3.

Application Info

Copyright: |Ehris Prinos, Symantec Corp. |

Signature:

File 1ds:  [Prm1 | [Prv2 ]| I |

Figure 6-3 The Application Info dialog box

2. Type your name and company, or fictional ones, in the
Copyright field.

3. Type a four-letter signature, Pr Mo, in the signature field.

4. Type Pr ML and Pr M2 for the file IDs. File IDs are used by
the Finder to associate your application with its particular
document types.

5. Click OK to close the Application Info dialog box.

Don’t change the application information after starting your project,
unless you don’t mind some of your files being regenerated.

Building the User Interface

Creating the main window
You're ready to create your main window. Start by opening the
default Main view.

1. Double-click Main in the Views List window.

The Main view edit window appears. You need to empty
it and prepare it for your own additions.
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2. Choose Select All (Command-A) followed by Clear from

the Edit menu.

You need to change the characteristics of the main

window.

3. Choose View Info from the View menu.

A View Info dialog box such as the one shown in Figure

6-4 appears.

Main (Document) Info

Title: | Process Info

i ndow Class:

| 1D:128 [ modal
(<] Use file

| B4 Print

[] actclick

Pogition | Staggered wr] a0t !

B<] qudweayFlag

i proclDn:

Figure 6-4 The Main View Info dialog box

4. Type Pr ocessl nf o (no space) into Name and

Process | nf o into Title.

5. Click the second window type icon from the left to make
the view’s window a noGr owDocPr oc type (procl D 4)
(with a close box but no scroll bars).

You can leave the rest of the default values as they are.

6. Click OK to close the View Info dialog box.
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Note
Throughout this tutorial, you are asked to give
names (identifiers) to various visual elements. It is
extremely important that the names you type match,
in spelling and case, those given in the tutorial. If
any of the names are not the same, the pre-edited
source files provided for you will not compile

properly.

You can now see how your window will look when
running the application.

7. Choose Try Out from the View menu (Command-Y).
The window should look similiar to the one in Figure 6-5.

= [=———= Process Info §—|

Figure 6-5 Previewing the Process Info view window

8. Close the window after examining it to see if it is correct,
by either clicking its close box or choosing Close from
the File menu (Command-W).

You should now set the size of the Process Info window.

9. Use the size box in the Main view edit window to extend
your window’s size to approximately a six-inch square.
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10. Resize the gray rectangle (the window’s por t Rect ) to fit
snugly within the window using the sizing handle at its
lower-right corner. If you drag the size box to the edges
of the window, the view scrolls automatically.

Drawing rectangles

It will be more convenient to have the Tool Palette handy

throughout the tutorial, so you should tear it off and place it next to
the Main view edit window.

1. Click the Tools menu and drag the mouse beyond the
edge of the Tool Palette. You can now place the menu’s
outline wherever you want it to be.

Figure 6-6 shows the Tool Palette identifying callouts for
the tools you will use in this tutorial.

T

Select 7>k @ Static Text
Push Button ———| E‘k Radio Button
Pop-up Menu 743 Check Box
o =] Icon Button
List/Table —— 5] | Subview
—|— — Rectangle

Figure 6-6 The Tool Palette with callouts for tools used in this tutorial

The six tools at the bottom of the Tool Palette look and
act like the standard drawing tools found in Macintosh
draw programs. Using the Rectangle tool, draw three
rectangles in your main window.

2. Choose the Rectangle tool from the Tool Palette. Double-

clicking the tool causes it to stay selected until you
choose a different tool.
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3. Create three rectangles in your Main view edit window by
clicking where you want to place the upper-left corner of
each rectangle and then dragging until it's the right size.

4. Size and position your rectangles so the Main view edit
window resembles the one in Figure 6-7.

S I=——"—"— Processinfo

mEE

Figure 6-7 The Main view edit window

The rectangles serve as decorative elements and delineate functional
areas in the main window. They can also be activated to serve as
buttons or used to mask off certain active controls. You will explore
the latter concept later.
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Creating static text items

Note
As you work through this part of the tutorial, you

may want to look ahead to Figure 6-23, which
shows you how the finished window appears.

Give the upper-right rectangle a title.

1. Select the Static Text tool from the Tool Palette, click near
the top of the upper-right rectangle, and type in the
words Process Control.

2. Click in the window to end the typing task.

Note
If you need to edit the text after ending the typing
task, select the text and press Return.

3. Select the text and move it to the location where it looks
best.

Note
Rather than resize or move the text graphically, you
can choose Pane Info from the Pane menu box
and edit the values at the top of the dialog
(Command-L).

Creating push buttons

The top-right rectangle contains three push buttons of the
ClconButton class. This button type supports multiple activation
states. The first push button causes the program to drop into the
debugger.

1. Select the Icon Button tool from the Tool Palette and click
toward the upper-left edge of the upper-right rectangle.

The button appears with a default icon; however, some
more interesting ones have been copied into the resource
file. You can select one of these icons instead of the
default one.
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2. Choose Pane Info from the Pane menu (Command-L), or
double-click the bottom pane.

The Pane Info window, similar to the one shown in
Figure 6-8, appears. Note that the value in the Identifier
field may vary.

1denti fier : | [ENETI
\'f'idth: Height:

[~ ClconButton
Off Hi  On On Hi

¢ ¢

buttonkind: [ PushButton w]
[ eolorHitite [ outlinedn

walue: El

[+ CleonPane

[ CPane

Figure 6-8 The Pane Info window for the Debugger button

3. Open the ClconButton class by clicking the triangle to the
left of the class name.

As you can see, there are four possible states for a
ClconButton: Off, Off Hi, On, and On Hi, and each of
these can have its own icon.

4. Click the icon representing the Off position.
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An Icon Pick dialog box comes up, showing all the icons
in the Vi sual Architect.rsrc file and thus are
available for your use, as shown in Figure 6-9.

Icon Pick

- 123

Figure 6-9 The Icon Pick dialog box

5. Click the bomb symbol with the fuse unlit (ID #128) and
click OK.

6. Repeat the previous two steps for the Off Hi button state
using the icon of the bomb with the lit fuse (ID #129).
The On and On Hi states are not used for this type of
push button.

Define the behavior of the button by setting the value of
the but t onKi nd data member.

7. Choose PushButton from the buttonKind pop-up menu.
Now it’s time to make the button actually do something.

Associating commands with buttons
First, set the current command associated with the Debugger button.

1. Open the ClconPane class by clicking the triangle to the
left of the class name. Note that the Command field is
currently set to cndNul | .

You need the Debugger button to perform a command
that doesn’t yet exist in the list. It will be a custom
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L 4
command called cndEnt er Debugger that invokes the
debugger.

Later, code will be provided to perform the actual
command. For now, however, the command name can be
added to the project so a framework can be generated for
the code.
2. Choose Other from the Command pop-up menu (at the
top), as shown in Figure 6-10.
Identifier: |[ENHE |
[ ClconButton 7
[~ ClconPane
Command: T
crd 1 HalfSpace
[z CPane cmdébout
B criddlignCenter
[ C¥iew cmdélignLeft o
crnd&lignRight
cmdBold el
crndCancel
crdClear
crdClose
-

Figure 6-10 Choosing Other from the Command pop-up menu in the
Pane Info window
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The Commands dialog box appears, similar to the one
shown in Figure 6-11.

Commands
cmdClose il -::denterI]Ehugger |
cmdCondense
Mumber: 512
cmdCopy '
cmdCut Actions: :
cmdDoubleSpace In Class:

cmdEnterDebugger

cmdExtend Hiann | Mone W%

cmd I talic :

cmddJustify
cmdNew

cmidsnll

Figure 6-11 The Commands dialog box

3. Choose New Command from the Edit menu
(Command-K) or press Return to activate the edit text
field, then type in your new command name,
cndEnt er Debugger .

You now need to tell Visual Architect that you want a
command handler to be generated in the class CMain for
the cndEnt er Debugger command.

4. Choose CMain from the In Class pop-up menu.
5. Choose Call from the Do pop-up menu.
6. Click OK to close the Commands dialog box.

You are back in the Pane Info window for the Debugger
button. Verify that the Command pop-up in ClconPane is
set to cndEnt er Debugger .

7. Click the close box to leave the Pane Info window.
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Assigning identifiers

Visual Architect gives all the user interface elements you create a
unique name, but it is easier to keep track of them if you give them
more meaningful names. For example, name the button you just
created DebuggerButton.

1. Choose Identifier from the Pane menu (Command-J).

The Identifier dialog box appears, as shown in Figure 6-12.

Identifier

Identifier: | DebuggerButton

Figure 6-12 The Identifier dialog box

2. Type Debugger But t on in the Identifier field and click
OK.

Note
You can also set the identifier of a pane directly in
the Pane Info dialog box.

You also need to do this with the rest of the elements you create,
with the exception of simple components such as decorative
rectangles and static text items. This way, names in the code that you
generate match those in the source files provided in the tutorial
folder.

The second push button in the group is for killing the currently
selected process in the list. To create this button, repeat the steps in
“Creating push buttons,” “Associating commands with buttons,” and
“Assigning identifiers,” with the following departures:

= Creating push buttons, step 1: Position this button just
under the first button.

= Creating push buttons, step 5: Click the resting gun icon
(1D #131) for the Off state.
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< Creating push buttons, step 6: Click the shooting gun icon
(ID #130) for the Off Hi state.

= Associating commands with buttons, step 3: Name the
new command cndKi | | Process.

= Assigning identifiers, step 2: Set the identifier to
Ki | | Button.

The third push button in the group brings the selected process
window to the front. To create this button, you again need to follow
the steps for creating the Debugger button, with the following
departures:

= Creating push buttons, step 1: Position this button just
under the second button.

= Creating push buttons, step 5: Click the smiling sun face
behind the square icon (ID #132) for the Off state.

« Creating push buttons, step 6: Click the smiling sun face
in front of the square icon (ID #133) for the Off Hi state.

= Associating commands with buttons, step 3: Name the
new command crmdBr i ngToFr ont .

= Associating commands with buttons, step 4: Choose CApp
(not CMain) from the In Class pop-up menu.

= Assigning identifiers, step 2: Set the identifier to
Bri ngToFr ont But t on.

You need the cndBr i ngt oFr ont command to be handled by the
application (CApp), because windows other than CMain (Process
Info) support cndBr i ngToFr ont . (This is not true of the first two
commands.)

This ClconButton class has no text associated with it, as a check box
or radio button does, so you should create a static text element that
goes next to each of the icon buttons.

1. Using the Static Text tool, create a static text pane next to
each of the three buttons, and type in the names Ent er
Debugger, Kill Process,andBring to Front,
respectively.
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You have completed your three push buttons and set up
commands (and handlers) for each of them. You can now
try out the buttons.

2. Choose Try Out (Command-Y) from the View menu.

A preview window appears as before, but now there are
active buttons. When you’re finished previewing, close
the window:

« Either click the window’s close box or choose Close
(Command-W) from the File menu.

Positioning objects

*

You now need to properly position the user interface elements you

created within the Process Info view. A constraint grid has been
activated by default to help you align your objects in straight rows
and columns.

1. Verify that Honor Grid in the Options menu is checked.

Position each of the three buttons and static text objects
in turn.

2. Select the object using the Select tool.
3. Drag the button to its new position.

There are two additional methods for positioning
elements. You can do either of the following:

= Move the selected element one grid step in any
direction by pressing the appropriate arrow key (up,
down, left, or right).

= Position and resize the selected element by editing its
data members directly in the Pane Info window, which
is opened by choosing Pane Info from the Pane menu
(Command-L). The left, top, width, and height values
control the position and size of the element within its
enclosing pane.

Changes made graphically are reflected in the values of
the data members, and vice versa.
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As a further refinement of the objects’ placements, you
can have them aligned automatically.

4. Select the three buttons using the Select tool by clicking
one button, then shift-clicking the other two.

5. Choose Left from the Align hierarchical menu in the
Pane menu.

Repeat steps 4 and 5 for the static text objects.

Creating check boxes

In the bottom rectangular section of the main window, you will
create a graphical representation of the flag settings in the ' SI ZE'
resource of the process currently selected in the process list. First
give a title to the bottom rectangle, as you did for the upper-right
rectangle.

1. Using the Static Text tool, create a static text object at the
top-left corner of the bottom rectangle and type Si ze
Resour ce to name it.

You need to create the check boxes that display the state
of each flag. You should create 11 check boxes in two
columns, as shown in Figure 6-13.

—S5ize Resource

[] TeutEdit Services [] Get Front Clicks
[]Stationery Aware []Background Only
[JLocal & Remote HL Events [ Multifinder Aware

[] 32 Bit Compatible [] Runs in Background

[] Child-Died Erents []Suspend/Resume Events
] High Level Event Aware

Figure 6-13 The Size Resource check boxes

2. Double-click the check box tool so the tool remains
selected continuously.

Repeat the following three steps for each check box:

3. Click the cursor approximately where you want the
check box positioned.
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The text field for the button is opened automatically

when you place the check box.

Table 6-1.

. Type in the appropriate label for the check box from

. Set the identifier for the check box by choosing

Identifier from the Pane menu (Command-J), typing in
the appropriate identifier from Table 6-1, and clicking OK.
Remember that spelling is important.

Check box label Identifier
TextEdit Services TEServices
Stationery Aware Stationery

Local & Remote HL Event LocalRemoteHL
32 Bit Compatible 1s32Bit
Child-Died Events ChildDied

High Level Event Aware HighLevelAware
Get Front Clicks FrontClicks
Background Only BOnly
Multifinder Aware Multifinder
Runs in Background RunsIinBackground
Suspend/Resume Events SuspendResume

*

Table 6-1 Check box labels and identifiers

Here's an example of how the decorative rectangles
discussed earlier can be given a more active role in your
user interface. By default, the want sCl i cks attribute (in
the CView part of the class) is set to TRUE. However, these
particular check boxes are for display only—you don't
want the user to be able to click them and change the state
of the check box. One way to prevent this is to go into the
Pane Info window for each of the 11 check box items and
change want sCl i cks to FALSE. A quicker way is to set
the rectangle surrounding the check boxes to ignore
mouse clicks, and place it on top of all the check boxes.

1. Select the rectangle surrounding the check boxes using
the Select tool.

2. Choose Bring To Front from the Pane menu.

3. Choose Pane Info from the Pane menu (Command-L) to
open the Pane Info window.
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4. Open the CView class and verify that the check box for
the data member want sCl i cks is not checked.

5. Close the Pane Info window.

Now the rectangle acts like a transparent sheet of glass
over the check boxes, allowing them to be seen but not
touched.

As a final step, bring the rectangle’s label in front of the
rectangle.

6. Select the static text item “Size Resource.”
7. Choose Bring To Front from the Pane menu.

Creating a subview
The remaining rectangular area in the main window is going to
contain a subview. First, give it a title.

1. Using the Static Text tool, create a static text object at the
top-left corner of the upper-left rectangle and type
Process Li st to name it.

Next, create the subview.
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2. Select the Subview tool and create a subview just inside
the rectangle’s border, as shown in Figure 6-14.

—Process List

e

e,

Figure 6-14 Creating the Process List subview

Note the shading of the subview area; it's clearly not an
ordinary rectangle. You can verify this by examining the
Pane Info window for the subview.

3. Choose Pane Info from the Pane menu (Command-L) to
open the Pane Info window and open the
CSubviewDisplayer class.

The CSubviewDisplayer’s Subview contains question
marks (??7) because no subview has yet been instantiated.
A subview is an entirely new view, so you must first
create the view.

4. Close the Pane Info window.

5. Choose New View from the View menu to open the New
View dialog box.

Visual Architect and THINK Class Library Guide 83



84

6 Tutorial: Process Monitor

6. Choose Subview from the View Kind pop-up menu and

name the subview Pr ocessLi st Subvi ew, as shown in
Figure 6-15.

Mame: | ProcessListSubview |

View Kind: RATTITT

Please name the new view

Floating Window
Main Window
Modal Dialog

New... Dialog
Splash Screen

Tearoff Menu !

Window

Figure 6-15 Creating a subview using the New View dialog box

7.

10.

11.

12.

Click OK to close the New View dialog box.

A new editing window opens, into which you can add the
subview’s elements. First, however, you’ll want to have
CMain’s subview pane refer to this new subview.

. Choose Processinfo from the Windows menu.

. Select the unnamed subview in the Process List area using

the Select tool.

Choose Identifier from the Pane menu (Command-J),
name the subview Pr ocLi st Subvi ew, and click OK.

Once again, choose Pane Info from the Pane menu
(Command-L) to open the Pane Info window and open
the CSubViewDisplayer class.

Choose ProcessListSubview from the Subview pop-up
menu and close the Pane Info window.

The subview is now properly incorporated into the Main view.
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Creating a scroll table

This subview contains a list of processes in a scrolling table, with a
pop-up menu, to allow a user to choose how to display the
processes. First return to the subview’s own editing window. To
begin editing the process list subview, bring its window to the front.

1. Choose ProcessListSubview from the Windows menu.

2. Select the List/Table tool and click-drag in the left side of
the Subview window to create a scroll table pane, as
shown in Figure 6-16.

ProcessListSubuiew

mEE

it

200,172 =1

Figure 6-16 Creating a scroll table in the ProcessListSubview view

3. Choose Identifier from the Pane menu (Command-J)
and type Pr ocessTabl e.

When the table pane is selected, the Scrollpane Info
item in the Pane menu becomes enabled. Although you
won't need to change any of the values in CScrollPane
now, you can verify that the Scrollpane item is enabled.
To do this:

4. Select ScrollPane from the Pane menu to open the
Scrollpane Info dialog box, and open the CScrollPane
class.

5. Close the Scrollpane Info dialog box.
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Setting the table command

The Pane Info window for the scrollpane brings you to the data
members for the CTable item contained within the scrollpane, not to
the scrollpane itself.

1. Choose Pane Info from the Pane menu (Command-L) to
open the Pane Info window, and open the CTable class.

You can set the double-click command for the table; this
is the command that executes whenever a user double-
clicks an item in the table.

2. Scroll down to the Command pop-up menu and choose
cmdBringToFront from the list, as shown in Figure 6-17.

[[=——— ProtessTable —=———————

Identifier: F'

[~ CTable
Mumber ufEu]umns:|:|
topLeftindent: h: |0 |v: o |
draw arder

defRow Height:
defColwidth:

selectionFlags: [] sel0nlyOne
[ selMNobisjoint
[] =elExtendDirag
[] s&1 DragRects
indent:  h: (3 |w [13 |

Command: | cmdBringTaFront vl

|:| drawhctiveBorder

Figure 6-17 The Pane Info window for the ProcessTable scrollpane
3. Close the Pane Info window.

When the user double-clicks a process in the process list, that
process becomes the foreground application.
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Creating a derived class

Because you want to give your table pane the functionality to
display a list of processes, you need to make it a derived class of
CArrayPane.

1. Choose Classes from the Edit menu to open the Classes
dialog box.

2. Enter a new class either by choosing New Class from the
Edit menu (Command-K) or by clicking under the list of
existing classes and typing CPr ocessAr r ayPane as the
name of the class, as shown in Figure 6-18.

Classes == —————
CApp ik [:Pruc:eserragPanE
CMain

Base Class: | CArrayPane |

CProcessArrayPane

[ Define Data Members ]

Library class: | |

.

Figure 6-18 The Classes dialog box

3. Choose CArrayPane from the Base Class pop-up and click
OK to close the Classes dialog box.

You now need to set the CProcessArrayPane class as the
one of which the scroll table pane is an instance.
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4. Choose CProcessArrayPane from the Class hierarchical
menu in the Pane menu, as shown in Figure 6-19.

| Pane DN

Pane Info... #L
ScrollPane Info...

MCITTNE - cArrayPane

Font CProcessArrayPane
Size :
Style »

Color...

Align >

Bring To Front
Send To Back

ek Babion broun

Identifier... 3#d

Figure 6-19 Setting the class of the scroll table pane

Now when you open the Pane Info window for the table
pane, CProcessArrayPane appears in the class hierarchy.

You also may want to extend the functionality of the
whole subview (to handle certain commands from a pop-
up menu). To do this, you must create a new subview
class derived from CPanorama.

5. Choose Classes from the Edit menu.

6. Enter a new class either by choosing New Class from the
Edit menu (Command-K) or by clicking under the list of
existing classes, and typing
CPr ocLi st Subvi ewPanor ana as its name.

7. Choose CPanorama from the Base Class pop-up and click
OK to close the Classes dialog box.

8. Click somewhere on the ProcessListSubview view that
doesn’t contain the scrollpane.
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9. Choose CProcListSubviewPanorama from the Class
hierarchical menu in the Pane menu.

Now the entire subview is actually a CProcListSuviewPanorama into
which you can add functionality.

Creating a pop-up menu
You will now create a pop-up menu in the subview.

1. Select the Pop-up Menu tool and click beneath the table
pane, on the left side.

Note that the pop-up menu already has default values
entered in it. You need to put your own menu values in it.

2. Choose Menus from the Edit menu to bring up the
Menus dialog box, similar to the one shown in Figure
6-20.

Menus

¢ ] [

Edit
File % (Apple Menu)
Font [Edit Menu Items |
Size
rrr— 2

MDEF 10: D

5

Figure 6-20 The Menus dialog box

Note that the normal default menu types (for example,
File and Edit) already exist, as does the pop-up menu you
just added, generically titled Popup Menu. You should
now name this menu, as well as the items within it.

3. Click the Popup Menu item and type Vi ew By: into the
text edit field as the name of your menu.
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4. Click the Edit Menu Items button to bring up the Menu
Items dialog box.

5. Change the three item names to Nane, Seri al Nunber,
and Si gnat ur e by clicking them and then typing the
text.

6. Select Name from the menu item list and choose the
check mark item in the Mark pop-up menu, as shown in
Figure 6-21.

MMenu ltems

liew By:

Name _______BllName |
Serial Number
Signature (] Has submenu

Submen i3

it
Command: | cmdliewByName |

Figure 6-21 Choosing the check mark in the Menu Edit dialog box

This last step ensures that Name appears as the default choice in the
View By pop-up menu.

Associating commands with a menu
To associate commands with each of the pop-up menu choices, first
these commands have to be created, as did the icon buttons earlier.

1. Click the Name item to select it.

2. Choose Other from the Commands pop-up menu to bring
up the Commands dialog.
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6.

7.

. Press Return to create a new command and type

cndVi ewByNane to name it. Choose
CProcListSubviewPanorama from the In Class pop-up
menu, and choose Call from the Do pop-up menu.

. Click OK to close the Commands dialog box.

. Repeat steps 1 through 4 for the Serial Number and

Signature items, naming their commands cndVi ewBy PSN
and cnmdVi ewBy Si gnat ur e, respectively.

Click OK to close the Menu Items dialog box.

Click OK to close the Menus dialog box.

Now the CProcListSubviewPanorama can handle any of the three
menu selections.

Finishing the pop-up menu
You're almost finished with the pop-up menu. You now need to
ensure that only one of the three menu items can be selected at a

time.

Visual Architect and THINK Class Library Guide

*

91



6 Tutorial: Process Monitor

1. Choose Pane Info from the Pane menu (Command-L) to
open the Pane Info window, and open the CPopUpPane

class.
Identifier: | |
Width: [194 Height:

[+ 8 dFepunians

[~ CPopupPane
itsMenu-=
CPapup:
itsMark: |

i radioGroup
CPapupMenu:

[J autoSelect

] multiselect

itsMenu:
firstSelection: |:|

I

[ CPane

Figure 6-22 Clicking radioGroup in the Pane Info window

2. Click the Radio Group radio button, as shown in Figure
6-22, and close the Pane Info window.

3. In the Identifier field at the top of the window, type
Vi ewByMenu and close the Pane Info window.

4. Close the ProcessListSubview edit window.
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Trying out the completed main window
Your Main view window should now appear as shown in

Figure 6-23.
S[I=————— Processinfo |
—Process List —Process Control
ProcessList5Subvyiew

6\ Enter Debugger

%W Kill Process
I

ﬁ Bring to Front

—5ize Resource

[ TeutEdit Services ] Get Front Clicks

] stationery Aware ] Background Only
[JLocal & Remote HL Erents [ ] Multifinder Aware

[]32 Bit Compatible (] Runs in Background

] Child-Died Erents []Suspend/Resume Events

[]High Level Event Aware

[<a]

Figure 6-23 The completed Main view window

You can now preview how the main window will look in the
running application.

1. Choose Try Out from the View menu (Command-Y).
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The main window comes up as it will in the running
application and lets you manipulate the controls, as in
Figure 6-24.

[I=—— ——— Process Info ="r=—"———"~—11=

—Process List —Process Control

it
6\ Enter Debugger

“& Kill Process
i

ﬁ Bring to Front

Serial Number

Signature

—5ize Resource

[] TextEdit Services [] Get Front Clicks

] Stationery Aware ] Background Only
[JLocal & Remote HL Events [ ] Multifinder Aware

[]32 Bit Compatible ] Runs in Background

(] Child-Died Erents [] Suspend/Resume Events

] High Level Event Aware

Figure 6-24 Previewing the Main view window

2. Close the preview window after verifying that the controls
function properly.

Creating the alternative main window

The main window you just finished shows several kinds of process
information, in addition to a subview containing a list of processes.
The next view you create is an alternative window containing only
the process list. It will be another main window.
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1. Choose New View from the View menu to open the New
View dialog box.

2. Choose Main Window from the View Kind pop-up menu
and type Pr ocessLi st Onl y as the view name, as
shown in Figure 6-25.

Please name the new view

NMame: [ProcessListOnly |

Floating Window
Main Window
Modal Dialog
New... Dialog
Splash Screen
Subview

Tearoff Menu
Window

Figure 6-25 Creating a Main view using the New View dialog box
3. Click OK to close the New View dialog box.
The ProcessListOnly view edit window appears.

4. Choose View Info from the View menu to bring up the
View Info dialog box.

5. Type Process Li st as the view window title. (Leave
the view’s name as is.)

6. Make the view’s window the same kind of window as the
Processinfo window, that is, a window with no scroll bars
or size box (the second window type from the left), and
click OK.

This view is going to have the same subview within it that
the main window has.

As before, you should create a subview in the window.
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7. Select the Subview tool and create a subview just inside
the gray-outlined rectangle within the window, as shown

in Figure 6-26.
S 1=—————— ProcesslListOnly BE|
iis
Y =
g, & 376, 176 [

Figure 6-26 Creating the subview in the ProcessListOnly view

8. Choose Pane Info from the Pane menu (Command-L) to
open the Pane Info window. Open the
CSubviewDisplayer class, choose ProcessListSubview
from the subview pop-up menu.

9. Type ProcLi st Subvi ewin the Identifier field and close
the Pane Info window.

Because the subview handles its own commands, there’s
nothing left to do with respect to assigning command
handlers for this window.

Now the alternative main window, CProcessListOnly, is
complete. You're ready to create the final view.

10. Close the ProcessListOnly view edit window.

Creating the New... Dialog
The dialog that comes up when a user chooses New from the
application’s File menu is called a New dialog.
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1. Choose New View from the View menu to open the New
View dialog box.

2. Choose New... Dialog from the View Kind pop-up and
type W ndowChooser as the view’s name, as shown in
Figure 6-27.

Please name the new view

Mame: | WindowChooser

Uiew Kind: FETEITT

Floating Window
Main Window
Modal Dialog

Splash Screen
Subview
Tearoff Menu
Window

Figure 6-27 Creating a New... Dialog view using the New View
dialog box

3. Click OK to close the New View dialog box.

The WindowChooser view edit window appears. By default, the
dialog is a double-bordered modal dialog window.

Adding radio buttons
You need to add two radio buttons that let the users choose which
of the two views they want to create.

1. With the Static Text tool, create a static text item at the top
of the dialog and type the text Creat e a wi ndow
showi ng: .

2. With the Radio Button tool, create two radio buttons
underneath the static text item, one above the other, and
give them the labels Process Li st and
I nformati on and Process List Only.

Visual Architect and THINK Class Library Guide 97



6 Tutorial: Process Monitor

3. Select each radio button in turn, choose Identifier from
the Pane menu (Command-J), type Pr ocLi st Andl nf o
and ProclLi st Onl y, respectively, as identifiers, and
click OK.

4. Select the Process List and Information radio button,
choose Pane Info from the Pane menu (Command-L) to
open the Pane Info window, and open the CControl class.

5. Set contrlValue to 1, as shown in Figure 6-28, so this
button will be selected by default, and close the Pane Info
window.

E[[1==——= ProclListAndInfo §—|

Identifier: | ProcListadndl nfo

Left: 136 Top: 5z

Width: Height:

[+ & #adistantral
[ CButton

[~ CControl

contriTitle:

|F‘ru:u:ess List and Information

contrivValue: |:|

Figure 6-28 The Pane Info window for the radio button

Adding OK and Cancel buttons
1. Select the Button tool and click the lower-right corner of
the dialog to create an OK button.

2. Choose Identifier from the Pane menu (Command-J),
type OK, and click OK.

By default, the first button you add to a view is named
OK and has cnd (X as its command.
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3. Select the Button tool again and click to the left of the first
button to create a Cancel button.

4. Choose ldentifier from the Pane menu (Command-J),
type Cancel , and click OK.

By default, the second button you add to a view is named Cancel
and has cndCancel as its command.

When you are finished with the buttons, the result should resemble
Figure 6-29.

L]

WindowChooser

Create a window showing:
i Process List and Information

) Process List Only

[<af

Figure 6-29 The New... Dialog view edit window

Editing menus

The last thing to do before saving your project is to customize the
menu bar for your application. In this case, there are only a few
interesting things you can do from a menu while running the
application, so you should remove menu choices that are not
supported.

1. Choose Menu Bar from the Edit menu to open the Menu
Bar dialog box.

2. Select the File menu from the list and click the Edit Menu
Items button to bring up the Menu Items dialog box.
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3. Delete all menu items except New, Close, and Quit by
selecting them from the list and pressing Delete. You
should keep the dividers between the three menu items
in place.

4. Click OK to close the Menu Items dialog box.

5. Select the Apple menu in the menu list and click the Edit
Menu Items button to bring up the Menu Items dialog
box.

6. Choose the top menu item in the list, type About
Process Mbni t or...to rename it, and click OK.

7. Click OK in the Menu Bar dialog box to close it.

You've finished using Visual Architect to design your user
interface, and you can now save the Vi sual
Archi tect. rsrcfile.

8. Choose Save from the Edit menu (Command-S).

Generating Code for Your Application

Having built the user interface for the tutorial application, you are
now ready to give it life, that is, to generate code that enables it
to run.

The code falls into two main categories. One supports the
application’s function (the display and manipulation of running
processes), and the other supports the user interface. It is the latter
that Visual Architect generates; the functional code still needs to be
written by the programmer. This code is provided for you in the
Extra Sour ces folder and in the pre-edited files of the Sour ce
folder.
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1. Choose Generate All from Visual Architect's THINK
Project Manager menu (the one that looks like the
THINK Project Manager application icon), as shown in
Figure 6-30.

benerate...
benerate Rll...

Bring Up To Date 23U
Run #R

Figure 6-30 The THINK Project Manager menu in Visual Architect

A dialog box appears showing the progress of the code
generation, as in Figure 6-31.

Writing...

CSaver_class.cpp

Figure 6-31 The Code Generation Progress dialog box

By default, Visual Architect generates code to the Sour ce
folder within the Process Mbni t or folder, using
standard macro files. After Visual Architect creates the
files, it adds them automatically to your project. When
generation is complete, the folder in your Pr ocess
Moni t or folder called Sour ce contains the generated
code.

2. Switch to the THINK Project Manager application, scroll
the Process Monitor.1t project window to the end, and
open the Application segment by clicking the small
triangle to the left of its name.
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Look at the project window to verify that Visual Architect has added
the new source files to your project in the Application segment (this
will be the last segment of your project), shown in Figure 6-32.

Process Monitor.m §—|

% Name
CPlusLib
Segment 14
ANSI
BEL
Hisc Libs
Resources
THINK Inspector
Precompiled Symbols
Extra Sources
. '\_‘*App'licatiun

+ Chpp.cp
CHain.cp
CProcess drray Pane.cp
CProcessListOnly .cp
CProcListSubviewF anorama.cp
CSaver_class.cpp
CwindowChooser .cp
rain.cp
FLACEHOLDER .c:pp
References.cp
#_IC hpp.cp
#_CMain.cp
#_CProcesshrrayFPane cp
#_CProcessListOnly .cp
#_CProcLlistSubviewPanorama.cp
#_CwindowChooser .cp
Totals
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Figure 6-32 The Process Monitor.Tt project window showing the
source files within the Application segment

Customizing your code

At this point, Visual Architect has generated the user interface code.
This is normally the time at which you would add your functional
code. As mentioned earlier, however, the functional part has been
added for you. To get an idea of the changes made, you can look at
the source files directly. Edited portions of changed source files are
marked clearly so you can distinguish easily between generated and
customized code. The edits are preceded and followed by the
comments shown following:
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[] eeeee Visual Architect Tutorial Code Change Begin eeeee

< modified code goes here>

[| seeee Visual Architect Tutorial Code Change End eeee-

In addition, all files in the Ext ra Sour ces folder were created for
the tutorial. These files implement classes that don’t have any visual
elements, so they can't be specified by Visual Architect. These files
have already been added to your project.

Running the application
You first need to compile the project.

1. Choose Bring Up to Date from the Project Menu.
If that was successful, run the application.
2. Choose Run from the Project menu.

If you get compile errors, it's likely that you have misspelled one of
the identifiers or forgotten to set an identifier where one is needed. If
s0, go back to Visual Architect to correct the mistake, then choose
Run from Visual Architect's THINK Project Manager menu. Files
that need to be are regenerated automatically.

Once the program is running, experiment as you like. However,
keep in mind the following notes:

= If you try to Kill a process whose Runs in Background box
is unchecked, remember that it won't die until that
process is brought to the foreground. This is because the
application won't process the quit event until it gets a
chance to execute its event loop. Try killing Visual
Architect for an example of this.

= Some processes in the list may not respond to the Bring
to Front button. Look at the Background Only bit in the
Size Resource section. If it's checked, then the selected
process doesn’t have a user interface and can’t be queued
as the foreground application.

< If you haven't installed a low-level debugger such as
MacsBug, be sure you run the tutorial under the THINK
Debugger before trying the Enter Debugger button.

Visual Architect and THINK Class Library Guide 103



6 Tutorial: Process Monitor

Where to Go Next

This tutorial demonstrated some of the more advanced techniques
used in working with Visual Architect. You should now proceed with
Chapter 3, “THINK Class Library Basic Concepts,” and Chapter 4,
“Visual Architect Basic Concepts,” to begin developing your own
applications.
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the THINK Class
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-I-his chapter explores aspects of the THINK Class Library that you
encounter in the course of building an application. No topic is
covered exhaustively here; the class descriptions in the final part of
this book provide the definitive reference. Nevertheless, the
discussions are sufficiently detailed to give you a sound
understanding of how the Library works and of how to use it to
build a robust application. This chapter assumes that you have read
those that precede it and that you have worked through the tutorials.
It begins by reviewing material from Chapter 3, “THINK Class Library
Basic Concepts,” to provide background for a more in-depth
treatment. After reading this chapter, you will know enough about
the THINK Class Library to modify and enhance the sample projects,
or perhaps to begin a new project.
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Introduction

This chapter discusses the essential features of the THINK Class
Library and talks about some of the general topics in application
building. After you read this chapter, you should try running and
modifying the demonstration applications. Make sure to follow the
instructions in Chapter 2 of the THINK C User’s Guide for installing
the THINK Class Library and its demonstration programs.

Naming Conventions

The THINK Class Library follows these naming conventions:

Name Description

CNare The name of a class

aNane A formal parameter

cNane A static data member

f Nane A flag, usually a Boolean data member

gNane A global variable

kNane A constant, defined with #def i ne, enum or const

i t sName A data member

t heNane A variable, usually a local variable or data member;
sometimes used for formal parameters

mac Name A Macintosh data structure, used either as a data
member or as a local variable

Table 7-1 Naming conventions

You should give your classes names that begin with any letter other
than C. Adhering to this practice will avoid conflicts with names of
classes in future versions of the THINK Class Library.

Previous versions of the THINK Class Library were designed to be
implemented in both Symantec C++ and THINK C with Object
Extensions. In order to remain backward compatible with THINK C
with Object Extensions, THINK Class Library classes still contain
explicit initialization and destruction member functions. The old
initialization function for a class CNane is denoted by | Nane; the
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old destruction member function is always named Di spose. These
member functions are now anachronisms, superseded by genuine
C++ constructors and destructors. However, their continued presence
guarantees that existing code written for earlier versions of the
THINK Class Library will not require extensive rewriting.

Fundamental Structures

The THINK Class Library is organized into three distinct, interacting
structures: the class hierarchy, the visual hierarchy, and the chain of
command. The class hierarchy is the set of all the classes that make
up the THINK Class Library. The visual hierarchy describes the
organization of all visible entities in a given application. The chain of
command specifies which objects in an application get to handle
commands, and in what order.

The THINK Class Library uses an object called a switchboard to
convert Macintosh events into appropriate calls to member functions.
Each application has only one instance of a switchboard object.
Another object, called the bartender, converts menu selections into
direct commands. The unique bartender object is pointed to by the
global variable gBar t ender.

The class hierarchy

The class hierarchy is the set of all the classes in the THINK Class
Library, ordered by the derivation relationship. Seeing a diagram of
the class hierarchy can help you understand the structure of the
THINK Class Library. Using the Browser, you can display the class
hierarchy for a particular class, and then print it.

Do not think of the class hierarchy as a functional description of the
THINK Class Library. For example, find the CRadioGroup class
toward the right in the diagram. You might believe, wrongly, that this
class interacts somehow with the CBureaucrat class. Instead, the
hierarchy embodies inheritance, which means that objects of derived
classes possess all the attributes and behaviors of objects of ancestor
classes.

The THINK Class Library contains abstract classes; only instances of
their derived classes are ever created. The most important abstract
classes in the THINK Class Library are CCollaborator, CBureaucrat,
CView, CDirectorOwner, and CApplication.
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The visual hierarchy

The visual hierarchy is composed of all the visible objects, or views,
in a running application. The relationship of enclosure imposes a
hierarchy on views. Except for the desktop, everything that you see
on the screen—every view—is enclosed by another view.

At the top of the visual hierarchy is the desktop, an object of class
CDesktop. Every THINK Class Library application has a unique
desktop object, pointed to by the global variable gDeskt op. The
desktop encloses all of the windows in an application. Each window
encloses one or more panes, which may in turn enclose other panes.

Panes can handle user actions such as mouse clicks. When you click
with the mouse, the switchboard determines in which pane the click
occurred and calls that pane’s Dod i ck function.

As descendants of CBureaucrat, views can also be in the chain of
command and respond to direct commands.

The chain of command

The chain of command specifies which objects get to handle direct
commands and in what order. An object can be in the chain of
command if and only if it is a bureaucrat—an instance of a class
derived from CBureaucrat. Every bureaucrat thus has a DoCommand
function, which derived classes can override to handle specific
commands.

The supervisor of a bureaucrat is the next object up the chain of
command. If a bureaucrat can’t handle a direct command, it passes
the command on to its supervisor by calling that object’s
DoComrand function. The application is the only bureaucrat that
does not have a supervisor. If the application doesn’t handle the
command, no object will. Every THINK Class Library application has
a unique application object, pointed to by the global variable

gAppl i cation.

The first object that has the chance to handle a command is called
the gopher. The current gopher is pointed to by the global variable
gGopher. Usually, the gopher is a pane in the active window.

A bureaucrat that supervises a window is called a director. This kind
of bureacrat is important enough to merit a class, CDirector, derived
from CBureaucrat. Directors handle the communication between the
visual hierarchy and the chain of command. For instance, when a
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window gets an activate event, it calls the Act i vat eW nd function
of its supervisor, which is by definition a director. The director can
then take some action as a result of the window’s becoming active.

Another important kind of bureaucrat is the document. A document
is a director that has a file associated with it. The CDocument class
defines the properties and behaviors of documents. Documents
manage the communication between windows, files, and menu
commands. The default document class handles common commands
such as Save, Save As, and Print. You can think of a document as a
file that is viewed through a window. It is better thought of as the
essence of a Macintosh application. A document is anything that you
can display and manipulate inside a window.

Bureaucrats themselves are descendants of the class CCollaborator. A
collaborator is an object that can inform other objects of changes.
The collaborator announcing changes is called the provider; those
that receive such announcements are called its dependents. For
instance, a provider might be a document that displays data in
several windows; its dependents might be the windows. If the data
changes, the provider lets the dependents know, so the windows
can redisplay the data correctly.

The flow of control

The chain of command and the visual hierarchy get their direction
from the switchboard. The switchboard gets events from the
Macintosh Event Manager and converts the events to member
function calls affecting either the chain of command or the visual
hierarchy. Functions that affect the chain of command are usually
called via the gopher, the first bureaucrat in the chain. Functions
affecting the visual hierarchy are called via the active window or the
desktop.

When you click with the mouse, the switchboard calls the desktop’s
Di spat chd i ck function. If the click was in the menu bar, the
desktop calls a function of the bartender that updates the state of the
menus before they appear. Then the bartender gives every
bureaucrat in the chain of command the chance to enable or disable,
and check or uncheck, any pertinent menu items. The desktop then
uses the bartender to convert the menu selection into a direct
command and finally calls the gopher’'s DoComrand function.

If the click was in a window, the desktop calls the window’s
Di spat chd i ck function, which eventually results in a call to the
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Dod i ck function of the pane in which the click occurred. The
pane’s DoCl i ck function can then do whatever is appropriate for
the pane. It could even call t he DoConmand function of an object
in the chain of command.

When the switchboard gets an activate or an update event, it calls
the Acti vat e, Deact i vat e, or Updat e function of the window.
The window then calls the corresponding member function—
Acti vat eW nd, Deacti vat eW nd, or Updat eW nd—of its
director.

When you type, the switchboard calls the DoKeyDown or

DoAut oKey function of the gopher. If you hold down the Command
key as you type, the switchboard asks the bartender to convert the
key into a command, and then calls the gopher’s DoConmrand
function.

If you're running under System 7 or MultiFinder and you bring
another application to the foreground, the switchboard calls the
Suspend function of the application object (not the gopher), which
in turn calls the Suspend function of every director. Similarly, when
your application comes to the foreground, the switchboard calls the
application’s Resune function, which in turn calls the Resune
function of every director.

The THINK Class Library treats desk accessories as if they were in
their own layer, even if you're not using System 7 or MultiFinder.
Thus, your application still gets suspend and resume “events” when
you bring up a desk accessory.

Writing an Application with the THINK Class
Library

To create an application with the THINK Class Library, you derive
classes from existing classes. The classes you need to derive from
are: CApplication, CDocument, and various classes derived from
CPane. Your application class determines the overall structure of
your application. The document class implements file handling for
your application, and the pane classes implement how the
information in your files appears in the document windows.
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Note
Many THINK Class Library pane classes already
supply the functionality you want for your
application; these you can simply use as is. Usually
you derive new pane classes to customize or add to
the behavior of existing classes; but you can also
derive pane classes that implement completely
original user interfaces.

In addition to the derived classes, you also must create a resource
file for your project. This resource file must contain the standard
THINK Class Library resources as well as your own. These standard
resources are in the file TCL Resour ces. When you use the
THINK Class Library, make a copy of this resource file, and name it
Project. r sr ¢, where Project is the name of your project. Then add
your own resources to the file or project.

Note
For more information about resource files and the
THINK Class Library, see “THINK Class Library
Resources” later in this chapter. To learn about
using resources with a project, see Chapter 9,
“Organizing Projects,” in the THINK C User’s Guide.

Creating the application class

For standard Macintosh applications, you must derive an application
class from CApplication. Your class must define a constructor and
override these member functions:

Set UpFi | ePar anet ers
Cr eat eDocunent
OpenDocunent
DoComrand

Your application class constructor should initialize any new data
members that your derived class declares. It must call CApplication’s
constructor with the appropriate arguments. Among the many
initializations it performs, CApplication’s constructor sets the global
variable gAppl i cat i on to point to your unique application object.
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Set UpFi | ePar anet er s sets up the standard file parameters that
specify which files are visible in the standard file box when the user
chooses Open from the File menu.

Cr eat eDocunent creates a new, untitled document. The class of
the document it creates is one that you derive from CDocunent .
After creating the document, your Cr eat eDocunent function
should call the document’s NewFi | e function. That function gets
called when the user chooses New from the File menu.

OpenDocurnent is similar to Cr eat eDocument . Instead of calling
the newly created document’s Newfi | e function, though, your
OpenDocurnent should call its OpenFi | e function. The
OpenDocunent function takes one parameter, an SFRepl y record,
which contains the information about the file that the user chose to
open.

DoConmmand handles all application-specific commands. However,
usually you find that most commands specific to your program are
best handled at the document level. Some commands, like New,
Open, and Quit, are already handled by the default application
class, CApplication.

Creating the document class

The document is where your application draws and displays its data.
All documents have windows associated with them. Most documents
also have an associated file. Neither the window nor the file is
created automatically. You must create them yourself.

Your document class must derive from CDocument. It must define a
constructor and override these member functions:

DoCommand
NewFi | e
OpenFi l e
DoSave
DoSaveAs
Revert

If your document class defines new data members, its constructor
should initialize them. Make sure that your constructor calls the
CDocument constructor. The supervisor of a document is always

gAppl i cati on.
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If your document allocates memory, you should also define a
destructor to deallocate it.

Note
You do not need to delete the i t sSW ndow or the
i t sFi | e data members. The virtual destructor
~CDocunent does that for you.

Your document classes’ DoConmand functions do most of the work
in your application. When a window is active, one of its panes is the
gopher, and the pane’s supervisor is the same as the window’s—
namely, the document. Thus, the switchboard calls the pane’s
DoCommand function first. But typically, a pane passes a direct
command on to its supervisor. Your document class should handle
all the commands it knows about, and call CDocunent ’s
DoCommand when it can’t. Performing this last step ensures that the
application object’'s DoCormmand is called for commands that your
document doesn’t process.

Your document classes’s NewFi | e function is called when the user
chooses New from the File menu. This function must create a
window and attach its panes. The Newfi | e function doesn’t have to
create a file until the user tries to save the document.

Your document’s QpenFi | e function is called when the user
chooses Open from the File menu. The OpenFi | e function has
one argument: a pointer to a Macintosh SFRepl y record. When the
OpenkFi | e function is called, you can be sure that the SFRepl y
record is properly filled in. Your OpenFi | e function needs to create
a file object (usually of class CDataFile). You can call any of several
CDataFile reading functions to obtain the file’s contents. Your
OpenkFi | e function also needs to create a window and its attached
panes to display the contents of the file, just as your NewFi | e
function does.

When the user chooses Save from the File menu, your document’s
DoSave function is called. Your DoSave function should write the
contents of its file to disk. The file object is stored in the data
member i tsFil e.

When the user chooses Save As from the File menu, your
document’s DoSaveAs function is called. This function takes an
SFRepl y record as argument, which is guaranteed to be properly
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filled in. Your document class needs to override this function to
write its data to a file.

If your application supports the Revert command, you should
implement it in the DoRevert function. Your implementation might
do the same thing as closing without saving, then opening the file
again.

Make sure that your DoCommand function itself, or one of the
functions it calls, sets the flag data member di rt y to TRUE when
the document is changed. Your document class’s DoSave,
DoSaveAs, and DoRevert functions should clear the dirty flag after
successfully performing their roles.

Creating the pane classes

Once you've created your windows and opened your files, you need
to display them somewhere. In the THINK Class Library, you don't
write directly onto the window. Instead, you create pane classes—
classes derived, not necessarily directly, from CPane.

A pane class should define a constructor and override these member
functions:

Dr aw
DoCl i ck

If your pane class defines new data members, its constructor should
initialize them. Your constructor should also call the constructor of
its base class. The supervisor of a pane should be either the pane
that encloses it or the director that its window belongs to.

The pane constructor is where you set the pane’s location in its
enclosure and its characteristics. If you want your pane to receive
clicks, be sure to call Set Want sCl i cks( TRUE) ; otherwise, mouse
clicks in your pane are ignored.

If your pane allocates memory, you should also define a destructor
to deallocate it.

The Dr aw function is where your pane should draw its contents.
You can assume that the port, clip region, and coordinate systems
have been set up correctly when Dr aw is called. See the section
“Drawing in a pane” later in this chapter to learn about drawing in a
pane.
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When you click a pane, its Dod i ck function is called. Your

Dod i ck can perform an action such as drawing in the pane; or it
can initiate a process such as dragging an object or selecting multiple
objects. Some panes, such as the edit text pane implemented by
CEditText, have built-in DoCl i ck functions, which may already
implement the behavior needed by your pane class.

If you want your mouse action to be undoable, you need to create a
derived class of CMouseTask and call its Tr ackMbuse function. The
section “Mouse tracking” later in this chapter discusses undoable
mouse actions in detail.

Working with Panes

In the THINK Class Library, all your drawing takes place in a pane. A
pane is a rectangular region of the screen completely enclosed by a
window. A window may have several panes, and each pane may
have several subpanes. A pane can handle mouse clicks and events
that affect its display such as activate and deactivate events. Each
pane has its own drawing environment.

Every pane has an enclosure that completely encloses the pane. A
pane also has a supervisor—an object in the chain of command. A
pane’s enclosure and supervisor can be the same object, particularly
if the pane belongs to another pane. In the most common case,
though, the supervisor is the director that owns the window or the
pane.

Every pane has its own drawing environment. The rectangle that
describes the edges of a pane is the frame. The frame defines a local
coordinate system for the pane. In most cases, the upper-left corner
of the pane is the point (0, 0).

Windows and panes

Every pane is an object of some class derived from the abstract class
CView, which defines the behavior of visual entities. CView is the
base class of CPane. A window is a view, but it is not a pane;
likewise, the global desktop object, gDeskt op, is a view but not a
pane. All other visual entities are panes; they include such things as
controls, borders, pictures, and size boxes.
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Every view has one enclosure. For example, in the window in Figure
7-1, there are eight views and seven panes (the window is not a
pane):

el Hl

CPicture

—

CScrollPane

CScrollBar
CCheckBox =1 Shrink to Fit
CEditText > =K | [
CSizeBox

Figure 7-1 Panes in a window

The size box, the check box, the text, and the scroll pane are
enclosed by the window. The two scroll bars belong to the scroll
pane. The picture is enclosed by the scroll pane.

Coordinate systems

When you're working with panes in the THINK Class Library, you
need to know about four coordinate systems:

« Global coordinates

« Window coordinates

« Frame coordinates

= QuickDraw coordinates

The desktop, some internal member functions, and some Toolbox
routines use global coordinates. In this coordinate system, all units
are in pixels, and (0, 0) is at the top-left corner of the main screen.
You rarely use global coordinates in the THINK Class Library.
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With window coordinates, the top-left corner of the window’s
content region is (0, 0) and each unit is a pixel. You need to use
window coordinates to set the position of a pane whose enclosure is
a window. Window coordinates are also useful as a common point
of reference for two different panes in the same window.

Frame coordinates provide a local coordinate system for a pane.
Units in frame coordinates are in pixels, and the point (0, 0) is
usually the upper-left corner of the pane. If the pane moves within
its enclosure, the coordinate system does not change; the upper-left
corner is still (0, 0). The only time this origin point changes is when
you scroll a panorama, which is a special kind of pane. Each pane
can dynamically choose to use long (32-bit) or short (16-bit)
coordinates by calling the inherited CView function

UselLongCoor di nat es( fUselLong ).

All drawing and mouse tracking is done in QuickDraw coordinates.
This is the coordinate system that the Macintosh Toolbox uses for its
drawing operations. QuickDraw coordinates are valid only after a
call to Pr epar e. The relationship between QuickDraw coordinates
and the other coordinate systems depends on whether a pane is
using long-frame coordinates or short-frame coordinates.

Short coordinates map directly to QuickDraw coordinates. Each
element in a short coordinate uses 16-bit values, so a pane that uses
short coordinates is limited to the rectangle (-32768, —-32768, 32767,
32767). Long coordinates layer a 32-bit coordinate system on top of
the QuickDraw 16-bit coordinates. The long coordinate system lets
you use a much larger coordinate area for your pane. Since all
drawing takes place in QuickDraw coordinates, you have to map the
long coordinates to QuickDraw coordinates when you draw in a
pane.

The CPane class defines several functions that transform coordinates
from one system to another.

Drawing in a pane

Every pane has its own drawing environment. The rectangle that
describes the edges of a pane is the pane’s frame. The frame defines
a local coordinate system for the pane.
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To draw in a pane, you usually override its Dr aw function. The
THINK Class Library calls your pane’s Dr aw function whenever the
pane needs to be updated.

Note
Update events are given low priority by
Wai t Next Event (and Get Next Event). If you
want to redraw your pane immediately, you can call
your own Ref r esh function to force an update
event.

To draw directly in a pane as a result of a mouse click, override the
pane’s DoCl i ck function and do the drawing in your DoCl i ck
function.

Use the standard QuickDraw routines to draw. The pane’s Pr epar e
function sets up the QuickDraw port. If your pane uses short
coordinates, the coordinate system is set up correctly. If your pane
uses long coordinates, you need to transform frame coordinates to
QuickDraw coordinates before you draw. You can use CPane
functions Fr ameToQD and Fr ane ToQDR to convert frame points
and rectangles to QuickDraw points and rectangles.

The THINK Class Library uses the types LongRect and LongPt for
both long and short coordinates. Most of the descendants of CView
that work with points and rectangles use these types.

Note
If you've worked with earlier versions of the THINK
Class Library, this uniform use of LongRect and
LongPt is the biggest change you'll notice, since it
will necessitate some changes to your programs.
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These types are defined as follows in LongCoor di nat es. h:

typedef struct LongPt
{

long v, h;
} LongPt;

typedef struct LongRect
long top, left, bottom right;
} LongRect;

If the pane uses short coordinates, frame coordinates and
QuickDraw coordinates are identical. Therefore, the values stored in
aLongRect orinalongPt are already in QuickDraw coordinates.
To use them with QuickDraw routines, however, you need to
convert those structures to the QuickDraw types Rect and Poi nt .
The THINK Class Library provides several utility routines to perform
these conversions. For a complete list, see the section “Long
Coordinate Utilities” in Chapter 7, “Programming with the THINK
Class Library.”

Properties of panes

When a pane moves or changes size, all of the panes that it encloses
change as well. The way a pane changes depends on its sizing
characteristics. When you create a pane, you specify its horizontal
and vertical sizing characteristics.
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The horizontal sizing characteristic specifies how the pane’s left and

right edges change.

Horizontal sizing
si zFlI XEDLEFT

si zFl XEDRI GHT

si zFI XEDSTI CKY

si ZzELASTI C

Meaning

The left edge of the pane is always the same
number of pixels from the left edge of the
enclosing pane as it was when originally
placed.

The right edge of the pane is always the
same number of pixels from the right edge
of the enclosing pane as it was when
originally placed.

The left and right edges stick to their original
locations in the enclosing pane. If the
enclosure scrolls horizontally, the pane will
scroll with it.

The width of the pane grows or shrinks by
the same amount as the width of the
enclosing pane.

Table 7-2 Horizontal sizing characteristics

The vertical sizing characteristic specifies how the pane’s top and

bottom edges change.

Vertical sizing
si zFl XEDTOP

si zFlI XEDBOTTOM

Meaning

The top edge of the pane is always the same
number of pixels from the top edge of the
enclosing pane as it was when originally
placed.

The bottom edge of the pane is always the
same number of pixels from the bottom edge
of the enclosing pane as it was when
originally placed.

Table 7-3 Vertical sizing characteristics
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Vertical sizing Meaning

si zFI XEDSTI CKY  The top and bottom edges stick to their
original locations in the enclosing pane. If
the enclosure scrolls vertically, the pane will
scroll with it.

si zELASTI C The height of the pane grows or shrinks by
the same amount as the height of the
enclosing pane.

Table 7-3 Vertical sizing characteristics (Continued)

Here are a couple of examples. A vertical scroll bar in a window has
the horizontal characteristic si zFI XEDRI GHT, so that it has a fixed
horizontal length and remains anchored to the right edge of the
window. Vertically, it changes with the height of the window
because it has the characteristic si zELASTI C. A status box in the
lower-left corner of a window has the horizontal characteristic

si zFI XEDLEFT and the vertical characteristic si zFl XEDBOTTOM
As a result, it has a constant size and remains anchored to the lower-
left corner of the window.

In Figure 7-2, the box with the thick outline represents the window.
It contains a main pane that takes up most of the window, and
several other panes. The two panes that hold the scroll bars are fixed
to the edges of the window. When the window is resized, each
grows or shrinks in one dimension by the same amount as the
window. The panes that hold the grow box and the status box are
anchored to the bottom corners of the window. The square pane in
the upper-left portion of the main pane is always there, regardless of
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how the window changes. Its dimensions do not change
automatically.

H: sizFIXEDSTICKY  H: sizFIXEDRIGHT
V: sizFIXEDSTICKY V: sizELASTIC

H: sizELASTIC

V: sizELASTIC

H: sizFIXEDLEFT

V: sizFIXEDBOTTOM

H: sizELASTIC H: sizFIXEDRIGHT
V: sizFIXEDBOTTOM V: sizFIXEDBOTTOM

Figure 7-2 Horizontal and vertical sizing

Panoramas

Almost everything you want to display is bigger than a pane.
Graphics and text, for instance, frequently take up more room than a
pane contains. The THINK Class Library provides a panorama class,
CPanorama, that lets you display in a pane portions of a large
graphic.

Look at the sailfish in Figure 7-3. Imagine that the only part of the
fish you can see is the portion inside the frame. Currently, the frame
displays the sailfish’s tail; but you can move, or scroll, the frame to
see other parts, such as the head. This is how a panorama works.

The rectangle that encloses the entire panorama is called the bounds
rectangle. It defines the size and coordinate system of the panorama.
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Usually, the upper-left corner of the bounds rectangle is the point (0,
0), and its coordinate system uses pixels as units.

The coordinate system of the bounds rectangle specifies how the
frame moves over the panorama when you scroll. Usually, the frame
moves one pixel at a time. In some applications, though, scrolling in
a different way is more natural. For instance, in a text editor,
scrolling vertically one line at a time probably makes the most sense;
in a spreadsheet, rows provide the most natural unit of vertical
scrolling.

You can specify a scale to indicate how many pixels make up a
single panorama unit. You can set different scales for horizontal and
for vertical units. In a graphics application, each unit might be 1
pixel. In a spreadsheet, a vertical unit might be 12 pixels, and a
horizontal unit might be 60 pixels.

The units of the panorama bounds rectangle are for scrolling only.
For drawing, you use the frame coordinates, which are always single
pixel units.

There are two ways to talk about the upper-left corner of a frame.
Expressed in panorama units, this corner designates the position of
the frame in the panorama. The same corner, expressed in frame
coordinates, designates the origin of the frame.

Remember that scrolling always occurs in panorama units, and
drawing always occurs in frame coordinates. As you scroll, the origin
of the frame changes. Here are a couple of examples to clarify these
concepts.
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In Figure 7-3, both the horizontal and vertical scales are set to 1 pixel
per panorama unit. The bounds rectangle of the panorama is
(0, 0, 400, 380). The frame’s position in the panorama is (165, 210).

0.0) bounds
position anorama
(165, 210) P
frame
(400, 380)

Figure 7-3 Graphic panorama and its scales

Since the panorama units match the frame units, the position of the
frame in the panorama and the origin of the frame are the same.

In Figure 7-4, which shows a panorama with text, the horizontal
scale is 6 pixels per unit and the vertical scale is 12 pixels per unit.
The bounds rectangle of the panorama is (0, 0, 40, 9). In the
panorama scale, this means 8 lines of 40 characters each. The
position of the frame in the panorama is (0, 3), the beginning of the
fourth line. The origin of the frame, however, is at (0, 36). If you
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0,0

wanted to draw a line to strike out the word “And,” you would draw
it from (0, 42) to (18, 42).

bounds frame

position (0, 3)

‘Twas brillig and the slithy toves
Did gyre and girmble through the wabe——
Al mimsey were the borogove

panorama

LLx)

origin (0, 36)

And the mome raths outgrabe.

“Beware the Jabberwock, my son,
The jaws that bite, the claws that catch

Beware the Jubjub bird and shun
the frurmious Bandersnatch!™

(40,9)
Figure 7-4 Text panorama and its scales

Scroll panes

To make it easy to use panoramas, the THINK Class Library provides
a class called CScrollPane that implements a scroll pane. Scroll panes
let you attach scroll bars to your panorama.

You create a scroll pane the same way you would any other pane.
First, request a vertical scroll bar, a horizontal scroll bar, and a size
box. Then use the | nst al | Panor anma function to associate a
panorama with the scroll pane. The scroll pane examines the
panorama and adjusts the scroll bars appropriately. You can specify
how many panorama units to scroll when you click on different
parts of the scroll bar.

The scroll bars and the panorama communicate through the scroll
pane. When you click one of the scroll bars, it informs the scroll
pane, which tells the panorama how much to scroll.

Cursor tracking

The Adj ust Cur sor function that all panes inherit from CView lets
you change the cursor when it moves into your pane. When you
need only one cursor for a pane, which is the usual case, all you
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have to do is set the cursor with the Toolbox routine Set Cur sor .
Look at the Adj ust Cur sor function in CEditText for an example.

Sometimes, though, you might want to use different cursors within
the same pane. The Adj ust Cur sor function lets you do this as
well, but at the cost of a little more work. See the description of the
CView class in Chapter 121, “CView.”

Working with Menus

The THINK Class Library lets you identify menu items by assigning
them unique command numbers. Command numbers are positive
long integers in the range 0 to 2,147,483,647. Those in the range 1 to
1023 are reserved for the THINK Class Library. Command number 0
is reserved for cndNul |, the null command. All other command
numbers (1024 to 2,147,483,647) are available for your application.

The reserved command numbers are for the most common
Macintosh application commands, such as Open, Save, Quit, and
Page Setup. Be sure to use the appropriate reserved number to
invoke the associated application command implemented by the
THINK Class Library. For a list of all the reserved commands, see
Chapter 23, “CBartender.”

When you choose a command from a menu, the desktop calls the
Fi ndCndNunber function of the bartender. The bartender matches
the menu ID and the item number to a command number and calls
the gopher’s DoConmand function. Remember, the gopher is the first
object in the chain of command, and thus the first object given the
chance to handle a command.

Using MENU resources
To create menus with ResEdi t , you must append the command
number to the menu item. The menu item and the command
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number are separated by the character #. For example, Figure 7-5
shows the File menu as viewed in ResEdi t .

= I=="—"——F"o—=— MENU “File” ID = 2 from TCL Resources

m Entire Menu: & Enabled
New#2 EN
Open...#3 %0 Title: @ [File |
Close#4 A1) i3 % (Apple menu)
Save#5 ®S

Save As...#6
Revert to Saved#7

Page Setup...#8
Print...#9 ®P

s

Figure 7-5 File menu viewed in ResEdi t

Note
If you don’t append a command number to a menu
item, the bartender automatically assigns that item
to the command crdNul | .
The MENU resources for You can use any menu ID for your application’s menus. The THINK

these menus are in the file  Class Library reserves the following menu IDs for certain menus:
TCL Resources.

Menu title Menu ID Mnemonic
Apple 1 MENUappl e
File 2 MENUfi | e
Edit 3 MVENUedi t
Font 10 MVENUF ont
Size 11 MENUsi ze

Table 7-4 Menu IDs

After you create all the menus that your application needs, create an
" MBAR 1 resource that contains the IDs of these menus. The
application’s Set UpMenus function creates the bartender (stored in
the global variable gBar t ender ) to read the MBAR 1 resource.
The bartender creates the tables that match command numbers to
menu items.
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Note
The application’s menus must be in MBAR 1
unless you change the definition of MBARapp in
Const ant s. h.

If you want the bartender to return the menu ID and item number of
a particular menu item, use the special command number -1 in your
MENU resource. The bartender returns the negative of the long
integer that contains the menu ID in the high word and the menu
item number in the low word.

Building menus on the fly

Menus created while a program is running, such as Font menus,
don’t have command numbers associated with their items that
you've specified at design time. Instead, the bartender’s

Fi ndCndNunber function returns the negative of the long integer
that contains the menu ID in the high word and the item ID in the
low word. When your DoComand function gets a negative
command number as argument, you must figure out the command
from the menu ID and item number.

For example, if DoComand gets a command -655369
(OXFFF5FFF7), the sign of the argument indicates that no command
number defined at design time is associated with the menu item. To
extract the menu ID and the item number, negate the value and split
it into two words. The negative of the sample argument is 655369
(0x000A0009), so the menu ID is 10 and the item number is 9.

N\
—(‘ menul D menul tem

Figure 7-6 How FindCmdNumber builds command numbers

You can add menu items to existing menus. These items must be
added at the end of an existing menu; otherwise, the bartender gets
confused.

Dimming and checking menu items

The bartender includes functions for enabling and disabling, as well
as checking and unchecking, menu items. When you click the menu
bar, the bartender calls the gopher’s Updat eMenus function.
Typically, this results in the Updat eMenus function being called for
every bureaucrat in the chain of command. In the general case, all
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the items in the menu start out disabled and unchecked. Then each
bureaucrat enables the menu items that pertain to it. Once the
appropriate items have been enabled and checked, the Toolbox
routine MenuSel ect is called to display all the menus.

Note
This process of enabling, disabling, checking, and
unchecking takes very little time. No noticeable
delay occurs between clicking the menu bar and the
display of the menu.

Suppose you click the menu bar of a text-processing application.
First, the bartender disables all the menu items. Then, the application
enables the application-related menu items such as New, Open, and
Quit. The document enables the document-related items, such as
Save, Save As, and Revert (if the document has been changed). A
pane might check the current font and size in the Font menu.
Finally, the menu appears on the screen with the correct items
checked and enabled.

The Updat eMenus functions of your application, document, and
pane need to enable each item. To ensure that item-enabling

proceeds from the general (application) to the specific (pane), call
the base class function first in your own Updat eMenus function.

You can use the bureaucrat functions Set Di mOpt i on and

Set Unchecki ng in your application Set UpMenus function to
modify the preliminary disabling (or “dimming”) and unchecking
process. Set Di nOpt i on lets you specify whether the bartender
should dim all, some, or none of the items when you click the menu
bar. For Font menus, for instance, dimming all the font names and
then enabling them again makes little sense.

Dim Option Meaning
di nNONE Never dim any of the menu items.

Table 7-5 Menu dimming options
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Dim Option Meaning
di nSOVE Dim only the menu items that have
command numbers associated with them.

di mALL Dim all of the menu items. Each
bureaucrat’'s Updat eMenus function
must enable the items for the commands it
handles. This is the default.

Table 7-5 Menu dimming options (Continued)

Set Unchecki ng lets you specify whether the bartender unchecks
all menu items.

Unchecking option Meaning

TRUE Uncheck all the menu items at menu
selection. Your Updat eMenus function
should check the appropriate items. Use
this option for menus, such as Font menus
or Style menus, whose items are mutually
exclusive.

FALSE Don't uncheck any menu items at menu
selection. This is the default, since most
menu items never need to be checked.

Table 7-6 Menu unchecking options

Handling Low-Memory Situations

The CApplication class provides several functions that deal with low-
memory situations. These functions use a memory reserve called the
rainy day fund.

Note
For details about the functions and data members
described in this section, see Chapter 18,
“CApplication.”

When you create a CApplication object, you supply arguments to its
constructor specifying how much memory your application should
allocate for the rainy day fund. You also specify how many bytes
should be available to satisfy Toolbox routine memory requests, and

Visual Architect and THINK Class Library Guide 133



7 Programming with the THINK Class Library

how many bytes of that fund should be available to satisfy critical
operation requests. These values are stored in the data members
t ool boxBal ance and criti cal Bal ance.

If the Macintosh Memory Manager gets a request for more memory
than is available, it calls a grow zone function. In the THINK Class

Library, the grow zone function calls the application’s G owmvenor y
function.

The Gr owMenor y function tries several strategies to free memory in
the heap. First, it calls the application’s Meror yShor t age function.
Your application class should override this function to release
memory that is not crucial to execution. For instance, your

Menor yShor t age function might delete a buffer it no longer
needs. If the Menor yShor t age function isn’t able to release
enough memory, G omvenor y starts using the rainy day fund.

G owMenor y looks first at the i nCri ti cal Oper ati on data
member to release memory from the rainy day fund:

If inCriticalOperation is... Leave this much in reserve
TRUE t ool boxBal ance
FALSE critical Bal ance

Table 7-7 How much memory to leave in reserve

A critical operation is an operation that occurs in response to a single
Macintosh event, and that should never fail—even though it might
require a large amount of memory. For instance, saving a file is a
critical operation. You can use the routine

SetCritical OperationtosettheinCritical Operation
flag.

If G owvenor y still isn’t able to release enough memory and the
canFai | flag is TRUE, it returns without trying to allocate any more
memory. Setting the canFai | flag to TRUE indicates that the
application can deal with a failing memory request.

If the canFai | flag is FALSE, G- owivenor y tries to release all the
memory left in the rainy day fund, because the application is not
prepared to deal with a failing memory request. If there is still not
enough memory, even after using the rainy day fund, the application
will probably crash.
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You can use the routine Set Al | ocat i on to set and reset the
canFai | flag. In general, your application should be prepared to
handle failing memory requests.

Undoing and Mouse Tracking

The THINK Class Library provides a class that lets you implement the
Undo command easily. In the default implementation, each
document has its own undo history.

Undoing

The THINK Class Library uses the abstract class CTask to implement
undoable actions. For every undoable action in an application, you
need to create a derived class of CTask.

After you perform an action, you store enough information to undo
it in the task’s data members. Then you call the supervisor’s

Not i f y function with the task as an argument. The CDocument
class implements the Not i f y function to store a task in one of the
document’s data members. When you choose Undo from the Edit
menu, the document’s DoConmand function calls the Undo function
of the task it stored.

Here’s an example. Suppose you've derived a class from CTask to
change the font in an edit text pane. Before calling the edit pane’s
DoConmmand function to change the font, you create a task and store
the current font in a data member that you have defined. After you
pass the font command to the edit text pane, you call the document’s
Not i fy function with the task as an argument.

The Undo function would simply call the document’s DoConmrand
function to change the font back to the saved, previous one. Since
the command goes through the regular command chain, the
DoComrand function would create a task to let you undo what you
were undoing.

Mouse tracking

The THINK Class Library uses the undo mechanism to make mouse
tracking easier and undoable. The CMouseTask class is an abstract
class that defines functions specifically for mouse tracking.

To implement a mouse tracking task, define a derived class of
CMouseTask and override the KeepTr acki ng and EndTr acki ng
functions. The KeepTr acki ng function does whatever you want to
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happen while the mouse is down. The EndTr acki ng function does
whatever you want to happen when the mouse is released.

For example, if you're moving a rectangle from one place in a pane
to another, KeepTr acki ng might draw a gray outline that moves as
you move the mouse. The EndTr acki ng function would erase the
rectangle from its old location and redraw it in the new location.

To make your mouse task undoable, you need to store enough
information in the task object to undo the effects of mouse tracking.
You must also override Undo (inherited from CTask) to use this
information to undo the effects of the mouse task.

After tracking the mouse, you can call the document’s Not i fy
function with the task as an argument. When you choose Undo from
the Edit menu, the document calls Undo to undo the effects of
mouse tracking.

Debugging and the THINK Class Library

The THINK Class Library incorporates features that help you debug
TCL programs.

Debugging aids in Symantec C++

If the preprocessor symbol  TCL DEBUG __ is defined, various
error-checking functions, such as the TCL_ASSERT macro, are
enabled. The TCL_ASSERT macro takes a Boolean expression as an
argument and displays an alert if the assertion is FALSE.

In Symantec C++, the global variables gBr eakFai | ur e and
gAskFai | ur e let you examine and simulate exceptions. If

gBr eakFai | ur e is TRUE, the THINK Class Library calls the
Toolbox routine Debugger when Fai | ur e is called, and it calls
DebugSt r when the ASSERT macro is called with an argument that
evaluates to FALSE. If gAskFai | ur e is TRUE, the THINK Class
Library calls Debugger when the utility routines such as

Fai | OSErr are called that may raise exceptions. You can then
change the arguments to the utility routine to simulate an exception.

There are two underscores at the beginning and end of
__TCL_DEBUG__. You can set the value of __ TCL_DEBUG__ on
the Prefix page of the Symantec C++ Options dialog.
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The THINK Class Library requires that certain resources be present in
your project’s resource file. All of the resources described in this
section are in the file TCL Resour ces. The mnemonic constants
for all of these resources are in the file Const ant s. h, which
resides in the Cor e Header s folder within the Cor e Sour ces
subfolder of the Cl ass Li br ary folder.

Alerts

The ' ALRT' and' DI TL" resources always have matching IDs. You
can change these resources to suit your application.

ALRT/DITL ID Used for

128 General. A handy, all-purpose alert box. The
"DI TL' contains only “*0” so you can use the
Toolbox routine Par anifext to set up the text.

150 Confirm to revert to last saved version.

151 Confirm to save changes before closing or quitting.

200 Severe Macintosh error has occurred.

250 No printer selected.

251 Error alert. The ' DI TL' message is “Coul dn’ t
conpl ete the | ast command because
0.

252 Error alert. The ' DI TL' message is “Coul dn’ t

successfully startup or quit the
application because "~0.”

253 Assertion failed. Used by assertion in exception
handling.
300 Macintosh OS error alert.

Table 7-8 Alert and dialog resources
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Controls

The THINK Class Library uses this CNTL template for all the scroll
bars it creates.

CNTL Used for
300 Scroll bar

Table 7-9 Control resources

Error message strings

The THINK Class Library uses a resource of type ' Est r' to report
Macintosh errors. ' Estr' resources have exactly the same format as
' STR ' resources. You can use the ResEdi t command Open as
Template from the File menu to open and editan ' Estr' resource
asan' STR '.

The ID of the ' Estr' resource is the error code you want to
identify. The file TCL Resources includes' Estr's. The error-
handling class CError uses ' Estr' resources to display messages.
You should create an ' Estr' for every error an application reports

to the user.

Estr Used for

-108 Out of memory

-192 Tried to get nonexistent resource

Table 7-10 Error string resources

Menus

The THINK Class Library reserves the menu IDs shown in Table 7-11
for the standard menus. The File and Edit menus contain all the
standard items. You can remove the ones that don't apply to your
application. The bartender builds the desk accessory menu for you
automatically, but you have to build the Font and Size menus
yourself in the Set UpMenus function of the application. For sample
Font and Size menus, see the TinyEdit project in the TCL Denbs

folder.

Menu Used for
1 Apple

2 File

3 Edit

Table 7-11 Menu resources
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Menu Used for
10 Font
11 Size

Table 7-11 Menu resources (Continued)

Note
The mnemonics for these menus are in
Commands. h, not in Const ant s. h.
Menu bars

The THINK Class Library uses the ' MBAR' resource to install all the
menus in your application. This resource automatically includes the
Apple, File, and Edit menus.

MBAR Used for
1 List of all menus to install at application startup.

Table 7-12 Menu bar resource

Small icon

Earlier versions of THINK Class Library used a small icon instead of
the Toolbox routine Dr awG owl con to draw a grow box. If your
application uses Sl CNs, you can use the routine Dr awSI CN to draw
it in a pane. See Chapter 127, “TCL Utilities” for details.

SICN Used for
200 Grow box

Table 7-13 Small icon resource

Strings and string lists

The THINK Class Library uses these strings for various prompts and
messages. You can modify these to suit your application. The string
resources are in Table 7-14.

STR Used for
150 Prompt for the Save As dialog box.
300 Generic operating system error message used

when no Est r resource is available.

301 Generic error suffix, “of a Mac OS Error”.

Table 7-14 String resources
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The string list resources are in Table 7-15.

STR# Used for

128 List of common Macintosh words and phrases. This
list includes qui tti ng, cl osi ng, Undo, Redo,
Untitl ed, Show i pboard, and H de

i pboard.
129 Strings used for low-memory warnings.
130 Task names for changing the wording of the Undo

menu item text. This resource has no strings. An
application should add strings to this list if it
supports Undo. See the descriptions of CTask and

CMouseTask.
131 Strings used by exception handler.
133 Strings used for dialog entry validation.

Table 7-15 String list resources

Window template

The THINK Class Library requires only one window template for the
Clipboard window. An application usually defines one or more
additional W ND templates.

WIND Used for
200 Clipboard. Window template used for displaying
the clipboard.

Table 7-16 Window resource

Segmentation and the THINK Class Library

You can segment your application in any fashion. Remember,
however, that certain files and libraries must be in a resident
segment—that is, a segment that is never purged.
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These files and libraries must be in a resident segment:

e CApplication.cp

* Exceptions.cp

* LongCoor di nates. cp
e TCLpstring.cp

e« TCLUtilities.cp

e CPlusLib

e MacTr aps

e MacTraps2

Modifying the THINK Class Library

In general, to change the behavior of one of the THINK Class Library
classes, you create a derived class of the class you want to modify,
and add new member functions or override the existing ones you
need to change. Almost all member functions in the THINK Class
Library are virtual.

In rarer cases, you might decide to change the source code for a
THINK Class Library class. However, two dangers are inherent in this
approach. First, Symantec will release new versions of the THINK
Class Library. Changes made in the source code may make it difficult
to use new classes or updates of existing classes. If you do make
changes to a class’s source code, make sure to keep an archival copy
of the original files and to mark your changes clearly.

The second danger is somewhat more subtle. As you use the THINK
Class Library, you may want to create general-purpose, reusable
classes derived from THINK Class Library classes. Neither you nor
anyone else can use these classes in other programs if, in creating
these classes, you relied on features of THINK Class Library classes
that you introduced by changing source code.

Note
Under your license agreement, you may distribute
new classes derived from the classes in the THINK
Class Library. You may not, however, distribute
modified sources of THINK Class Library classes.
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Where to Go Next

Learning to use the THINK Class Library takes time and
experimentation. Start with the TinyEdit example in the TCL Denos
f ol der. You might start by adding an About box to the TinyEdit
application. (Hint: Since displaying the About box should occur in
response to an application-wide command, implement it in the
application’s DoCommand function.) You may also want to
experiment with the NewClassDemo, ArtClass, and AEStarter demos,
also in the TCL Denvos folder. As you explore how these
applications are put together, refer to the chapters in Part 4 of this
guide to understand how the classes of the THINK Class Library
work.
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-I-The Obiject 1/0 capabilities of the THINK Class Library make it easy
to store objects to and retrieve objects from disk, preserving their
entire state. Thus, your objects can persist even while the application
that created them is not running; when the application next retrieves
these objects, they are recreated exactly as they were when stored.
Among the many uses you'll find for this capability is preserving the
complete state of an application before it quits. You can preserve, for
example, open documents, windows, panes and their contents, sizes
and positions, and so on. This chapter also introduces the THINK
Class Library view utilities, which build on Object I/0 to facilitate
reading and writing views and windows stored as resources.
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Introduction

Object I/0 provides everything you need to permanently store
objects on disk as documents or resources. Object 1/0 can:

Write any object to disk and read it back

Read and write complete recursive data structures with
one program statement

Read and write simple data, such as integers and strings

Be easily extended to read and write your own classes,
regardless of whether or not they are derived from THINK
Class Library classes

Object 1/0 is also used to read view resources written by Visual
Architect. For information on this topic, see the section “Using the
View Ultilities”, later in this chapter.

Object I/0O is more than a simple 1/O library: It allows you to read
and write arbitrary collections of objects with a single program
statement. Input in Object I/0 is polymorphic; you do not need to
know the specific class of the object about to be read in, only its root
class—the object’s ancestor class that is highest in the class hierarchy
and has no base class.

Forty-four of the standard THINK Class Library classes can do Object
I/0, including all the collection classes. To extend Object 1/0 for
your own derived classes, you only need to write two macros and
define two simple member functions in each derived class.

Streams

Obiject I/0 does its work using streams. A stream is an object that
gets and puts information either sequentially or randomly.

CStream
CStream is an abstract base class that defines the basic protocol—the
functions used to get and put—for all stream classes.

CStream is different from the C++ iostream classes. The main job of
the iostream classes is translating between binary and text format.
The CStream derived classes are binary streams. They get and put
data in internal format, avoiding conversion overhead. Also, to read
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an object from an iostream, you must know the exact class of the
object, whereas CStream only requires that you know the object’s
root class.

CFileStream, CHandleStream, and CCountingStream

The three concrete stream classes in the Object 1/O Library are
CFileStream, CHandleStream, and CCountingStream; all are
descendants of CStream. CFileStream reads and writes a Macintosh
data file using a CDataFile object. CHandleStream reads and writes a
Memory Manager handle. Typically, CFileStream is used to get and
put documents, while CHandleStream is used to get and put
resources. CCountingStream does no I/0. It is used to simulate
output operations to determine how much space they require.

CFileStream and CHandleStream are both derived from the
intermediate class, CBufferedStream. CBufferedStream improves the
performance of file streams (up to 10:1) by buffering chunks of data
to be read or written in program memory, rather than reading or
writing each data item immediately from or to the buffers used by
the operating system.

Handle 1/0 isn't buffered. A CHandleStream uses CBufferedStream
purely for its get and put functions. The handle is the buffer, in this
case.

Basic stream operations
The five basic functions of a stream are Qpen, C ose, At End, Get
and Put :

= Open readies a stream for input or output (or both).

= O ose completes any outstanding put operations and
returns the stream to the unopened state.

At End tests for end-of-stream.

Get reads bytes from a stream opened for reading.

Put writes bytes to a stream opened for writing.

These five functions, together with the usual complement of
constructors, initialization functions and destructors, make possible
any sort of sequential 1/0—at least in principle.
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In practice, a number of higher-level functions are provided to make
programming more convenient. These functions get and put
primitive data types, Memory Manager data, and objects.

Primitive data functions
Functions that get and put primitive data types are listed here:

Get Put Type
Cet Bool ean Put Bool ean Bool ean
Cet Char Put Char char

Get CString PutCString char *
Cet Doubl e Put Doubl e short doubl e

Cet Fl oat Put Fl oat fl oat
Cet I nt Put | nt int

Get Long Put Long | ong
Cet Short Put Short short

Get Str 255 Put St r 255 unsi gned char *
(Pascal string)

Table 8-1 Primitive data Get and Put functions

Should you wish to do so, adding more primitive-type functions to
your stream-derived class is easy; however, the types listed in Table
8-1 meet most needs when they are coupled with appropriate
typecasting.

Note that the f | oat and doubl e functions use IEEE standard 32-
and 64-bit formats, respectively.

Memory Manager data functions
Functions that get and put Memory Manager data are:

Get Put Type
Cet Handl e Put Handl e Handl e
CGetPtr Put Ptr Ptr

Table 8-2 Memory manager data Get and Put functions

Of course, these functions do not get and put the handle or pointer.
Instead they get and put the data on the heap pointed to by the
handle or pointer.

Get Handl e and Get Pt r allocate new space on the heap and then
copy the information from the stream to the allocated space.
Get Handl e and Get Pt r may fail to find the memory they need. If
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s0, they raise an exception using the THINK Class Library exception
mechanism, by calling Fai | ur e.

Calling Put Handl e or Put Pt r with a null pointer is permissible; it
does not cause an error. Likewise, Get Handl e and Get Pt r may
return a null pointer.

Object functions
Member functions that get and put object data are:

Get Put Type
Get Obj ect Put Obj ect any class

Table 8-3 Object functions

Put Obj ect writes an object to a stream, and Get Cbj ect reads an
object from a stream. A class that is to be used with Object I/0 must
be declared as a run-time type identification (RTTI) class using the
TCL_DECLARE_CLASS and TCL_DEFI NE_CLASS macros
described in Chapter 9, “Exception Handling and RTTI.”

Like Get Handl e, Get Obj ect allocates memory from the heap and
then copies the object’s contents from the stream to the allocated
space, returning a pointer to the new object. Get Obj ect uses the
new_by name function, described in Chapter 9, “Exception
Handling and RTTI,” to create the object.

It is permissible to call Put OCbj ect with a null pointer, and
Get Obj ect may return a null pointer.

More about Get Obj ect and Put Obj ect is in the CSaver section
later in this chapter.

Views and bureaucrats
Two additional functions get only object data:

Function Type
Cet Bur eaucr at CBur eaucr at *
Cet Vi ew CVi ew*

Table 8-4 Views and bureaucrats
You may never use Get Bur eaucr at , but Get Vi ew can be handy.

Object I/0 can get and put windows, panes, controls, borders,
environments—most objects that represent what the user sees. This
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capability allows you to get and put the entire visual state of a
window almost as easily as reading or writing an integer.

You put a view with Put Cbj ect . You get a view with Get Vi ew.
Get Vi ew is used because the newly created object needs to know
its enclosure and supervisor during initialization. Having obtained
that information, Get Vi ew calls Get Obj ect .

Get Vi ew is called by the TCLGet NamedW ndow and
TCLGet NanmedSubvi ew functions used to read view resources
written by Visual Architect.

Using get and put
Get and put functions are used in the obvious way. The first
argument to all put functions is the data to be written. For example:

stream Put Long( aVal ue) ;

Get functions return simple data as values, and record or array data
as the value of the first argument. For example:

aVal ue = stream Get Long();
stream Get St r255(str);

Getting and putting objects is no more difficult, though the syntax is
a little different. For example,

Put Obj ect (stream itsContents);
Get Obj ect(stream & tsContents);

A document might use the first statement above to write its entire
contents to a stream, and the second statement to later read the
contents back.

>> and << stream operators
CStream, like C++ iostreams, overloads the << and >> operators to
allow you to use the following more succinct notation:

stream << al ong << ashort;

in place of:

stream Put Long(al ong) ;
stream Put Short (ashort);

where al ong is of type | ong and ashort is of type short.
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The standard THINK Class Library classes that can be read or written
also overload the << and >> operators, allowing the same concision
for reading and writing objects:

stream << myQhj Ptr;

instead of:

Put Obj ect (stream nyQbj Ptr);

If you want to override these operators for your own classes, add
declarations like those in the following example to your class
declarations:

friend CStream& operator <<
(CStreanm& s, Myd ass* p)
{ return Puthject(s, p); }
friend CStream& operator >>
(CStrean& s, MyCl ass*& p)
{ return Gethject(s, p); }

The THINK Class Library overloads these operators only for root
classes—such as CCollaborator—in the class hierarchy that can do
object 1/0, because those classes contain all the information strictly
needed by Get Obj ect and Put Qbj ect . Then, for example, when
writing or reading a CView object, the THINK Class Library uses
code such as the following:

stream << aVi ew;
stream >> (CCol | aborator*) aView,

The CView pointer, being derived from CCollaborator, satisfies the
<< operator for CCollaborator. However, the argument to >> must
be typecast, as C++ will not automatically coerce a reference to a
derived class pointer (here, CView*&) to a base class pointer (here,
CCollaborator*). You can use this same strategy for your own classes,
if you wish, or you can simply overload the << and >> operators for
each class that you want to do Object I/0.

PutTo and GetFrom

Object I/0 adds two new virtual functions to every class that can do
Object I/0: Put To and Get Fr om Unlike the put and get functions,
which are CStream member functions or friends of that class, Put To
and Get Fr omare member functions of the persistent objects
themselves. You generally will use these when reading and writing
objects.
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Put To and Get Fr omare called with a reference to a stream their
argument. The Put To function for each class is responsible for
putting the data members of the class to the stream. The Get Fr om
function is responsible for getting the data members of the class
from the stream and further initializing the class as needed.

For Object I/0 to work on your objects, you usually need to include
these two functions in each object class. (If a class has no data
members and requires no special initialization, it does not need to
add Put To and/or Get Fr omfunctions.)

Most THINK Class Library classes are provided with Put To and
CGet Fr omfunctions, so you have many examples. All follow the
same general structure:

« Put data members to the stream
« Call inherited Put To
= Put subordinate objects to the stream

The Get Fr omfunction has the following general outline:

« Get data members from the stream
Initialize as needed by subordinate objects
Call inherited Get Fr om

Get subordinate objects from the stream
Finish initialization for the class

A subordinate object is one pointed to by a data member of the class
is saved with the object being written and restored with object being
read.

By convention, a class puts all non-object data members to the
stream and lets its base classes put all their non-object data members
before it puts any subordinate objects. This stores the primitive data
for each object contiguously on the stream. It also allows an object
to completely recover its non-object data members and initialize
itself before any subordinate objects are read. This can be important
if the subordinate objects refer to the object in the course of
initializing themselves.
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Sample PutTo function
Most Put To and Get Fr omfunctions are quite simple. For example:

voi d CDi al ogText:: Put To(CStrean& strean
{

SaveDi al ogText s;

s. maxVal i dLengt h = maxVal i dLengt h;
s.isRequired = i sRequired;

s.val i dateOnResi gn = val i dat eOnResi gn;
stream Put Struct (s);

CEdi t Text:: Put To(aStream;

}

The above is the actual text of the CDi al ogText : : Put To
function. As you can see, the function simply copies data members
to astruct, puts the struct to the stream, and calls its base
class’s Put To function to do everything else.

Saving subordinate objects
The ability to save subordinate objects allows you to save or restore
entire objects with a single call to Put Obj ect or Get Obj ect .

There is no requirement that a class’s Put To and Get From
functions put and get subordinate objects. This is entirely up to the
class. How a class treats the objects it points to establishes the
boundaries of the data structure that Put Obj ect writes each time it
is called.

A class may refrain from putting an object it points to for several
reasons—most notably, because the object is not saved at all or
because some other class will save it. In the former case, the object
pointed to must be created afresh by the class’s Get Fr omfunction.
In the latter, the Get Fr omfunction must obtain a pointer to the
object, such as from a global variable. Both kinds of behavior fit
readily within the general structure provided.

Duplicate checking

You may wonder how Put To and Get Fr omwork if an object is part
of a pointer-based data structure that isn't a tree, but contains
multiple pointers to the same object, or even cycles. For example,
each THINK Class Library view object contains a pointer to its
enclosure, and many views can share the same enclosure.
Nevertheless, Put To and Get Fr omwork properly with views.
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CStream deals with recursive data structures by using a feature called
duplicate checking. Duplicate checking is an option and must be
turned on by calling the CheckDupl i cat es function.

Duplicate checking works by remembering all objects written to a
stream. If an object previously written is again an argument to

Put Obj ect , the object is not written again; instead, an ID number
uniquely identifying the object is written to the stream. On input,
the process works in reverse; ID numbers are converted to pointers
to objects previously read.

CSaver, described next, turns on duplicate checking so that the
i t sCont ent s object can represent a fully general data structure.

CSaver

CSaver, a class derived from CDocument, adds persistence to the
behavior of documents. You must derive your document classes
from this class if you want them to be capable of Object 1/0.

If you examine a project generated with Visual Architect that has a
main window that uses files, you will see that while the application
has complete file-handling capability—New, Open, Close, Save,
Save As, and Revert—it contains no file I/0 code. This is because it
inherits all its 1/0 behavior from the CSaver class.

CSaver builds on the CDocument class, implementing file 1/0
functions that in CDocument are merely abstract. CDocument
provides a basic framework for file operations with its NewfFi | e,
OpenFi | e, DoSave, DoSaveAs, and DoRevert abstract functions.
However, these functions do not actually do anything, because
CDocunent makes no assumptions about the contents of the
document or how the file is used.

Document ground rules
CSaver fleshes out the CDocument skeleton by establishing some
ground rules:
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= For a document on disk, a file and window are always
open when the document is open and they are closed
when the document is closed.

« A new document does not have a file until it is saved.

These rules ensure that the application has exclusive access to the
document’s file while the document is open.

CSaver reads and writes the file’s data fork using a CFileStream. The
document’s contents are read into memory when the document is
opened, written when the document is saved, and removed from
memory when the document is closed.

Document contents
This section describes how CSaver knows what to read and write.

CDocument assumes that for each document there is a primary file
pointed to by the i t sFi | e data member, and a primary window
pointed to by the i t sSW ndow data member. CSaver adds an

i t sCont ent s data member. i t sCont ent s is a pointer to the
document’s contents as represented in memory. Of course, most
contents don't fit into a single object. Usually, i t sCont ent s points
to an object that is the root of a data structure consisting of objects
linked together by pointers, as shown in Figure 8-1.

N . e
N C - C

[ — T
Figure 8-1 Pointer-linked object data structures

The kind of object i t sCont ent s points to is entirely up to the
application. It may be a CList or any other kind of pointer-based data
structure. The objects in the data structure can point to other objects,
to Memory Manager Pt r or Handl e data, or to each other. The
contents data structure does not need to be simple. It can be an
arbitrary graph and it can have recursive cycles. CSaver supports this
generality because Object 1/0 does.

When a document is saved for the first time, CSaver creates a new
CDataFile object asi t sFi | e. It then saves i t sCont ent s (the
entire data structure, not just a single object) to the new file. When a
document is opened, CSaver creates a new CDataFile asi t sFi | e,
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opens it using the information provided by calls to one of its
specification member functions, and reads i t sCont ent s (the
entire data structure) from the file.

Reading and writing i t sCont ent s is done by creating a stream
and calling its Get Cbj ect or Put Qhj ect functions, as described
previously in this chapter. From the point of view of the application
code, reading and writing is completely automatic.

All an application needs to do to take advantage of automatic 1/0 is
to derive its document class from CSaver and to follow a simple
discipline when defining the classes of objects pointed to by

i t sCont ent s. These steps are outlined here.

Defining your document class
To use CSaver:

= Derive your document class from CSaver, specifying the
class of the i t sCont ent s data member, such as:

cl ass MyDoc : public CSaver<MyDat a>

= Add a source file to explicitly expand the CSaver template
class. See the Chapter 94, “CSaver.”

« Qverride CSaver functions as needed to create and
manage the document window or windows.

< Follow a simple outline when defining your
i t sCont ent s. See the section “Defining Your Contents
Classes” later in this chapter.

The only three virtual functions your document class must override
are:

Function Description

VakeNewW ndow Creates a new, empty window

MakeNewCont ent s  Creates new, empty contents

Fai | Open Fails if file is already open in this
application

Table 8-5 CDocument member functions to override when using
CSaver
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In addition to the required three, most documents need to override
the virtual functions listed in Table 8-6 for translating between
itsContents anditsW ndow.

Function Description

W ndowToCont ents  Updates i t sCont ent s from the
information displayed in the window.
Called before putting i t sCont ent s.

Cont ent sToW ndow  Displays i t sCont ent s in the window.
It is called after getting i t sCont ent s.

Table 8-6 CDocument updating functions

A third category of CSaver functions allows you to change or
customize CSaver’s default behavior. These hooks include:

Function Description
ReadCont ent s Default calls Get Obj ect for
i tsContents.
WiteContents Default calls Put Obj ect for
i tsContents.
NewFi | eType Default uses first in applications type list.

Posi ti onW ndow  Default staggers using decorator.

MakeW ndowNane Default uses file name or Untitled.

Table 8-7 CSaver functions

Creating and opening documents

The CApplication class defines Cr eat eDocunent and
OpenDocurnent virtual functions. Cr eat eDocunent creates a new
document; OpenDocumnent opens an existing document. Both
functions then call various member functions of the document, and
recover from any failures in those functions by deleting the
document.

Defining your contents classes

Define a single object as the root of your i t sCont ent s data
structure. When you create a new document, store a pointer to this
object in i t sCont ent s.
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For Object 1/0 to work as intended, the root object should define
Put To and Get Fr omfunctions that put and get the other objects
comprising the document. For instance, in some applications the
root object is a CList object, which already automatically puts and
gets the objects on the list. Of course, the root object does not have
to be a CList; it can be of any type.

You must define Put To and Get Fr omfunctions for all of the object
classes that are part of the document’s data. See the “PutTo and
GetFrom” section earlier in this chapter for details.

Duplicate checking in CSaver

CSaver uses duplicate checking, so the i t sCont ent s data
structure can be fully general. See the “Duplicate Checking” section
earlier in this chapter for more information.

Using CSaver with Visual Architect

If you generate code with Visual Architect and your main view uses
a file (the default), the document class generated to direct the view
will be derived from CSaver. You do not have to worry about
NewFi | eType, Posi ti onW ndow, or MakeW ndowNarne; the
generated code overrides these functions. Visual Architect also
generates Cr eat eDocunent and QpenDocument functions for
you.

Two additional files are generated for each document view that uses
files: I t sCont ent sC ass_cl assnane. h and

CSaver _cl assnane. cp, where cl assnane is the name of the
document class. Visual Architect does not know the class of the

i t sCont ent s variable. In the | t sCont ent s ass file, the class
defaults to CCollaborator. If this is not correct, change all occurrences
of CCollaborator in the | t sCont ent sd ass file to the appropriate
class name.

Objects on the Scrap

Obiject I/0 can be very handy for working with the scrap, allowing
you to cut, copy and paste objects to and from your program with
very little effort.

Cutting and copying create a temporary output CHandleStream
object in order to write the selected objects to a handle. You save the
handle on the scrap with your own resource type. To paste, create
an input CHandleStream object to convert the handle back to
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objects, then splice the objects into your views and other data
structures.

To illustrate this technique, here is a code example quoted verbatim
from Visual Architect. The statements TRY, CATCH, and ENDTRY are
exception-handling macros; and they are discussed in detail in
Chapter 9, “Exception Handling and RTTI.” If you are unfamiliar with
exception handling, you may think of TRY and CATCH as providing
an object-oriented version of the standard C set j np. The analogue
to calling | ongj np, not seen here, is provided by an object
“throwing an exception.” The statements in the block delimited by
TRY and CATCH comprise a “try block”; they can cause an exception
to be thrown that this example is prepared to deal with. The block of
statements between CATCH and ENDTRY deals with, or “catches,”
any exception caused by execution of the try block; it is analogous
to the block of statements that handles error returns to the location
following set j np.
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void CTaskCopyCut d ear: : Do(voi d)
{

CHandl eStream *stream =
NewQut put Handl eSt r eam( NULL) ;

Handl e h;
TRY
i f (nanel ndex == i ndexCut
| | namel ndex == indexC ear)

copyli st - >DoFor Each( Hi del t);

Put Obj ect (stream copylist);
h = stream >CGet St reantHandl e() ;

gd i pboar d- >Enpt yScrap() ;
gd i pboard->Put Data(' | TEM, h);

stream >Di sposeAl | ();

}
CATCH
{
stream >Di sposeAl | ();
}
ENDTRY
i f (nanel ndex == i ndexCut
| | namel ndex == indexC ear)
edi t or - >Renunber Qbj ect s() ;
done = TRUE;

}

As you can see, Object 1/0 leaves very little to do. The example also
illustrates how the THINK Class Library’s Clipboard object can be
useful in simplifying the scrap interface, even if your program does
not display a Clipboard window.

Reading and Writing Resources

In the typical Macintosh application, when a file is opened the entire
contents of the document are read into memory. The user may
change the contents and save them, causing the entire contents to be
written back to the file. Closing the document removes the contents
from memory.

Some documents are too large to fit entirely in memory, or have
parts that can be saved independently. In this case, a random I/O
capability is needed. Object I/0O gives you two choices:
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< You can implement random access using CFi | eSt r eam
as a base class. In this approach, opening a document
would read only the main part of the document and a
directory to the rest of the document into memory. Your
derived class would be responsible for allocating space in
the file stream, keeping a directory, compacting, and so
on.

= You can use the Resource Manager or an equivalent to
store, retrieve, and index objects or object data structures.

This section discusses using the Resource Manager for this task.

Object I/0 does not try to fool the Resource Manager and convert
resources to objects in place. Saving each object as an individual
resource would use the disk inefficiently and would be too slow for
most applications.

Saving a collection of objects in each resource can be very fast and
efficient. This approach works around some of the restrictions of the
Resource Manager (such as the 2727 resource limit), and takes full
advantage of Object 1/O’s ability to save and restore entire data
structures at a time.

Object I/0 provides a CHandl eSt r eamclass that is designed to be
used with resources. A handle stream is used as a buffer between the
object or object data structure to be read or written, and the resource
represented by the handle.

On input, Get Resour ce creates the handle and a
CHandl| eSt r eamobiject translates between handle and object(s).
The handle is then released, freeing the buffer storage.

For output, there are two possibilities:

= For an existing resource, a CHandl eSt r eamobject
translates between the object(s) and the resource
handle. ChangedResource and Wit eResour ce or
Updat eResFi | e change the resource on disk.

< For a new resource, a CHandl eSt r eamobject creates a
new handle as it converts object(s) to the handle.
AddResour ce is then used to add the handle to the
resource file. (Alternatively, AddResour ce can be used
for both existing and new resources in a general-purpose
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function that always removes any existing resource before
attempting to add one.)

The general outline for getting an object from a resource is:

aResource = GetResource(...);

aStream = Newl nput Handl est rean( aResource);
aSt ream >Get Obj ect (&nbj ect) ;

del ete aStream

Rel easeResour ce( aResour ce) ;

After this code executes, anChj ect points to the object read from
the resource.

Putting an object data structure to a resource can be accomplished as
follows. As in the preceding example, aSt r eamis a
CHandl eSt r eamvariable:

aStream = NewCut put Handl eSt r ean{ NULL) ;
aSt r eam >Put Obj ect (anCbj ect) ;

aResource = aStream >CGet St reanHandl e() ;
del ete aStream

AddResour ce(aResource, ...);

Rel easeResource(aResource)

These sequences are general-purpose and sufficient for most needs.
However, nothing about Object 1/0 requires you to follow this
approach. A file stream can do random 1/O, so you can construct
any sort of access with it. Or, you might construct a new

CBuf f er edSt r eamderived class to take advantage of the buffered
resource 1/0O available in System 7.

Whatever approach you choose, Object I/0 either provides what
you need off the shelf or gives you a solid platform for constructing
more sophisticated solutions tailored to the needs of your
application.

Using the View Utilities

This section describes how to use the Visual Architect view utilities
to open and display Visual Architect view resources. Even though
Visual Architect generates code to open alerts and windows in
response to commands (see Chapter 11, “Creating and Editing Menus
and Commands”), the view utilities make it easy to:

= Open windows or subviews defined as view resources in
your own code.
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< Use Visual Architect view resources in THINK Class
Library programs that are not generated by Visual
Architect.

The functions introduced in this chapter are documented in the
section “View Resource Utilities” of Chapter 127, “TCL Utilities,”
which you should consult for additional information.

View Resources

Visual Architect views are stored as resources of ' CVue' type in the
resource fork of your application or, during debugging, in your
project’s Vi sual Architect.rsrc file.

Two kinds of view resources are currently defined: window and
pane. Window view resources hold all the windows you define in
Visual Architect—dialogs, document windows, plain windows, and
floating windows. Pane view resources hold subviews.

Internally, a Visual Architect view resource has two parts: a header,
and body. The header is the same for both window and pane
resources. It is defined by the C struct:

typedef struct {

unsi gned char versi on;

unsi gned char ki nd;

Poi nt initial Position;
} Vi ewResour ceHeader ;

This format is supplied for your information only. Using the view
utilities, you never have to inspect the contents of a view resource.
Additional kinds of view resources, possibly with different header
information, may be added in the future.

The body of a view resource is simply the window or pane as
written to a stream by Object 1/0. Each object in the stream begins
with a class identifier and is followed by the data written by the
Put To member function of each derived class of the object,
beginning at the outermost level. The format of the view resource is
implicitly defined by the operation of the Put Cbj ect function and
the Put To member functions of the CView-derived classes you
define.

Object 1/0 is used to read the body of a view resource. The
CSt r eam : Get Vi ew member function does the actual translation
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from the resource encoding to objects in memory. Get Vi ew, in
turn, calls Get Obj ect.

Since Object 1/0 does the translation, all that remains for you to do
is allocate a stream for input, read the resource from disk, and delete
the stream after the view is in memory. In fact, you don’t even have
to do this—view utility functions do it for you.

TCLGetNamedWindow
The TCLGet NanmedW ndow function creates a window from a view
resource. Its prototype is:

CW ndow * TCLGet W ndow( St r 255 narne,
CBur eaucr at *aSupervi sor);

Only three lines of code are required for a director to read a window
stored on disk as a view resource and display it to the user as the
frontmost window. For example:

CW ndow *t heW ndow;

t heW ndow = TCLGet NamedW ndow(
“\pM/WnN”, this);

t heW ndow- >Sel ect () ;

Any run-time initialization you need to do, such as initializing panes
with data from a program, should be inserted between the calls to
TCLGet NanedW ndow and Sel ect .

The view utilities also include a TCLGet W ndow function for
fetching a view resource by resource ID. Visual Architect works only
with named views.

TCLGetNamedSubview
The TCLGet NanedSubvi ew function creates a pane from a view
resource stored on disk. Its prototype is:

CPane *TCLGet NanedSubvi ew Str 255 nane,
CVi ew *anEncl osur e,
CBur eaucr at *aSupervi sor);

Only two lines of code are required for a document director to read
a subview stored as a view resource and add it as a subview of the
window’s main panorama. This is illustrated in the following
example:

Visual Architect and THINK Class Library Guide 163



8 Using Object I/0

CPane *t hePane;

t hePane = TCLGet NamedSubvi ew( “\ pMySub”,
i tsMai nPane, this );

Depending upon how you set it up in Visual Architect, the subview
pane will be automatically positioned either at a fixed position in the
panorama or at the bottom, beneath all other panes. The subview
always makes room for itself in the panorama’s bounds.

Code to reposition the subview within its enclosure or to do any
run-time initialization should be placed after the call to
TCLGet NanedSubvi ew.

The view utilities also include a TCLGet Subvi ew function for
fetching a view resource by resource ID instead of by name.

Locating panes within views

Within an application, for every item in a view, Visual Architect
assigns a unique value to each | D data member. Each item has a
related view resource. The value assigned to the | D data member is
the item number concatenated to an adjusted view resource ID,
which is the item’s view resource ID minus 128. (128 represents the
offset from the lowest-numbered view resource.)

You can call Fi ndVi ewBy| D, passing this unique 1D value to locate
the pane corresponding to any item. You do not have to calculate or
hard-code these ID values; Visual Architect generates symbolic
names for you in a file named vi ewnanel t ens. h, where

vi ewnane is the name of the view (not the name of the view’s
director class).

You do not need to use Fi ndVi ewByl D just to obtain a pointer to
an item in a window. More direct means exist for this task. For all
panes enclosed by a window, with the exception of scrolling panes
and panoramas, Visual Architect ensures that a pointer to that pane
exists and has a name. Visual Architect generates codes in the

Mak eNewW ndow member function of each lower-level director
class that initializes a pointer to each item in the window. These
pointers’ names are created by combining the view name with the
item identifier, which you set or Visual Architect generates
automatically (such as f Mai n_Pi ct 1 for a Pl CT type item in the
Main view). You can simply use these pointers in your derived
director class to directly reference each item in the window.
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Panoramas are treated differently because they are optionally
enclosed by a pane of type CScr ol | Pane. For example, a table
that has a horizontal or vertical scroll bar or a size box will be
automatically enclosed in a CScrollPane. Similiarly, when the main
panorama of a window or subview has a scroll bar or size box, it is
enclosed in a CScrollPane.

The simplest way to locate the outermost panorama in a window is
tocallthe View Uilities function GetltenPoi nter with an
item number of 0. To get a pointer to the CScrollPane, first locate the
panorama item; the scroll pane will be pointed to by the item’s

i t sEncl osur e data member.

How objects in view resources are initialized

When generated code reads a view resource, each individual pane is
initialized by its default constructor (the constructor with no
arguments) and by Get Fr omfunctions. If you derive a class from
such a pane or panorama and you define it to be in a view, you can
perform any additional initialization by adding code to its default
constructor and/or Get Fr omfunction.

Once a window has been completely initialized, the
MakeNewW ndow function generated in the window's director class
sets the i t sSW ndow data member to point to it.
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-I-he THINK Class Library includes an exception-handling mechanism
to detect and respond to failures. This mechanism lets you divide
your routines into two parts: one to handle normal operation and
another to handle abnormal situations.

The THINK Class Library provides two styles of exception handling.
Simplified exception handling, compatible with previous versions of
the THINK Class Library, provides a simplified execution model in
which functions can “fail” with an error code or message code, and
the failures caught by untyped handlers. Typed exception handling,
the second style, is similar to exception handling in the C++ draft
standard. In this style, functions throw a typed exception, which
handlers can catch by type. Two different sets of macros implement
the two styles. A single try block must use only one style, but the
two can be mixed in the same program.

Run-Time Type Identification (RTTI) is a feature proposed in the
C++ draft standard that makes it possible to test and compare the
class of objects at run-time. The THINK Class Library implements a
large subset of the proposed RTTI standard.

This version of the THINK Class Library uses macros to implement
exception handling and RTTI in anticipation of compiler support for
these features. When that support becomes available, the macros will
be redefined to use it so that you will not have to change your
THINK Class Library programs. All exception-handling macros are
defined in Excepti ons. h; all RTTI macros are defined in

TCLd assl nfo. h.

E Contents
What is an exception handler?. . . . . . . . . . . . .61l
Using the exception mechanism . . . . . . . . . . . .63
Exception handling conventions . . . . . . . . . .63
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What Is an Exception Handler?

An exception is an occurrence of an abnormal condition during the
execution of a program. For example, your program’s normal
operation is to open a file, read and write its data, and close the file.
In the course of operation, though, your program could encounter
problems: for instance, the file may not exist, the file may be
unavailable, media errors may exist, or your program may not be
able to close the file.

The exception-handling mechanism in the THINK Class Library lets
you separate the part of a routine that specifies normal operation
from the part that handles errors. Without an exception handler, your
program might have this kind of structure:

create a file object
if creation failed
report an error
el se
open the file
if open failed
delete the file object
report an error
el se
all ocate a buffer
if allocation failed
delete the file object
report an error
el se

As you can see, the normal flow of control is hidden in all the error-
checking code. With an exception handler, your code looks more
like the following:

TRY TO DO THE FOLLOW NG
create a file object
open the file
al l ocate a buffer
read the contents of the file
close the file
CATCH ANYTHI NG THAT VENT WRONG
if the file is still open, close it
if the file was created, delete it
if the buffer was allocated, release it
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The normal portion is called the try block and the portion that
handles abnormal conditions is called the handler. A statement that
is in the try block or is called from the try block can “throw an
exception” to stop normal operation and go to a handler.

The exception-handling mechanism keeps a stack of handlers. If a
function throws an exception and there is no handler in that
function, control passes to a handler attached to the most recently
entered try block. The THINK Class Library has a handler in
CApplication’s Run function, so any exception is caught that is
thrown after the Run event loop has been entered.

Here’s an example. Suppose you have three functions, each with a
try block and handler:

void A()
{

try
call B()
catch
cleanup A

void B()
{

try
call C()
catch
clean up B
throw same exception

}
void ()
{

try
do something
catch
cleanup C
throw same exception

}

If an operation in function C's try block throws an exception, control
passes to Cs handler. When that handler is finished and the
exception is rethrown, control passes to B's handler, and then finally
to A’s handler. If B had no handler, control would proceed from C's
handler to A’'s handler.
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Not every routine needs to have try blocks and handlers, only those
that need to clean-up errors. Sometimes you can rely on a caller’s
handler to do the clean-up for you. See the section “Use handlers
only when necessary” later in this chapter for more information.

Note
Although the exception-handling routines are
designed to work with the THINK Class Library, you
can use them in a limited way with non-THINK
Class Library programs. To do this, you must
include BELLi b and Excepti ons. cp in your
project, and compile with NO_TCL defined.

When Does the THINK Class Library Throw An
Exception?

In general, whenever the THINK Class Library calls a Toolbox
function that returns an error code, it tests the value of the code and
throws an exception if it is anything other than noErr.

If an object cannot be created (that is, if a call to oper at or new
fails), the THINK Class Library throws an exception. Hence,

oper at or new never returns NULL. Therefore, your code must be
prepared to deal with an exception whenever it creates an object on
the heap or calls a function that does so.

After the THINK Class Library calls the Memory Manager directly to
create a Handl e or Pt r, it checks to see that the requested memory
was actually allocated; if the request was not granted, the THINK
Class Library throws an exception. Similarly, after the THINK Class
Library attempts to load a resource, it checks to make sure the
operation succeeded (there may not have been enough memory in
which to load the resource), and throws an exception if it did not.

Typed Exception Handling

The THINK Class Library supports a subset of exception handling
proposed by the C++ draft standard. Using this subset, your
functions can throw and catch typed exceptions.
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The macros provided for typed exception handling are:

Macro Description

try_ Begins a try block. Equivalent to
the standard t r y keyword.

catch_ Catches an exception of the

(cl ass, nane) indicated class. The variable narme

is defined within the handler as a
pointer variable of the class.
catch_( A, a) isequivalent to
the standard cat ch( A *a).

catch_reference_ Catches an exception of the
(class, nane) indicated class. The variable name
is defined within the handler as a
reference variable of the class.
catch _reference(B, b) is
equivalent to the standard
cat ch(B& b).

catch_no_i nstance_ Catches an exception of the
(class) indicated class.
catch_no_i nstance_(A) is
equivalent to the standard
catch(A).

catch_all _() Catches any previously uncaught
exception. catch_al | _() is
equivalent to the standard
catch(...).

end try Ends a try block and sequence of
handlers. end_try_ has no
standard equivalent.

Table 9-1 Typed exception-handling macros
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Macro Description

t hrow (val ue) Throws the specified value as an
exception. t hrow _(a) is
equivalent to the standard
throw a).

throw sane_ () Rethrows the current exception.
throw sane_ () is equivalent to
the standard t hr ow() .

Table 9-1 Typed exception-handling macros (Continued)

Defining exception classes

The typed exception macros can throw and catch only classes
declared to be TCL_EXCEPTI ON_CLASS or classes derived from
such classes. Each root class that is to be thrown should be declared
in the following manner:

cl ass MyException TCL_EXCEPTI ON_CLASS

member functions and data as needed

b

Note
The TCL_EXCEPTI ON_CLASS macro actually
derives the root class from a base exception class
named _BR_CException. However, the inner
workings of TCL_EXCEPTI ON_CLASS and other
exception-handling macros are not further
documented, as they will change or disappear when
the compiler supports exception handling. No class
or interface underlying these macros is guaranteed
to appear in future releases of the THINK Class
Library.

The CException class
All exceptions thrown by the THINK Class Library are of class
CException, which is declared as:
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cl ass CException TCL_EXCEPTI ON_CLASS

{
publi c:
CException(short err, |ong nsg);
short GetErr();
I ong Get Msg();
void SetErr(short err);
voi d Set Msg(l ong nsQ);

H

See “Displaying error messages” later in this chapter to see how the
err and nsg values are used.

Using typed exceptions
The form of a typed try block with handlers looks like this:

try_
anything that might throw an exception
catch (dassl, varl)

recover from exceptions of Classl
varl is a pointer to an exception object of that class

catch all ()

recover from any other exceptions
}
end _try_

When an exception is thrown, the catch expressions are examined in
order. If the class of a catch expression is the same as (or a base
class of) that of the thrown object, the corresponding handler is
executed. cat ch_al | _ matches any thrown class. Handlers
appearing after the first matching handler are not executed. If no
catch expression matches, no handler is executed and exception
handling resumes with the handlers of the next dynamically
enclosing try block.

Note
The way in which catch expressions are matched
imposes two conditions on the order of handlers.
First, handlers for derived classes must precede any
handlers for their base classes. Second,
catch_al | _, if provided, must be the last handler.
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In cat ch_ expressions, the second argument provides the name of
a pointer variable that the exception handler initializes to point to a
copy of the thrown object; in cat ch_r ef er ence_ expressions, the
second argument provides the name of a reference variable that is
initialized in the same way. These variables let you obtain further
information from the exception objects.

Unlike simplified exception handlers, typed exception handlers do
not propagate automatically. That is, they do not rethrow the
exception automatically. If you want a handler to pass control to a
handler in the next active try block, you must explicitly call t hr ow_
ort hrow_sane_.

The following example illustrates how to catch an exception thrown
by the THINK Class Library, how to intercept and exit normally for
any “file not found” errors, and how to rethrow any other exceptions
thrown by the THINK Class Library.

try_
{
} .
catch_( CException, thrown)
{
if (thrown->GetErr() == fnfErr)
tell user
}
el se
throw sanme_();
}
end _try_

Example 9-1 Catching THINK Class Library exceptions with typed
handling

Returning

You must not r et ur n from within a try block or handler. Except for
throw_andthrow sane_, try blocks and handlers should follow
structured programming rules and have a single entry and a single
exit.

Visual Architect and THINK Class Library Guide 175



9 Exception Handling and RTTI

Exception specifications

In the draft C++ standard, exception specifications let you limit the
types of exceptions a function can handle. The THINK Class Library
does not implement exception specifications. All functions can
handle exceptions of any type.

Simplified Exception Handling

The simplified exception-handling macros are compatible with
previous releases of the THINK Class Library. Using the simplified
exception macros, you can define try blocks and catch all thrown
exceptions. The primary ways in which simplified exception
handling differs from typed-exception handling are:

= You cannot access a thrown value or detect its type. Thus,
only a single handler is allowed.

= By default, simplified exception handlers rethrow the
current exception at the end of the block. If you do not
want the exception rethrown, you must suppress it by
executing the NO_PROPAGATE macro.

The macros provided for simplified exception handling are:

Macro Description

TRY Begins a try block.

CATCH Catches all exceptions. Only one
CATCH macro per TRY is permitted.

ENDTRY Ends a try block and handler.

NO_PROPAGATE Does not rethrow the current

exception at the end of the handler.
Valid only within a CATCH handler.

Table 9-2 Simplified exception handling macros

Note
The simplified exception handling macros are
actually implemented using typed exception
handling. The Fai | ur e function throws an
exception with a value of class CException.
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The basic form
This is the basic form of a simplified exception handler:

voi d Exanpl e()

TRY
This is the normal flow.
Anything here can throw an exception that will be
caught in the handler.

}

CATCH
This is the handler.
Clean up after errors here: close files, release
memory, etc.

}
ENDTRY

Here is a concrete example:
voi d Exanpl e()
{

CThing *objectl
CThi ng *object?2

new CThi ng;
NULL;

TRY

obj ect 2 = new CThi ng;
}
CATCH

TCLFor get Cbj ect (obj ect1);
TCLFor get Obj ect (obj ect 2);

}
ENDTRY
}

Example 9-2 A simple exception handler

In Example 9-2, there are two places in which an exception can be
thrown. First, if you create obj ect 1, and there is not enough
memory, new fails and throws an exception. In this case, no
recovery is necessary in the Exanpl e function, so the creation of
obj ect 1 is attempted outside a try block. The exception passes to
the nearest handler further up the call chain.
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In the second case, if you create obj ect 2 and there is not enough
memory to allocate and initialize it, new takes place within the try
block and control passes to the Exanpl e function’s CATCH handler.
TCLFor get Cbj ect (obj ect 1) deletes obj ect 1 (which is always
non-NULL if control reaches the handler).

TCLFor get Cbj ect (obj ect 2) either does nothing if obj ect 2 is
NULL (memory allocation failed), or deletes the object if it is non-
NULL (failure occurred during initialization).

Retrying a try block

Previous releases of the THINK Class Library defined a RETRY macro
that allowed a handler to restart its try block at the beginning. This
macro is no longer supported. Instead, code such as the following
can be used for the same effect:

Bool ean retry = FALSE;

do
{
TRY
try block
CATCH
{

i f (condition)
retry = TRUE;
NO_PROPAGATE;

}

}
ENDTRY

}
while (retry);
Example 9-3 Retrying a try block

Exception Handling And Destructors

When an exception is thrown, the handler that catches it should be
able to restore the program to a correct state. However, there are
some clean-ups that handlers cannot perform when an exception is
thrown by a constructor. These are:

= Calling stack object destructors

= Ordering of the calls to destructors
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= Freeing memory in the heap allocated by oper at or
new

= Using the stack to clean up the heap

With respect to the sequence of calling destructors, handlers cannot
perform some clean-ups when an exception is thrown by a
constructor:

= Calling destructors of sub objects
« Calling the destructor of a base class

Calling stack object destructors

The draft C++ standard requires that when an exception is thrown,
destructors must be called for all live objects on the stack until the
first handler is executed. The THINK Class Library supports this
requirement with the TCL_AUTO_DESTRUCT _OBJECT macro.

This macro is used to declare root classes, as in the following:

class Myd ass TCL_AUTO DESTRUCT OBJECT

éubl icC:
M/d ass();
~M/d ass();
;. ce

Example 9-4 Auto-destruct class declaration

The macro declares the class to be an auto-destruct class. When an
object of this class or any derived class is constructed on the stack
and an exception occurs later in its scope, the object’s destructor will
be called. For example, suppose MyClass’s constructor and
destructor are defined as follows:
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?/yo ass:: Myd ass()

gCount er ++;
TCL_END_CONSTRUCTOR

}
MyCl ass: : ~Myd ass()

TCL_START_DESTRUCTOR
gCounter--;

Note
See the “Ordering of the calls to destructors”
section below for an explanation of the
TCL_END_CONSTRUCTOR and
TCL_START_DESTRUCTOR macros.

Then the following behavior is seen:

void foo()
gCounter = 0;
Myd ass nyobj ; /1 gCounter==
do something that may throw exception

} /1 gCounter==

Regardless of whether f 0o returns normally or throws an exception,
f 00’s caller always sees the value of gCount er as 0.

Although the example just given is somewhat artificial, it does
illustrate the behavior of auto-destruct objects. It also provides a
model on which you can base your auto-destruct classes.

Classes without destructors do not require auto-destruct capability.
However, declaring a class auto-destruct can make programs easier
to maintain if that class has derived classes with destructors.

Ordering of the calls to destructors

When a constructor throws an exception, the draft C++ standard
requires that destructors be called for all objects fully constructed by
the constructor. Next, the destructor for the object’s base class must
be called before further exception handling is performed. The
THINK Class Library performs the first operation—calling derived
object destructors—automatically, provided the classes of the
derived objects are declared as TCL_AUTO_DESTRUCT _OBJECT.
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To call a base class’s destructor, however, the THINK Class Library
must know which constructors are finished and which destructors
have already been called. You perform this by using the

TCL_END_ CONSTRUCTOR and TCL_START _DESTRUCTOR macros.
The TCL_END_CONSTRUCTOR macro must be the last statement
executed by a constructor of an auto-destruct class; the
TCL_START_DESTRUCTOR macro must be the first statement in an
auto-destruct class destructor. Both are written without trailing semi-
colons.

Freeing heap memory allocated by operator new

When you attempt to create an object on the heap using oper at or
new, memory for the object is allocated on the heap. If the object’s
constructor throws an exception, your program does not have a
pointer to this memory. Consequently, there is no way you can write
a handler to recover the memory. If handlers were solely responsible
for freeing heap memory, any exception in a dynamic object’s
constructor would cause a memory leak.

To prevent such leaks, the THINK Class Library provides the
TCL_NEWmacro, which you can use wherever you would have used
oper at or new. For example, use:

M/C ass *p = TCL_NEW MO ass, ());

instead of:

MyCl ass *p = new MO ass();

The first argument to TCL_NEWis the name of the class; the second
is the constructor argument list enclosed in parentheses. If the
constructor has no arguments, () must be written for the second
argument, as shown above.

The macro works by first calling global oper at or newto allocate
memory for the object, and then calling a replacement oper at or
new to invoke the object’s constructor. For this reason, the macro
cannot be used with classes that overload oper at or new.
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Note
Classes used with TCL_NEWmust be declared as

auto-destruct classes. The THINK Class Library must
determine the proper destructor to call prior to
freeing the memory for the object; it can do so only
if the TCL_END_ CONSTRUCTOR and
TCL_START_DESTRUCTOR macros are used.

Using the stack to clean up the heap

Auto-destruct stack objects can also clean up memory allocated on
the heap without using try blocks. For example, this is the definition
of the CWatchDesc class provided by the THINK Class Library:

cl ass CwWat chDesc TCL_AUTO DESTRUCT OBJECT

{
publi c:
Cwat chDesc( AEDesc *wat ch)
{ watched = watch; TCL_END_CONSTRUCTOR }
CWat chDesc( AEDesc& wat ch)
{ watched = &watch; TCL_END CONSTRUCTOR}

~CWat chDesc()
{ TCL_START_DESTRUCTOR,
i f (watched) TCLForget Desc(wat ched);

}
voi d Keep() { watched = NULL; }
private:
AEDesc *wat ched; // The watched descri ptor
b

Example 9-5 CWatchDesc definition

The CWatchDesc class watches Apple event descriptor records,
which contain a handle to heap storage. When the end of a block is
reached in which a CWatchDesc object is declared, or when an
exception is thrown in the block, the Apple event descriptor pointed
to by the wat ched variable is disposed by the CWatchDesc
destructor. At any time in the block, the program can elect to Keep
the descriptor, in which case the watcher has no further effect on it.
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This allows you to write code such as the following:

voi d MyCreat eTwoDescs()

{
AEDesc d1;
AEDesc d2;
M/Creat eDesc(..., &d1);
Cwat chDesc wat chd1(dl);
MyCreat eDesc(..., &d2);

Cwat chDesc wat chd2(d2);
operations that may throw exception

}

The alternative is longer code that is less easily understood:

voi d MyCreat eTwoDescs()

{
AEDesc di;

AEDesc d2 = {typeNul|};

M/Creat eDesc(..., &d1);

try_

{
M/Creat eDesc(..., &d2);
operations that may throw exception
TCLFor get Desc(d1);
TCLFor get Desc(d2);

}

catch_all _()

TCLFor get Desc(d1);
TCLFor get Desc(d2);
t hrow sane_();

end try_
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Using Exceptions

Use handlers only when necessary

You don’t need a handler when you create an object if you know
that the object will be destroyed by another handler. Here is an
example:

voi d CWApp: : Creat eDocunent ()
CWyDoc *newDoc = NULL,;
TRY

newDoc = new CMyDoc(...);
newDoc- >NewFi | e() ;

}
CATCH

TCLFor get Obj ect (newbDoc) ;

}
ENDTRY
}

voi d CWDoc: : NewFi | e()

Bui | dW ndow() ;
i t sWndow >Sel ect ();

}
voi d CwDoc: : Bui | dW ndow()
CCool Pane *myPane;

i tsWndow = new CW ndow(...);
myPane = new CCool Pane(itsWndow, ...);

}

Example 9-6 A set of routines with only one handler

In Example 9-6, only CMyApp: : Cr eat eDocunent needs a
handler. The others do not. Bui | dW ndow creates a window and
immediately stores it in i t SW ndow, which is a data member of
CMyDoc. Bui | dW ndow also creates a pane, which is immediately
added into the view hierarchy by the CCool Pane constructor. If an
exception is thrown, it will be caught in Cr eat eDocunent ’s
handler, which calls TCLFor get Obj ect . TCLFor get Ohj ect
deletes newDoc, which deletes i t sW ndow. In turn, i t sSW ndow
deletes all panes that the window encloses.
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Returning values

You must not return from a try block. If your function returns a
value, it should return after ENDTRY. For example, look at
CDat aFi | e: : ReadAl | :

Handl e CDat aFil e:: ReadAl | ()
{

regi ster OSErr err Code;
| ong | engt h;
Handl e contents = NULL;

TRY
{
Fai | OSErr ( Get EOF(ref Num & ength));
contents = NewHandl eCanFai |l (I ength);
Fai | Nl L(contents);
Fai | OSErr ( Set FPos( r ef Num
fsFrontart, OL));
Fai | OSErr ( FSRead(ref Num &l engt h,
*contents));

%IATCH
TCLFor get Handl e(cont ent s) ;
%ENDTRY
return contents;
}
Example 9-7 Returning a value from a function with try blocks and

handlers

The ReadAl | function in Example 9-7 is a good example of using
the exception-handling mechanism. Note how all of the File
Manager routines that return error codes are wrapped in calls to

Fai | OSEr r. This utility function checks the error return value; if the
return value is not noEr r, it throws an exception. Note also how the
function uses NewHandl eCanFai | to allocate a handle. The latter
function ensures that the Memory Manager won'’t use any of the
memory reserves to get memory. The call to Fai | NI L throws an
exception if the handle couldn’t be allocated.

Displaying error messages

Handlers ensure that the program is correct in the face of failures,
but they usually do not make the program succeed. When your
program is unable to carry out an action the user has requested, you
need to tell the user that the action couldn’t be performed.
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The most common approach is to display an alert, informing the
user that the most recent operation was not carried out with a brief
explanation. The THINK Class Library encapsulates this approach as
the default behavior of THINK Class Library applications. The Run
event loop has a CException handler that calls Err or Al ert to
display an alert, at the same time displaying the error code with or
without a short message specified for the exception. If the exception
is not derived from CException, the Run handler displays an alert
saying only that an exception occurred during the last operation.

The error code and message displayed are obtained from the thrown
CException object. The error code is usually an OSEr r value
returned by a Toolbox function. Message values are constructed by
calling the Speci f yMsg utility function, which packs the resource
ID of a' STR#' resource, and an index into that resource, into a
single long value. See the description of Err or Al ert in Chapter
126, “TCL Utilities,” to learn how the function interprets the error
code and message values.

CException’s Set Err and Set Msg functions allow you to reset the
error code and message values in a handler; you can then call

t hr ow_same_ to propagate the exception with modified values.
The primary use of this capability is to change the value of the error
code to kSi | ent Err after you have completely handled the error,
so that any higher-level handlers can be invoked without displaying
an error alert to the user. You can also use Set Msg to change the
alert the user sees, to provide an explanation more informative than
a mere numeric code.

If you want a more elaborate error message for a given exception,
catch the exception in one of your own typed handlers, display the
desired message to the user, and call CException’s Set Er r member
function to change the error code value to kSi | ent Err. Then
rethrow the exception to allow other handlers to clean up.

kSi | ent Err tells the handler in the application’s Run event loop
not to display an alert to the user, but instead to proceed silently to
fetch the next event.

Exception Handling Functions

These functions facilitate throwing and responding to exceptions.
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Failure

Fail

FailEvent

FailEventMsg

Exception throwing functions
void Failure (short error, |ong nmessage);

Throws a CException class object containing the er r or and
nmessage values. If error isnotkSi | ent Er r and the exception is
not handled by one of your handlers, the handler in CApplication’s
Run function displays an error alert.

Note
Previous versions of the THINK Class Library set
the global variables gLast Err or to error and
gLast Message to nessage. Developers were
invited to examine and modify these values. For
compatibility, these variables are still set by
Fai | ur e and examined by
CAppl i cati on: : Run. However, this usage is
discouraged and the variables will be removed in a
future version of the THINK Class Library. Use
typed exceptions if you need to see the values of
error or nessage. Instead of assigning values
directly to these variables, call Set Err or Set Msg
before rethrowing the exception.

For an explanation of the message parameter, see the description of
Error Al ert in Chapter 127, “TCL Utilities.”

short Fail (short error);
Calls Fai l ure(error, 0).

short Fail Event ();
Calls Fai | ur e( err AEEvent Not Handl ed, 0).

short Fail Event Msg (|l ong nessage);
Calls Fai | ur e( err AEEvent Not Handl ed, nsg).

Note that error codes and messages thrown during the processing of
Apple events are not seen by users, but are passed back in the reply
to the Apple event.

Error detection functions

Because most exceptions occur as a result of error codes returned by
the Toolbox, the THINK Class Library provides a number of
functions that test for errors and throw an exception only when one
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FailMemError

FailNIL

FailResError

FailNILRes

FailOSErr

SpecifyMsg

SetFaillnfo

is found. You should use these routines whenever you call the
Resource Manager or Memory Manager, or any other Toolbox
routine that returns an error code.

void Fail MenError ();

Throws an exception if the Toolbox function MenEr r or returns
anything but noEr r ; in that case, it calls Fai | ure(err, 0), where
err is the value returned by MenEr r or.

void FailINIL (void *p);

Throws an exception if p is NULL; in that case, it calls
Fail ure(nmentul | Error, 0).

void Fail ResError ();

Throws an exception if the Toolbox function ResEr r or returns
anything but noEr r; in that case, it calls Fai | ure(err, 0),
where er r is the value returned by ResErr or.

void Fail NILRes (void *p);

Throws an exception if p is NULL; in that case, it calls
Failure(err, 0), where err is the value returned by
ResEr r or if that is non-zero, or r esNot Found otherwise.

voi d Fail CSErr (OSErr errCode);

Throws an exception if er r Code is anything but noEr r ; in that
case, it calls Fai | ure(err Code, 0).

Utility routines
| ong Speci fyMsg (short strlListlD,

short strlndex);
Creates a message value. Str Li st Dis the resource ID of a
" STR#' resource, and st r | ndex is the index into that resource.
The value returned should be passed to Fai | ur e (or one of the
routines that calls Fai | ur e). See the description of Error Al ert in
Chapter 127, “TCL Utilities.”

void SetFaillnfo (short newkrror,

| ong newiessage);
Sets the global variables gLast Err or and gLast Message. Sets
gLast Error to newError. Sets gLast Message to newiMessage
if that global is zero, leaving it unchanged otherwise.
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Note
This function will be removed in a future release of
the THINK Class Library. If you want to change an
active CException, use a typed handler and call
Set Err or Set Msg. For more information, see the
section “Displaying error messages” earlier in this
chapter.

Run-Time Type Identification (RTTI)

Run-Time Type Identification (RTTI) is a feature that makes it
possible to test and compare the class of objects at run-time.
Although current C++ implementations do not provide this
capability, the feature has been proposed in the C++ draft standard.
The THINK Class Library implements a large subset of the
functionality of the proposed RTTI standard.

RTTI support
Using RTTI, it becomes possible to do the following at run-time:

= Safely cast a pointer to a base class to a pointer to a
derived class

= Test whether or not the class of an object is derived from
a given class

= Test whether or not the class of an object is equal to a
given class

= Test whether or not the classes of two objects are equal

< Obtain the name of a class as a null-terminated string

= Obtain the name of an object’s class as a null-terminated
string

Because RTTI is not yet implemented by the compiler, RTTI support
is available only to those classes (and their instances) that have been
explicitly declared to be RTTI classes. All classes in the THINK Class
Library are RTTI classes that instantiate THINK Class Library
applications or derive further classes. The procedure for making a
class an RTTI class is explained in the section “Defining RTTI
classes” later in this chapter.

Dynamic casting
The TCL_DYNAM C_CAST macro provides safe casting of a base
class pointer to a derived class pointer.
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TCL Macro: TCL_DYNAM C _CAST(T, p)
Proposed standard: dynani c_cast <T*>( p)

If the class of *p is T or a class derived from T, the macro returns p
cast to type T*; otherwise, it returns NULL. Ordinarily, casting from a
base class to a derived class is unsafe because ( ( T*) p) returns
garbage if p is not of type T or derived from T. However, it is safe to
perform such a cast using TCL_DYNAM C_CAST because the macro
first performs a membership test.

TCL_DYNAM C_CAST returns NULL if either T or the class of *p is
not an RTTI class.

TCL_DYNAM C_CAST can be used to test whether an object is of a
given class or derived class. The following example illustrates this:

CPanenyPane;
if ( TCL_DYNAM C CAST(CButton, &myPane) )

/1 This block always executes

}
el se

/1 This bl ock never executes
}

Type identification
The type identification macros provide for run-time comparison of
types.

TCL Macros: TCL_TYPEI D_FROM TYPE( T)
TCL_TYPEI D_FROM PO NTER( p)
Proposed standard: t ypei d( T)

typei d(*p)

These macros return a type identifier. Two type identifiers can be
compared for equality and inequality, as in the following sample
comparisons:

TCL_TYPEI D_FROM TYPE( CBut t on)
== TCL_TYPEI D_FROM PO NTER( p)

TCL_TYPEI D_FROM TYPE( CBut t on)
I = TCL_TYPEI D_FROM POl NTER( p)

190 Visual Architect and THINK Class Library Guide



Run-Time Type Identification (RTTI) .

TCL_TYPEI D_FROM TYPE(T) returns NULL if T is not an RTTI
class. TCL_TYPEI D_FROM PO NTER( p) returns NULL if *p is not
an RTTI class.

Obtaining class nhames
The class name macros let you obtain the name of a class or of an
object’s class as a string.

TCL Macros: TCL_CLASSNAME_FROM TYPE( T)
TCL_CLASSNAME_FROM PO NTER( p)

Proposed standard: t ypei d( T) . nane()
typei d(*p). nane()

Each of these macros returns the name of its argument as a const
char * as the following example illustrates:

CBut t onnyBut t on;

if (!'strcnmp(“CButton”,
TCL_CLASSNAME FROM PO NTER( &myPane)))

{

/1 This block al ways executes
el se

/'l This bl ock never executes
}

TCL_CLASSNAME FROM TYPE( T) returns NULL if T is not an RTTI
class. TCL_CLASSNAMVE_FROM PO NTER( p) returns NULL if *p is
not an RTTI class.

Note
TCL_CLASSNAME _FROM PO NTERIis equivalent to
cl ass_nane from earlier versions of the THINK
Class Library.
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The member, class_name, and new_by name macros

The THINK Class Library provides the functions nenber,

cl ass_nane, and new_by_name for compatibility with previous
releases. They are implemented as macros that use the RTTI macros.

Function Description

member(T, p) Returns TRUE if the class of *p is T or
derived from T; returns FALSE otherwise,
or if either T or the class of *p is not an
RTTI class. Equivalent to
'l TCL_DYNAM C_CAST(T, p).

class_name(p) Returns the name of the class of *p as a
char *, if that class is an RTTI class.
Equivalent to
TCL_CLASSNAME_FROM PO NTER( p) .

new_by name(T) Returns a pointer to an object of class T, or
NULL if T is not an RTTI class. Similar in
effect to new T.

Table 9-3 Backward-compatible RTTI functions

To allocate memory for the object it creates, new_by nane(T)
uses the class T's oper at or new if it exists; otherwise,
new_by_name uses the global oper at or newto allocate heap
memory. The object is then constructed by the default constructor
for class T, namely T() .

Note
Classes used with new_by_name should define a
default consructor.

Defining RTTI classes

Every class that is to have RTTI capability or will be used with
menber, cl ass_nane or new_by_ nane, must be explicitly made
an RTTI class. You do this by executing the TCL_DECLARE_CLASS
macro in the . h file that declares the class, and one of the
TCL_DEFI NE_CLASS macros in the . cp file that defines it.
Moreover, this must be done for every base class of the class (and
not just immediate base classes), because the base classes of an RTTI
class must themselves be RTTI classes.
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TCL_DECLARE_CLASS requires no arguments and is written
without a trailing semicolon. The define class macros are more
complicated.

To define a class, you must specify the class name and the names of
its immediate base classes, and whether the class is to be used with
new by nane. There are 10 macro variants, as follows:

TCL_DEFI NE_CLASS_M)( class) ;

TCL_DEFI NE_CLASS_ML( class, base) ;

TCL_DEFI NE_CLASS_M( class, basel, base?) ;
TCL_DEFI NE_CLASS_M3( class, basel, base2, base3) ;
TCL_DEFI NE_CLASS_MA( class, basel, base2, base3,
based) ;

e TCL_DEFI NE_CLASS _DO( class) ;

e TCL_DEFI NE_CLASS D1( class, base) ;

e TCL_DEFI NE_CLASS D2( class, basel, base2) ;

e TCL_DEFI NE_CLASS D3( class, basel, base2, base3) ;

e TCL_DEFI NE_CLASS D4( class, basel, base2, base3,
base4) ;

The numbers 0 through 4 specify the number of immediate base
classes. If a class has more than four base classes, you have to define
your own macro. The Mmacros allow only the RTTI macros,
nmenber, and cl ass_nane to be used; the D macros (for
“Dynamic”) allow new_by nane as well.

There is also a separate set of macros for defining dynamic template
classes:

« TCL_DEFI NE_TEMPLATE_CLASS DO( name, T);

« TCL_DEFI NE_TEMPLATE_CLASS D1(name, T,
base) ;

« TCL_DEFI NE_TEMPLATE_CLASS D2( name, T,
basel, base2) ;

« TCL_DEFI NE_TEMPLATE_CLASS D3(name, T,
basel, base2, base3) ;

« TCL_DEFI NE_TEMPLATE_CLASS D4(name, T,
basel, base2, base3, base4) ;
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These template class definition macros work when there is only a
single variant class. For example, to define CList<CView>, write:

TCL_DEFI NE_TEMPLATE_CLASS D1( CLi st,
CView, CPtrArray<CView>).

See the CLi st _CVi ew. cpp file for examples of the template class
definition macros.

The declarations and definitions of the THINK Class Library classes
contain abundant examples of how to use the

TCL_DECLARE CLASS and TCL_DEFI NE_CLASS macros, which
you should examine to reinforce the previous discussion.

Note
If you declare a class to be an auto-destruct class

and you want it also to be an RTTI class, then you
should use one of the root class macros
TCL_DEFI NE_CLASS_M or

TCL_DEFI NE_CLASS DO to define it. Although
your auto-destruct class is actually derived from
_BR_Exception, you should treat it as a root class
when defining its heritage for RTTI.
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Editing Views .
10

I his chapter explains how to create and initialize new views, and edit
existing ones.

Contents
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Adding Balloon Help .

Keyboard Shortcuts .
Scroll keys
Arrow keys .
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Creating Views
9 .

Creating Views

To create a new view, choose New View from the View menu. New
View is enabled whenever there is a Views List window open.

When you create a new view, you are asked to specify some
information about the view in the New View dialog box.

New liew Bae——|

Please name the new view

Name: |I.Intit|ed |

View Kind: | Dialog |

Figure 10-1 The New View dialog box

The name you specify becomes the name of the ' CVue' resource
created for the view. Visual Architect requires that the view name be
unique within the project, so it can be used to construct identifiers
that are also guaranteed to be unique. If you specify a name that
already appears in the project, you will be asked to specify another
name.

The View Kind defines the role the view plays in your application. It
must be selected from the choices in the pop-up menu, as illustrated
in Figure 10-2.

Dialog

Floating Window
Modal Dialog
New... Dialog
Splash Screen
Subview
Tearoff Menu
Window

Figure 10-2 The View Kind pop-up menu
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Dialog

Floating Window

Main Window

Modal Dialog

Choose the role that best fits the window or subview you want to
design. Then click OK or press Return to create the new view.

The new view appears as a View Edit window, ready for you to
begin populating with panes, as described later.

Kinds of views
There are nine kinds of views available. All are windows except the
subview kind, which is a pane.

A dialog view may be used in any context, usually to present and
gather information. Dialog views are preset to modeless. A dialog
view uses a CDialog window and is implemented using a
CDialogDirector-derived director.

A floating window view is drawn in front of all non-floating
windows. A floating window is often used as a palette, that is, a
collection of drawing tools, colors, or patterns in which one is the
current selection. A floating window is never activated or
deactivated. A CSelector-derived panorama displays the palette and
monitors selections. If a floating window is to be used as a menu, it
should be implemented as a tear off menu view instead of as a
floating window view. At run-time, all floating windows are created
during initialization and hidden offscreen until needed. A floating
window view uses a CWindow window and is implemented using a
CFloatDirector-derived director.

A main window view serves as the center of the user’s attention. It
displays the document in a document-editing application, or serves
as a home display in a utility or database-type application. A main
window is created when New or Open is chosen from the File
menu. A document-based application usually defines just one main
window, but it may define more if it edits more than one document
type. A main window view usually uses a CWindow window, but
can instead use a CDialog window if the programmer chooses. A
main window view is always implemented using a CDocument-
derived director. If the main window view is associated with a file
(the default), the document class is derived from CSaver.

A modal dialog view is the same as a dialog view, as described
earlier, but is preset as modal. As with a dialog view, a modal dialog
view uses a CDialog window and is implemented using a
CDialogDirector-derived director.
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New... Dialog

Splash Screen

Subview

Tearoff Menu

Window

*

A New... Dialog view is a modal dialog view used to select the type
of document to create when New is chosen from the File menu. It is
used only if the application needs to create more than one document
type. The New... Dialog view uses a CDialog-derived window and
is implemented using a CDialogDirector-derived director.

A splash screen view is a dialog view that is displayed as soon as
possible after the application launches, and removed as soon as
initialization completes. A splash screen is modeless. A splash screen
view uses a CDialog-derived window and is implemented using a
CDialogDirector-derived director.

A subview is the only kind of Visual Architect view that isn’t a
window. A subview is a pane. Visual Architect allows you to define
panes independent of the windows that display them. This allows
you to reuse the same pane in multiple windows, or to nest the view
hierarchy of a window arbitrarily deep while retaining the ability to
edit it in a manageable way. A subview can scroll and can contain
any other pane types, including other subviews.

A tear off menu view is a particular type of floating window view
that is used as a menu. A tear off menu uses a CWindow window
and is implemented using a CTearOffMenu-derived director.

A window view is a separate kind of view that functions as a plain
window. A window view is used when a document needs more than
one window to display its contents. The view directly supervised by
the document is designated as a main window view, while all other
views are window views. You can also use the plain window kind
when none of the other kinds seems to meet your needs. A window
view uses a CWindow window and is usually implemented using a
CDocument-derived director.

Automatically-derived director class

Usually you have to open the Classes dialog box to define your
own derived classes. But Visual Architect automatically defines a
director class for each view you create. The default name given to
the director class is Cviewname, where viewname is the name you
give the view. (You can change the class name in the Classes dialog
box, but you cannot delete the class or change the base class.)

By way of background, every window in the THINK Class Library
consists of at least two objects: a window and a director. The
window object is responsible for display; it contains the panes
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the user sees. The director object is responsible for control; it
supervises the window and receives all commands and

Pr ovi der Changed calls generated by or for the window. The
director serves as the intermediary between objects inside and
outside the window, and often helps coordinate the actions of
multiple objects within the window. For example, when the value of
a control changes, the director receives a Pr ovi der Changed call
with a cont r ol Val ueChanged reason code. If another control
dims as a result of this change, the director-derived class is
responsible for making it happen.

Deleting views

You can delete a Visual Architect view from your THINK Project
Manager project by selecting the view name in the Views List
window and choosing Delete View from the View menu. Note that
this does not automatically remove the files from the THINK Project
Manager project associated with, for example, the view's director
class. These files must be removed by hand in the THINK Project
Manager.

The View Edit Window

Although Visual Architect has many other capabilities, most work
with Visual Architect is in the view editor, designing windows for
your application.

202 Visual Architect and THINK Class Library Guide



The View Edit Window .

Whenever you create a new view, as described in the previous
section, or open an existing view from the Views List window (by
choosing Open View from the View menu, or by double-clicking
the name of the view), you are presented with a View Edit window
like that shown in Figure 10-3.

Main

oG

o User PortRect ———
Position Area

d ] I

Figure 10-3 An empty View Edit window

The Visual Architect View Edit window is similar to the familiar
MacDraw[] drawing window. The name of the view appears as the
title of the window. Note that the view name is not necessarily the
same as the title of the user window. The view name is set when the
view is created and can be changed in the View Info dialog box.

User PortRect

The thick gray rectangle outline extending from the upper-left corner
to the lower-right corner of the View Edit window, with a sizing
handle in the lower-right corner, is the User PortRect, as shown in
Figure 10-3. The User PortRect defines the actual size of the user
window or subview you are editing. You can make the user window
larger or smaller by dragging the sizing handle until the rectangle
outline reaches the desired size. The Show Position option,
described in “The Options Menu” section later in this chapter, is
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helpful when resizing the user window. To see a window exactly as
it will appear to the user, choose Try Out from the View menu
(Command-Y) at any time.

The fact that the drawing area extends beyond the User PortRect
means that you can edit objects that are outside the user window.
This can be useful for editing panes that are only visible under
certain conditions in the running application and are kept offscreen
until needed.

If the user window has scroll bars, an additional one or two gray
lines appear inside the User PortRect, showing the space occupied
by the scroll bars.

Position Area

The white rectangle in the lower-left corner of the View Edit window
is the Position Area, as shown in Figure 10-3. When the Show
Position option is enabled (see “The Options Menu” later in this
chapter), the coordinates of the currently selected object or objects
are shown in this area.

Panes

Every graphical object inside a view is a pane—an object of a class

derived from CPane. Panes are created by selecting a pane type from
the Tool Palette, described later in this chapter. By selecting a tool,

you can instantly drop or draw a pane object of the corresponding

type into a view.

The View Info Dialog Box

Whenever the View Edit window is displayed, you can edit the
attributes of the view as a whole by choosing View Info from the
View menu.

The View Info dialog box lets you see the class of the window and
director objects, and lets you specify other information as
appropriate for the kind of view. You can edit the information in this
dialog box at any time, not just before you begin laying out your
windows.

The View Info dialog box is customized for each kind of view. Each
kind of View Info dialog box is discussed in a separate section.
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Dialog Info
The Dialog, Modal Dialog, New... Dialog, Splash Screen, and
Window Info dialog boxes have the same layout, shown in Figure

10-4.
Dialog Info
R Dialog LR [ modal
D HEREAEEEEN
Title: |MyDialog | ] e

window Claszs: Chialog W

=lu[=[mRN=]=]=1t

[Jvert. Serall [] Horiz. Scroll [ Size Box [] godvwayFlag [ actClick
Position Lett: [40 | Top: [40 | procio:[8 ]
Width: 400 Height: 200

Min width: | 40 Min Height: | 40 Cancel

Max Width: 512 Max Height: | 342

Figure 10-4 The Dialog Info dialog box
The dialog items are described below:

Name
The name of the view; also the name of the view resource.

ID
The view’s resource ID. Automatically set by Visual Architect when
the view is created.

Title
The title of the window or dialog.

Modal
If checked, the dialog is modal. Not relevant for window views.

Director Class
The name of the CDirector-derived (for the window view) or
CDialogDirector-derived (for the other views) class.
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Window Class
The name of the CWindow-derived (for the window view) or
CDialog (for the other views) class.

Window Type

Click one of the ten window type icons corresponding to the known
window pr ocl Ds. If you select the icon with the question mark, you
must supply the pr ocl D yourself (see “procID” below).

Vert. Scroll

Checked if the window or dialog has a vertical scroll bar. If checked,
the main panorama of the window or dialog is enclosed in a
CScrollPane.

Horiz. Scroll

Checked if the window or dialog has a horizontal scroll bar. If
checked, the main panorama of the window or dialog is enclosed in
a CScrollPane.

Size Box

Checked if the window or dialog has a size box. If checked, the
main panorama of the window or dialog will be enclosed in a
CScrollPane.

goAwayFlag
Checked if the window or dialog has a goAwayFlag. Not relevant if
the view is a modal dialog.

Position
This indicates whether the view is initially centered, staggered, or
has its upper-left corner at a fixed position.

Left, Top
The upper-left corner of the view, if Position is set to Fixed.

Width, Height
The width and height of the view.

Min Width, Min Height, Max Width, Max Height
The si zeRect for the window or dialog.

proclD
The numeric pr ocl D used to define the window type; can also be
set using the window type icons, as discussed above.

206 Visual Architect and THINK Class Library Guide



The View Info Dialog Box .

helpResID

Balloon Help resource ID. Automatically set by Visual Architect
when you edit Balloon Help, which is discussed later in this chapter.
Do not change this value unless you are certain of what you are
doing.

actClick

Normally, if the user clicks a window or dialog in the background,
the window or dialog is activated (brought to the foreground) but
the pane that was clicked does not see the activate click. If actClick
is checked, the pane does see the activate click.

Main Window Info

Main (Document) Info

Name: | R LERE [ madal
] : (<] Use file
Title: |Ma1n | [ Print

i ndaw Class:

En=nRE]=l=]=]E

[<] vert. Seroll [£] Horiz. Seroll (€] Size Box (<] qodewayFlag [ actClick
Position Left: |40 | Top: |40 | prociD:

Yiidth: 400 Height: Z00

Min width: |40 Min Height: | 40 Cancel

I
1
il

Max width: 312 Max Height: | 342

Figure 10-5 The Main Info dialog box

Most of the dialog items are the same as those of the Dialog Info
dialog box. The items that are different or are used differently are
described in the following sections.

Modal
Since the main window should generally be modeless, leave this
check box unchecked.
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Use file

If checked, the main window supports open, save, and revert file
functions; the director class is derived from CSaver. If unchecked, the
main window has no associated file; the director class is derived
from CDocument.

Print
If checked, the contents of the window or dialog can be printed.

Window Class

Normally, a main window’s window object is derived from
CWindow. Use this pop-up menu if you have defined a CWindow-
derived class you want to use for this window. A main window can
also use a CDialog-derived window, but its director class is always
derived from CDocument, not CDialogDirector.

Floating Window Info
The Floating Window and Tearoff Menu Info dialog boxes are
the same.

Float Info

Marne: | MyFloati ng'Wi ndow 1D: 130

Title: | MyFloatingi ndow

window Class:

CEEEEEEH
H| K

[J wert. Serall [ Horiz Scroll (] actClick

proclD: | 3200 WDEF [D: 200

width:  [400 | Height:  [200
(0|

i
i |

Minwidth: | 40 MinHeight: |40 Cancel

Maxwridth: MaxHeight: | 342

Figure 10-6 The Floating Window Info dialog box

Many of the dialog items in these dialog boxes are the same as those
in the Dialog Info dialog box discussed above. The items that are
different are described here.
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Window Type

The window type icons represent the pr ocl D for the window. The
standard floating window WDEF supports a drag bar at the top or left
side of the window. Click one of the first two icons to select the
standard floating window WDEF. If you click the icon with the
question mark, you must supply the pr ocl D yourself.

Menu
The menu used for a tear-off menu. This is only enabled for a tear-
off menu view.

WDEF ID

The resource 1D of the ' WDEF' . This value is set automatically
according to the following formula:

WDEF ID = (proclD - variation code) / 16

Since the floating window and tear-off menu views cannot use files,
be modal, or print, these three check boxes are not present in the
View Info dialog boxes.

Subview Info

The Subview Info dialog box is much smaller than the other View
Info dialog box because this subview is not a window but a
panorama (with an optional scroll pane).

Subview Info

IR MySubview | 10: 131

[ ¥ert. Seroll [] Horiz. Seroll [] Size Box

Frame: width:| 400 height: [ 200

Bounds: right: (512 bottom: |32 Lancel

il
i

i

Step: hStep: watep:

Figure 10-7 The Subview Info dialog box

Name
Name of the subview.

1D
The ' CVue' resource ID.
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Class

The name of the CPanorama-derived class for this subview, or None
if you have not changed the subview’s main panorama’s class. See
“Defining a subview class” below.

Vert. Scroll
Checked if the subview has a vertical scroll bar. If checked, the
subview’s main panorama will be enclosed in a CScrollPane.

Horiz. Scroll
Checked if the subview has a horizontal scroll bar. If checked, the
subview’s main panorama will be enclosed in a CScrollPane.

Size Box
Checked if subview has a size box. If checked, the subview’s main
panorama will be enclosed in a CScrollPane.

Frame width and height
The width and height of the subview.

Bounds right and bottom
The bottom-right corner of the panorama’s bounds rectangle. The
top-left value is always (0, 0).

Note
You can set the bounds of the subview’s panorama
directly in the Subview Info dialog box. This
method is particularly useful for a scrolling subview.

Step hStep and vStep
The horizontal and vertical step values (number of pixels the
panorama scrolls in a single step).

Defining a subview class

Unlike other views, no derived class is defined automatically when
you create this view. This is because it is not strictly necessary to
define a panorama-derived class in order to use a subview if the
panes in the panorama do all the work. However, if you want to
draw in your subview’s panorama, receive commands, or override
other member functions, you must derive your own panorama class
and use it for the subview’s panorama. Here’s how to do it:

= Use the Classes dialog box to define your own derived
class of CPanorama.
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« In the View Edit window, with no panes selected, choose
Class from the Pane menu and choose your derived class
from the submenu.

The Tool Palette

The Tool Palette, shown below, is displayed when you click the
Tools menu. The palette is a tear-off menu, so you can drag it to
another position on the screen; it remains visible until you close it.

]
k
(K]
54
=

g

=!
+

T

OB 3 ==

Figure 10-8 The Tool Palette

Select

Choosing the Select tool changes the cursor to an arrow, the
standard Macintosh selection cursor. Select single pane objects in the
usual way—nby clicking them; select multiple panes by clicking an
empty part of the drawing area and, holding the mouse button
down, dragging the cursor until the selection rectangle encompasses
the panes you want to select.

As described later in the section “The Options Menu,” Visual
Architect offers two selection modes: Normal and Lazy Select.

Normally, after you use a tool once, the tool reverts to the Select
tool. However, if you double-click a tool, the tool “sticks on,” so you
can use it multiple times without reselecting. When a tool is stuck
on, you can unstick it by selecting another tool.
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For the Static Text tool, the cursor changes to an I-beam when the
cursor is positioned over an activated View Edit window.

—|— The crosshair cursor is used for all other tools.

Drop or draw

For all tools except Select and Static Text, after selecting the tool,
you can click and drag in the View Edit window to create a pane
object of arbitrary size, or you can create a new pane of a default
size simply by clicking the mouse in the View Edit window. When
you click with the Static Text tool, Visual Architect displays the I-
beam cursor. You can type in as much text as you like; the new static
text pane is always sized to the amount of the text.

Creating panes: the pane tools
Each pane tool is described separately. The class of the pane each
tool creates is indicated in parentheses—for example, (CStaticText).

A Static Text and Edit Text

The Static Text and Edit Text tools create static (CStaticText) and
editable (CDialogText) text panes. For static text, a blinking insertion
bar appears, letting you enter text once you click in the View Edit
window to position the pane. For both types, you edit the text of an
existing pane by selecting the pane and pressing Enter (or Return).
This changes the cursor to an I-beam, which you then click within
the text to position the cursor. Terminate text editing either by
pressing Enter or clicking outside the pane. You can set the font,
size, style, and color of text panes with the appropriate items in the
Pane menu.

Push Button, Radio Button, Check Box, and Scroll Bar
|| ':E' The Push Button, Radio Button, Check Box, and Scroll Bar tools
create standard control pane objects with push button, radio button,
check box, and scroll bar behavior (CButton, CRadioControl,
CCheckBox, and CScrollBar classes).
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Note
The CScrollBar class is specialized to deal with
Apple’s standard scroll bar control, which behaves
rather idiosyncratically. Chances are you will have
to override one or more CScrollBar member
functions to handle another kind of slider.

Pop-up Menu

The Pop-up Menu tool creates standard pop-up menu panes
(CStdPopupPane), which are used to display any menu you create.
See Chapter 11, “Creating and Editing Menus and Commands.”

Icon and Picture

The Icon and Picture tools create standard THINK Class Library icon
(ClconPane) and picture (CPicture) pane objects in black-and-white
or in color.

Icon Button and Picture Button

The Icon Button and Picture Button tools create icon (ClconButton)
and picture (CPictureButton) multi-state button panes. These buttons
can have a different appearance for on/off and highlight states, or
can be color-highlighted or framed. Icon and picture buttons can be
configured to act as push buttons, radio buttons, or check boxes. For
example, the lock-down, pop-up buttons such as you find in a
cassette recorder behave like radio buttons, while a light switch
behaves like a check box.

List/Table
The List/Table tool creates scrollable lists or tables (CArrayPane).
You can easily create lists of text, icons, or pictures.

Subview

The Subview tool creates panes (CSubviewDisplayer) that refer to
subviews that are displayed in this pane at run-time. The subview
itself is a separate view and is edited in its own View Edit window.
Subviews are scrollable panoramas that can contain any number of
other panes.

Panorama

The Panorama tool creates generic scrollable panoramas
(CPanorama). You use this to set aside sub-areas within your view’s
main panorama for special purposes, such as text editing or drawing.
Unlike a subview pane object, a panorama object is not dynamic: It
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consists of only one pane, whose type is specified using the Pane
Info dialog box described later in this chapter.

Note
You do not have to explicitly create a panorama
object to make your view scrollable, since views are
always enclosed in a panorama. Use the panorama
tool only if you want to create a “sub-"panorama
that does not contain the entire view.

Straight Line and Unconstrained Line

The Straight Line and Unconstrained Line tools create “straight” or
unconstrained line graphic panes (both of the CLine class). The
slope of a straight line is restricted to be a multiple of 45 degrees.
Line pane objects can have any pen size, mode, color, or pattern.

/ |+

Rectangle, Rounded Rectangle, Oval, and Polygon

The Rectangle, Rounded Rectangle, Oval, and Polygon tools create
graphic panes—rectangle (CRectOvalButton), rounded rectangle
(CRoundRectButton), oval (CRectOvalButton), or polygon
(CPolyButton) obijects, respectively.

00
MO

The previous six graphic panes can have any pen size, mode, color,
or pattern, and can be unfilled or filled with any pattern. Graphic
panes are not just drawings; any graphic pane can act as a button of
any kind. One very good use for these graphic buttons is to draw
them over picture panes and make them invisible by setting the pen
size to 0. In this way, since the graphic buttons can be of any
arbitrary size and shape, you can make different parts of a picture
click-sensitive. By setting the cl i ckCnd for shape buttons using the
Pane Info dialog box (described later in this chapter), each different
picture part can respond differently to user clicks.

All pane objects are created at the same view nesting level, even
radio buttons. The drawing order and tab order of panes is initially
the order in which they are created. You can change the relative
order of panes by choosing Bring To Front and Send To Back from
the Pane menu. You can see the relative order of panes by choosing
Show Item Numbers from the Options menu.

Panoramas (panes of class CArrayPane, CPanorama, CEditText, or
any class you derive from these classes) are implicitly enclosed in a
CScrollPane whenever they have a horizontal or vertical scroll bar or
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a size box. You can change the attributes of a pane’s scroll pane
using the Pane Info window, described later in this chapter. If a
panorama has no scroll bars or size box, the CScrollPane will not be
present in the view resource or in the view at run-time.

Note
Although CDialogText is derived from CEditText,
panes of the CDialogText class (those created with
the Edit Text tool) do not contain a scroll pane.

In addition to using the Tool Palette, you can create static text or
picture panes by pasting Pl CT or TEXT data from the Clipboard.

Editing Panes

You can alter almost all attributes of a pane. Many attributes can be
changed through menu commands. Others can be changed using the
Pane Info window, which allows you to edit the data members of
the panes directly. This section will describe both approaches.

Editing a pane’s text

You can directly edit the text of static text, edit text, push button,
radio button, or check box panes without using a separate dialog
box. Simply select the pane and press Enter. If your keyboard does
not have an Enter key, press Return.

You can type in or edit any text in the pane, up to 32K characters.
Press Return to add new lines to the text. When you are finished
editing, press Enter or click outside the pane. Panes are resized
automatically to fit the text.

Text in control panes is automatically centered vertically when you
enter multiple lines of text. Push button text is centered horizontally
as well. Static text panes more than one line high retain their original
shape; to change the shape, reselect the pane and pull the knob in
the lower-right corner to the desired shape. Edit text panes of any
size retain their shape unless you extend the pane by typing more
text than the box can hold; that is, you can make an edit text pane
larger, but not smaller, by entering text into it.

Static and edit text panes are edited with the whol eLi nes attribute
on, so there is no extra space at the bottom of the pane.
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Font attributes

The font, size, and style of panes that display text can be changed by
selecting the desired value in the Font, Size, or Style sub-menus in
the Pane menu. Visual Architect alters the associated environment
objects or, if appropriate, the TextEdit records associated with
selected panes according to your selections.

Visual Architect creates controls using a control procedure that is
sensitive to style, so font changes apply to push buttons, check
boxes, and radio buttons, as well as text panes.

The Pane Info window

Double-clicking a pane, or selecting a pane and choosing Pane Info
from the Pane menu (Command-L), opens a dialog box containing
information about the currently selected pane. If a pane has an
associated scroll pane, you can also choose Scrollpane from the
Pane menu to bring up the Pane Info window for the scroll pane.

Identifier: | MydKButton |
~ CButton
Command: [ emddK w|
[ CControl
[ CPane
£
]

Figure 10-9 The Pane Info window

The Pane Info window is different for each pane class, but all are
organized similiarly, as shown in Figure 10-9.

The title of the Pane Info window is the identifier you set by editing
the Identifier edit text box at the top of the window or by choosing
Identifier from the Pane menu. (Visual Architect gives each pane a
default name when it is created.)
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The Left, Top, Width, and Height edit text boxes at the top of the
window let you change the position and size of the pane relative to
the view's main panorama (that is, the enclosing window).

The remainder of the Pane Info window shows the pane’s class
hierarchy, beginning with the outermost-derived class of the pane
and ending with the CView class. (Base classes of CView are not
shown because they do not have any data members that can be
edited.)

Clicking the right-pointing triangle to the left of a class name opens a
sub-area, reveals the contents of that class, and pushes down the
classes below it. Clicking a down-pointing triangle closes the
subarea, hides that class’s contents, and pulls up the classes below.

Each class sub-area contains the editable subset of the data members
for that class. See Part Four of this guide, “THINK Class Library
Reference,” for definitions of these data members. The labels shown
in the Pane Edit window are generally the same as the data member
names in the THINK Class Library. Data members that do not appear
in the subpanes are dynamically computed from the other data
members when the view is actually run.

Changes made in the Pane Info window are reflected immediately in
the target pane. For example, if you type a value into the wi dt h or
hei ght data members of the CPane class, the size of your pane
changes while you are typing.

The Pane Info window is specific to a view. If you have more than
one view open at the same time, you also can have more than one
Pane Info window open. If you close a view, any Pane Info window
associated with the view is automatically closed.

Although it takes only a few paragraphs to describe the hierarchical
subpanes, they are one of the most powerful features in Visual
Architect and worth studying further.

Cutting and pasting panes
You can cut panes and paste them to the same or to different views.

You can paste TEXT and Pl CT data from other programs into views.
If you paste into a selected pane, the text or picture for that pane is
replaced. If you paste TEXT and PI CT data when no panes are
selected, a new static text or picture pane is created.
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Choose Duplicate from the Edit menu (Command-D) to make a
copy of panes without involving the Clipboard. If you duplicate a
pane and then move it, subsequent duplicate commands place the
new panes the same distance apart.

Choosing the Clear command from the Edit menu deletes selected
panes.

Cut, Copy, Paste, Clear, and Duplicate are undoable.

Editing Panoramas

For every window or subview, Visual Architect creates a panorama
to hold all items you place in the view. If you select scroll bars or a
size box for the view, the panorama is placed inside a scroll pane.
This is all done automatically. In some cases you will want to change
the class of the panorama so that it can perform specialized
functions. To do this, define a CPanorama-derived class in the
Classes dialog box. Then, in your view, make sure that no panes are
selected and change the view panorama’s class by choosing the
Class hierarchical menu in the Pane menu and then choosing the
class you want from the submenu.

The Options Menu

Visual Architect lets you customize the view editor’s action by
selecting one or more options from the Options menu.

+ Honor Grid
« Lazy Select

Show Item Numbers
S$how Button Groups

+ Show Position

Figure 10-10 The Options menu

218 Visual Architect and THINK Class Library Guide



The Options Menu

*

All options are set to the default settings, which may be changed in
the Preferences dialog box. The Preferences dialog box is
accessed by choosing Preferences from the File menu.

Honor Grid

When the Honor Grid menu item is checked, top-left and bottom-
right coordinates of newly drawn or resized panes in the View Edit
window are forced to be even multiples of the grid step size. When
unchecked, panes can be placed at any pixel position in the View
Edit window and can be any size.

The grid step size is initially four pixels and can be set to any
positive power of two value in the Preferences dialog box.

Even when the grid is on, a pane may be positioned off the grid in
several ways:

= The pane may have been created before the grid was
turned on.

= With the Command key held down, the arrow keys move
a pane in single-pixel steps. See the “Keyboard Shortcuts”
section later in this chapter.

< Entering numeric values in the hEncl or vEncl data
members text boxes of a pane in the Pane Info window
moves the pane to that exact position.

When a pane is moved by dragging, it maintains its relative offset
from the grid. When multiple panes are moved at the same time,
they maintain their positions relative to each other.

Lazy Select

When the Lazy Select menu item is checked, the selection rectangle
needs only to intersect a pane’s frame to select it. When unchecked,
a pane is selected only if the selection rectangle completely encloses
the pane’s frame (similar to how select is done in MacDraw).

One reason to use Lazy Select is that it is not always obvious what a
pane’s frame size is—the frame may be larger than the drawing
inside. On the other hand, when panes overlay, it is easier to select
small panes on the inside with Lazy Select off.
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Show Item Numbers

When the Show Item Numbers menu item is checked, the number
of each pane in the drawing order is displayed in a small box in the
upper-right corner of the pane’s frame. When unchecked, item
numbers are not shown.

Panes earlier in the drawing order (lower numbers) appear behind
panes later in the drawing order (higher numbers).

The drawing order is the same as the tab order in dialog views.

To change a pane’s item number, choose the Bring To Front and
Move To Back items from the Pane menu. Newly created or pasted
panes always appear at the end of the drawing order, that is, with
the highest item numbers. Checking Show Item Numbers
automatically unchecks Show Button Groups.

Show Button Groups

When the Show Button Groups menu item is checked, the button
group of each button is displayed in a small box in the upper-right
corner of the pane’s frame. For buttons that are not a part of a button
group, or non-button panes, the button group is shown as 0. When
unchecked, button groups are not shown. Checking Show Button
Groups automatically unchecks Show Item Numbers.

Show Position

When Show Position is checked, the coordinates of the currently
selected pane or panes, or the coordinates of the User PortRect, are
shown in the Position Area in the lower-left corner of the View Edit
window. When unchecked, nothing is displayed in the Position
Area.

Adding Balloon Help

To add Balloon Help to a pane, choose Balloon Help from the Edit
menu while the pane is selected. The Balloon Help window appears
as shown in Figure 10-11. The four balloons correspond to the
different states of the pane object at run-time. You type into these
balloons the text you want to appear when the user points to the
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pane with Show Balloons active. Refer to Inside Macintosh Volume
VI for details on the uses of these four balloon states.

E[[[=———-= Balloon Help
Far: item 11 Column3eparatorscheckBox (CCheckBox )
Enabled: Dimrned:
' y
ik this option if o ot available since
you want separators you have anly ane text
drawn between text calumn.
calumns.
LN 7 L w
Enabled and checked: Enabled and rmarked:

Ty T
= Click this option if ¢
you do not want
separators drawn

between text columns.

b, o LN .

Figure 10-11 The Balloon Help window

The Balloon Help window is associated with whichever pane is
selected in the active View Edit window. Thus, if you leave the
Balloon Help window open and select another pane, the Balloon
Help window is updated to reflect this new pane. The top of the
Balloon Help window shows the current pane object.

Keyboard Shortcuts

Visual Architect provides several keyboard shortcuts for editing
views.

Scroll keys

The Page Up key scrolls the View Edit window back one page. The
Page Down key scrolls the window forward one page. The Home
key scrolls to the upper-left corner. The End key scrolls the window
to the lower-right corner.

Arrow keys
The arrow keys provide a quick way to move or resize a pane in
small increments.

= The arrow keys move a pane one grid step in the desired
direction, whether or not the grid is on.
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< With the Command key held down, the arrow keys move
a pane one pixel in the desired direction.

= With the Option key held down, the arrow keys resize a
pane by moving the corresponding edge one grid step in
the desired direction, whether or not the grid is on. For
example, pressing Option-Left Arrow moves the left side
of the selected pane(s) one grid step to the left, leaving all
other sides in their original positions.

= With the Command and Option keys held down, the
arrow keys resize a pane by moving the corresponding
edge one pixel in the desired direction.
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Menus and Commands
11

I his chapter describes how to create and edit menus and commands.
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Editing Menus

This section explains how to create and edit menus, menu bars, and
menu items.

Menus

Choose Menus from the Edit menu to create and edit menus. The
Menus dialog box is shown in Figure 11-1.

Menus
« W |
Edit
File @ & [(Apple Menu)
Font (Edit Menu Items |
Size
Style A MENU 1D:

b
MDEF ID: [0 |

5]

Figure 11-1 The Menus dialog box

The Menus dialog box lets you create and delete menus and change
the title, menu ID, and MDEF ID associated with each menu. Menus
in the Menus dialog box scrolling list appear in alphabetical order
by title.

Editing a menu title. Select the menu in the scrolling list to bring its

title into the edit text box in the upper right of the dialog box. Then
edit the title.
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Note
Visual Architect currently does not let you define a
menu with no characters in the title. If you need
such a menu, you have to edit the ' MENU' resource
in ResEdit.

E To set the O symbol as the title of the Apple menu, click the radio
button below the edit text box.

As you type or correct a menu title, it is automatically put in
alphabetical order in the list of menus.

Creating a new menu. Choose New Menu from the Edit menu

(Command-K) or press Return. This creates a new, untitled menu.
Give the menu a title by typing into the edit text box in the upper
right of the dialog box.

Deleting an existing menu. Select the menu in the scrolling list
and press Delete. If you delete a menu that appears in the menu batr,
the menu is removed from the menu bar.

Editing menu items. Click the Edit Menu Items button to edit the
contents of a selected menu. See the “Menu items” section later in
this chapter.

Menu attributes
The following attributes can be set for each menu:

MENU ID. When you create or import a menu, Visual Architect
automatically assigns that menu a unique resource and menu ID.
You can change the menu and resource 1D by entering a value in the
Menu ID field. Visual Architect does not let you create a menu
whose resource ID and menu ID are different. (This is the most
common programming mistake associated with menus.) Seldom do
you need to change this field.

MDEF ID. The MDEF ID field lets you use a custom menu definition
procedure (MDEF). The system default value is 0. Seldom do you
need to change this field.
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Menu bars

Choose Menu Bar from the Edit menu to edit the menu bar. The
Menu Bar dialog box, shown in Figure 11-2, is very similar to the
Menus dialog box discussed in the previous section.

Menu Bar
[ | —
Edit {® &% (Apple Menu)

[ Edit Menu Items |
MENU 1D: 1
MDEF 1D: 0

Add Menu:El
=

Figure 11-2 The Menu Bar dialog box

The Menu Bar dialog box lets you create menus, add and delete
menus in the menu bar, and change the title and relative position of
menus in the menu bar. Menus in the Menu Bar dialog box scrolling
list appear in order of their appearance in the menu bar.

Editing a menu title. Select the menu in the scrolling list to bring its
title into the edit text box in the upper right of the dialog box. Then
edit the title.

To set the O symbol as the title of the Apple menu, click the radio
button below the edit text box.

Creating a new menu. Choose New Menu from the Edit menu
(Command-K) or press Return. This creates a new, untitled menu
and adds it to the menu bar. Give the menu a title by typing into the
edit text box in the upper right of the dialog box.
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Adding an existing menu. Select the name of the existing menu to
be added to the menu bar from the Add Menu pop-up.

Removing a menu from the menu bar. Select the menu in the
scrolling list and press Delete. Note that the menu will not be
deleted, only removed from the menu bar.

Moving a menu up or down. Click the menu in the scrolling list
and drag it up or down to the desired position.

The top-to-bottom position in the scrolling list corresponds to the
left-to-right position of the menus in the menu bar displayed by your
program.

Editing menu items
Click the Edit Menu Items button to edit the contents of a selected
menu. See the “Menu items” section later in this chapter.

Menu attributes

Menu attributes, discussed in the “Menus” section earlier in this
chapter, can be examined but not edited in the Menu Bar dialog
box.

Menu bar 1D

The menu bar is created with ' MBAR' resource ID 1. This is the
menu bar loaded by default when a THINK Class Library program
starts up, and it is the only menu bar supported by the THINK Class
Library. Use ResEdit to create additional menu bars if your program
supports them.
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Menu items

The Menu Items dialog box, shown in Figure 11-3, is opened from
the Menus and Menu Bar dialog boxes either by selecting a menu
and clicking the Menu Items button or by simply double-clicking the
menu title in the scrolling list.

Menu ltems

File

New %
Open...
- [JHas submenu

Close Submeay Hi
Save As... Emd—keg:[l

Revert to Saved...

- leon: | v | Mark:
Fage Setup...

Print...

i
Command: | cmdSave ¥|

Figure 11-3 The Menu Items dialog box

The Menu Items dialog box lets you add, delete, move, and change
menu items, as well as change the attributes associated with each
menu item.

The edit text box in the upper right of the dialog box holds the title
of the currently selected menu item from the scrolling list. Edit this
box to change the title of the menu item.

Creating a menu item. Choose New Menu Item (Command-K) or
press Return. This creates a new, untitled item at the bottom of the

menu. Give the menu item a title by typing into the edit box in the

upper right of the dialog box.

Deleting a menu item. Select the menu item in the scrolling list and
press Delete.
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Moving a menu item up or down. Select the menu item and drag
it up or down to the desired position.

Menu item attributes
To edit the attributes of the currently selected menu item, edit or
select the appropriate dialog field or button.

Has submenu. Check this box if the menu item is hierarchical and
has a submenu.

Submenu ID. If the menu item has a submenu, this field is enabled.
Enter the menu ID of the submenu. Because it is not easy to
remember numerical menu IDs, you can optionally select the
submenu from the pop-up menu to the right of the submenu ID edit
text box.

Cmd-key. Enter the Command key, if any, associated with this menu
item. Note that this item is dimmed if the menu item has a submenu.

Note
Do not use Command keys in pop-up menus. For a

Command key in a CPopupPane to be recognized
as a menu command, the pane must be the gopher
or a supervisor of the gopher. Since a pop-up pane
is not a candidate to be the gopher, and pop-up
panes seldom supervise anything, these conditions
will not be met.

Icon. Click the icon to set an icon for the menu. (The No Icon icon
shows when an icon is not selected.) This brings up an icon
selection dialog box that allows you to pick any' | CON' or' SI CN
(small icon) resource in the project.

Mark. This command lets you choose the check mark to be used
with the menu or choose None.

Note
Only the Chicago font in 12-point size provides the

« check mark character. For pop-up menus in
other fonts or sizes, use the v (square root) or «
(bullet) character.
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Command. Command lets you set the command to be sent when
the menu item is selected. The pop-up shows the commands defined
in the THINK Class Library file Comrmands. h and those you define
in the Commands dialog box in Visual Architect.

Color

The Menu Items dialog box does not allow you to define color
menu items. Use ResEdit or Rez if you need to do this. The
Macintosh Human Interface Guidelines recommend coloring menus
sparingly or not at all.

Adding Balloon Help

To add Balloon Help to a menu or menu item, choose Balloon Help
from the Edit menu while the menu or menu item is selected. A
Balloon Help window appears with four balloons labeled Enabled,
Dimmed, Enabled and Checked, and Enabled and Marked, as shown
in Figure 11-4. Enter into these balloons the text you want to appear
when the user points to the menu or menu items with Show
Balloons active. The four balloons correspond to whether the menu
item is enabled, dimmed (disabled), enabled and checked, or
enabled and marked (with a symbol other than a check mark—for
example, a bullet), respectively, at the time the balloon is displayed
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to the user. For menus, the behavior of the Enabled and Checked
and the Enabled and Marked balloons is undefined but the balloons
may be used by your application for special purposes.

S[[=——— Balloon Help EI
Enabled: Dimried:
"y "y
Choosze this cammand Sutamatic page
if you want automatic renumbering not
page renumbering awailable since no
turned on. document is upenl
. .
Enabled and checked: Enabled and marked:
"y "y
Choose this commmand Diarnond i ndicates that
if you want automatic autamatic page
page renumbering renumbering is
turned off. currentlyin
progress,
. .

Figure 11-4 The Balloon Help window for menu items

Editing Commands

This section explains how to define THINK Class Library commands,
as well as how to specify what the commands do and the classes that
handle them.
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Commands
Choose Commands from the Edit menu to open the Commands
dialog box, shown in Figure 11-5.

Commands
cmdCopy E‘ c:mdduggle |
cmdCut Mumber: 515
cmdDoubleSpace Actions:
cmdExtend In Class: | CMyDoc |
cmdJuggle . .
emdJustify View: | CFourBallDialog |
cmdNew
cmdMNull
cmaok =

Figure 11-5 The Commands dialog box

The Commands dialog box lets you add, delete, and rename
commands, as well as change the handlers and actions associated
with each command.

The edit text item in the upper right of the dialog box holds the
name of the currently selected command from the scrolling list. Edit
this item to change the name of the command. Visual Architect does
not let you change the names of commands predefined by the
THINK Class Library.

The scrolling list, which is in alphabetical order by command name,
lets you select a command to edit or delete.

Adding a new command. Choose New Command from the Edit
menu (Command-K) or press Return to create a new, untitled
command entry. Give the command a name by typing into the edit
text box in the upper right of the dialog box.
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Deleting an existing command. Select the item in the scrolling list
and press Delete. Visual Architect does not let you delete commands
predefined by the THINK Class Library.

Command attributes
You can edit the following attributes of the selected command:

Number. This is the number associated with the command. New
commands are assigned numbers automatically by Visual Architect.
Your program never deals with command numbers directly but with
symbols for the command names you define, as described in the
“Command handling in generated code” section below.

In class. Select one of your derived classes to handle the command.
More than one class can handle the same command. Each one that
does is checked when you pop up the In Class menu. To remove
command handling from a class, uncheck it.

Do. In this pop-up, specify the action taken by the command
handler defined in the In Class pop-up. Three actions are supported:
Open, Call, and None, as described in the “Command handling in
generated code” section below.

View. In this pop-up, specify the view object that is affected by the
action. For an Open action, the view objects listed in the pop-up are
the names of any dialog or window you have defined. The pop-up is
disabled when Call or None is selected.

Command handling in generated code

Symbols for commands you define in Visual Architect are generated
to the file AppConmands. h. You can #i ncl ude this file in any of
your classes that need to refer to commands.

A DoConmmand member function is generated in each derived class
on which you select to take action, or handle.

= If the action is Open, Visual Architect generates code in
the DoCommand member function of the specified class to
call a function named DoCommandname (where
Commandname is replaced by your command name).
Code generated for this function opens and selects the
specified dialog or window. This generated code goes
into the lower-level class.
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« If the action is Call, Visual Architect generates the
DoCommand case and the DoCommandname function
into the lower-level class, as with Open. But the function
does nothing; you must override it in your derived
(upper-level) class.

= If the action is None, Visual Architect generates a case for
the command switch in the DoComrand function, but the
case does nothing. This prevents supervisors from
receiving the command.

Command hints

Command editing is easy to describe, but it is quite powerful once
you become accustomed to making objects send commands that
other objects in the chain of command intercept and handle in their
DoConmand functions. The following hints will start you in the right
direction.

Remember the chain of command

The object that is to handle the command must be in the same chain
of command as, and upstream of, the object that sends the
command. Commands sent by menu bar menus can be handled by
any object upstream of the gopher in the gopher’s chain of
command, while commands sent by a button, for example, are seen
only by objects upstream of the button in the button’s chain of
command.

The only exception to the chain of command rule is a floating
window. The floating window director relays all commands it
receives and does not handle to the gopher (unless the gopher is
inside the floating window). This starts the command up the
gopher’s chain of command, so commands from floating windows
can behave like menu commands.

Commands from tear-off menus

For a tear-off menu, the grid selector sends a command that
ultimately gets directed to the gopher. The command sent is the
generic form of a menu command: a negative long integer whose
absolute value has the menu ID in the high-order word and the
ordinal of the selected item, starting from 1, in the low-order word.
This means that you do not have to specify commands for menu
items in tear-off menus. An added advantage of using selector
commands is that the selector sends the same command, whether or
not the menu is torn off.
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Useful command actions

Experience shows that the most useful of the command actions is
Open. None is seldom used because it usually does not matter that
other objects in the chain of command see a command they do not
handle. Cal | is also seldom used because it is easier for your upper-
level class to override the DoConmmand member function and handle
the command case directly than to go through an extra level of
indirection.

Commands in modal dialogs

In modal dialogs, the convention is to assign cndK to the OK
button and cndCancel to the Cancel button. When the dialog
director receives either command, it returns from DoModal Di al og.
Visual Architect generated code always calls DoMbdal Di al og with
cmdXK as the default command.

Often you want to take one action if the users close a modal dialog
with the OK button and another if they use the Cancel button. The
simplest way to do this is to override the EndDi al og member
function in your view director class. Let CDialogDirector decide
whether the command should dismiss the dialog box, then have
your code take the appropriate actions. For example:

voi d MyDi al og: : EndDi al og(| ong wi t hCnd,
Bool ean fVal i date)

Bool ean di sm ss = CDi al ogDi rector:: EndDi al og(
wi thCrd, fValidate);
if (dismss)
if (WithCrd == cmdCK)
{
response to K
}
else if (withCnd == cndCancel)
{
response to cancel

return di sm ss;

}

Buttons or other objects in modal dialogs should not send a
cnmdCl ose command.
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Closing a modeless dialog

The Macintosh Human Interface Guidelines recommend that the
only ways to close a modeless dialog box are with the Close menu
item or the close box. (A modeless dialog box should always have a
close box.) Therefore, just as in modal dialog boxes, buttons or other
objects should not send a cndCl ose command.

Visual Architect and THINK Class Library Guide 237



11 Creating and Editing Menus and Commands

238 Visual Architect and THINK Class Library Guide



Editing Classes 4
12

I his chapter explains how to create and define derived classes within
Visual Architect.

Define a derived class whenever you want to extend the behavior of
a director, window, or graphical object in your user interface. Visual
Architect generates code for the derived class (see Chapter 13,
“Generating Code”) that you can extend however you like.
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Classes

Choose Classes from the Edit menu to display the Classes dialog
box, shown in Figure 12-1.

Classes

CHpp
CMain

Base Class: [ CDialogText
CMyDialogText ase Class: | CDialogTex )

Blcvyvialogrent |

[ Define Data Members ]

Library class: | |

5

Figure 12-1 The Classes dialog box

The Classes dialog box lets you create and define new derived
classes and delete and edit certain existing classes. Derived class
names are listed in alphabetical order in the scrolling list.

Once you have defined a derived class, you can specify it as the
class for your user interface objects. To do this, select the object and
choose Class from the Pane menu and choose the derived class
from the submenu.

The edit text field in the upper right of the dialog box holds the
name of the currently selected class from the scrolling list. Use this
box to change the name of a class.

Delete a class

Select the class in the scrolling list and press Delete. Classes created
automatically by Visual Architect for the application class and view
directors cannot be deleted.

Create a class

Choose New Class from the Edit menu (Command-K) or press
Return. This creates a new, unnamed class. Give the class a name by
typing into the edit text box in the upper right of the dialog box.
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Set the base class

Pop-up the Base Class menu to select the base class of the class you
are creating or editing. Only user-interface base classes supported by
the THINK Class Library appear in the Base Class menu. The Base
Class pop-up is disabled for the application class and for the director
classes created automatically for views.

Set a library class

Ordinarily, a class you define in the Classes dialog box is derived
directly from the base class shown in the Base Class pop-up. If you
want to derive a class from one of your own library classes, type the
name of that library class into the Library Class edit text box.

When Visual Architect generates code using the supplied macro files,
it derives the lower-level class from your library class instead of from
the class specified in the Base Class pop-up. Visual Architect
assumes that your library class is derived from the base class shown
in the Base Class pop-up. This class is used to select the appropriate
macro file for code generation. Visual Architect also assumes that the
name you specify for your library class is valid and does not conflict
with any other class names.

Define Data Members

Clicking the Define Data Members button in the Classes dialog box
brings up the Define Data Members dialog box, shown in Figure 12-2.

Define Data Members

class ADateClass : CDialogText {

l1ong date; |_|

char formatCode;

Type: | long |

[ 1 [ #as:a

[<] GetFrom [] PutTo

o

[Eancel] [ oK ]

Figure 12-2 The Define Data Members dialog box
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Actions enabled by Define Data Members dialog box

The Define Data Members dialog box lets you quickly define data
members used to parameterize your derived classes. The values of
data members of pane-derived classes can be defined within Visual
Architect through the Pane Info window (see Chapter 10, “Creating
and Editing Views”).

Add a new data member

Choose New Data Member from the Edit menu (Command-K) or
press Return to create a unnamed member entry, and then give the
data member a name by typing into the edit text box in the upper
right of the dialog box. Next, select a type for the data member from
the Type pop-up menu. Data members are listed in the scrolling list
in the order in which you add them.

Delete an existing data member
Select the data member from the scrolling list and press Delete.

Reorder data members
Click the data member in the scrolling list and drag it to the desired
position.

Change the type of a data member
Select the data member in the scrolling list and select a new type
from the Type pop-up menu.

Define a char array

To define an array of char or unsi gned char, create a data
member of type char and type a number between the [ ] brackets in
the edit text box . Check the Pascal box if you want an unsi gned
char array to be interpreted as a Pascal string (beginning with a
length byte) rather than as a C string (ending with a zero byte).

GetFrom and PutTo

Check these boxes to have Visual Architect include the currently
selected data member in the GetFrom and PutTo streams,
respectively.

Visual Architect automatically generates the object I/0 functions
GetFrom and PutTo in derived classes. Views and subviews you
define in Visual Architect are read as resources and interpreted by
Object 1/0. Object 1/0 input works by defining a GetFrom function
in each derived class for which data members appear in the view
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resource. Object I/0 output works by defining a PutTo function in
each derived class. See Chapter 8, “Using Object 1/0,” for more
information on this topic.

Limitations of Define Data Members dialog box

The Define Data Members dialog box is not intended to provide a
general-purpose data design capability. Rather, it is a quick and easy
way to parameterize your user interface classes. For example,
whenever MyDialogText is used as the class of a dialog text box in a
view, you can preset magi cNumto any value you like.

It is possible to define data members of arbitrary types for your
derived classes even though there are only a small number of
primitive types in the Type pop-up. You can define as many data
members as you like, of any type, in the header file of your upper-
level class.

ADateClass example

The example in Figure 12-2 illustrates the benefits and limitations of
this feature. Suppose you need a dialog text box that accepts and
displays dates in a variety of formats. Since the THINK Class Library
doesn’t have such a class, you have to derive it from CDialogText.

Your derived class, ADateClass, needs at least two data members:

a long integer to hold the date and an unsi gned char to hold the
desired data format leading to the definitions shown in Figure 12-2.
With Visual Architect you can define these members easily, and you
are able to give them initial values in the Pane Info dialog box,
discussed in Chapter 10, “Creating and Editing Views.” Visual
Architect automatically generates the code to read your initial values
from the view resource.

However, if you are defining these members by hand, you might
prefer to give the dat eFor mat member a type of Dat eFor m
which is equated to unsi gned char in Packages. h. This
signifies that this member holds values from the standard Dat eFor m
enumeration. But because Visual Architect is not a compiler, you are
restricted to built-in types.

The two data members in ADateClass are generated in the lower-
level class of your derived class. You can still add members, such as
handles and pointers to other objects or structures, to the upper-level
class. These members will be initialized to zero when the object is
created from a view resource.
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Effect of Changes on Existing Views

You can freely add, delete, and change derived classes. If a derived
class is currently in use, any change to that class necessitates a
corresponding change in all views containing objects of that class.
Visual Architect makes these changes automatically.

If a class name is changed, the new name replaces the old in the
affected views. If a class is deleted or its base class is changed,
current objects of that class revert to the former base class. For
example, if you define a class MyButtonClass with base class
CButton and use several MyButtonClass objects in views, the objects
revert to CButton class when you delete MyButtonClass.

If you add or delete a data member or change its type, the old data
in existing objects of the class is discarded and the new data is
initialized to binary zeros.

Visual Architect and THINK Class Library Guide 245



12 Editing Classes

246 Visual Architect and THINK Class Library Guide



Generating Code
13

I his chapter describes how to generate the code for a complete
application with Visual Architect.
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Generating the Code Files

To generate code, choose Generate or Generate All from the
THINK Project Manager menu, shown in Figure 13-1. Generate
generates code only for files that need updating as a result of
changes you have made in Visual Architect since you last generated
files. Generate All generates code for all files. Generate and
Generate All commands will not affect generate-once files that have
already been generated.

Generate... £ 1
Generate All...

Bring Up To Date 32U
Run *R

Figure 13-1 The THINK Project Manager menu in Visual Architect

If you have checked the Confirm Saves option in the Preferences
dialog box, you are asked if you want to save your Visual Architect
project before generating. Click OK to save and generate. Otherwise,
the project will be saved automatically.

While code generation is underway, you are informed of progress in
a dialog box like the one shown in Figure 13-2.

= Generating:

= CWowApp.c

Figure 13-2 The Code Generation Progress dialog box

The Code Generation Progress dialog box shows the name of
each file as it is being generated. To stop generation in progress,
click the Stop button or press Command-. (Command-Period).
Stopping generation does not remove any files already generated.

When all files have been generated, the dialog box changes to
Updating Project, and your THINK Project Manager project is
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updated. All generated files not already in the THINK Project
Manager project are added; generated files already in the project are
marked for recompilation. If you have a generated file open in the
THINK Project Manager, it is closed without saving its contents to
prevent your project from containing the wrong version of the file.

Setting Up Generation

Code generation in Visual Architect is controlled by a macro file that
you select. By default, Visual Architect looks for a macro file named
Gener at eTCLApp, first in the THINK Project Manager tree and
then in your project tree.

Gener at eTCLApp contains macros that tell Visual Architect which
code files to generate. The code files are generated to a folder
named Sour ce, located inside the folder that contains your Vi sual
Archi tect. rsrcfile.

You can change which macro file Visual Architect uses to generate
code by choosing Set Generate File from the File menu and
selecting the macro file in the standard File Open dialog box.

Structure of the Generated Code

Visual Architect supplies a set of macro files capable of generating a
complete THINK Class Library application. Before you generate code
for the first time, you should fill out the Application Info dialog
box and define a Main view.

The following sections explain the code generation strategy followed
by Gener at eTCLApp and the other macro files in the Macr os
folder supplied with Visual Architect.

Preserving your code when regenerating

Code generation doesn’t happen only once. Each time you make
changes to views, classes, commands, and so on in Visual Architect,
new files must be generated and/or previously generated files must
be regenerated. For each class you define, Visual Architect generates
files defining the class and implementing the behavior you specified
in Visual Architect. You can then modify these files by hand to add
additional behavior.

To preserve code that you add by hand through multiple passes of
code generation, the standard macro files generate two kinds of files:
lower-level and upper-level. The terminology comes from visualizing
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the class tree with the root class at the bottom, the lower-level class
above it, and the upper-level class on top.

For every derived class you define, Visual Architect produces an
upper-level file defining the derived class, and a lower-level file
defining the immediate base class of that class. The THINK Class
Library base class of the derived class, the lower-level derived class,
and the upper-level derived class form a sort of class sandwich, with
the lower-level class in the middle. For example, if you derive a class
named CMyButton from the THINK Class Library CButtonProc,
Visual Architect constructs the following class hierarchy:

CMyButton Upper-level Class

_CMyButton Lower-level Class

CButtonProc Base Class

Figure 13-3 Sample split-level class hierarchy

Lower-level files are rewritten each time Visual Architect generates
source code for a class. Upper-level files are generate-once files and
are written only the first time Visual Architect generates source code
for a class. Subsequent generation does not touch upper-level files.

You fill in the upper-level files with your own code. You can add or
remove member functions or data members and fill out the
generated functions with your own code. This split-level approach
adds only a few bytes to your program size, but it makes your
generated code immune to subsequent changes that you make in
Visual Architect.

Lower-level files are not restricted to files defining derived classes.
Visual Architect also generates header files as lower-level files to
define symbols. An example is the vi ewnanel t ens. h file, which
contains symbolic names for the panes in a view.

Lower-level files contain as much of the information that might
change as a result of editing in Visual Architect as possible. While
this technique shields your code from the effects of most iterative
design changes, there are several things to watch out for, as
described in the following paragraphs.
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Deleting or renaming panes

If your handwritten code uses a symbolic name for a pane, and you
change the name or delete the pane, your code obviously must
change. Usually, the compiler warns you of errors of this sort.

Changing class names

If you change the name of one of your derived classes, an entirely
new set of upper- and lower-level files is generated for the class, and
you have to copy your code from the old upper-level files to the
new ones.

The names of lower-level files for derived classes begin with the
characters x__ (x underscore). Otherwise, they are the same as the
names of the corresponding upper-level files.

Generated files

The files listed in the table below are generated for every
application, regardless of size.

File name Description

X_appclass.cp The lower-level source code for your
application class.

x_appclass.h The header file for the lower-level
application class.

appclass.cp The upper-level source code for your
application class.

appclass.h The header file for the upper-level

application class.

viewnamel t ems. h  Header files defining symbols for panes in
each view.

AppCommands. h The header file defining symbols for the
commands you define in Visual Architect.
The AppConmmands. h file is regenerated

each time.
Ref erences. cp The files defining a
Ref erences. h Ref er enceSt dCl asses function that

force a reference to every THINK Class
Library that can do Obiject I/0.

Table 13-1 Code files generated by Visual Architect
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Inside Macro Files

This section tells how to modify and write your own macro
generation files. If you always use the macro files supplied with
Visual Architect, you can skip the rest of this chapter.

Macro files that drive code generation are ordinary text files. Macro
files shipped with Visual Architect were created in THINK Project
Manager. You can use any text editor to create the files as long as
they have file type TEXT.

The fact that generated macro files are ordinary text files makes them
easy to customize. To customize, you need to know the Visual
Architect macro language, which is described in the remainder of
this chapter.

Visual Architect macro language

The Visual Architect macro language embeds macro processing
statements in ordinary C++ source text. Visual Architect uses the $
character to indicate the start and end of a Visual Architect macro.
When a macro file is used to generate source code, all text outside a
macro is copied to the output file without change. Text inside a
macro, including the $ delimiters, is replaced with zero or more
characters that depend on the current value of the macro.

There are two kinds of macros: statement macros and expression
macros. A statement macro begins with the first non-whitespace
character on a line and occupies the entire line. The entire line is
removed from the output. In computer jargon, a statement macro
and the line it is on are replaced by a null string. An example of a
statement macro is:

$do wi ndows$

An expression macro can appear anywhere on a line. Visual
Architect evaluates the expression, computes a character string
value, and replaces the macro with the value. An example of an
expression macro appearing in a source code line is:

itsWndow >SetTitle(“$wi ndow title$”);

Expression macros can appear anywhere in any line, including
within statement macros. In the latter case, expression macros are
evaluated and replaced before the statement macro is interpreted. If
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you want to use the $ character as ordinary text, you must double it,
as in:

CopyPString("\ p$$2. 99", str);

which copies the Pascal string " $2. 99" . Doubling works inside C++
macros as well.

Statement macros

Each statement macro begins with a keyword immediately following
the leading $, which tells what kind of statement it is. The keyword
must be one of the following:

defi ne
do

el se

el sei f
end
generate
i f

pop

push

Each statement type is described below.

define statement
Use def i ne to set the value of a macro variable to a desired value.
The format of a define statement is:

$def i ne variablename expression$

The variable name must begin with an alphabetic character and must
be less than 31 alphabetic or numeric characters. The underscore
character " _" is considered an alphabetic character.

The expression may be any combination of variable names,
constants, and operators that would be permitted within the body of
an expression macro. Visual Architect evaluates the expression just
as it would an expression macro and assigns the result to the macro
variable.

Once a variable is defined, it holds that value until it is redefined in
another def i ne statement or until the variable is removed by a pop
statement.

Certain variables are predefined by Visual Architect to hold character
strings, records, or arrays. If you define a variable with the same
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name, it hides the predefined variable until the variable you defined
is popped. In general, it is a good idea to choose variable names that
do not conflict with those listed in the “Predefined variables” section
later in this chapter.

do statement
Use a do statement to iterate over each element in an array. The
format of a do statement is:

$do arrayvariablename$

The array variable name must be one of those predefined by Visual
Architect.

The do statement operates by repeatedly scanning the text between
the do statement and the closest matching end statement, once for
each array element. If there are no elements in the array, or if the
array variable is undefined, the text between the do and end
statements is skipped.

Before starting each iteration, two variables are automatically
defined: the array element name and the variable i . The variable i is
assigned the index of the current array element, from 1 through the
number of elements in the array.

All array variable names defined by Visual Architect are plural, for
example, wi ndows. For each array variable, the array element name
is singular, for example, wi ndow. Usually, an array element is a
record, which means it has subvalues. Subvalues can be accessed by
placing a period after the element name, followed by the name of
the record item. For example:

wi ndow. title

is the title of the “current window,” that is, the current value of the
wi ndow variable.

The following example shows a do loop, which generates a C++
macro for every window:

$do wi ndows$
#def i ne W ND$wi ndow. i d$ $wi ndow. r esi d$
$end$
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else statement

Use an el se statement to reverse the sense of a preceding i f or
el sei f statement and to conditionally expand one or more lines.
The format of the el se statement is:

$el se$

If the value of the preceding i f or el sei f expression is TRUE, the
el se statement causes lines between it and the nearest matching
end statement to be skipped. If the value is FALSE, the lines
following el se are expanded.

elseif statement

Use an el sei f statement to reverse the sense of a preceding i f or
el sei f statement and conditionally expand one or more lines. The
format of the el se statement is:

$el sei f expression$

If the value of the preceding i f or el sei f expression is TRUE, the
el sei f expression is not evaluated; statements between el sei f
and the nearest matching end statement are skipped. If the value is
FALSE, the expression is evaluated and the el sei f statement
behaves like an i f statement.

end statement
Use an end statement to end the scope of ado, i f, el se, or
el sei f statement. The format of the end statement is:

$end comment$

If a comment appears in the end statement, there must be at least
one whitespace character after the end keyword.

generate statement
Use a gener at e statement to create a new output file. The format
of the gener at e statement is:

$gener at e outputfilename macrofilename
[once] [keep] $

The gener at e statement creates a new output file with the
specified name and fills it with text produced by expanding the
specified macro file.
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The output file name can contain a folder name. If no folder by that
name exists in the Sour ce folder, a folder is created inside the
Sour ce folder. If a folder with that name already exists, the file is
placed inside that folder.

If the keyword once is specified, the file is not generated if a file
with the same name already exists in the specified folder. Use once
for files you want to modify by hand, so that they will not be
overwritten the next time code is generated. If you want to
regenerate a once file, move the previously generated file out of its
folder.

If the keyword keep is specified, variables defined while the file is
being generated are retained. By default, these variables are popped
automatically. The use of the push and pop statements is described
shortly.

if statement
Use an i f statement to conditionally expand one or more
subsequent lines. The format of the i f statement is:

$i f expression$

If evaluating the expression results in a value other than zero or
results in an empty string, the expression is considered to be TRUE
and the lines following the i f statement until the next matching

el se, el sei f, or end statement are expanded. Otherwise, the
expression is FALSE, and all text between the i f statement and the
next matching el se, el sei f, or end is skipped. You can nest i f
statements.

pop statement
A pop statement discards all variables defined since the last push
statement. The format of the pop statement is:

$pop$

The variables defined automatically by a do statement are popped
automatically when the matching end statement is processed.
Similarly, variables defined during processing of a generate
statement without a keep keyword are popped automatically as
soon as the file is generated. Otherwise, variables you define remain
defined until you explicitly pop them. You rarely need to use push
and pop, but in some circumstances they are useful in preventing
inactive variables from wasting memory.
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push statement
Use a push statement to establish the context for a subsequent pop
statement. The format of the push statement is:

$push$

Expression macros
An expression macro evaluates an expression, producing a character
string whose contents replace the macro in the output text.

The result of an expression macro is not rescanned for macros; it
goes directly to the output (or statement macro) without being
interpreted further.

An expression is composed of variable names, constants, and
operators. The value of any expression or subexpression is a
character string. Certain operators may cause string operands to be
converted to long integers; the numerical result of the operation is
then converted back to a string.

An undefined variable is interpreted as a null string.

Operators

Macros may contain the following operators which, except for
automatic string-to-long coercion, are defined like their C and C++
language counterparts:

+ - *F [ <35>~ & MNE&& || < <=>>==1=1

In addition, the dot operator (. operator) is used to select a record
item.

Expressions may be put in parentheses.

Constants

String, character, and integer constants are permitted in expressions.
Long integer and hexadecimal forms are also allowed. Octal
constants are not supported.

258 Visual Architect and THINK Class Library Guide



Inside Macro Files

Predefined variables

*

Visual Architect predefines a number of variables, which are listed in
the table below. For further definition of records or arrays that have
record elements, see “Record types” later in this chapter.

Variable name
abbr evDat e

app

bar nenus

cl asses

cl asseschanged

comands

conmandschanged

copyri ght

dat e

di al ogs

docunent s

floats

| ongDat e

Predefined as...
The current date as an abbreviated date
string

The application record

An array with one menu record element for
each menu you define to be part of the
THINK Class Library menu bar

An array with one class record for each class
displayed in the Classes dialog

1 if Generate All is chosen or if any classes
changed since last generate; otherwise, 0

An array with one command record for each
command you define in the Commands
dialog

1 if Generate All is chosen or if any
commands changed since last generate;
otherwise, 0

The copyright text you specify in the
Application Info dialog

The current date as a date string

An array with one view record for each
modal or modeless dialog view you define

An array with one view record for each
document (Main) view you define

An array with one view record for each
floating window view you define

The current date as a long date string

Table 13-2 Predefined variables
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Variable name Predefined as...
nmenus An array with one menu record for each
menu you define

newdi al og A view record for the New... Dialog, if any

popnenus An array with one menu record for each
pop-up menu you define

shortDat e The current date as a short date string

spl ash A view record for the splash screen

subnenus An array with one menu record for each

hierarchical submenu you define

subvi ews An array with one view record for each
subview you define

tearoffs An array with one view record for each tear-
off menu you define (the menu associated
with the view is in the record variable

nenu)
time The current time
Vi ews An array with one view record for each

view you define (all views)

vi ewschanged 1 if Generate All is chosen or if any
views changed since the last generate;
otherwise, 0

wi ndows An array with one element for each window

view you define

year The current year

Table 13-2 Predefined variables (Continued)

Record types

A macro record is a variable with named elements. Like a C or C++
st ruct, a record element always has a record name with a period,
followed by an element name. For example:

vi ew. changed
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A do statement implicitly defines a record on each iteration that
corresponds to the i th element of the array controlling the do. For
example:

$do vi ews$

defines a record variable named vi ew within the scope of the do.
On each iteration, vi ewis set to a different view record. Elements of
this record are referred to within the do as. For example:

vi ew. acti ons
The following sections define each record type separately:

App record
An app record contains application information you set in the
Application Info dialog box.

Record element Description

changed 1 if application changed since the last
generate; otherwise, 0

cl ass A class record for the application class

copyri ght The value of the copyright string

docTypel The first document OSType

docType2 The second document OSType

docType3 The third document OSType

docType4d The fourth document OSType

filetypes An array of filetype records for the

application’s document types; same values
as docTypel-docTyped

nane The application name

Nare Application name, with the first character
capitalized

nunfil etypes The number of file (document) types
defined

si ghature The application signature (creator code)

Table 13-3 Application record description
Action record

An action record describes a command action defined in the
Commands dialog box. Each action defines a handler class, what
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happens, and, in the case of an Open action, the class of the view

that is opened.

Record element
cl ass

cl assNane
command

Vi ew

what

Description

A class record for the class of the view
created as a result of Open; NULL if not an
Open action

The name of the class that handles this
action

A command record for the command that
causes the action

A view record for the view created as a
result of an Open action; NULL if not an
Open action

Which action: None, Call, or Open

Table 13-4 Action record description

Class record

A class record describes each class displayed in the Classes dialog

box.

Record element
actions

basenane
changed

ki nd

menber s
nactions
name
nnenber s

super nane

Vi ew

Description

An array of action records for each action
handled by this class

Name of nominal base class or base of
library class, if defined

1 if class changed since last generate;
otherwise, O

An ordinal denoting the kind of class; class
kinds are defined in the Gener at e TCLApp
macro file

An array of member records describing the
data members defined in Visual Architect
The number of actions handled by this class
The name of the class

The number of data members defined in
Visual Architect

The name of the base class; either a user or
a THINK Class Library class

A view record for the class; NULL if the
class is not the director class of a view

Table 13-5 Class record description
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Command record

A command record describes each command you define in the

Commands dialog box.

Record element Description

actions An array of action records for the command

nactions The number of actions caused by the
command

name The command name

Nane The command name with the first letter
capitalized

num The command number

Table 13-6 Command record description

File type record

A file type record contains a single, four-character file type, for

example, TEXT.

Record element Description

type The four-character type

Table 13-7 File type record description

Menu record

A menu record describes each menu you define in the Menus or

Menu Bar dialog box.

Record element Description

I D The ' MENU resource ID

nmdef | D The ID of the menu definition procedure

menul D The menul Dinside the ' MENU resource
(Visual Architect always sets this the same
as the ' MENU resource ID.)

menul t ens An array of menu item records for this menu

name The name of the ' MENU resource

nMenul t ens The number of items in this menu

title The menu title

Table 13-8 Menu record description
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Member record

A member record describes each data member you define in the
Define Data Members dialog box. A data member declaration can
be generated from the macros:

$menber . type$ S$nenber. nane$ $nenber. el ent;

Record element Description

el em The number of elements in an array data
member as a string enclosed in brackets, for
example, [ 15] ; NULL if not an array

getfrom TRUE if member to be included is generated
Get Fr omfunction (object 1/0)

i spascal 1 if a Pascal string; O if a C string

name The name of the data member

nel ement s The number of elements in an array data
member, for example, 15; O if not an array

putto TRUE if member to be included in
generated Put To function (object 1/0)

type The type of the data member as a character
string

t ypecode A numeric code indicating the type of the

data member, numbered from 1 through
12: Bool ean, char, doubl e, f| oat,

| ong, short, Str31, Str255, Str63,
unsi gned char, unsi gned | ong,
unsi gned short

Table 13-9 Member record description

Menu item record
A menu item record describes each menu item you define in the
Menu Items dialog box.

Record element Description

command A command record for the command sent
by the menu item; NULL if no command

i con The resource ID of the ' | CON' , reduced
icon, or ' si cn' resource

key The key character if nonzero and outside
the range 0x1B through Ox1F; otherwise,
NULL

Table 13-10 Menu item record description
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Record element
mar k

nanme
reduced
sicn

subnenu

subnmenul D

title

Description

The mark character if nonzero and outside
the range Ox 1B through Ox1F; otherwise,
NULL

The name (string value) of the item

1 if reduced; O if not

1lificonisa’' sicn' resource; O if not

A menu record for the submenu if the item
has a hierarchical menu; otherwise, NULL
The resource ID of the submenu if the item
has a hierarchical menu; otherwise, NULL
The title of the menu

Table 13-10 Menu item record description (Continued)

Pane record

A pane record describes each pane in a view.

Record element
active

aut oRefresh
basecl ass

canBeGopher
cl assnane
hei ght

hel pResl ndex
hEncl

hSi zi ng

I D
identifier

I dentifier
ki nd

usi ngLongCoord

vEncl
vi si bl e

Description

1 if pane is initially active; O if not

1 if aut oRef r esh set for pane; 0 if not
The name of the standard THINK Class
Library or user library class that is the
immediate base of the (lower-level) pane
class

1 if canBeGopher set for pane; O if not
The name of the pane class

The pane’s hei ght value

The pane’s hel pResl ndex value

The pane’s hEncl value

The pane’s hSi zi ng value

The pane’s | D value

The identifier of the pane as defined in the
Identifier dialog or defined automatically
by Visual Architect

The identifier with the first letter capitalized
An ordinal that identifies the superclass
category of the pane; the ordinals are
defined in the Gener at eTCLApp macro
file

The pane’s usi ngLongCoor d value

The pane’s vEncl value

The pane’s vi si bl e value

Table 13-11 Pane record description
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Record element Description

vSi zi ng The pane’s vSi zi ng value
want sCl i cks The pane’s want sCl i cks value
wi dt h The pane’s wi dt h value

Table 13-11 Pane record description (Continued)

Point record
A point record contains a point.

Record element Description
h Horizontal coordinate
\% Vertical coordinate

Table 13-12 Point record description

Rectangle record
A rectangle record contains a rectangle.

Record element Description

bott om Lower vertical coordinate

I eft Upper horizontal coordinate
ri ght Lower horizontal coordinate
top Upper vertical coordinate

Table 13-13 Rectangle record description

View record
A view record contains information about a view defined in Visual

Architect. Record elements indicated as “(windows only)” are
defined only for views that are windows, that is, not subviews.

Record element Description

actdick 1 if the view’s panes see the click that
activates the window (windows only)

actions An array of action records with one element

for each action performed by this view, as
set up in the Commands dialog

centered 1 if the view is centered; O if not

changed 1 if the view has been changed since the
last generate; O if not

di rectorcl ass The class name of the view’s director

(windows only)

Table 13-14 View record description
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Record element
di rectorki nd

fixedPosition

floating
goaway

hei ght
hel pResl| D

hori zscrol |

I D
i sdi al og

i sdocunent
i smodal

i ssubvi ew
i swi ndow
i tens
maxHei ght
maxW dt h
menu

nm nHei ght
m nW dt h
nodal
nacti ons

nanme

Name

Description

A numeric code indicating the kind of
director that supervises the view; director
kinds are defined in the Gener at e TCLApp
macro file (windows only)

1 if the view’s window is to be opened at a
fixed position on the screen; 0 if not
(windows only)

1 if the view is a floating window; 0 if not
(windows only)

1 if the view’s window has a goAway box; 0
if not (windows only)

The window height (windows only)

The resource ID of the ' hrmu' resource for
this view (windows only)

1 if the view’s panorama is enclosed in a
scrollpane with horizontal scroll bars

The view's ' CVue' resource ID

1 if the view is a modeless dialog; O if not
(windows only)

1 if the view is a document (Main view); 0
if not (windows only)

1 if the view is a modal dialog; O if not
(windows only)

1 if the view is a subview; 0 if a window

1 if the view is a window; O if a subview
An array of pane records for the items in
this view; same as panes

The maximum height (windows only)

The maximum width (windows only)

The ' MENU resource ID; 0 unless view is a
tear-off menu

The minimum height (windows only)

The minimum width (windows only)

1 if the view is modal; O if not (windows
only)

The number of actions performed by this
view; 0 if none

The view name as defined in Visual
Architect

The view name with the first letter
capitalized

Table 13-14 View record description (Continued)
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Record element
nitens

npanes
panes
panor ama

position

print

procl D
scrol | pane

si zebox
st agger ed

title
usefile

vertscroll

vi ewki nd

WDEFi d

wi dt h
w ndowcl| ass

w ndowki nd

Description

The number of items in this view; same as
npanes

The number of panes in this view; same as
ni tems

An array of pane records for the panes in
this view; same as i t ens

A pane record for the view’s main
panorama

A point record containing the view’s initial
position; the value of posi ti on is only
meaningful if f i xed is TRUE

1 if the view is printable; O if not (windows
only)

The window’s pr ocl D (windows only)

1 if the view’s main panorama is enclosed
in a scrollpane; O if not

1 if the view’s panorama is enclosed in a
scrollpane with a size box; 0 if not

1 if the view’s window is initially staggered;
0 if not (windows only)

The view’s window title (windows only)

1 if the view uses a file; 0 if not (windows
only)

1 if the view’s panorama is enclosed in a
scrollpane with a vertical scroll bar; O if not
A numeric code indicating the kind of view;
view kinds are defined in the

Cener at eTCLApp macro file

The view’s window definition procedure
"WDEF' ID (procl D/ 16) (windows only)
The window width (windows only)

The class name of the view’s window
(windows only)

A numeric code indicating the view’s
window kind; window kinds are defined in
the Gener at eTCLApp macro file
(windows only)

Table 13-14 View record description (Continued)
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CAbstractText

14°*

Introduction

CAbstractText is an abstract class that provides you with a template
for creating a pane that displays text.

Heritage
Base Class CPanorama
Derived Classes CEditText

Using CAbstractText

CAbstractText is an abstract class for creating panes that display text.
A text pane is usually the panorama in a scroll pane, so the text can
be scrolled through. The class supports word wrap, which you can
control with the line width argument to CAbstractText’s constructor.
The Speci fy member function lets you specify whether the user
can edit and copy your text pane’s text. The DoCommand member
function handles all common text-editing commands such as cutting,
copying, pasting, font selection, and line spacing.

To handle the Undo command, CAbstractText creates task objects
for many common commands, and tells them to perform or undo
their tasks by calling their member functions. CTextEditTask,
described in Chapter 118, handles typing, cutting, copying, and
pasting. CTextStyleTask, explained in Chapter 120, handles font, size,
and style commands.

When you perform a task that can be undone, the name of the
Undo command changes. For example, it becomes Undo Typing
after the user types. The Undo labels for CAbstractText are stored
in the resource ' STR#' 130. The index of the first string is stored
in the class data member cFi r st Taskl ndex. By default,

Fi r st Taskl ndex is 1. If you move the strings to a different place
in" STR#' 130, you should set this data member to the index of
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the first string. If you don’t use Undo labels, set this data member to
0. The labels must be in the following order: Typing, Cut, Copy,
Paste, Clear, Formatting.

Because it's an abstract class, you can't create an instance of
CAbstractText. You must create an object of a derived class, such as
CEditText or CStyleText. Those classes are based on the Macintosh
TextEdit (TE) routines and become slow if they contain over 4000
characters. If your text pane needs to handle more text, derive your
own class from CAbstractText.

Most of CAbstractText’s functions do nothing. They are placeholders
for the functions that derived classes must override. The rest of
CAbstractText's member functions call them. These are the functions
to override:

Dod i ck Set Text Ptr

Get Text Handl e Set Font Nunber
Set Font Styl e Set Font Si ze
Set Text Mbde Set Al i gnCd
Set Al i gnCd Set Spaci ngCnd
Get Hei ght Get Char O f set
Get Char Poi nt Get Text Styl e
Get Char Styl e Fi ndLi ne

Get Lengt h TypeChar

Set Sel ecti on Get Spaci ngCnd
Get Sel ection Get NunLi nes
CopyText Range Per f or nEdi t Conmrand
I nsert Text Ptr Dawd| e

The following two functions assume that the text in your pane is
stored in a single contiguous buffer. If it isn’t, you should override
these functions:

Cet Char Bef ore Cet Char Aft er
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2
Data Members

The following data members are public. i t sTypi ngTask can be
used by any class. cFi r st Taskl ndex is a static data member that
only CAbstractText and its derived classes should use.

Data member Type Description

i tsTypi ngTask CText Edi t Task* Active typing task

cFi rst Taskl ndex short Index in ' STR#'
130 resource of first
undo label

The following data members are protected:

Data member Type Description

i neWdth short Width of a text line in
pixels. If negative, lines
are as wide as the pane.

fi xedLi neHei ght s Bool ean TRUE if all lines are the
same height.

whol eLi nes Bool ean TRUE if lines aren’t cut
off vertically.

| ast Font Num short Last font number.

| ast Font Cd | ong Last font-command
number.

| ast Text Si ze short Last seen text size.

| ast Si zeCd | ong Last size-command
number.

edi tabl e Bool ean TRUE if user can edit
text.

styl abl e Bool ean TRUE if user can

change font, size, or
style of text.

scrol | Hori z Bool ean TRUE if automatic
horizontal scrolling is
enabled.
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Member Functions

Creation and destruction

CAbstractText

CAbstract Text (CVi ew *anEncl osur e,
CBur eaucr at *aSuper vi sor,
short aWwdth, short aHei ght,
short aHEncl, short aVEncl,
Si zi ngOpti on aHSi zi ng, Sizi ngOption aVSi zi ng,
short alLi neWdth, Bool ean aScroll Hori z);

Constructor. Initializes an abstract text pane.

Most of the arguments to the constructor are identical to those of
CPane’s constructor. aLi neW dt h specifies how wide the lines are
to be. If a line width is less than 0, the text wraps to the width of the
pane. Supplying the value MAXINT disables word wrap. The default
value is -1. aScr ol | Hor i z specifies whether the text should scroll
horizontally. TRUE enables horizontal scrolling; FALSE disables it.
Setting aScr ol | Hor i z to TRUE is meaningful only if aLineWidth is
positive and is greater than the width of the pane. The default value
is FALSE.

Note
The descriptions of the other arguments are in
CPane.

CAbstractText
CAbstract Text ();

Default constructor. Implicitly called when an object is created by
new_by_ nane. It can also be used in combination with
| Abstract Text for backward compatibility.

274  Visual Architect and THINK Class Library Guide



Member Functions .

IAbstractText
voi d | Abstract Text (CVi ew *anEncl osure,
CBur eaucr at *aSupervi sor,
short aWwdth, short aHei ght,
short aHEncl, short aVEncl,
Si zi ngOpt i on aHSi zi ng, Si zi ngOpti on aVSi zi ng,
short aLi neWdth);
Initializes an abstract text pane. If no constructor arguments are
specified, the pane must be further initialized by calling
| Abstract Text . If any constructor arguments are specified,
| Abst ract Text must not be called. See constructor for
descriptions of the arguments.

IViewTemp
void | ViewTenp (CVi ew *anEncl osure,
CBur eaucr at *aSupervi sor,
Ptr viewData );
Initializes an abstract text object from a view template. The data
members are set using the view template pointed to by vi ewDat a.

Accessing

Specify
voi d Specify (Bool ean fEditable,

Bool ean f Sel ectabl e, Bool ean fStyl able);
Specifies whether the user can edit, select, and style text. This
member function sets edi t abl e to f Edi t abl e, want sCl i cks to
f Sel ect abl e, and st yl abl e to f St yl abl e. By default, text is
editable, selectable, and stylable. If editing is allowed, the user can
insert and delete text. If selecting is allowed, the user can select text
for copying to the Clipboard. If styling is allowed, the font, style, and
size of the text can be changed.
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To make your Speci f y calls more understandable, the THINK Class
Library defines constants that you can use instead of TRUE and

FALSE:;
kEdi t abl e kNot Edi t abl e
kSel ect abl e kNot Sel ect abl e
kStyl abl e kNot St yl abl e

This list describes some common ways to call Speci fy:

= To let the user edit and style text, call
Speci fy(kEdi t abl e, kSel ect abl e,
kStyl abl e) .

= To prevent the user from editing, styling, or selecting text,
call Speci fy(kNot Edi t abl e, kNot Sel ect abl e,
kNot St yl abl e) .

= To let the user select text (to copy it, for example) but not
edit or style it, call Speci f y(kNot Edi t abl e,
kSel ect abl e, kNot Styl abl e).

= To let the user select and edit text, but not style it, call
Speci fy(kEdi t abl e, kSel ect abl e,
kNot St yl abl e) .

= To let the user select and style text, but not edit it, call
Speci f y(kNot Edi t abl e, kSel ect abl e,
kStyl abl e) .

Note
If f Sel ect abl e is kNot Sel ect abl e, Speci fy
disables editing and styling, regardless of the values
of f Edi t abl e and f St yl abl e.

You can call Speci fy at any time. For example, you can lock text
(that is, disable editing) to prevent accidental editing, then let the
user unlock it later.

GetSpecification

voi d Get Specification (Bool ean *fEditabl e,
Bool ean *f Sel ectabl e, Bool ean *f Styl abl e);

Returns whether the text in this pane is editable, stylable, or
selectable.
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Command

DoCommand
voi d DoConmand (| ong t heComand) ;

Handles the common commands that apply to text such as cutting,
copying, pasting, font selection, styling, alignment, and spacing.
DoConmand handles the commands listed below, passing all other
commands to its supervisor.

= Editing commands: cndCut , cndCopy, cndPast e,
cndCl ear, cndSel ect Al |

= Style commands: cndPl ai n, cndBol d, cndl tal i c,
cndUnder | i ne, cndQut | i ne, cndShadow,
cnmdCondense, cndExt end

= Alignment commands: cndAl i gnLeft,
cndAl i gnCent er, cndAl i gnRi ght

= Spacing commands: cndSi ngl eSpace,
cndlHal f Space, cndDoubl eSpace

= Font selection from the Font menu (MENUf ont )
= Size selection from the Size menu (MENUsi ze)

To let the user undo actions, this member function creates a task
object for most commands. It creates a CTextEditTask object for an
editing command and a CTextStyleTask object for a style, alignment,
spacing, font, or size command.

UpdateMenus
voi d Updat eMenus();

Updates the menus items that pertain to text processing just before
the menu appears. This function enables the Cut, Copy, and Clear
commands if there is a current selection, and enables the Paste
command if there is text in the Clipboard. This function also checks
the current font, size, style, alignment, and spacing commands.

Note
See the implementation of this member function
for an example of how to write your own
Updat eMenus function.
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DoKeyDown
voi d DoKeyDown (char theChar, Byte keyCode,

Event Record *nacEvent);
Handles a key down in a text pane. Usually, DoKeyDown passes
function keys and command keys to its base class and inserts other
characters into the text. This table shows how DoKeyDown handles
command keys and function keys:

If the key is... This member function...

Any command key Passes it to the base class

Home, Page Up, Passes it to the base class

Page Down

End Scrolls to the bottom left of the text

A cursor key Calls TypeChar and notifies the
editing task of the change in the
selection

Any other key Passes it to the editing task, which

should insert the character if the text
pane is editable

Table 14-1 How DoKeyDown handles keys

DoAutoKey

voi d DoAut oKey (char theChar, Byte keyCode,
Event Record *macEvent);

Handles an auto key in a text pane. If the command key is down,

this function does nothing. Otherwise, this function calls

DoKey Down.

PerformEditCommand
voi d Perfornkdi t Command (| ong t heConmand) ;

Performs the standard Cut, Copy, Paste, and Clear commands on
the text. The task classes call this function to perform and undo an
edit command. The default function does nothing. Your derived class
must override this function.

TypeChar
voi d TypeChar (char theChar, short theModifiers);

Processes a keystroke. This function does not need to set up for an
Undo command and should handle the key directly. The task classes
call this function to perform a keystroke. The default function does
nothing. Your derived class must override this function.
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SelectionChanged
voi d Sel ecti onChanged ();

Called when the selection has just changed. This function calls the
Br oadcast Change function with t ext Sel ect i onChanged as
the reason. If this text pane has an editing task, it calls the

Sel ect i onChanged function.

MakeEditTask
CText Edi t Task *MakeEdi t Task (|l ong editCnd);

Creates a task to handle typing and the Cut, Copy, Paste, and Clear
commands. This function creates a CTextEditTask object. If you
override this function, your function must create a CTextEditTask-
derived object. MakeEdi t Task is a protected member function.

MakeStyleTask
CText Styl eTask *MakeStyl eTask (I ong editCnd);

Creates a task to handle font, style, size, alignment, and spacing
commands. This function creates a CTextStyleTask object. If you
override this function, your function must create a CTextStyleTask-
derived task object. MakeSt yl eTask is a protected member
function.

BecomeGopher
Bool ean BeconeGopher (Bool ean fBeconi ng);

Returns TRUE if requested action completed without error. If

f Becomi ng is TRUE, this text pane is becoming the gopher. This
function activates it and enables the Font, Size, and Style menus. If
f Becomi ng is FALSE, this text pane is no longer the gopher. This
function deactivates the pane and disables the Font, Size, and Style
menus.

Display

ScrollToSelection
void Scroll ToSel ection ();

Scrolls so that the current selection is visible.
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SetHorizontalScroll
voi d Set Hori zontal Scrol | (Bool ean doHori z);

Enables automatic horizontal scrolling if doHor i z is TRUE; disables
it if doHor i z is FALSE. By default, it's disabled. If automatic
horizontal scrolling is enabled, the insertion point or selection is
automatically scrolled into view if it moves beyond the right or left
margin of the pane.

SetSelection

void SetSelection (long sel Start, |ong sel End,
Bool ean f Redraw);

Sets the selection to the range corresponding to character positions

sel Start through sel End. The default function does nothing.

Your derived class must override this function.

GetSelection
void GetSelection (long *sel Start, |ong *sel End);
Returns the start and end of the current selection. The default

member function does nothing. Your derived class must override this
function.

SelectAll
void Sel ectAll (Bool ean fRedraw);

Selects all the text in this text pane. This function uses Get Lengt h
to determine the length of the text.

HideSelection
voi d Hi deSel ecti on(Bool ean hi de, Bool ean redraw);

Hides the current selection or insertion point if hi de is TRUE.
Otherwise, the current selection or insertion point is visible. The
default function does nothing. Your derived class must override this
function.

Paginate
voi d Paginate (struct CPrinter *aPrinter,
short pageWdth, short pageHei ght);

Splits the text pane into pages. This function ensures that lines aren’t
cut in half horizontally at the end of a page.
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Text specification

SetTextString
void SetTextString (Str255 textStr);

Uses the specified string as the text pane’s text. This function uses
Set Text Pt r to set the text.

SetTextHandle
voi d Set Text Handl e (Handl e t ext Hand);

Set the text for this pane to the contents of t ext Hand.. This
function uses Set Text Pt r to set the text.

SetTextPtr
void SetTextPtr (Ptr textPtr, |ong nuntChars);

Uses the first numChar s characters that t ext Pt r points to as the
text for this abstract text object. The default function does nothing.
Your derived class must override this function, which must make a
copy of the text.

GetTextHandle
Handl e Get Text Handl e ();

Returns a handle to the text. The default function does nothing. Your
derived class must override this function. In most cases, the text class
should keep its text in a handle, and this function should return that
handle—not a copy of it.

If your implementation requires the function to return a copy of the
text in a handle, your derived class should override any functions
that call Get Text Handl e to dispose of the handle. In
CAbstractText, the member functions Get Char Bef or e and

Get Char Af t er expect Get Text Handl e to return a handle to the
actual text.

CopyTextRange
Handl e CopyText Range (long start, |ong end);

Returns a copy of the text specified by st art and end. The default
member function does nothing. Your derived class must override this
member function.
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InsertTextPtr
void InsertTextPtr (Ptr text, long | ength,

Bool ean f Redraw);
Inserts a copy of the given text at the start of the selection. t ext is a
pointer to the text. The default member function does nothing. Your
derived class must override this member function.

InsertTextHandle
voi d | nsert Text Handl e (Handl e text,
Bool ean f Redraw);
Inserts a copy of the given text at the start of the selection. t ext is a
handle to the text.

GetCharBefore
voi d Get CharBefore (long *aPosition,

t Char Buf char Buf);
Returns the character before aPosi ti on. The character and its size
are returned in char Buf , and aPosi ti on is updated with the
starting position of the character. If there is no character before
aPosi ti on, then this member function sets the length of the
character to 0 and does not update aPosi ti on.

GetCharAfter
void Get CharAfter (long *aPosition,

t Char Buf char Buf) ;
Returns the character after aPosi ti on. The character and its size
are returned in char Buf , and aPosi ti on is updated with the
starting position of the character. If there is no character after
aPosi ti on, then this member function sets the length of the
character to 0 and does not update aPosi ti on.

Text characteristics

SetFontNumber
voi d Set Font Nunber (short aFont Nunber);

Sets the font by font number. The default member function does
nothing. Your derived class must override this member function. If
your derived class supports multiple fonts in a pane, this function
should set the font for the current selection. Otherwise, it should set
the font for the whole text pane.
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SetFontName
voi d Set Font Name (Str255 aFont Nane);

Sets the font by font name.

SetFontStyle
void SetFontStyle (short aStyle);

Sets the font style. aSt yl e may be one of the following: bol d,
italic,underline,outline, shadow, condense, or ext end.
The default member function does nothing. Your derived class must
override this member function. If your derived class supports
multiple styles in a pane, this member function should set the style
for the current selection. Otherwise, it should set the style for the
whole text pane.

SetFontSize
voi d SetFont Si ze (short aSize);

Sets the font size to the specified size. The default member function
does nothing. Your derived class must override this member
function. If your derived class supports multiple styles in a pane, this
member function should set the size for the current selection.
Otherwise, it should set the size for the whole text pane.

SetTextMode
voi d Set Text Mode (short aMode);

Sets the text mode to the specified mode. aMode can be one of the
following: srcOr, srcXor, or srcBi c. The default member
function does nothing. Your derived class must override this member
function.

SetAlignCmd
void SetAlignCrd (I ong anAlignnent);

Sets the text alignment. anAl i gnnent is one of the following:
crmdAl i gnLeft, cndAl i gnRi ght, or cndAl i gnCent er. The
default member function does nothing. Your derived class must
override this member function. If your derived class supports
multiple alignments in a pane, this member function should set the
alignment for the current selection only. Otherwise, it should set the
alignment for the whole text pane.
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GetAlignCmd
long GetAlignCnd ();

Returns the current alignment. It can be one of the following:
crmdAl i gnLeft, cndAl i gnRi ght, cndAl i gnCent er, or
crmdNul | . The default member function does nothing. Your derived
class must override this member function. If your derived class
allows different alignments within a text pane and the current
selection contains more than one alignment, this member function
should return crdNul | .

SetSpacingCmd

voi d Set Spaci ngCnd (| ong aSpaci ngCmd) ;

Sets the space between lines of text. aSpaci ngCnd can be one of
the following: cndSi ngl eSpace, cnd1Hal f Space, or
crmdDoubl eSpace. The default member function does nothing.
Your derived class must override this member function.

GetSpacingCmd

| ong Get Spaci ngCmd ();

Returns the space between lines of text. It can be one of the
following: cmdSi ngl eSpace, cnd1Hal f Space, or

crmdDoubl eSpace. The default function does nothing. Your derived
class must override this function.

GetHeight
| ong Get Height (long startLine, |ong endLine);

Returns the total height in pixels of the indicated lines of text. The
default function does nothing. Your derived class must override this
function.

GetlHeight
short GCet 1Hei ght (I ong aLi neNun);

Returns the height in pixels of the indicated line of text.

GetCharOffset
| ong Get CharOffset (longPt *aPt);

Returns the character position nearest the coordinate aPt . aPt must
be in frame coordinates. The default function does nothing. Your
derived class must override this function.
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GetCharPoint
voi d Get Char Poi nt( long offset, longPt *aPt);

Returns the coordinates of the character position of f set in *aPt .
aPt is in frame coordinates. The default function does nothing. Your
derived class must override this function.

GetCharStyle
void GetCharStyle (long char O f set,
Text Style *theStyl e);
Returns style information in *t heSt yl e for the character at position
char O f set.

GetTextStyle
voi d Get Text Style (short *whichAttributes,

Text Style *aStyle);
Returns current text style information. whi chAt t ri but es is a flag
that indicates which text attributes to report. The default function
does nothing. Your derived class must override this function. If your
derived class supports multiple styles in a text pane, this member
function should report only those attributes that are continuous over
the current selection, and should set whi chAt t ri but es to those
attributes.

The attributes flags and Text St yl e record are described in Inside
Macintosh Volume VI, Chapter 15, “TextEdit.”

Calibrating

SetWholeLines
voi d Set Whol eLi nes (Bool ean aWhol eLi nes);

If aWhol eLi nes is TRUE, this function resizes the frame so that it
displays only whole lines. The text pane is not redrawn.

GetWholeLines
Bool ean Get Whol eLi nes();

Returns the value of the whol eLi nes data member. If TRUE, the
frame is set to display only whole lines and not partial lines.
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ResizeFrame
voi d Resi zeFranme (Rect *delta);

Resizes the frame when the size of its pane changes. The del t a
rectangle specifies how each side changes. Positive values mean
down and to the right. Negative values mean up and to the left.

FindLine
| ong FindLine (long charPos);

Returns the line number containing the specified character position.
The default function does nothing. Your derived class must override
this function.

Both line and character numbering start at 0. If the character position
is before the start of the text (a negative number), this member
function should return 0. If the character position is beyond the end
of the text, this member function should return the number of the
last line.

GetLength
| ong GetlLength ();

Returns the length in bytes of the text buffer. The default function
does nothing. Your derived class must override this function.

GetNumLines

| ong Get Nuniines ();

Returns the total number of lines in the text buffer. The default
function does nothing. Your derived class must override this
function.

Cursor

AdjustCursor

voi d Adj ust Cursor (Point where,
RgnHandl e nouseRgn);

Turns the cursor into an I-beam when the mouse is in the edit text
pane.

Object I/0

PutTo
void PutTo (CStream& aStrean;

Writes to the stream.
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GetFrom
voi d Get From (CStream& aStrean;

Reads from the stream.

Member Functions: Protected

CAbstractTextX
voi d CAbstract Text X ();

Performs common constructor initialization.
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Introduction

CAppleEvent is a class whose objects contain an Apple event and its
reply. The basic THINK Class Library handles the four required
Apple events (Open Application, Open Documents, Print
Documents, and Quit Application). If you make use of the Apple-
event-aware functionality of CApplication, CDocument, and so on,
your application can be scriptable and recordable using the Core,
Miscellaneous, Text, and other Apple-event suites defined by the
Apple Event Registry.

Heritage
Base Class None
Derived Classes None

Using CAppleEvent

When your application receives an Apple event, the THINK Class
Library puts it in a CAppleEvent object. If the event is one of the four
required events, it is passed to the application by calling the
application’s DoRequi r edEvent member function. If the event is
not one of the four required events and your application takes
advantage of the Apple-event-aware features of the THINK Class
Library, the event is dispatched directly to the appropriate
CAppleEventObject-derived object. You don’t need to write any code
to handle the four required Apple events or any of the events
handled by the CApplication, CDocument, CSwitchboard,
CStyleText, or CWindow classes.

If you want your application to handle an Apple event other than the
four required events or if you want your application to be scriptable
and recordable—you must base your application on the Apple-

event-aware classes. You also must write a DoAppl eEvent member
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function to handle the event. That function should be in the class of
the object that is the target or direct object of the event: your derived
class of CApplication, CDocument, CPane, and so on. You don't
need to derive a new class from CAppleEvent to handle new Apple
events.

CAppleEvent provides a number of functions that allow you to
extract the parameters from an Apple event or add parameters to the
reply. After you extract the parameters you know about, call the
CAppleEvent's Fai | Mor eRequi r edPar ans function, which fails
with an er r AEPar anM ssed error code if you have not extracted
all the required parameters.

If your Apple event needs to interact with the user (for example, if it
displays a dialog), call the application’s Request | nt er acti on
function, specifying whether the interaction is required or optional.
Request | nt er act i on fails if a required interaction is not
permitted; otherwise, it returns TRUE if the requested interaction can
take place, and FALSE if it is not allowed.

Apple events succeed by default. If Fai | ur e is called during
handling of an Apple event, the event fails, returning the contents of
the exception’s error code as its result code and the message
indicated by the exception’s error message code, if any, as its error
string.

How the THINK Class Library handles Apple events

When you initialize your application, it checks to see if the Apple
Event Manager is installed. If it is, the switchboard installs a number
of handlers and object accessors from the CAppleEventObiject class.

When the switchboard receives a high-level event, it assumes the
event is an Apple event and calls the Apple Event Manager’s

AEPr ocessAppl eEvent function. AEPr ocessAppl eEvent calls
the handler installed for the event directly.

AEPr ocessAppl eEvent calls one of the CAppleEventObject
handler functions: Gener i cResul t Handl er,

Generi cNoResul t Handl er, Generi cAppHandl er, or

Gener i cGopher Handl er. The first three functions resolve the
direct object or insertion location parameter of the event to
determine which object should handle the event; then they dispatch
the event directly by calling the object’s DoAppl eEvent function.
Generi cGopher Handl er dispatches the event to the application
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or to the object that is currently the gopher. In every case, the object
that ultimately handles the event must be an instance of a derived
class of CAppleEventObiject.

Data Members

The following data members are protected:

Data member
t heEvent

t heReply

t heRef Con
event Cl ass

event | D

canl nt er act

di rect| sToken

notificati onRec

i dl eProc

di rect Obj ect

i nsertionLoc

Type

const Appl eEvent *

Appl eEvent *

| ong
DescType

DescType

Bool ean

Bool ean

NMRec*

struct

AEI dl eUPP

AEDesc

AEDesc

Description

Pointer to the Apple
event.

Pointer to the
default reply.

The reference value.
The event class; for
example, ' aevt' .
The event ID; for
example, ' oapp' .
TRUE if interaction
with the user has
been previously
requested and
approved.

TRUE if direct object
is token.

The Notification
Manager record for
AEl nt eract Wt h-
User. By default, it's
NULL.

The idle procedure
for AEI nt er act —
W t hUser. If NULL,
uses CSwitchboard'’s
idle procedure.

The cached token
value of the direct
object parameter of
the event.

The cached token
value of the
insertion loc
parameter of the
event.
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Data member Type Description
i nsertionPos DescType Insertion location
position.
current Event static Pointer to the event
CAppl eEvent*  currently being
handled.

previ ousEvent CAppl eEvent *  Pointer to the
previous event. Non-
NULL if an event was
being handled when
the current event was
received.

Member Functions

Creation and destruction

CAppleEvent
CAppl eEvent (const Appl eEvent

*t heEvent = NULL,

Appl eEvent *theReply = NULL,

| ong t heRef Con = 0);
Constructor. Initializes a CAppleEvent object. t heEvent is the
Apple event that CSwitchboard received. t heRepl vy is the default
reply that the Apple Event Manager generates for an Apple event.
t heRef Con is the reference value for this event’s class and ID as set
by CSwitchboard. For the default handlers, t heRef Con is always 0.

CAppleEvent

CAppl eEvent ();

Default constructor. Implicitly called when this object is created by
new by nane. Can also be used in combination with

| Appl eEvent for backward compatibility.

~CAppleEvent
~CAppl eEvent ();

Destructor. Calls CAppleEventObject's EndEvent function to delete
any AEObijects created as tokens during processing of this event.
Disposes of the direct object and insertion loc descriptors.
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IAppleEvent
voi d | Appl eEvent (const Appl eEvent *theEvent,

Appl eEvent *theReply, |ong theRef Con,

DescType anEvent Cl ass, DescType anEventID);
Initialization function provides for backward compatibility. If no
constructor arguments are specified, a new object must be further
initialized by calling | Appl eEvent . If any constructor arguments
are specified, | Appl eEvent must not be called. See the non-default
constructor for descriptions of the arguments.

Dispose
voi d Di spose ();
For backward compatibility. Calls del et e t hi s.

Accessing

GetDirectObject
Bool ean Get Direct Obj ect (AEDesc *obj Token);

Returns in obj Token the resolved token value of the direct object
parameter of the event. Fails if there is no direct object parameter.

The direct object is cached by the event and should not be disposed
by the caller. Subsequent calls to Get Di r ect Cbj ect return the
same value with no further overhead.

The token is a descriptor whose descriptor type is the object
class of the token and whose data handle contains a pointer to the
AEMhj ect that handles the event.

The token may also be at ypeAELi st descriptor, in which case it is
an AEDescLi st . The Apple Event Manager’s Object Support Library
automatically forms a list of tokens as the result of a query with a
test; certain AEQbj ect accessors may also return lists of tokens.
Lists of tokens are preprocessed by the Generi cResul t Handl er
and Generi cNoResul t Handl er functions, which break down
events directed to multiple objects into multiple events, each
directed to a single object. Generi cResul t Handl er also collects
results from such events into result lists. In most cases, your
application objects do not need to deal with token lists.
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GetlnsertionLoc
voi d GetlnsertionLoc (Bool ean | ocRequi red,

AEDesc *| ocToken, DescType *thed ass);
Returns in | ocToken the resolved token value of the insertion loc
parameter of the event, and *t heCl ass to the element class of the
insertion. Fails if there are no insertion loc or element class
parameters. To handle events in which the insertion loc is not a
required parameter, use Get Opt i onal Par anmDesc to obtain a
descriptor of it.

The insertion loc is cached by the event and should not be disposed
of by the caller. Subsequent calls to Get | nserti onLoc return the
same value with no further overhead.

DescListToArray

CArray *DesclLi st ToOArray(const AEDesc *descli st,
DescType itenlype, Size itenSize);

Converts a descriptor of t ypeAELi st to a CArray whose contents

are the items of the list. The items must be of uniform type and size.

If the list has no items it returns an empty array. It fails if any error is

encountered.

FailMoreRequiredParams

voi d Fai | Mor eRequi r edPar ans() ;

Fails if the event contains required parameters that have not yet been
read by the handler.

InteractionPermitted
Bool ean I nteractionPermtted(Bool ean required);

r equi r ed is TRUE if the operation cannot be performed

without user interaction (for example, in a dialog requesting the user
to specify a file name), or FALSE if the interaction is optional

(for example, in a dialog requesting the user to confirm a

save). Returns TRUE for any interaction if the event specifies

kAEAl waysl nt er act , TRUE for required interactions if the event
specifies KAECanl nt er act , and FALSE otherwise.

Objects should not call this function directly, but should call the
application’s Request | nt er act i on function instead.
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GetCurrentEvent
static CAppl eEvent *Get Current Event();

Returns a pointer to the Appl eEvent currently being handled.

GetOptionalParamDesc
Bool ean Get Opti onal Par anDesc(
AEKeywor d t heKeyword, DescType desiredType,
AEDesc *result);
Returns in r esul t a descriptor of an optional event parameter.
t heKeywor d is the parameter keyword. desi r edType is the
parameter type; specify t ype AEW | dCar d if the parameter can
have more than one type. The function returns TRUE if the
requested parameter is present in the event, and FALSE if not.

The function fails if any error other than er r AEDescNot Found is
returned by the Apple Event Manager.

GetOptionalParamPtr
Bool ean Get Opti onal Par anPtr (

AEKeywor d t heKeyword, DescType desiredType,

Si ze requestedSi ze, void *data);
Returns in dat a the value of an optional event parameter.
t heKeywor d is the parameter keyword. desi r edType is the
parameter type; specify t ype AEW | dCar d if the parameter can
have more than one type. r equest edSi ze is the expected size of
the value. The function returns TRUE if the requested parameter is
present in the event, and FALSE if not.

The function fails if the size of the parameter data is not the
requested size or if any error other than er r AEDescNot Found
is returned by the Apple Event Manager.

GetRequiredParamDesc
voi d Get Requi r edPar anDesc(
AEKeywor d t heKeyword, DescType desiredType,
AEDesc *result);
Returns in r esul t a descriptor of a required event parameter.
t heKeywor d is the parameter keyword. desi r edType is the
parameter type; specify t ype AEW | dCar d if the parameter can
have more than one type. The function returns TRUE if the
requested parameter is present in the event, and FALSE if not.
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The function fails if any error other than er r AEDescNot Found is
returned by the Apple Event Manager.

GetRequiredParamPtr
voi d Get Requi redPar anPt r (

AEKeywor d t heKeyword, DescType desiredType,

Si ze requestedSi ze, void *data);
Returns in dat a the value of a required event parameter.
t heKeywor d is the parameter keyword. desi r edType is the
parameter type; specify t ype AEW | dCar d if the parameter can
have more than one type. r equest edSi ze is the expected size of
the value.

The function fails if the size of the parameter data is not the
requested size or if any error other than er r AEDescNot Found
is returned by the Apple Event Manager.

GetAttributeDesc

void Get Attri buteDesc(AEKeyword t heKeyword,
DescType desiredType, AEDesc *result);

Returns in r esul t a descriptor of an event attribute. t heKeywor d

is the attribute keyword. desi r edType is the attribute type.

The function fails if the attribute is not found or cannot be coerced
to the requested type.

GetAttributePtr
voi d CGetAttributePtr( AEKeyword t heKeyword,
DescType desiredType, Size requestedSize,
void *data);
Returns in dat a the value of an event attribute. t heKeywor d is the
attribute keyword. desi r edType is the attribute type.
r equest edSi ze is the expected size of the returned data.

The function fails if the attribute data is not of the requested size, is
not found, or cannot be coerced to the requested type.

GetEventClass
DescType Get Eventd ass ();

Returns the event class, for example ' aevt' . The event class and
event ID uniquely identify an Appl eEvent .
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GetEventID
DescType GetEvent|D ();

Returns the event ID, for example ' oapp' . The event class and
event ID uniquely identify an Apple event.

GetEvent
const Appl eEvent *Get Event ();

Returns a pointer to the Apple event.

GetReply
Appl eEvent *GetReply ();

Returns a pointer to the Apple event reply.

GetRefCon
| ong Get Ref Con ();

Returns the Apple event reference value for this event’s class and ID.
By default, this is always 0 in the THINK Class Library. To use other
values, override the | Swi t chboar d member function in
CSwitchboard, and change its call to AEI nst al | Event Handl er.

GetDesclList

voi d CGet DescLi st ( AEKeyword whi chParam
AEDescLi st *desclList);

Returns in descLi st the AEDescLi st associated with the

keyword whi chPar am

ExtractFromDescList
CArray *Extract FronDesclLi st (AEKeyword

whi chParam DescType itenType, Size itenSize);
Gets the descriptor list associated with the parameter whi chPar am
and puts its items into a CArray. This member function is especially
useful if all the items in the list are the same size and the data in the
list is not keyword-separated. This member function does not use
keywords.
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GotRequiredParams
Bool ean Got Requi redParans ();

Performs the recommended check to determine if all the required
parameters of an Apple event have already been extracted. You
should usually call Fai | Mor eRequi r edPar ans instead.

Requestinteraction
OSErr Requestlnteraction (long tineQutTicks);

Called to indicate that you need to interact with the user (for
example, to put up a dialog) to handle the event. If interaction is
allowed and the application is brought forward before the timeout
period has elapsed, then this member function returns noErr and
you can proceed with the interaction. If any other value is returned,
then your attempt to interact failed.

This member function calls AEI nt er act W t hUser, with

ti meQut Ti cks, an idle procedure, and a pointer to a Notification
Manager record. By default, the idle procedure calls the
switchboard’s Appl eEvent | dl e function(see Chapter 112,
“CSwitchboard”). To use a different idle procedure, assign it to the

i dl epr oc instance data member. Also, the Notification Manager
record pointer is NULL by default, so AEI nt er act Wt hUser
supplies its own default record. To use your own record, assign it to
the noti fi cati onRec instance data member.

Obijects should not call this function directly, but should call
CAppl i cation:: Request | nteracti on instead.

Member Functions: Private

CAppleEventX
voi d CAppl eEvent X();

Performs common initialization.
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Introduction

CAppleEventObject implements the behavior required of the Apple
event Object Model cObject class. See the Apple Event Registry for an
explanation of the Object Model and the cObject class.

Heritage

Base Class None
Derived Classes CApplication
CClipboard
CDocument
CProperty
Cwindow
CFileElement
Your own Object Model classes

Using CAppleEventObject

CAppleEventObject can be used as a mixin or as a base class.
Usually, CAppleEventObiject is used as a mixin for classes that
directly correspond to classes in the Object Model, as CApplication
corresponds to cApplication or CDocument to cDocument.
CAppleEventObject is used as the base class for classes that would
not exist in the TCL were it not for Apple events, such as CProperty.

CAppleEventObject contains pure virtual functions for the basic
operations of an Apple event handler and object accessor. See Inside
Macintosh: Interapplication Communication for a complete
description of these operations.

Event handlers

Each CAppleEventObject object acts as a handler for events directed
to that object. An event is directed to an object if the object is
specified as the direct object or insertion loc parameter of the event,
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or if the object is implied by the event. For example: your current
selection is implied by the Cut event from the Miscellaneous suite.

For most events, the handler that the Apple Event Manager is one of
the generic handler functions defined by CAppleEventObject. The
generic handler functions resolve object specifiers and identify the
CAppleEventObject class objects that ultimately handle the event.
They also gather results into a result list. To act as an event handler,
a CAppleEventObiject derived class must override the following pure
virtual member functions:

Member function Override needs to...

DoAppl eEvent Handles the event and, if
necessary, return a result.
Usually, DoAppl eEvent calls
a specific member function
for each event, for instance,
Handl eCet Dat a.

Get Cont ai ner Returns a pointer to the
CAppleEventObiject class
object that contains this
object.

Getd asslI D Returns the AEDescType for
the class of the Apple event
object, for example,
cDocument.

Get Def aul t Type Returns the AEDescType for
the default type of data
returned by a Get Data event
directed to the object.

MakeSel f Descri pt or Returns an Apple event
descriptor and key that
describe this object.

Every object returns some sort of data. Objects such as documents
simply return an object specifier that can be used to target the
document; objects such as text paragraphs return the text. Therefore,
most CAppleEventObject derived classes will override

DoCet Dat aEvent .
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Almost all Apple event objects have properties and will need to
override the following functions to allow accessing and changing
property data:

Member function Override needs to...

DoPropertyGet Data  Return the data for one of the
object’s properties.

DoPropertySet Data Change the data for one of the
object’s properties.

CAppleEventObject defines a number of other Do functions,
described in the section “Event handling” later in this chapter. Your
class should override each function corresponding to an event that
objects of that class handle. Events for which no Do function is
predefined can be handled by adding a case to your

DoAppl eEvent function.

Object accessors

Events that conform to the Apple event Object Model use object
specifiers to describe application objects. Object specifiers are
internal forms that might appear, for example, in AppleScript as:
title of first docunent of application "MApp".

To interpret the event correctly, your application must convert each
object specifier into a pointer to the corresponding application
object. If there is no corresponding application object, as would be
the case for the specifier above, the specifier must be converted into
a pointer to an object that represents the Apple event object while
the event is being processed.

The Apple Event Manager provides the Object Support Library (OSL)
to assist with interpreting object specifiers. When an event processes
an object specifier, the event handler calls the OSL's AEResol ve
function to convert the object specifier into a token. A token is an
Apple event data descriptor whose descr i pt or Type is the class of
the Apple event object, and whose dat aHandl e is a handle of a
four-byte location on the heap that contains a pointer to the
CAppleEventObject corresponding to the specified Apple event
object. In other words, a token descriptor is an indirect pointer to a
CAppleEventObject, packaged with type information.

Beginning with the application object, the OSL works its way from
the outermost container in the specifier to the innermost element or
property (in the text form of the specifier, this would be from right to
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left). It uses the AccessOhj ect function to ask the
CAppleEventObject container at each level of the specifier to return
a token representing the next most specific object, until the specifier
is fully resolved. The specifiertitl e of the first docunent
of application "M/App" OSL would first ask the CApplication
object to return a token designating the “first document” object.
Then the OSL would ask the CDocument object pointed to by that
token to return a token designating the title of the document. This
second token would point to a CProperty object. This completely
resolves the object specifier.

As each new token is returned, the OSL automatically frees the
memory occupied by the previous token’s Apple event descriptor.
This releases the dat aHandl e memory, but has no effect on the
CAppleEventObject class object pointed to indirectly by the

dat aHandl e. All temporary Apple event objects created during the
course of an event are automatically deleted when the event is
finished.

As far as the OSL is concerned, a specifier is completely resolved
once AEResol ve returns a token representing the most specific
object or objects specified. The generic handler that called
AEResol ve then uses that token to hand the event over to the
objects for processing.

For the events in the Core and Miscellaneous suites, the
CAppleEventObject class contains generic handlers that perform
most of the actions described above. To act as an object accessor, a
CAppleEventObject derived class needs to override only the
following member functions:

Member function Override needs to...

Accesshj ect Returns a token designating an element
or property of the object

Count nj ect s Returns the number of elements of a

particular type in the container
Conpar eQbj ect s Returns the result of comparing the

CAppleEventObiject class object with

another object or constant data

The Accessbj ect, Count Obj ect s, and Conpar eQbj ect s
member functions work the same as the MyObj ect Accessor,
My Count Obj ect s, and MyConpar ehj ect s callback functions
described in Inside Macintosh: Interapplication Communication.
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Data Members

Static data members

CAppleEventObject defines the following public static data member:

Data member Type
nul | Desc AEDesc

Any class that needs a null descriptor value

Protected data members

The following data members are protected:

Data member Type
| astEl enentI D static |ong

head static
CAppl eEvent

oj ect *
cal | backFl ags static short

st ack static

CAppl eEvent
oj ect *[]

stackTop static short

Description
Null descriptor

can use nul | Desc.

Description

Used for generating
unique IDs

Head of list of
CAppleEventObijects
(The Type must be
entered with no
breaks)

Flags used to call
AEResolve

Stack of
CAppleEventObijects
used by each active
Apple event (The
Type must be entered
with no breaks)

Top of event stack

The stack depth, set by the TCL_EVENTSTACKTOP preprocessor
variable defined in CAppl eEvent Obj ect . h, determines the
number of events that can be active at once. The default value is 3.

Object data members

The following data members are protected:

Data member Type
el enentI D |ong

Description
The object’s unique
ID

next CAppl eEvent Obj ect * Next in the list of

CAppleEventObjects
used by active events
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Data member Type Description

prev CAppl eEvent Obj ect * Previous in the list of
CAppleEventObjects

di sposabl e Bool ean TRUE if the object is

automatically
deleted at the end of
the event that
created it

Symbols
CAppl eEvent Obj ect . h defines a preprocessor variable for a
property not in the Apple event registry:

Symbol Value Description

pPosition ' ppos' The upper-left
corner of the
object’s pBounds
rectangle

Member Functions

Creation and destruction

CAppleEventObject
CAppl eEvent bj ect (Bool ean i sDi sposabl e);

Constructor. If i sDi sposabl e is TRUE, the CAppleEventObiject is
deleted when the currently active event terminates. i sDi sposabl e
should be set to FALSE when CAppleEventObject is a mixin to
existing application classes, and to TRUE for classes that are used
only during an active event.

~CAppleEventObject
~CAppl eEvent Obj ect ();

Destructor. Removes object from the list of objects associated with
the currently active event.

Token memory management

DeleteObject
voi d Del eteQbject ();

Deletes the Apple event object if it is disposable. During object

specifier resolution, some event objects are created dynamically to
serve as tokens. These objects are automatically deleted when the
event is completely processed, as described in EndEvent later in
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this chapter. Usually, only a small amount of memory is occupied by
tokens that might be deleted earlier than the end of the event.
However, your program can delete Apple event objects sooner, by
calling Del et eObj ect . You should not call oper at or del ete
directly for an Apple event object used as a token, because it may be
needed after the event is complete—as are, for instance, the
CApplication and CDocument objects.

Event handling

DoAppleEvent
voi d DoAppl eEvent (CAppl eEvent *theEvent,

AEDesc *result);
Processes an Apple event. Returns the result of the event, if any, in
the r esul t descriptor. Usually, an object's DoAppl eEvent
function consists of switch statements that identify the event by class
and ID, then call another member function (for example,
DoGet Dat aEvent for the Get Data event) to actually do the work.
DoAppl eEvent is a pure virtual function and must be overridden.

Note
In previous versions of the THINK Class Library, the
only argument of DoAppl eEvent was t heEvent .
The additional r esul t argument is needed to
efficiently handle events that address multiple
objects and return multiple results, as explained
below.

Overriding implementations of DoAppl eEvent usually pass back
the result to be returned as the event’s reply in the resul t
descriptor, rather than stuffing it directly into the r epl y Apple event
descriptor within t heEvent . This lets the

Generi cResul t Handl er collect results from multi-object events
into a list. Otherwise, each application object would have to loop
through token lists for any event that might specify more than one
direct object.

Your DoAppl eEvent override function should deal with each event
it recognizes and call CAppl eEvent Qbj ect : : DoAppl eEvent (or
the base class’s function, if your class is not directly derived from
CAppleEventObject) to handle events that can be done in a general-
purpose way. If neither your override nor CAppleEventObject’s
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DoAppl eEvent member function handles an event, the event fails
with an er r AEEvent Not Handl ed error code.

CAppleEventObject’'s DoAppl eEvent member function contains
cases for events that can be handled in the same way by all objects,
such as the Count El ement s and Get Dat aSi ze events. If you do
not like CAppleEventObiject’s way of dealing with an event, add a
case for it in your own DoAppl eEvent function.
CAppleEventObject also contains code to call specific “Do” functions
for events that many objects recognize. This saves duplicating the
dispatching code in each derived class. These functions are
described below.

DoCloneEvent
voi d DoC oneEvent (CAppl eEvent *theEvent,

AEDesc *result);
Handles the Clone event from the Core suite. The default function
fails. If your derived class handles the Clone event, you should
override this function.

DoCountElementsEvent
voi d DoCount El enent sEvent (

CAppl eEvent *theEvent, AEDesc *result);
Handles the Count Elements event from the Core suite. The default
function calls the Count Cbj ect s member function of the event’s
direct object.

DoCreateElementEvent
voi d DoCr eat eEl enent Event (

CAppl eEvent *theEvent, AEDesc *result);
Handles the Create Element event from the Core suite. The default
function fails. If your derived class handles the Create Element event,
you should override this function.

DoDeleteEvent
voi d DoDel et eEvent ( CAppl eEvent *theEvent,

AEDesc *result);
Handles the Delete event from the Core suite. The default function
fails. If your derived class handles the Delete event, you should
override this function.
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DoGetDataEvent
voi d DoGet Dat aEvent ( CAppl eEvent *t heEvent,

AEDesc *result);
Handles the Get Data event from the Core suite. The default function
calls MakeSel f Speci fi er. If your derived class handles the Get
Data event, you should override this function.

DoGetDataSizeEvent

voi d DoGet Dat aSi zeEvent ( CAppl eEvent *t heEvent,
AEDesc *result);

Handles the Get Data Size event from the Core suite. The default

function calls DoGet Dat aEvent, gets the size of the returned data,

then disposes the data.

DoMoveEvent
voi d DoMoveEvent ( CAppl eEvent *t heEvent,

AEDesc *result);
Handles the Move event from the Core suite. The default function
fails. If your derived class handles the Move event, you should
override this function.

DoSetDataEvent
voi d DoSet Dat aEvent ( CAppl eEvent *t heEvent,

AEDesc *result);
Handles the Set Data event from the Core suite. The default function
fails. If your derived class handles the Set Data event, you should
override this function.

DoCutEvent
voi d DoCut Event ( CAppl eEvent *theEvent,

AEDesc *result);
Handles the Cut event from the Miscellaneous suite. The default
function fails. If your derived class handles the Cut event, you should
override this function.

DoCopyEvent
voi d DoCopyEvent ( CAppl eEvent *t heEvent,

AEDesc *result);
Handles the Copy event from the Miscellaneous suite. The default
function fails. If your derived class handles the Copy event, you
should override this function.
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DoPasteEvent
voi d DoPast eEvent ( CAppl eEvent *theEvent,

AEDesc *result);
Handles the Paste event from the Miscellaneous suite. The default
function fails. If your derived class handles the Paste event, you
should override this function.

DolsUniformEvent

voi d Dol sUni f or nEvent ( CAppl eEvent *t heEvent,
AEDesc *result);

Handles the Is Uniform event from the Miscellaneous suite. The

default function fails. If your derived class handles the Is Uniform

event, you should override this function.

DoPropertyGetDataEvent
voi d DoPropertyGet Dat aEvent (DescType property,
const AEDesc *requestedType,
AEDesc *dat a);
This function acts on a Get Data event for a property of the object
and returns the value of the property in the dat a argument. Any
object class that has properties must override this function.
request edType is a descriptor or at ypeAELi st list of
descriptors containing the desired type of the returned data.

When an object specifier for a property is resolved in your
AccessOhj ect function, the usual technique is to allocate a
CProperty object that identifies the property and contains a pointer
to the object containing the property. Then, for a Get Data event, the
property-containing object’s DoPr oper t yGet Dat aEvent function
is called by the CProperty object. Set Data events are handled
similarly. Since most events directed to properties are Get Data or Set
Data, this approach handles most events without requiring that a
separate CAppleEventObiject derived class be defined for each type
of property.

The default member function handles the pBest Type,

pDef aul t Type, pNane, pl ndex, pl D, and pd ass
properties, and fails for any other properties. Your

DoPr opert yGet Dat aEvent function should always call its
base class’s DoPr oper t yGet Dat aEvent function for any
properties it does not recognize.
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DoPropertySetDataEvent

voi d DoPropertySet Dat aEvent (DescType property,
const AEDesc *data);

This function acts on a Set Data event for a property of the object

and stores the contents of the dat a argument into the property. Any

object class with properties that can be set must override this

function. See DoPr opert yGet Dat aEvent above for a discussion

of how property events are handled.

The default member function fails. Your

DoPr opert ySet Dat aEvent function should call its base class’s
DoPr opert ySet Dat aEvent function for any properties it does
not recognize.

BecomeSelection
voi d BeconmeSel ection ();

When an object’s pSel ect i on property receives a Set Data event, it
should resolve the object specifier data to a token and call the token
object’s BeconeSel ect i on function.

Object information

GetSelection
CAppl eEvent Obj ect *CGet Sel ection ();

This member function returns a pointer to the Apple event object
corresponding to the current selection relative to the called object.

The gGopher global pointer plays no role in identifying the current
selection; the pointer is incorrect if the application is in the
background. In any case, there is no guarantee that the class of the
object pointed to by gGopher is derived from CAppleEventObject—
for example, CDialogText is not. Each open window or document
may have its own current selection, which corresponds to the
gopher only for the active window.

The default function returns NULL. Classes that can contain the
current selection must override this function. A returned NULL value
indicates that the object has no current selection or that the selection
is incapable of responding to an event.

CAppleEventObject’'s Gener i cGopher Handl er function, which
resolves gopher-specific events such as Cut or Paste, calls the
application’s Get Sel ect i on member function. If the application
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returns NULL, the event fails; otherwise, the handler calls the
selection’s DoAppl eEvent function.

CApplication overrides Get Sel ecti on. If there are no open
documents, it returns NULL; otherwise, it returns the result of calling
the active document’s Get Sel ect i on member function. (If the
application is in the background, the active document is the
document that would be active if the application were in the
foreground.)

CDocument does not override Get Sel ect i on. Your document-
derived class must override it, usually to return the result of calling
Get Sel ect i on for the next-most-specific container. For example,
for a text document, your document class would likely call the

Get Sel ect i on member function of i t sMai nPane.

GetContainer
CAppl eEvent Obj ect *Get Contai ner ();

Returns a pointer to the Apple event object that contains this object.
This is a pure virtual function; all derived classes must override it.

GetClassID
DescType Getd assID ();

Returns the Apple event Object Model class of this object. This is a
pure virtual function; all derived classes must override it.

GetDefaultType
DescType Get Def aul t Type ();

Returns the default type of data returned by a Get Data event
directed to this object. This is a pure virtual function; all derived
classes must override it.

GetBestType
DescType Get Best Type ();

Returns the type of data returned by a Get Data event directed to this
object that most faithfully represents the object. The default function
returns the result of calling Get Def aul t Type.
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GetElementID

|l ong GetElenentID ();

Every CAppleEventObject has a unique | ong value for any single
run of the application. This value serves as the ID of an Apple event
object.

GetElementindex
| ong Cet El enent | ndex ();

Returns the index of the element in its container.

GetElementName
voi d Get El enent Nane (Str255 nane);

Returns the element’s name in namne. The default function fails.
Element classes must override this function; properties need not.

GetElementNameDesc
voi d Get El enent NanmeDesc ( AEDesc *naneDesc);

Returns in naneDesc the name of the element as a t ypeChar
descriptor. The default function calls Get El errent Nane.

Accessors

AccessObject
voi d Accessbj ect (DescType desiredd ass,

const AEDesc *cont ai ner Token,

DescType contai nerd ass, DescType keyForm

const AEDesc *keyData, AEDesc *theToken,

| ong t heRefcon);
AccessObj ect returns a token representing the requested property
or element. The object that gets the AccessObj ect call is always
pointed to by the cont ai ner Token argument. The arguments are
the same as for the object accessor callback function described in
Inside Macintosh: Interapplication Communication.

AccessSelection
voi d AccessSel ecti on(DescType desiredd ass,
const AEDesc *contai ner Token,
DescType contai nerd ass, DescType keyForm
const AEDesc *keyData, AEDesc *theToken,
| ong theRefcon);
This function calls Get Sel ect i on to obtain the current selection. If
there is a current selection, its AccessObj ect function is called.
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GetElementByName

voi d Get El enent ByNane (DescType desiredd ass,
Str255 nanme, AEDesc *token);

Returns a t oken for the element in the container with the specified

nane. desi r edd ass tells what kind of element to locate. The

default function loops through the container, calling

Get El enrent Byl ndex and Get El enrent Nane until it finds the first

element with the same name; it fails if it does not find such an

element.

GetElementBylndex
voi d Cet El enent Byl ndex (DescType desiredd ass,

| ong i ndex, AEDesc *token);
Returns a t oken for the element in the container with the specified
i ndex. desi r edd ass tells what kind of element to locate. The
default function fails; container classes must override this function.

GetElementByID
voi d Cet El enent Byl D (DescType desiredd ass,

Il ong 1 D, AEDesc *token);
Returns a t oken for the element in the container with the specified
I D. desi redd ass tells what kind of element to locate. The
default function loops through the container, calling
Get El ement Byl ndex and Cet El enment | D until it finds the
element; it fails if the element is not found.

CountObijects
voi d Count Obj ect s(DescType desiredd ass,

I ong *result);
Count Qbj ect s returns in r esul t the number of elements of the
desi redd ass in the container whose Count Cbj ect s function is
called. Every container class must override this function.

The Object Support Library calls this function while resolving object
specifiers that contain tests.
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CompareObjects
voi d Conparehj ect s(DescType conpari sonQper at or,
const AEDesc *tokenOrLiteral,
Bool ean i sToken, Bool ean *result);
Conpar e(bj ect s compares the value of the called object to that of
the t okenOr Li t er al argument; it returns TRUE if the values are
equal, FALSE if they are not. If i sToken is TRUE,
t okenOr Li t eral must be a token; otherwise, t okenOr Li t er al
must be literal data. Every element class must override this function.

Conpar eQbj ect s is called by the Object Support Library while
resolving object specifiers containing tests.

EqualObject
Bool ean Equal Obj ect ( CAppl eEvent OCbj ect *otherPtr);

Compare t hi s to another object pointer. The default function just
compares the pointers. This function may be overridden so that
tokens which are not identically equal can to be treated as if they are
the same.

Marking

Marking functions are only called by the OSL if your application calls
Resol ve (or AEResol ve) with a KAEI DoMar ki ng callback flag.
Resol ve uses the value of the cal | backFl ags static data
member, which is initially set to KAElI DoM ni num(no marking). If
objects in your application use mark tokens, call

Set Cal | backFl ags with a value of kAElI DoMar ki ng.

When the OSL collects multiple tokens into a list, it stuffs them in a
t ypeAELi st descriptor. The list representing, for example, every
word in a long document can be much larger than the original
document. Mark tokens let the application choose its own
representation for lists of tokens. The name mark tokens comes from
the idea that the original application objects might be marked in
some way to indicate they are members of a token list. However, any
implementation will do. In particular, CRunArray class objects make
good mark tokens for elements, such as text, that are easily
identified by integer offsets.

GetMarkToken
voi d Get MarkToken (AEDesc *result);

Returns a mark token as the r esul t .
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If a particular object cannot mark, it simply returns

er r AEEvent Not Handl ed; the OSL will then collect tokens from
this container in a t ypeAELi st descriptor, just as if marking were
not enabled.The default Get Mar kToken function returns

er r AEEvent Not Handl ed.

MarkObiject
voi d MarkQbj ect (const AEDesc *t heToken,

| ong mar kCount) ;
A mark token’s Mar kObj ect function is called by the OSL to add
t heToken to the list represented by the mark token. The
mar kCount is the index of the value in the mark token. Mark
counts start at 1 and increase by 1 each time Mar kQbj ect is called
for a particular mark token. The count need not be explicitly stored
in the mark token.

AdjustMarks
voi d Adj ust Marks(long newStart, |ong newsStop);

When the OSL needs to reduce the number of elements in the list
represented by the mark token, it calls Adj ust Mar ks, specifying
the range of elements that are to remain in the list; all others are
discarded. Adj ust Mar ks is called only once for a given mark
token.

Creating object specifiers

MakeSelfSpecifier
voi d MakeSel f Speci fier (AEDesc *specifier);

This function calls MakeSel f Descri pt or and the container’s
MakeSel f Speci fi er to construct an object specifier representing
the called object. Only the application class needs to override this
function.

MakeSelfDescriptor
voi d MakeSel f Descri ptor (DescType *keyForm

AEDesc *keyDat a) ;
MakeSel f Descri pt or returns the keyFor mand keyDat a
uniquely identifying this object within its container. There are usually
several ways to identify an object; the values returned should be
chosen so the object can be located most quickly. For elements kept
in CPtrArray lists by the container, MakeSel f Descri pt or usually
returns a keyFor mof f or mAbsol ut ePosi ti on and a keyDat a
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descriptor of t ypeLongl nt eger containing the index of the object
in the container’s list.

This function is pure virtual; all derived classes must override it.

Tokens

MakeToken
voi d MakeToken (AEDesc *token);

Returns a t oken descriptor pointing to this object. The token’s
descri pt or Type is the value returned by Get Cl assl D.

DisposeToken
static void DisposeToken (AEDesc *token);
Gets rid of a token and its associated storage. The dat aHandl e

storage is released. If the token points to a disposable object, the
object is deleted.

Note
It is dangerous to call Di sposeToken if there can
be more than one pointer to the object the argument
token points to. For example, do not call
Di sposeToken on tokens packed into an
AEDesclLi st ; if you do, when they are unpacked
they will point to objects which have been deleted.
Instead, call AEDi sposeDesc or TCLFor get Desc.
Other than to conserve intermediate storage, you
never actually need to call Di sposeToken; all
disposable tokens created during an event are
deleted when the event is completed.

TokenToPtr
static CAppl eEvent Obj ect *TokenToPtr (

const AEDesc *token);
Returns a pointer to the object the token points to. The token must
be atypeNul | application token or have been created by a call to
MakeToken; it must not be a t ypeAELi st token.

IsListToken
static Bool ean |sListToken (const AEDesc *token);

Returns TRUE if the token has t ypeAELi st .

Visual Architect and THINK Class Library Guide 315



16 CAppleEventObject

IsMarkToken

static Bool ean | svarkToken (const AEDesc *token);
Returns TRUE if the token is a mark token. Returns FALSE if the
token is a list or if the token object’s | sMar kCbj ect function
returns FALSE.

IsMarkObject
Bool ean | sMarkQoj ect ();

Member function returns TRUE if the object is a mark token. The
default function returns FALSE. Mark token objects must override.

Factoring

SendEventToThis
voi d SendEvent ToThi s (DescType event d ass,
DescType event| D, Bool ean direct oject,
| ong sendhMbde);
Creates and sends a simple event to this application. event C ass
and event | D identify the event. The value of sendMbde is OR’ed
with kAENoRepl y and KAEAI waysl nt er act to yield the mode
used to send the event. If di rect Cbj ect is TRUE, add a
keyAEDi r ect Obj ect specifying this object.

MakeEventToThis
voi d MakeEvent ToThi s (DescType event d ass,
DescType event| D, Bool ean direct ject,
Appl eEvent *event);
Creates an event to be sent to this application. event Cl ass and
event | Didentify the event. If di r ect Obj ect is TRUE, add a
keyAEDi r ect Obj ect specifying this object.

SendEventNoReply
voi d SendEvent NoReply (
const Appl eEvent *event,
| ong sendhbde);
Sends the event with KAENor mal Priority and
kAEDef aul t Ti neout . sendMode is OR’ed with KAENoRepl y to
yield the mode used to send the event.
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SendCreateElementToThis
voi d SendCreat eEl enent ToThi s (

DescType el enent d ass);
Sends a Create Element event to this application specifying this
object as the keyl nsert Her e parameter and the el ement Cl ass
as the keyAEQbj ect Cl ass parameter.

SendSetPropertyToThis
voi d SendSet PropertyToThis (

DescType property,

DescType typeCode, void *dataPtr,

Si ze dataSi ze, | ong sendMode);
Sends a Set Data event to this object’s specified property. t ypeCode
is the type of data to be sent, dat aPt r points to the data, and
dat aSi ze is its length in bytes. sendMode is treated as described
in SendEvent ToThi s earlier in this chapter.

Static utility functions

The utility functions are THINK Class Library versions of Apple Event
Manager functions commonly used by handlers and accessors. Utility
functions throw appropriate exceptions if an Apple Event Manager
function returns a non-zero error code or if data of incorrect type is
encountered.

GetProperty
static DescType CetProperty(
const AEDesc *propDesc);
Returns the property ID (for example, pNane) from the pr opDesc
descriptor.

CreateDesc
static void CreateDesc(DescType typeCode,

void *dataPtr, Size dataSi ze,

AEDesc *result);
Creates a r esul t descriptor with its descri pt or Type set to
t ypeCode and its dat aHandl e set to the value of dat aPtr,
which is dat aSi ze bytes long.
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CreateLongDesc
static void CreatelLongDesc (DescType typeCode,
| ong data, AEDesc *result);
Creates a r esul t descriptor with t ypeCode as its descriptor type
and | ong (4-byte) data.

CreateBooleanDesc

static void CreateBool eanDesc (Bool ean dat a,
AEDesc *result);

Creates a r esul t descriptor with t ypeBool ean descriptor type

and Bool ean (1-byte) data.

CoerceDesclList
stati c Bool ean CoerceDesclLi st (

const AEDesc *toTypes, AEDesc *desc);
Coerces the desc argument to one of the types in the listt oTypes,
which are in priority order. t oTypes may also contain a single
t ypeType descriptor. Returns TRUE if the resulting desc satisfies at
least one of the types in the list.

Unlike AECoer ceDesc, Coer ceDescLi st does not always make
a copy of the coerced descriptor. If desc already satisfies t oTypes,
it is returned unchanged. Otherwise, the original desc is disposed
and a new desc of the desired type is created.

CoerceDesc
static void CoerceDesc (DescType toType,

AEDesc *desc);
Coerces desc to the desired t oType. Unlike AECoer ceDesc,
Coer ceDesc does not always make a copy of the coerced
descriptor. If desc is already of type t oType, it is returned
unchanged. Otherwise, the original desc is disposed and a new
desc of the desired type is created. Throws an exception with an
error code of er r AECoer ci onFai | ed if coercion fails.

MayCoerceDesc

static OSErr MayCoerceDesc (DescType toType,
AEDesc *desc);

Same as Coer ceDesc, except MayCoer ceDesc returns an error
code instead of throwing an exception if coercion fails.
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GetDescData

static void GetDescData (const AEDesc *desc,
void *data, Size dataSize);

Extracts the dat a from the desc descriptor. The descriptor’s

dat aHandl e must hold exactly dat aSi ze bytes; if not, an

exception is thrown with an er r AECor r upt Dat a error code.

GetDescString

static void GetDescString (const AEDesc *desc,
unsi gned char *str, Size nmaxSize);

Returns the value of the desc descriptor in str as a Pascal string

of no more than maxSi ze bytes.

GetDescStr
static void GetDescStr (const AEDesc *desc,
char *str, Size maxSize);
Returns the value of the desc descriptor in st r as a C string of no
more than maxSi ze bytes.

GetDescLong
static | ong Get DescLong (const AEDesc *desc);

Returns the | ong value of the desc descriptor. The dat aHandl e
must be exactly 4 bytes long.

GetDescBoolean
static Bool ean Get DescBool ean (

const AEDesc *desc);
Returns the Bool ean value of the desc descriptor. The
descri pt or Type must be t ypeBool ean, t ypeTr ue, or
typeFal se.

GetDescRect

static void GetDescRect (const AEDesc *desc,
Rect *rect);

Returns the r ect value of the desc descriptor. The
descri pt or Type must be coerceable to t ypeQDRect .
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GetDescPoint

static void GetDescPoint (const AEDesc *desc,
Poi nt *pt);

Returns the pt value of the desc descriptor. The

descri pt or Type must be coerceable to t ypeQDPoi nt .

CreateList
static void Createlist (AEDescList *list);

Returns an empty descriptor list.

AppendDesc

static void AppendDesc (AEDescList *list,
const AEDesc *iten);

Appends the i t emdescriptor to the | i st.

Countltems

static void Countltens (const AEDesclList *list,
| ong *count);

Returns in count the number of elements in the | i st .

GetNthDesc

static void Get Nt hDesc (const AEDesclList *list,
| ong i ndex, DescType type, AEDesc *result);

Returns the descriptor at the i ndex location in the | i st as the

value of r esul t . If the descriptor cannot be coerced to t ype,

Get Nt hDesc fails.

ApplyDesc

static void ApplyDesc (const AEDescList *Ilist,
TCLAppl yDescFun fun, void *param;

Calls the function f un once for each element in the | i st with the

element descriptor as its first argument and par amas its second

argument. The function is declared as:

typedef void (*TCLAppl yDescFun) (
const AEDesc *desc, void *paran);
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MapDesc
static void MapDesc (const AEDescList *Ilist,
TCLMapDescFun fun, void *param
AEDesc *result);
Calls the function f un once for each element in the | i st with the
element descriptor as its first argument and par amas its second
argument. f un must return a result as its third argument for each
element in the list. The results are collected into a list and returned
by MapDesc as the value of resul t.

The function is declared as:
typedef void (*TCLMapDescFun) (

const AEDesc *desc, void *param
AEDesc *result);

SumDesc
static void SunDesc (const AEDescList *list,
TCLMapDescFun fun, void *param
AEDesc *result);
Calls the function f un once for each element in the | i st with the
element descriptor as its first argument and par amas its second
argument. f un must return a t ypeLongl nt eger descriptor result
as its third argument for each element in the list. The results are
collected into a list and returned by SunmDesc as the
t ypeLongl nt eger descriptor value of resul t.

Generic handling

The generic handler functions are called directly by the Apple Event
Manager based on the event ID and class, as set up in CSwitchboard
by the | nst al | Event Handl er s function.

The arguments to the generic handler functions are:

Argument Description
t heEvent The incoming event.
t heReply An Apple event descriptor used to hold

the result of the event or the error code
and message, if any.

ref Con A long value associated with the event
class and ID set by the application when
it calls AEl nst al | Event Handl er.
The THINK Class Library sets all
r ef Cons to O.
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All generic handlers package t heEvent, t heRepl y and r ef Con
as a CAppleEvent object, and call some CAppleEventObject’s
DoAppl eEvent function.

GenericAppHandler

static pascal OSErr GenericAppHandler (
const Appl eEvent *theEvent,
Appl eEvent *theReply, |ong refCon);

Calls gAppl i cati on’s DoAppl eEvent function.

GenericResultHandler
static pascal OSErr GenericResul t Handl er (

const Appl eEvent *theEvent,

Appl eEvent *theReply, |ong refCon);
This function resolves the event's keyDi r ect Obj ect parameter to
obtain the target object, then calls its DoAppl eEvent function
directly. The result returned by DoAppl eEvent is stored in the
reply as the value of the reply’s keyAEResul t parameter.

If keyDi r ect Obj ect specifies a list of objects, each object is sent
the event in turn and the function calls MapDesc to collect the
multiple results returned by DoAppl eEvent .

GenericNoResultHandler
static pascal OSErr GenericNoResul t Handl er (

const Appl eEvent *theEvent,

Appl eEvent *theReply, |ong refCon);
Same as Gener i cResul t Handl er, except that
Generi cNoResul t Handl er is called for events that do not return
a result. Consequently, Appl yDesc is called for events with
multiple objects instead of MapDesc.

GenericGopherHandler

static pascal OSErr GenericGopherHandl er (
const Appl eEvent *theEvent,
Appl eEvent *theReply, |ong refCon);

Calls the DoAppl eEvent function for the application’s current user
selection.
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GenericHandler

static pascal OSErr GenericHandl er (
const Appl eEvent *theEvent,
Appl eEvent *theReply, |ong refCon,
Generi cDi spat cher Function fun);

Internal function used to perform common operations for the
generic handlers.

GenericlnsertionHandler

static pascal OSErr GenericlnsertionHandl er (
const Appl eEvent *theEvent,
Appl eEvent *theReply, |ong refCon);

Calls the DoAppl eEvent function of the object specifed as the
keyAEl nsert Her e parameter.

Object specifier resolution

Resolve
static void Resolve (
const AEDesc *object Specifier,
AEDesc *theToken);
Uses the current cal | backFl ags to call AEResol ve. Throws an
exception if AEResol ve returns a non-zero error code.

SetCallbackFlags
static short SetCall backFl ags(short flags);

Sets the value of the cal | backFl ags static data member and
returns its former value.

Object Support Library callbacks

MyAccessObject

static pascal OSErr MyAccessOhject (
DescType desiredd ass,
const AEDesc *cont ai ner Token,
DescType contai nerC ass, DescType keyForm
const AEDesc *keyData, AEDesc *theToken,
| ong theRefcon);

The object accessor callback function calls Accesshj ect for the
object pointed to by the cont ai ner Token.
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MyCountObjects
static pascal OSErr MyCount Objects (
DescType desiredType, DescType contai nerd ass,
const AEDesc *contai ner Token, long *result);
The count objects callback function calls Count Cbj ect s for the
object pointed to by the cont ai ner Token.

MyCompareObjects
static pascal OSErr MyConpareQbjects (

DescType conpari sonQOper at or,

const AEDesc *the(bject,

const AE3esc *descOr Obj, Boolean *result);
The compare objects callback function resolves the t hebj ect
object specifier and calls Conpar ebj ect s for the object pointed
to by the resulting token.

MyGetMarkToken
static pascal OSErr MyGet Mar kToken (
const AEDesc *cont ai ner Token,
DescType contai nerd ass, AEDesc *result);
The get mark token callback function calls Get Mar kToken for the
object pointed to by the cont ai ner Token.

MyMarkObiject
static pascal OSErr MyMarkQhject (
const AEDesc *theToken,
const AEDesc *mar kToken, |ong markCount);
The mark object callback function calls Mar kObj ect for the object
pointed to by the mar kToken.

MyAdjustMarks
static pascal OSErr MyAdj ust Marks (
| ong newStart, |ong newstop,
const AEDesc *markToken);
The adjust marks callback function calls Adj ust Mar ks for the
object pointed to by the mar kToken.

MyGetErrDesc

static pascal OSErr MyGet ErrDesc (
DescPtr *appDescPtr);

The get error descriptor callback function returns a pointer to the
global error descriptor.
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Member Functions: Protected

LinkObject
voi d Li nkQObj ect ();

Adds this object to the list of objects for the current event.

DelinkObject
voi d DelinkQoject ();

Removes this object from the event’s list of objects.

DestackObject
voi d DestackCbject ();

Adjusts st ackTop if object being delinked is at st ackTop.

SetDisposable
voi d Set Di sposabl e (Bool ean disp);

Sets the value of the di sposabl e data member to di sp. There are
very few reasons to modify di sposabl e once it is set by the
constructor.

IsDisposable
Bool ean |sDi sposable ();

Returns the value of the di sposabl e data member.

DoEndEvent
voi d DoEndEvent (CAppl eEvent Obj ect *marKk);

Does the work for EndEvent , popping all CAppleEventObjects
created since Begi nEvent off the stack, and calling

Del et enj ect for each of them. It is implemented as a member
function so it can see the next object in the list. mar k points to the
stack bottom.

GetDescAnyString

static void GetDescAnyString (
const AEDesc *desc, unsigned char *str,
Si ze maxSi ze, Bool ean pascal String);

Helper function called by Get DescStri ng and Get DescStr.
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BeginEvent
static void Begi nEvent ();

Called only by the CAppleEvent constructor to mark the bottom of a
stack of Apple event objects corresponding to the event.
CAppleEvent is declared a friend class so that it can access

Begi nEvent and EndEvent .

EndEvent
static void EndEvent ();

Called only by ~CAppleEvent destructor to delete all disposable
Apple event objects created since the corresponding Begi nEvent
call.
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Introduction

CAppleEventSender allows you to construct and send Apple events
to other applications and to receive and interpret replies.

A factored application should use the interfaces in
CAppleEventObject to send events to itself.

Heritage
Base Class None
Derived Classes None

Using CAppleEventSender

Each CAppleEventSender object represents a single Apple event to
be sent and an optional reply Apple event. Creating a
CAppleEventSender object automatically creates an event. Member
functions allow you to add parameters to the event and send it. If
there is a reply, additional member functions let you extract error
information or parameters from the reply. Deleting the
CAppleEventSender object disposes the output event and reply.

If you do not know the Process Serial Number (PSN) of the
application to which you want to send an event, call
CAppleEventSender’s Fi ndPr ocess static member function to find
the PSN before creating the sender. The PSN becomes an attribute of
the newly created output Apple event.

Much of the work of constructing Apple events and interpreting
replies lies in creating and decoding Apple event descriptors and
object specifiers. CAppleEventSender does not provide any functions
for these purposes. However, the CAppleEventObiject class has a
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number of static member functions you will find useful including,
among others:

Creat eDesc CGet DescString Createlist
Cr eat eLongDesc Cet DescStr AppendDesc
Cr eat eBool eanDesc Get DesclLong Count I tens
Coer ceDesc Get DescRect Get Nt hDesc
Get DescDat a CGet DescPoi nt

Table 17-1 Selected CAppleEventObject static member functions

Each of these functions corresponds to one or more Apple Event
Manager functions. Instead of returning error codes, however, the
CAppleEventObject functions throw an exception if an error code
other than noEr r is returned. Several of the functions are more
specialized and have fewer parameters than the corresponding
Apple Event Manager functions. See the CAppleEventObject chapter
for details.

Data Members

CAppleEventSender has the following protected data members:

Data member Type Description
event Desc AEDesc Output event
repl yDesc AEDesc Reply event

r epl yDesc is a null descriptor (descri pt or Type ist ypeNul )
until a reply is received.

Member Functions

All CAppleEventSender member functions throw an exception if any
operating system function returns an error code other than noErr.

Creation and destruction

CAppleEventSender
CAppl eEvent Sender (DescType event d ass,

DescType event| D, ProcessSerial Nunber *psn);
Constructor. event O ass and event | D specify the class and ID of
the newly created output event. psn is the Process Serial Number of
the application to which the event is ultimately sent.

The Process Serial Number of an application can be obtained by
calling the Fi ndPr ocess static member function.
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~CAppleEventSender
~CAppl eEvent Sender ();

Destructor. Disposes the output Apple event and, if one exists, the
reply event.

Accessing

CAppleEventSender does not mirror every Apple Event Manager
function. If you want to call one of those functions whose capability
is not provided by a member function, you can get direct access to
the output event and reply descriptors.

GetEvent
Appl eEvent *Get Event ();

Returns a pointer to the output event descriptor for use as an
argument to Apple Event Manager functions. Caller must not dispose
the event.

GetReply
const Appl eEvent *GetReply ();

Returns a pointer to the reply event descriptor for use as an
argument to Apple Event Manager functions. Caller must not dispose
the reply.

Putting event parameters

PutParamPtr
voi d Put ParanPtr (DescType key, DescType type,
voi d *param Size paranSti ze);
Adds a parameter with the specified key to the output Apple event.
t ype specifies the data type, par ampoints to the data, and
par anf5i ze specifies the length of the data in bytes. Calls
AEPut ParanPtr.

PutParamDesc

voi d Put ParanmDesc (DescType key, AEDesc *desc,
Bool ean di sposeArg);

Adds a parameter with the specified key to the output Apple event.

desc points to the data descriptor. If di sposeAr g is TRUE, the

descriptor is disposed after the parameter has been added to the

event. Calls AEPut Par anDesc.
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PutParaminsertionLoc

voi d Put Paranl nsertionLoc (AEDesc *obj Specifier,
DescType rel Pos, Bool ean di sposeArq);

Adds a keyAEl nsert Her e parameter to the output Apple event.

obj Speci fi er points to the object relative to which the insertion

is to take place; r el Pos indicates whether the location is before

(kAEBef or e) or after (KAEAf t er ) the object, or whether it is to

replace (KAERepl ace) the object. If di sposeAr g is TRUE, the

descriptor is disposed after the parameter has been added to the

event.

Sending

SendWait
| ong SendWait (long tinmeQutlnTicks,

AESendMbde fl ags);
Sends the output event to the target application and waits for a reply,
returning the value of the keyEr r or Nunber parameter from the
reply, or zero if none. ti meQut | nTi cks specifies how long the
function will wait before returning. The send mode f | ags are
OR’ed with KAEWAI t Repl y and used as an argument to AESend.

SendNoWait
voi d SendNoWait (AESendMbde fl ags);
Sends the output event to the target application and returns

immediately without waiting for a reply. The send mode f | ags are
OR’ed with kKAENoRepl y and used as an argument to AESend.

SendWaitMsg
| ong SendWait Msg (long tinmeQutlnTicks,

AESendMbde flags, short anALRT,

unsi gned char *nsgQ);
Sends the output event to the target application and waits for a reply.
ti meCQut | nTi cks specifies how long the function will wait before
returning. The send mode f | ags are OR’ed with kAEWAI t Repl y
and used as an argument to AESend.

If the reply contains a keyEr r or Nunber parameter with a non-
zero value, this function displays an alert with resource ID anALRT.
Before displaying the alert, Par amText is called setting the
substitution variables 0 through "3 to the event ID, error string
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returned in the reply, error number returned in the reply and nsg,
respectively. nsg may be NULL. After displaying the alert, this
function throws an exception with error code kSi | ent Err.

Getting reply parameters

GetErrorString
void GetErrorString (Str255 errorString);

Returns up to 255 characters of the reply event’'s keyEr ror St ri ng
parameter, or an empty string if that parameter is not present.

GetReplyParamPtr
voi d Get Repl yParanPtr (DescType key,

DescType dat aType, void *dataPtr,

Si ze dat aSi ze);
Gets a parameter with the specified key from the reply Apple event.
dat aType specifies the desired data type, dat aPt r points to the
data area to receive the data, and dat aSi ze specifies the maximum
length of the data in bytes. Calls AEGet Par anPtr.

GetReplyParamDesc
voi d Cet Repl yParamDesc (DescType key,

DescType desiredType, AEDesc *result);
Gets a parameter with the specified key from the reply Apple event.
desi r edType specifies the desired data type, r esul t points to the
descriptor to receive the data. Calls AEGet Par anDesc.

Utility

FindProcess
static OSErr Fi ndProcess(OSType typeToFi nd,
OSType creat or ToFi nd,
ProcessSeri al Nunber *psn);
Locates a process on the current machine. t ypeToFi nd is the
application type and cr eat or ToFi nd is the signature of the
process to be found. The result of the search is returned as the value
of psn.

Unlike most THINK Class Library functions, Fi ndPr ocess returns
an error code instead of failing if the error code is not noErr. It
behaves as it does because a failed search is not necessarily an
application error.
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Introduction

Every program must create a derived class of CApplication and
create only one instance of this class. The application is the highest
level in the chain of command. It is the only bureaucrat without a
supervisor.

Heritage
Base Classes CDirectorOwner
CAppleEventObject
Derived Classes None

Using CApplication

CApplication is one of the classes you must override to implement
an application with the THINK Class Library. An application usually
has one or more subordinate directors that govern the interaction
between commands and windows. The most common kind of
director is the document, which manages the interaction between a
window and a file.

The application and the chain of command

The application is the root of the chain of command. It is the only
bureaucrat without a supervisor. If the first object in the chain of
command (the bureaucrat known as the gopher, stored in the global
variable gGopher) can’t handle a command, it passes the command
to its supervisor. If no bureaucrat with a supervisor can handle the
command, it ends up with the application. If the application doesn’t
handle the command, it is ignored.

Writing the main program

Your main program must create an application object and assign it to
the global variable gAppl i cat i on. After initializing your
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application, call its Run function to get it started. Finally, call your
application’s Exi t function to give it a chance to clean up. Your
main routine should look like this:

voi d main()

gApplication = new

Cyour App( /* ctor args */);
gAppl i cati on->Run();
gApplication->Exit();

The derived class of your application must define or override these
five member functions:

Constructor (CYour App in the example)
OpenDocunent

Set UpFi | ePar anet ers

DoConmand

Cr eat eDocunent

Of course, your derived class can override additional member
functions if necessary.

Handling low-memory situations

The CApplication class provides several member functions that deal
with low-memory situations. These functions use a memory reserve
called the rainy day fund.

When you call CApplication, specify how much memory your
application should allocate for the rainy day fund. You also specify
how many bytes of that fund should be available to satisfy Toolbox
routine memory requests and how many bytes should be available to
satisfy critical operation requests. These values are stored in the data
members t ool boxBal ance and cri ti cal Bal ance.

If the Macintosh Memory Manager gets a request for more memory
than is available, it calls a grow zone function. The grow zone
function in the THINK Class Library calls the application’s

G owMenor y function.

The Gr owvenor y function tries several strategies to free memory in
the heap. First, it calls the application’s Meror yShor t age function.
Your derived class should override this function to release memory
that is not crucial to execution. For example, your
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Menor yShor t age function might release a code segment it's not
using or free a buffer it no longer needs. If the Menor yShor t age
function isn't able to release enough memory, Gr owivenor y starts
using the rainy day fund.

G owivenor y looks first at the i nCri ti cal Operati on data
member to relase memory from the rainy day fund:

If inCriticalOperation is  Leave this much in reserve
TRUE t ool boxBal ance
FALSE critical Bal ance

A critical operation is one that occurs in response to a single
Macintosh event, that might require a large amount of memory,
and that should not cause the application to crash. For example,
saving a file is a critical operation. You can use the function
SetCritical OperationtosettheinCritical Operation
flag.

If G owMenor y still isn't able to release enough memory and the
canFai | flag is TRUE, Gr owiMenor y returns without trying to
allocate any more memory. A TRUE setting for the canFai | flag
means the application can deal with a failing memory request.

If the canFai | flag is FALSE, G- owivenor y tries to release all the
memory left in the rainy day fund because the application is not
prepared to deal with a failing memory request. Without sufficient
memory, even after using the rainy day fund, it is likely that the
application will crash.

You can use the routine Set Al | ocat i on to set and reset the
canFai | flag. In general, your application should be prepared to
handle failing memory requests.

Global Variables and Data Members

The global variable gAppl i cati on points to your application
object. The CApplication constructor sets this variable.

The data members of the application class handle events, memory
shortage situations, standard file parameters, and flow of control.
Your derived class may define additional data members.
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Global variables

Variable Type Description

gAppl i cation CAppl i cati on* The single instance
of your application
object

gSystem t System A global record
with information
about the
Macintosh and
System that your
program is running
with

Static data members
Only member functions of CApplication and its derived classes
should use these static data members.

Data member Type Description
cMaxSl eepTime Static |ong default for
Wai t Next Event
Sel f PsnDesc Static AEDesc PSN for sending to
self

Event-related data members

The event data members handle the interaction between the
Macintosh Toolbox Event Manager and your application. Your
derived class should not manipulate these data members.

Data member Type Description

itsSwi tchboard CSwitchboard* Points to the event-
processing object.

i tsldl eChores CChor eLi st * Chores to perform at
idle time.

i t sUrgent Chores CChorelist* Chores to perform
after the current

event.
ur gent sToDo Bool ean TRUE if any urgent
chores are pending.
runni ng Bool ean If TRUE, the program

is still running.

336 Visual Architect and THINK Class Library Guide



Global Variables and Data Members

*

Phase-related data members
This data member tells you what phase your application is in.

Data member Type Description
phase short The phase the
application is in

These are the possible values for phase:

Value Description
applnitializing The application is initializing.
appRunni ng The application is running.
appQuitting The application is quitting.

Memory-related data members

Memory data members are used when your application is running
out of memory. The r ai nyDayFund data member specifies the
number of bytes to set aside for use when your application runs into
a critical memory situation. You specify this amount in your
application’s constructor.

Data member Type Description

r ai nyDayFund Size Bytes of memory to
set aside for critical
memory situations.

critical Bal ance Size Portion of rainy day
fund to use for
critical operations.

t ool boxBal ance Size Portion of rainy day
fund to use for
Toolbox operations
that must not fail.

tenmpAl | ocati on Size Portion of rainy day
fund that a routine
has borrowed.

r ai nyDay Handl e Handle to the reserve
memory.

r ai nyDayUsed Bool ean Has rainy day fund
been used?

memAar ni ngl ssued Bool ean Has the user been
alerted?
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Data member Type Description

canFai | Bool ean TRUE if it is OK for
memory request to
fail.

inCritical Operati on Bool ean TRUE if it is OK to
use up to

critical Bal ance

bytes from reserve.
newwW ndowOnSt artup  Bool ean TRUE if auto-new

when launched.

Standard file data members

The standard file data members are used in the ChooseFi | e
member function as parameters to the Macintosh Toolbox
SFPGet Fi | e routine. You set these data members in your
Set UpFi | ePar anmet er s member function.

Data member Type Description

sf Nunirypes short Number of file
types
recognized.

sf Fi | eTypes SFTypelLi st File types that
the application
recognizes.

sfFileFilter Fil eFilterUPP Filter for files to
display.

sf Get DLOGHook Dl gHook UPP Hook for
handling get
dialog.

sf Get DLOG d short Dialog resource
ID for get file.
Default is
getD gl D
(-4000).

sf Get DLOGFi | ter Modal Fil t er UPP Filter for get
dialog events.

appResFil e short Application
resource file.
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Editing-related data members
These data members keep track of undo and redo information for
the application.
Data member Type Description
| ast Task CTask* Last task
handled by
application.
undone Bool ean Has | ast Task

been undone?

Apple event data members
These protected data members store information on how the
application deals with Apple events.

Data member Type Description

factoring TCLFact or Choi ce  When to factor
Apple events

recordi ng Bool ean TRUE if
application is
recording

Utility data members
This protected data member keeps track of the last CDirector added
to the application.

Data member Type Description
| ast Added Chirector* Last director
added

Member Functions

The member functions of the CApplication class deal with
application initialization and document handling. Because the
application is the ultimate supervisor for all command obijects, it also
serves as the end of the chain of command.

Creation and destruction
The initialization functions set up the application’s memory and file
parameters.
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CApplication
CAppl i cation(short extraMasters,

Si ze aRai nyDayFund, Size aCriti cal Bal ance,

Si ze aTool boxBal ance) ;
Constructor. At least one of the arguments must be non-zero. The
arguments are passed to the | ni t Menor y function, which is
described later in this section.

In your derived class, you should implement a constructor that calls
the CApplication constructor with appropriate argument values for
your application. For example, if your application class is named

MyAppCl ass:

M/Appdl ass()
. CApplication(kExtraMasters,

kRai nyDaySi ze, kCritical Bal ance,
kTool boxBal ance)

{
[l Initialize MAppd ass
// data menbers here...

}

The CApplication constructor initializes the following global
variables. All are described in detail in Chapter 126, “Global

Variables.”
gAppl i cation gSi gnature
gSl eepTi ne gl BeantCur sor
gWat chCur sor gUtil Rgn
gCGopher gLast Vi ewHi t
gd i cks gSystem

Finally, the constructor calls the following application member
functions. The rest of this section describes these and other functions

in detail.
I ni t Tool box I ni t Menory
| nspect System I nstal | Pat ches
MakeSwi t chboar d MakeEr r or
MakeDeskt op Maked i pboard
MakeDecor at or Set UpFi | ePar anmet ers
Set UpMenus
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CApplication

CApplication();

Default constructor. Implicitly called when object is created by
new_by_name. Can also be used in combination with

| Appl i cat i on for backward compatibility.

~CApplication

~CApplication();

Destructor. The ~CAppl i cat i on destructor should never be called,
as the application object is never deleted. The system automatically
purges your application from memory when it quits. If your
application needs to clean up before quitting, override Exi t instead.

I1Application
void | Application (short extraMasters,

Si ze aRai nyDayFund, Size aCritical Bal ance,

Si ze aTool boxBal ance) ;
Initialization function provided for backward compatibility. If you do
not specify any arguments to the CApplication constructor, you must
call | Appl i cat i on immediately after calling the constructor. If you
specify any arguments to the constructor, you must not call
| Appl i cation.

InitToolbox
voi d I nitTool box ();

Initializes all of the Macintosh Toolbox managers. Your derived class
should not need to override this function.

InitMemory
void InitMenory (short extraMasters,

Si ze aRai nyDayFund, Size aCritical Bal ance,

Si ze aTool boxBal ance) ;
Initializes the Macintosh memory manager and sets up the
G owZone function used in low-memory situations.
extraMast er s is the number of times to call the Toolbox routine
Mor eMast er s. aRai nyDayFund is the number of bytes to set
aside in the application heap to deal with low-memory situations.
aCritical Bal ance is the number of bytes to use from the rainy
day fund for critical operations. aTool boxBal ance is the number
of bytes to use from the rainy day fund for Toolbox operations that
can't fail.
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aRai nyDayFund must be greater than or equal to
aCritical Bal ance, and aCri ti cal Bal ance must be greater
than aTool boxBal ance.

The values that you use as arguments to this function depend on the
memory requirements of your application. You can use these values
to get started:

Argument Suggested value
extraMasters 10

aRai nyDayFund 45000
aCritical Bal ance 40000

aTool boxBal ance 20000

MakeSwitchboard
voi d MakeSwi tchboard ();

Creates the application’s switchboard and stores it in the data
member i t sSwi t chboar d. If you create your own derived class of
CBartender, you should override this function in your application’s
derived class.

MakeError
voi d MakeError ();

Creates the error handler and stores it in the global gEr r or. If you
create your own error handler, you can create a derived class of
CError and override this function to use your error handler.

MakeDesktop
voi d MakeDesktop ();

Creates the desktop and stores it in the global gDeskt op. The
default function creates the standard CDesktop desktop. If your
application uses a nonstandard desktop, you should override this
function in your derived class.

MakeClipboard
voi d Maked i pboard ();

Creates the Clipboard and stores it in the global gCl i pboar d. If
you create your own derived class of CClipboard, you should
override this function to create a clipboard of your class.
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MakeDecorator
voi d MakeDecorator ();

Creates the window decorator and stores it in the global

gDecor at or. The window decorator is responsible for the default
sizes of windows and arranges them neatly on the desktop. If you
want to implement a different decorator, you can create a derived
class of CDecorator and override this function to use your decorator.

SetUpFileParameters
voi d Set UpFi |l eParaneters ();

Sets up the parameters that specify what kinds of files your
application works on. The THINK Class Library passes some of these
parameters to the Toolbox SFPGet Fi | e function, which displays
the standard get file dialog. Your derived class should override this
function and call the inherited function to set up the default values.

For example:

voi d MyAppCl ass: : Set upFi | ePar anet er s()
{

CAppl i cation:: SetupFil eParaneters();
sf Nunifypes = 1;
sfFileTypes[0] = "'MWFi';
gSignature = ' WAp';
}

Your own function should set the following data members and
globals:

Data Description

sf Nunifypes The number of different types of
files your application deals with. If
your application can open any kind
of file, use -1.

sfFi | eTypes The list of all file types that your
application deals with.
gSi gnature The four-character signature of your

application. Although it's not a data
member, this function is the place
to set up this global.
sfFileFilter Optional. A pointer to a function
that filters the file names your
application can deal with.
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Data Description

sf Get DLOGHook Optional. A pointer to a dialog
hook function for the standard get
file dialog.

sf Get DLOG d Optional. The resource ID of the
standard get file dialog you're
using. Do not change this data
member if you want to use the
default dialog.

sf Get DLOGFi | t er  Optional. A pointer to a dialog filter
procedure.

To learn about file filter functions, dialog hook functions, and dialog
filters, see Inside Macintosh Volume |, Chapter 20, “The Standard File
Package.”

SetUpMenus
voi d Set UpMenus ();

Calls MakeBart ender, reads all the menu information from your
application’s MBAR 1 resource, and builds the menus. This function
also builds the desk accessory menu.

If your application uses menus that need to be built on the fly, you
should override this function. For instance, if your application uses a
Font menu, you would build it in this function. Be sure to call

i nherited Set UpMenus to make sure all the regular menus get
built. See the description of CBartender, particularly the section
“Resource-based menus” in Chapter 23, “CBartender,” for more
information about building these kinds of menu.

MakeBartender
voi d MakeBartender ();

Creates the bartender object, which handles all interactions with the
menu bar and menu items, and stores it in the global gBar t ender.
If you create your own derived class of CBar t ender, you should
override this function in your derived class.

INnspectSystem
voi d | nspect System ();

Fills in the fields of the gSyst emglobal, which gives you
information about the Macintosh and the system software that your
application is running under.
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gSyst emis declared as follows:

typedef struct

Bool ean hasWNE 1;
Bool ean hasCol or Q@D 1;
Bool ean hasCestalt R I
Bool ean hasAppl eEvents : 1;
Bool ean hasAl i asMgr S I
Bool ean hasEdi ti onMyr 1;
Bool ean hasHel pMyr 1;
Bool ean hasScri pt Myr 1,
Bool ean hasFPU R I
short scriptslnstall ed;
short syst emVer si on;
} gSystem

The field scri pt sl nstal | ed tells you how many scripts are in
use. The field syst enVer si on gives you the version of the
Macintosh system that’s running. The version number is given as two
byte-long numbers. For example, if syst emVer si on is 0x0607,
the System version number is 6.0.7.

Advanced initialization

You should not need to override these functions. If you are an
advanced Macintosh programmer, you may want to take advantage
of the fact that they're called in the CApplication constructor.

InstallPatches
void Install Patches ();

Installs patches to Toolbox routines. The default function patches
LoadSeg to make sure that CODE resources can be loaded. If a code
resource can’t be loaded, the patch raises an exception. The default
function also patches Exi t ToShel | to call RenovePat ches.

RemovePatches
voi d RenovePat ches ();

Removes the Toolbox patches made in | nst al | Pat ches.

Accessing

GetPhase
short GCet Phase ();

Returns current application phase. The possible values are
appl nitializing, appRunni ng, and appQui tti ng.
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Command

The command functions handle events that the application takes
care of. Because calls frequently get passed up the chain of
command—from the pane, to the document, to the application—the
application is the last chance to handle commands. Most of the
command functions don’t do anything. They’re empty functions that
prevent the call from being passed on.

NotifyClean
voi d Notifyd ean(CTask *theTask);

In CApplication, Not i f yCl ean is the same as Noti fy. In
CDocument, Not i f yCl ean is the same as Not i f y, except that
Not i f yCl ean does not mark the document as dirty.

DoKeyDown
voi d DoKeyDown (char theChar, Byte keyCode,

Event Record *nacEvent);
You should handle key-down events within a pane or a document.
For applications, this function doesn’t do anything. It exists in the
event that the DoKeyDown function call gets passed up the chain of
command. Your derived class should not override this function.

DoAutoKey
voi d DoAut oKey (char theChar, Byte keyCode,

Event Record *nacEvent);
You should handle auto-key events within a pane or a document.
For applications, this function doesn’t do anything. It exists in the
event that the DoAut oKey function call gets passed up the chain of
command. Your derived class should not override this function.

DoKeyUp
voi d DoKeyUp (char theChar, Byte keyCode,

Event Record *macEvent);
You should handle key-up events within a pane or a document. For
applications, this function doesn’t do anything. It exists in the event
that the DoKey Up function call gets passed up the chain of
command. Your derived class should not override this function.
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Note
The Macintosh system event mask is usually set to
mask out key-up events. If you need to get key-up
events, be sure to reset the system event mask with
the Toolbox routine Set Event Mask.
DoCommand

voi d DoCommrand (| ong t heCommand) ;

This is the only application command function that really does more
than just return. DoCommand handles application commands that the
user chooses from the menu. These are the commands the default
DoComand function handles:

Command Action
cndNew Calls Cr eat eDocunent .
cndQpen Calls ChooseFi | e. If the reply is

good, calls OQpenDocunent . The
default ChooseFi | e function
calls SFPGet Fi | e with the

values you specified in the

Set UpFi | ePar amet er s function.
Your application must override the
OpenDocunent function.

cndd ose If the front window is a desk
accessory, close it. Your document
class should handle this command
to close documents.

cmdQui t Calls your application’s Qui t
function. The default Qui t function
calls the Qui t functions of the
supervisors (directors) of each open
window.

Table 18-1 Commands handled by DoCommand function
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Command Action

cndUndo, If the front window is a desk

cndCut accessory, always calls

gmgogg,rcmwast €, Syst enEdi t . Your document class
should handle these commands to
edit documents.

cmdToggl edip Calls the clipboard’s Toggl e

function.

Table 18-1 Commands handled by DoCommand function

If your application defines its own application-related events, your
application class should override this function. If your DoComand
function gets a command that it does not handle, it should call the
inherited DoConmand.

UpdateMenus
voi d Updat eMenus ();

This function enables the appropriate menu items just before a pop-
up menu is displayed . The default function enables the Quit
command. If the application is in the foreground, it enables the
Show/Hide Clipboard command. If the application is in the
background, this function enables the cndCl ose, cndUndo,
cndCut , cndCopy, cndPast e, and cndC ear commands for desk
accessories.

Your document’s Updat eMenus function should enable the
appropriate Edit menu commands for the document.

PackageAppleEvent
CAppl eEvent *PackageAppl eEvent (

const Appl eEvent *theEvent,

Appl eEvent *theReply, |ong theRefCon);
Packages an incoming Appl eEvent and its default reply into a
CAppl eEvent object. This function returns a CAppl eEvent
object. If you create a derived class of CAppl eEvent, you need to
override this function. CAppl eEvent is described in Chapter 15,
“CAppleEvent.”

Memory management
These functions deal with critical memory situations in your
application. The | ni t Menor y function sets the function
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G owZoneFunc as the function to call in low-memory situations.
This function calls your application’s Gr owiVenor y function to try to
reclaim enough memory to continue.

Note
G owZoneFunc is defined in CError. h.

RequestMemory
voi d Request Menory (Bool ean aCanFail);

Changes the canFai | data member, which controls how

G owiMenor y releases memory from the rainy day fund. If
aCanFai | is FALSE, Gr owmvenory is more conservative about
releasing memory for a failing memory request. If aCanFai | is
TRUE, G owmMenor y will exhaust the rainy day fund to satisfy the
request.

Instead of calling this function directly, you should use the utility
routine Set Al | ocat i on (described in Chapter 127, “TCL Utilities”).
Set Al | ocat i on calls the application’s Request Menory function
and returns the previous value so you can restore it.

In addition to Set Al | ocati on, TCLUti lities. h also defines
two constants, kAl | ocCant Fai | (FALSE) and

kAl l ocCanFai | ( TRUE). Because these constants are more self-
documenting than TRUE and FALSE, you should use them as
arguments to Set Al | ocat i on instead of the plain Boolean values.
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Here is an example:

voi d AC ass: : AFunction()
{

Bool ean ol dAl | oc;

ol dAl l oc = Set Al l ocati on( kAl |l ocCanFail);
myHandl e = NewHandl eCanFai | (50000L) ;
Set Al | ocati on(ol dAI'l oc);

if (myHandl e == NULL)
couldn’t get 50000 bytes
el se
go on with this operation

}

Remember that if the argument you pass to Set Al | ocat i on or
Request Menory is KAl | ocCant Fai | , G owmMvenor y will do
whatever it can to get the memory. If there still isn’t enough memory
after the rainy day fund has been exhausted, your program will
probably crash.

SetCriticalOperation
void SetCritical Operation (Boolean isCritical);

Sets the i nCri ti cal Oper ati on data member, which controls
how G owMenor y releases memory from the rainy day fund. If

i nCritical Operation is TRUE and a memory shortage causes
GrowMemory to be called, GrowMemory tries to release enough
memory in the rainy day fund to leave t ool boxBal ance bytes free.

Your application should call the utility routine

Set Critical Operation (described in Chapter 127, “TCL
Utilities™) instead of calling the Set Cri ti cal Oper at i on function
of gAppl i cati on.

Use this routine when there is an operation that must complete and
for which your application might need to use some of the memory in
the rainy day fund. The critical operation should release any memory
that it allocated.

For example, when your application is saving a file, you may need
to allocate an extraordinary amount of memory. In this case, you
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would call Set Cri ti cal Operati on to let G owMenory know
that, if necessary, you're willing to use more of the rainy day fund.
Once the operation is complete, you would dispose of the memory.

Note that the Run function resets i nCri ti cal Operati on to
FALSE every time through the event loop.

GrowMemory
|l ong G owMenory (Size bytesNeeded);

The Gr owZoneFunc function that the Memory Manager calls in
low-memory situations invokes this function to try to reclaim
memory. Gr omvenor y calls the application’s Menor yShor t age
function.

If Meror yShor t age isn’t able to release enough memory,

G owMenor y starts to use the rainy day fund. If

inCritical Operation is TRUE, G owvenory uses as much of
the rainy day fund as possible, while still leaving t ool boxBal ance
bytes in the fund. If i nCri ti cal Operati on is FALSE, it uses as
much as possible, while still leaving cri ti cal Bal ance bytes in
the fund.

If G owenor y still wasn't able to release enough memory from the
rainy day fund, and canFai | is FALSE, the entire rainy day fund is
released. If the entire rainy day fund has been exhausted, this
function calls Qut Of Menory.

MemoryShortage
voi d MenoryShortage (Size bytesNeeded);

The Gr owivenor y function calls your application’s

Menor yShor t age function to try to free memory. The default
Menor yShor t age function does nothing, so your derived class
should override this function. Your Menor yShor t age function
should try to free byt esNeeded bytes of memory, and it should
disable menu commands that won’'t work in low-memory situations.

Warning
Your Menor yShor t age function must not allocate

any memory.
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MemoryReplenished
voi d MenoryRepl eni shed ();

This function is called when the memory situation is no longer
critical. The default Menor yRepl eni shed function does nothing,
so your derived class should override this function. Your

Menor yRepl eni shed function should enable the commands you
disabled in the Menor yShor t age function. You might also want to
reallocate memory that you released in that function.

OutOfMemory
|l ong Qut O Menory (Si ze byt esNeeded);

A memory request cannot be satisfied and canFai | was FALSE, so
the application won't handle the memory allocation failure. This
function calls Fai | ure( mentul | Error, 0). If any memory is
left, the top-level handler displays an alert; it is likely that the
application will crash.

You can override this function if you can free up more memory, or if
you can exit the application gracefully without allocating memory.
Normally, you would try to free enough memory in your

Menor yShor t age function. If there are more drastic ways to
release memory, implement them here. This function should return
1 if it successfully releases memory, or O if it can't.

Warning
Qut O Menor y should not allocate any memory or

call any routines that allocate memory.

Execution

Most of these functions handle system-related events. The only
execution function your application should override is Exi t .

Run
void Run ();

Runs the application. This function calls the application’s
Process1Event function until the user chooses to quit.

Before running the program, this function calls your application’s
Pr el oad function to open or print documents that the user selected
and opened from the Finder.
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Your application should not override this function.

Process1Event
voi d ProcesslEvent ();

Processes and dispatch one event. This function calls the

Pr ocessEvent function of the switchboard (stored in the data
member i t sSwi t chboar d). If you installed an urgent chore, this
function calls its Per f or mfunction.

Preload
void Preload ();

If the user opened or chose to print files from the Finder, Pr el oad
calls the application’s OpenDocunent function for each document.
If the user chose the Print command, Pr el oad calls the gopher’s
DoConmmand( cndPri nt) function. After processing all the files, this
function calls the application’s St ar t UpAct i on function.

StartUpAction
void StartUpAction (short nunPrel oads);

Offers an opportunity to perform any startup actions. NunPr el oads
is the number of files that the user selected from the Finder. If
nunPr el oads is 0, the default function calls the

DoCommand( cndNew) function of the gopher (usually the
application). The effect of the default function is to open an untitled
document at startup.

Suspend
voi d Suspend ();
Your application is about to be suspended under MultiFinder or

System 7. The default function calls the Suspend function of
CDirectorOwner and sets the global gl nBackgr ound to TRUE.

Resume

voi d Resune ();

Your application has come back to the foreground under MultiFinder
or System 7. The default function calls the Resune function of
CDirectorOwner and sets the global gl nBackgr ound to FALSE.
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SwitchToDA

void SwitchToDA ();

A desk accessory is becoming active. The default function calls the
application’s Suspend function. Your application should not
override or use this function.

SwitchFromDA
void SwitchFronDA ();
Your application is becoming active after a desk accessory was

active. The default function calls your application’s Resune
function. Your application should not override or use this function.

Idle
void lIdle (EventRecord *macEvent);

Handles periodic tasks. It also checks to see if a critical memory
situation is no longer critical. | dl e calls the Dawdl e function of the
gopher and of each of the gopher’s supervisors. It also calls the
Per f or mfunctions of all chores. Your application should not
override this function.

Quit

Boolean Quit ();

The user wants to quit the application. This function calls the Qui t
function of the supervisor (a director) of each open window. Any of
the directors can cancel quitting. Your application should not
override this function.

Note
Qui t for directors returns a Boolean value. If it
returns FALSE, quitting is cancelled.

Exit

void Exit ();

The application is about to exit. Your main program should call
Exi t before it terminates; the THINK Class Library will not call the
function for you. The default function does nothing.

The Exi t function is the last chance you have to clean up after your
application. For example, this is a good place to delete any
temporary files you've created.
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JumpToEventLoop
voi d JunpToEvent Loop ();

This function is for compatibility with earlier versions of the THINK
Class Library. It calls Fai | ure(kSi | ent Err, 0) to force a return
to the top-level exception handler in Run.

Document

The document functions of an application deal with creating and
opening documents. In your derived class, the only document
functions you need to override are Cr eat eDocunent and
OpenDocurnent . All the other document functions are used
internally to implement standard behavior.

CreateDocument
voi d CreateDocunent ();

Creates a new document. The default DoCommand function calls the
application’s Cr eat eDocunent function when the user chooses
New from the File menu. Your application must override this
function. Your Cr eat eDocunent function needs to create a new
document, initialize it, and then call its NewFi | e function.

OpenDocument
voi d OpenDocunent (SFReply *macSFReply);

Opens an existing document. The nmacSFRepl y record specifies the
document to open. The default DoComand function calls the
application’s QpenDocurnent function when the user chooses Open
from the File menu.

Note
DoCommand actually calls the application’s
ChooseFi | e function first and, if the reply is good,
it calls the OpenDocunent function. Your
OpenDocunent function can assume that the
mac SFRepl y record is valid.

Your derived class must override this function. Your
OpenDocurnent function needs to create a new document, initialize
it, and then call its OpenFi | e( macSFRepl y) function.

Visual Architect and THINK Class Library Guide 355



18 CApplication

ChooseFile
voi d ChooseFile (SFReply *macSFRepl y);

Displays a standard get file dialog and places the reply in the
mac SFRepl y record. This function calls the Toolbox routine
SFPGet Fi | e with the file parameters you specified in the
Set UpFi | ePar anet er s function.

You can call ChooseFi | e from other objects to get the name and
location of a file. Don't forget to check the macSFRepl y. good
field to make sure that the information in the record is valid.

Your derived class should not override this function unless it uses a
different technique to open a document.

Periodic task

AssignldleChore
voi d Assi gnl dl eChore (CChore *theChore);

Adds t heChor e to the application’s list of chores. The application
calls the Per f or mfunction of each chore at idle time. Your
application should not override this function.

Note
If you want to remove the chore from the list later,
you must keep a pointer to the chore object.

CancelldleChore
voi d Cancel I dl eChore (CChore *theChore);

Removes t heChor e from the application’s list of chores. Your
application should not override this function.

AssignUrgentChore
voi d Assi gnUrgent Chore (CChore *theChore);

Adds t heChor e to the application’s list of urgent chores. The
application calls the Per f or mfunction of each urgent chore after
handling the current event, and then removes the chore. Your
application should not override this function.
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Class Resources

Resource Description
"MBAR 1 The application’s menu bar
"' STR#' 129 Low-memory warning strings

Apple Event Support

For information regarding Apple event member functions, please
refer to the supplemental information provided in the Appl e
event i nfo file in the Appl e Event C asses folder.
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Introduction

CArray implements a resizable array.

Heritage
Base Class CCollection
Derived Classes CRunArray

CVoidPtrArray

Using CArray

Use CArray when you want an array you can resize. The elements
may be any size, as long as they're all the same size.

To insert a new element into the array, use | nsert At | ndex. It
moves the element in that slot and all elements below it down one
slot. Its actions are illustrated in Figure 19-1.

1
2
3

1
2
3
4

Figure 19-1 Before and after InsertAtindex
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Use Set | t emto update the value of an existing element. The
function replaces the item at that slot with the new element, as
illustrated in Figure 19-2.

A W N
A W N

Figure 19-2 Before and after Setltem

To delete an element, use Del et el t em The function moves all the
elements below the deleted element up one slot.

CArray stores the elements in its array in one large piece of memory
that it allocates dynamically. It uses the data member bl ockSi ze to
control how to grow and shrink this memory. If there are no empty
slots when you try to insert an element, CArray grows memory by
bl ockSi ze slots. When you delete an element and there are

bl ockSi ze empty slots left, CArray shrinks the memory by

bl ockSi ze slots. By default, bl ockSi ze is 3.

CArray has two functions that move elements in the array: Swap and
Movel t emTol ndex. To store an element while moving it, CArray
has a temporary storage slot at the end of the array. To make sure an
element in temporary storage isn't accidentally overwritten, those
member functions set the flag usi ngTenpor ar y whenever they
put something in the temporary storage slot. This slot is not counted
in the sl ot s data member, which is the total number of slots that
can permanently store elements.

typedef struct tMvedEl enentlnfo
{
| ong origi nal | ndex;

| ong newl ndex;
} tMovedEl enment | nf o;
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The following table describes the correct usage of broadcast change
messages.

Message Info parameter usage

arrayl nsert El enent Index of new element

arrayDel et eEl erent  Index of deleted element

arr ayMoveEl enent Pointer to a t MovedEl enment | nf o
ar r ay Goi ngAway NULL

arrayEl ement Changed Index of changed array element

Table 19-1 Broadcast change messages

Data Members

CArray defines the following data members:

Data member Type Description

bl ockSi ze short Number of slots to allocate
when more space is
needed.

slots | ong Total number of slots
allocated.

hl t errs Handl e Items in the array.

el ement Si ze | ong Size of each element in
bytes.

| ockChanges Bool ean If TRUE, you can't insert or

delete in the array.
usi ngTenporary Bool ean If TRUE, temporary element
storage buffer is in use.

Member Functions

Creation and destruction

CArray
CArray (Il ong anEl enent Si ze = 0,

short aBl ockSi ze = 3);
Constructor. anEl enent Si ze is the size of each array element in
bytes. aBl ockSi ze is the number of elements to add to the array
when CArray allocates more space.

~CArray
~CArray();

Destructor. Frees the memory occupied by the array elements.
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1Array
void | Array (| ong anEl enent Si ze) ;

Initialization function provided for backward compatibility. If no
constructor arguments are specified, the array must be further
initialized by calling | Arr ay. If any constructor arguments are
specified, | Ar r ay must not be called. See constructor for a
description of the anEl enment Si ze argument.

Copy
voi d *Copy();

Returns a copy of this array.

Accessing

SetBlockSize
voi d Set Bl ockSi ze (short aBl ockSi ze);

Sets the number of elements to add to the array when CArray
allocates more space. | Arr ay initializes this value to 3.

SetLockChanges
Bool ean Set LockChanges (Bool ean fLockChanges);

If f LockChanges is TRUE, you can't use the | nsert At | ndex and
Del et el t emfunctions. This function sets | ockChanges to

f LockChanges and returns the previous value of | ockChanges.
CPt r Ar r ay uses this function to prevent you from corrupting the
array when you iterate over its elements with DoFor Each.

Insertion and deletion

InsertAtindex
void InsertAtlndex (void *itenPtr, [ong index);

Inserts the element at i t enPt r at the position i ndex. If i ndex is
already occupied, moves the element in that slot and all the
elements below it down one slot. If i ndex is beyond the last
position, adds the item to the end of the array. If necessary, this
function allocates a larger block of memory for the array. This
function calls the Br oadcast Change function with

arrayl nsert El enent as the reason.
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Deleteltem
void Deleteltem (Il ong index);

Deletes the element at index i ndex. This function moves all the
elements below i ndex up one slot. If the number of free slots is
greater than bl ockSi ze, this function reallocates a block of
memory that’s smaller by bl ockSi ze slots.

Setltem
void Setltem (void *itenPtr, |ong index);

Puts the element at i t enPt r into the array at position i ndex.

I ndex must be within the array. This function calls the

Br oadcast Change function with ar r ayEl enent Changed as the
reason.

Add
void Add (void *itenPtr);

Appends an item to the end of the array, extending the size by one
element. Sends dependents an ar r ayl nsert El ement message.

SetArrayltem
void SetArrayltem (void *itenPtr, |ong index);

Sets the contents of the array element at i ndex. i ndex must be
within the array. Sends dependents an ar r ayEl enrent Changed
message.

Membership

Getltem
void CGetltem (void *itenPtr, |ong index);

Returns the element at position i ndex in the block memory at
i tenPtr. i ndex must be within the array. i t enPt r must point to
a block large enough to hold one element.

GetArrayltem
void GetArrayltem (void *itenPtr, |ong index);

Retrieves the contents of the array element. i ndex must be within
the array. i t enPt r must point to storage large enough to hold one
element.
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Search
| ong Search (void *itenPtr,

Compar eFunc conpare);
Finds an element that satisfies a condition. The function conpar e
tests for the condition. It takes two arguments. The firstisi t enPtr
and the second is a pointer to an element in the array. conpare
should return 0 when an element satisfies the condition. i t enPtr is
a pointer to some data that you can use in the comparison. It can be
a pointer to data like that in the array, a pointer to another type of
data, or NULL.

Returns the array index of the found item if the search succeeds;
otherwise, returns BAD | NDEX, defined as (|1 ong) (-1).

Declare conpar e like this:

int conpare( void *itenPtr,
void *arrayElt );

Moving

MoveltemTolndex
voi d Movel tenfol ndex (Il ong currentl ndex,

| ong newl ndex) ;
Moves the element at cur r ent | ndex to newl ndex. This function
moves the elements between the old and new positions up or down
a slot. This function calls the Br oadcast Change function with
arrayMoveEl enent as the reason.

Swap
void Swap (long indexl, |ong index2);

Swaps the two items: Moves the item at i ndex1 to i ndex2, and
moves the item at i ndex2 to i ndex1. For both items, this function
calls the Br oadcast Change function with ar r ayEl erent Changed
as the reason.

Resizing

CArray uses these protected functions to resize its block of memory.
You should need to use them only if you are creating a derived class
of CArray. Only derived classes of CArray can use them.
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Resize
voi d Resize (long nuntlots);

Resizes the array so that it has nunSl ot s slots. This function
performs no error checking.

MoreSlots
voi d MoreSlots();

Adds bl ockSi ze slots to the array.

Temporary storage

CArray uses these functions to move elements into and out of the
temporary storage slot. You should need to use them only if you are
creating a derived class of CArray. In the THINK Class Library, only
derived classes of CArray can use them.

CopyToTemporary
voi d CopyToTenporary (long index);

Places the element in slot i ndex into temporary storage. This
function also sets usi ngTenpor ary to TRUE.

CopyFromTemporary
voi d CopyFroniTenporary (long index);

Places an item from temporary storage into slot i ndex. This function
also sets usi ngTenpor ary to FALSE.

Offset

CArray uses this function to find the offset into the array of an
element. You should need to use it only if you are creating a derived
class of CArray.

ItemOffset
long ItenOffset (long item ndex);

Returns the offset into the array of the slot i t em ndex in bytes.

Object I/0

PutTo
void PutTo (CStream& aStrean;

Writes the entire array to the stream.
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GetFrom
voi d Get From (CStream& aStrean;

Reads the entire array from the stream.

Member Functions: Protected

Insertitem
void Insertltem (long index);

Inserts space for an item into the array at the specified index. Any
items at or above i ndex are moved to the next higher position. If

i ndex is greater than the current size, then the item is appended to
the end of the array.

Putltems
void Putltens (CStream& aStrean;

Writes the elements of this array to the stream. Called by Put To.

Getltems
void Cetltens (CStream& aStrean;

Reads the elements of this array from the stream. Called by
Get From

Store

void Store (void *itenPtr, long index);

Puts the element ati t enmPt r into the array at position i ndex.
Whenever possible, use Set instead. This function performs no
error checking.

Retrieve

void Retrieve (void *itenPtr, |ong index);
Returns the element at position i ndex in the block memory at
i t emPt r. Whenever possible, use Get instead. This function
performs no error checking.
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CArraylterator
20

Introduction

CArraylterator lets you iterate through the elements of a CArray or
CList array.

Heritage
Base Class CCollaborator
Derived Classes CVoidPtrArraylterator

Using CArraylterator

CArraylterator provides a straightforward and error-resistant way to
loop through the items in a CArray. For example:

typedef struct { short i; ...} M/Rec;
CArray *array(sizeof (MyRec));

CArrayIterator iter(array, kStartAtBeginning);
M/Rec item

while (iter.Next(& ten))
if (itemi == 0)
}

The Next function fetches the next record from the array and
advances the cursor (see below). Successive calls to Next traverse
the entire array. When the cursor is at the end of the array, Next
returns FALSE.

You could simply loop through the array with an index, but that sort
of code is more error-prone: if the loop inserts or deletes elements in
the array, it usually fails.
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More than one iterator can operate on the same array at the same
time. For example, here is a loop that removes duplicate records
from the array above;

CArraylterator iter(array, kStartAtBeginning);
CArrayl terator check(array, 0);
MyRec r, dup;

while (iter.Next(&))

check. MoveTo(iter. Get Cursor());
whi | e (check. Next (&dup))
if (dup.i ==r.i && ...
array->Del etel tem(check. Get Cursor());
}

The cursor ranges from 0 to the number of elements in the array,
and is logically positioned at the start of the array, at the end, or
between two array items. For example, if an array has 5 items, a
cursor with value 3 is positioned between items 3 and 4, as
illustrated in Figure 20-1. Next returns item 4 and Pr ev returns
item 3.

Cursor

Cursorpositons: 0 1 2 3 4 5
Index values: 1123|465

Prev Next

Figure 20-1 Relationship of cursor position to index
Unlike a loop index, an iterator is not required to go only forward or
only backward; by calling Next , Pr ev, and MoveTo, you may go

forward, backward, or jump around in an arbitrary way during the
life of the iterator.

If the array associated with the iterator is deleted, the cursor is set to
0 and the Next and Pr ev functions return FALSE.
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Data Members

CArraylterator has the following protected data members:

Data member Type Description

i tsArray CArr ay* Pointer to array that you
iterate through

curPosition | ong Cursor position

Member Functions

Creation and destruction

CArraylterator
CArraylterator (CArray *array,

CursorPosition start);
Constructor. ar r ay specifies the array to iterate through and st ar t
specifies where iteration begins. st art may be specified as
kSt ar t At Begi nni ng, kSt art At End, St ar t Bef or e(index) , or
St art Af t er (index) , where index is the index of an array item,
from 1 to the number of items in the array.

Advancing and retreating

Next
Bool ean Next (void *itenptr);

If there are more items beyond the cursor, this function fetches the
next item pointer, replacing the value of i t enpt r, increments the
cursor, and returns TRUE. Otherwise, returns FALSE.

Prev
Bool ean Prev (void *itenptr);

If there are items before the cursor, this function fetches the previous
item pointer, replacing the value of i t enpt r, decrements the
cursor, and returns TRUE. Otherwise, returns FALSE.

Positioning

GetCursor
CursorPosition GetCursor ();

Returns the current cursor position. The cursor is always in the range
0 to the number of items in the array.
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MoveTo
voi d MoveTo (CursorPosition pos);

Resets the current cursor position. pos may be specified as

kSt ar t At Begi nni ng, kSt art At End, St art Bef or e( index) or
St art Af t er (index) , where index is the index of an array item,
from 1 to the number of items in the array.

AtEnd

Bool ean AtEnd ();

Returns TRUE if iterator is positioned at the end of the array or if the
array has been deleted.

AtBeginning
Bool ean At Begi nning ();

Returns TRUE if iterator is positioned at the beginning of the array or
if the array has been deleted.

Member Functions: Protected

Collaboration

ProviderChanged

voi d Provi der Changed (CCol | aborator *aProvi der,
| ong reason, void* info);

Receives ar rayDel et eEl enent and ar r ayl nsert El enent

reason codes as values of r eason when called with aPr ovi der

equaltoi tsArray.
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CArraylterator
20

Introduction

CArraylterator lets you iterate through the elements of a CArray or
CList array.

Heritage
Base Class CCollaborator
Derived Classes CVoidPtrArraylterator

Using CArraylterator

CArraylterator provides a straightforward and error-resistant way to
loop through the items in a CArray. For example:

typedef struct { short i; ...} M/Rec;
CArray *array(sizeof (MyRec));

CArrayIterator iter(array, kStartAtBeginning);
M/Rec item

while (iter.Next(& ten))
if (itemi == 0)
}

The Next function fetches the next record from the array and
advances the cursor (see below). Successive calls to Next traverse
the entire array. When the cursor is at the end of the array, Next
returns FALSE.

You could simply loop through the array with an index, but that sort
of code is more error-prone: if the loop inserts or deletes elements in
the array, it usually fails.
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More than one iterator can operate on the same array at the same
time. For example, here is a loop that removes duplicate records
from the array above;

CArraylterator iter(array, kStartAtBeginning);
CArrayl terator check(array, 0);
MyRec r, dup;

while (iter.Next(&))

check. MoveTo(iter. Get Cursor());
whi | e (check. Next (&dup))
if (dup.i ==r.i && ...
array->Del etel tem(check. Get Cursor());
}

The cursor ranges from 0 to the number of elements in the array,
and is logically positioned at the start of the array, at the end, or
between two array items. For example, if an array has 5 items, a
cursor with value 3 is positioned between items 3 and 4, as
illustrated in Figure 20-1. Next returns item 4 and Pr ev returns
item 3.

Cursor

Cursorpositons: 0 1 2 3 4 5
Index values: 1123|465

Prev Next

Figure 20-1 Relationship of cursor position to index
Unlike a loop index, an iterator is not required to go only forward or
only backward; by calling Next , Pr ev, and MoveTo, you may go

forward, backward, or jump around in an arbitrary way during the
life of the iterator.

If the array associated with the iterator is deleted, the cursor is set to
0 and the Next and Pr ev functions return FALSE.
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Data Members

CArraylterator has the following protected data members:

Data member Type Description

i tsArray CArr ay* Pointer to array that you
iterate through

curPosition | ong Cursor position

Member Functions

Creation and destruction

CArraylterator
CArraylterator (CArray *array,

CursorPosition start);
Constructor. ar r ay specifies the array to iterate through and st ar t
specifies where iteration begins. st art may be specified as
kSt ar t At Begi nni ng, kSt art At End, St ar t Bef or e(index) , or
St art Af t er (index) , where index is the index of an array item,
from 1 to the number of items in the array.

Advancing and retreating

Next
Bool ean Next (void *itenptr);

If there are more items beyond the cursor, this function fetches the
next item pointer, replacing the value of i t enpt r, increments the
cursor, and returns TRUE. Otherwise, returns FALSE.

Prev
Bool ean Prev (void *itenptr);

If there are items before the cursor, this function fetches the previous
item pointer, replacing the value of i t enpt r, decrements the
cursor, and returns TRUE. Otherwise, returns FALSE.

Positioning

GetCursor
CursorPosition GetCursor ();

Returns the current cursor position. The cursor is always in the range
0 to the number of items in the array.
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MoveTo
voi d MoveTo (CursorPosition pos);

Resets the current cursor position. pos may be specified as

kSt ar t At Begi nni ng, kSt art At End, St art Bef or e( index) or
St art Af t er (index) , where index is the index of an array item,
from 1 to the number of items in the array.

AtEnd

Bool ean AtEnd ();

Returns TRUE if iterator is positioned at the end of the array or if the
array has been deleted.

AtBeginning
Bool ean At Begi nning ();

Returns TRUE if iterator is positioned at the beginning of the array or
if the array has been deleted.

Member Functions: Protected

Collaboration

ProviderChanged

voi d Provi der Changed (CCol | aborator *aProvi der,
| ong reason, void* info);

Receives ar rayDel et eEl enent and ar r ayl nsert El enent

reason codes as values of r eason when called with aPr ovi der

equaltoi tsArray.
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The dependency
mechanism is described in
Chapter 33,
“CCollaborator.”

CArrayPane ,
21

Introduction

CArrayPane is an abstract class for displaying the contents of an
array object in a scrolling list.

Heritage
Base Class CTable
Derived Classes None

Using CArrayPane

CArrayPane is a derived class of CTable that displays the contents of
a CArray object. The array pane is a table that has one row for each
array element. By default, there’s only one cell per row. CArrayPane
uses the dependency mechanism to keep the table display
synchronized with the array. Whenever you add, delete, or change
an element, CArrayPane's Pr ovi der Changed function is called,
which automatically adds or deletes rows and redraws the
appropriate areas.

To use CArrayPane, you must create a derived class that draws the
contents of a cell. If your data can be represented as a string,
override Get Cel | Text to return a string. Otherwise, override

Dr awCel | to draw the cell. These member functions are defined in
Chapter 113, “CTable.”

To associate a CArray with a CArrayPane, call the CArrayPane’s

Set Ar r ay function, with the CArray object and a flag indicating
whether this CArrayPane owns the CArray. If the CArrayPane owns
the array, it will automatically delete it. If you want to share a single
array among multiple views, you should pass FALSE for the flag,

Visual Architect and THINK Class Library Guide 371



21 CArrayPane

and make sure that your director- or document-derived class deletes
the array.

orange
yellow
green

indigo
winlet
purple
mauve
black

white
hot pink

Figure 21-1 A CArrayPane

Data Members

CArrayPane defines these protected data members:

Data member Type Description
itsArray CArr ay* The array you're displaying
ownsArr ay Bool ean TRUE if dest ruct or should

delete i t SArray

Member Functions

Creation and destruction

CArrayPane
CArrayPane (CVi ew *anEncl osur e,
CBur eaucr at *aSuper vi sor,
short aWwdth, short aHei ght,
short aHEncl, short aVEncl,
Si zi ngOpti on aHSi zi ng = si zELASTI C,
Si zi ngOpti on aVSi zi ng) ;
Constructor. The arguments to this function are identical to those for
the CPane constructor.
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*

CArrayPane
CArrayPane ();

Default constructor. Implicitly called when object is created by
new_by_name. Can also be used in combination with | Ar r ayPane
for backward compatability.

~CArrayPane
~CArrayPane() ;

Destructor. If the array is owned, this deletes it.

IArrayPane
void | ArrayPane (CVi ew *anEncl osure,

CBur eaucr at *aSupervi sor,

short aWwdth, short aHei ght,

short aHEncl, short aVEncl,

Si zi ngOpt i on aHSi zi ng, Si zi ngOpti on aVSi zi ng) ;
Initialization function provided for backward compatibility. If no
constructor arguments are specified, the array pane must be further
initialized by calling | Ar r ayPane. If any constructor arguments are
specified, | Ar r ayPane must not be called. Arguments are the same
as for the constructor, except there are no default values.

IViewTemp

voi d | ViewTenp (CVi ew *anEncl osure,
CBur eaucr at *aSupervi sor, Ptr viewbData);

Initializes an array pane from a resource template.

Accessing

SetArray
void SetArray (CArray *anArray,

Bool ean f Oaner shi p);
Sets the array that this pane displays. If f Oaner shi p is TRUE, this
pane owns the array and deletes it when the pane is destroyed.
Otherwise, the pane doesn’'t own the array and doesn't delete it.

If the pane was already displaying an array that it owned, it deletes
the array.

GetArray
CArray *GetArray ();

Returns the array object this pane is displaying.
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Size

ChangeSize
voi d ChangeSi ze (Rect *delta, Bool ean redraw);

Changes the size of the array pane. Because an array table has only
one column, this function sets the column’s width to the frame’s
width.

Object I/0

PutTo
void PutTo (CStream& aStreamn;

Writes to the stream.

GetFrom
void Get From (CStream& aStrean);

Reads from the stream.

Member Functions: Protected

Change notification

ProviderChanged
voi d Provi der Changed (CCol | aborator *aProvi der,
| ong reason, void* info);
The array has been changed and a Br oadcast Change function has
been called on it. This function handles these reasons:

Reason Action

arrayl nsert El enent Add a new row for the element
arr ayDel et eEl enent Delete the element’s row

arr ayMoveEl enent Redraw all rows between the

element’s old and new rows
arrayEl enent Changed Redraw the element’s row

Table 21-1 Reasons that CArrayPane handles
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CArrowPopupFane o
22

Introduction

CArrowPopupPane is a pop-up menu pane that displays a
downward-pointing arrow. A pop-up menu pane is a pane that owns
a CPopupMenu and pops up the menu when clicked.

Heritage
Base Class CPopupPane
Derived Classes None

Using CArrowPopupPane

CArrowPopupPane follows Apple Human Interface Guidelines for a
pop-up menu that displays no text when it is not popped up. It
displays a downward-pointing arrow in a box with a drop shadow,
as in Figure 22-1. It is a derived class of CPopupPane, described in
Chapter 83, “CPopupPane.”

E| ~Uanilla

Chocolate
+ Strawberry

Sprinkles

IMalnuts !

+ Fudge
Butterscotch
Rasberry
Maple Syrup

Figure 22-1 A CArrowPopupPane
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Data Members

CArrowPopupPane defines no data members.

Member Functions

Creation and destruction

CArrowPopupPane

CAr r owPopupPane(short menul D,
Bool ean f Aut oSel ect, Bool ean f Ml ti Sel ect,
CVi ew *anEncl osur e,
CBur eaucr at *aSupervi sor,
short aHEncl, short aVEncl,
Bool ean f Radi oStyle = FALSE);

Constructor. menul D is the resource ID of the MENU resource.

f Aut oSel ect controls whether the menu automatically checks and
unchecks menu items when selected. f Mul ti Sel ect controls
whether multiple menu items may be selected. f Radi oSt yl e
controls whether the menu is to be used like a group of radio
buttons, with only one item checked at a time.

Note
The rest of the arguments are described under
CPane in Chapter 71. A CArrowPopupPane’s sizing
options are always si zF|I XEDSTI CKY.
CArrowPopupPane

CAr r owPopupPane ();

Default constructor. Implicitly called when an object is created by
new_by_ name. Can also be used in combination with
| Ar r owPopupPane for backward compatability.

IArrowPopupPane

voi d | ArrowPopupPane(short nenul D,

Bool ean f Aut oSel ect, Bool ean fMilti Sel ect,
CVi ew *anEncl osure, CBureaucrat *aSupervisor,
short aHEncl, short aVEncl,

Bool ean f Radi oStyl e = FALSE);

Initialization function provided for backward compatibility.
I Arr ayPane should only be called if the default constructor was
used. r adi oSt yl e and pri vat eMenu are set to FALSE.
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IViewTemp
void | ViewTenp (CVi ew *anEncl osure,

CBur eaucr at *aSupervisor, Ptr viewData);
This function is used internally for initializing from a resource
template. Each derived class of CArrowPopupPane overrides this
function to use its own resource template.

Drawing

Draw
void Draw (Rect *area);

Draws the pane’s pop-up menu when the menu isn’t selected.
Override this function if your derived class draws the menu
differently.

Member Functions: Protected

IArrowPopupPaneX
voi d | ArrowPopupPaneX ();

Performs common initialization.

CalcPopupPoint
poi nt Cal cPopupPoi nt (Point hitPt,
Short nodi fierKeys, |ong when);

Calculates the popup position in global coordinates.
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CBartender

23°

Introduction

The bartender is the object that manages the menu bar, menus, and
menu items. The bartender is an object of class CBartender. There is
only one obiject of this class, stored in a global variable.

Note
Earlier versions of the THINK Class Library used

CBarOwner, a derived class of CBartender, to
prevent excessive menu bar flashing. This version
of CBartender includes this improvement.

Heritage

Base Class None
Derived Classes None

Using CBartender

In the THINK Class Library, almost every menu item has a command
number associated with it. The bartender maintains a table that maps
menu items to command numbers. You should never try to access
the bartender’s data structures directly. Instead, use the access
member functions.

You should not need to make a derived class of CBartender. If, for
some reason, you do need to create a derived class, you'll also need
to override the Set UpMenus member function in your application
class to initialize your bartender.

To manipulate the menus or menu items, call the functions of the
global bartender object stored in the global variable gBar t ender .
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Creating standard menus

To associate a command number with a menu item, append the
command number to the end of the menu item in your ' MENU
resource. The menu item text and the command number are
separated by the character #. Figure 23-1 shows what the File menu
looks like in ResEdit:

S I=Y=———=—= MENU “File” I0 = 2 from TCL Resources

m Entire Menu: ] Enabled
New#2 BN
Open...#3 %20 Title: @ [File |
Close#4 E1 > % (Apple menu)

Save#5 ®S
save As...#6
Revert to Saved#7?

Page Setup...#8
Print...#0 *

[Lr

Figure 23-1 The File menu in ResEdit

If you don’t append a command number to a menu item, the
bartender automatically associates the command number cndNul |
with it.

The bartender builds its tables from the information in the ' MBAR
resource you pass to its constructor. Your application’s ' MBAR
resource should contain the menu IDs of all the menus that will
appear in the menu bar.

Note
By default, the application’s Set UpMenus member
function uses the ' MBAR resource with an ID = 1.
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The ' MENU resources for
these menus are in the file
TCL Resources.

You can use any menu ID for your application’s menus. The THINK
Class Library reserves the menu IDs in Table 23-1 for certain menus.

Menu title Menu ID Mnemonic
Apple 1 MENUappl e
File 2 MENUfi | e
Edit 3 MENUedi t
Font 10 MENUF ont
Size 11 MENUsi ze

Table 23-1 Menu IDs

Below are the commands that the THINK Class Library defines. In
Symantec C++, they are in the file Conrrands. h. Remember that the
THINK Class Library reserves the commands in the range 1 to 1023.

Table 23-2 lists standard File menu commands.

Command
cndQui t
cndNew
cmdQpen

cndd ose
cndSave
cndSaveAs
cndRevert
cndPageSet up
cndPri nt

(OOD\ICDU‘I#(JONI—‘G

Table 23-2 File menu command IDs

Table 23-3 lists the standard Edit menu commands.

Command ID
cndUndo 16
cndCut 18
cndCopy 19
cndPast e 20
cnddl ear 21
cmdToggl edip 22
cndSel ect Al | 23

Table 23-3 Edit menu command I1Ds
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Table 23-4 lists the text style commands.

Command ID
cndPl ai n 30
cndBol d 31
cmditalic 32
cnmdUnder | i ne 33
cndQut i ne 34
cndShadow 35
cndCondense 36
cndExt end 37

Table 23-4 Text style command IDs

Table 23-5 lists the text alignment commands.

Command ID
cndAl i gnRi ght 40
cndAl i gnLeft 41
cndAl i gnCent er 42
cmdJustify 43

Table 23-5 Text alignment command IDs
Table 23-6 lists the line spacing commands.

Command ID
cmdSi ngl eSpace 50
cndlHal f Space 51
cmdDoubl eSpace 52

Table 23-6 Line spacing command IDs

Table 23-7 lists miscellaneous commands.

Command ID Description

crmdNul | 0 Command that does nothing
cmdCK 100 OK button in dialog box
cnmdCancel 101 Cancel button in dialog box
cndAbout 256 About Application request

Table 23-7 Miscellaneous command IDs

If you want the bartender to return the menu ID and item number of
a particular menu item, use the special command -1 in your ' MENU
resource. The bartender returns the negative number of the menu 1D
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The values that Fi ndCrd
returns in these cases are
the negative of what
MenuSel ect would
have returned.

in the high word and the menu item number in the low word. This is
the same return format used for resource-based menus, described
next.

Resource-based menus

Your application may use menus that don’t have menu commands
associated with each item. The most common example is a Font
menu. Use the reserved Font menu in your ' MBAR' resource, and
add the resources with the AddResMenu Toolbox routine. Here’s
how you might write your Set UpMenus function in Symantec C++
to include a font menu:

voi d CYour App: : Set UpMenus()
{
MenuHandl e macMenu;

i nherited:: Set UpMenus();

AddResMenu( Get MHandl e( MENUf ont ),
"FONT' ) ;

Set Di nOpt i on( MENUf ont, di mNONE) ;

Set Unchecki ng( MENUf ont, TRUE) ;

Note
To learn about Set Di mOpt i on and
Set Unchecki ng, see “Dimming and checking
menu items” later in this chapter.

When you build a menu this way, the bartender is unable to
associate a command number with the menu items. In this case, the
bartender’s Fi ndCmdNunber returns the negative of the menu ID in
the high word and the item ID in the low word.

For example, if you choose the ninth font in the Font menu,

Fi ndCndNunber returns -655369 (OxFFF5FFF7). Since the
number is negative, you know that no command number is
associated with the item. To get the menu ID and the menu item,
negate the value and split it into two words. In this example, the
return value becomes 655369 (0x000A0009), which means that the
menu ID is 10 and the menu item is 9.

—( ‘ menul D ‘ menul t em \) ‘

Figure 23-2 How FindCmdNumber builds command numbers
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Note
There are functions to extract the high word and
low word of a long integer. In Symantec C++, the
functions are Hi Short and LoShort (defined in
d obal . h).

You can add menu items to existing menus. You might add the Font
menu to a general text-handling menu, or you might want to have a
menu with the names of all the documents your application has
opened. The important thing to remember is to add all these menu
items at the end of the existing menu. Otherwise, the bartender will
get confused.

Creating hierarchical menus
For a detailed description ~ Most of the time you'll be able to set up your hierarchical menus in
of hierarchical menus, see  your resource file. The key thing to remember is that the item to

Inside Macintosh V, which the hierarchical menu is attached uses the command key
Chapter 13, “The Menu equivalent and the item mark differently. The command key value
Manager. must be 0x1B (Control-[ ), and the value of the item mark is the

resource ID of the hierarchical menu.

Sometimes, you can'’t specify a hierarchical menu in a resource. In
these cases, use the | nsert H er Menu member function. This
function adds the hierarchical menu to an existing menu in the menu
bar and to the bartender’s table. Generally, you'll specify hierarchical
menus in your resource file. Use this function to insert hierarchical
menus from your program.

Note
For hierarchical menus to work correctly, you must
set them up either in the resource file or with a
call to I nsert H er Menu. If you use only the
Macintosh Toolbox routines, the bartender’s
item-checking functions will not work.
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The dimming,

undimming, and
unchecking take very little
time. You won’t notice a
delay between the time
you click on the menu bar
and when the menu is
displayed.

This example shows how to write a function to insert a hierarchical
Font menu as the third item in a Text menu from your program;

voi d CYour App: : Set UpMenus()

{
MenuHandl e nmacMenu;

short MENUt ext, itenNG

CAppl i cation:: Set UpMenus() ;

gBart ender - >l nsert H er Menu( MENUf ont ,
cndNul |, MENUt ext, 2);

AddResMenu( Get MHandl e( MENUf ont ),
"FONT' ) ;

Set Di mOpt i on( MENUf ont, di nNONE) ;

Set Unchecki ng( MENUf ont, TRUE) ;

}

Dimming and checking menu items

The bartender includes member functions to let you enable and
disable and check and uncheck menu items. When you click the
menu bar, the bartender calls the Updat eMenus function of every
bureaucrat in the chain of command. Generally, all menu items start
out dimmed and unchecked. Each bureaucrat then enables the menu
items that pertain to it. Once the appropriate items have been
enabled and checked, the Toolbox routine MenuSel ect displays all
the menus.

Suppose you click the menu bar of a text-processing application.
When you click the menu bar, the bartender disables all the menu
items before the Toolbox displays the menu. Then, the application
enables all the application-related menu items: New, Open and
Quit, for example. The document enables all the document-related
items: Save, Save As, Revert (if the document’s been changed), and
so on. A pane might check the current font and size in the Font
menu. Finally, the menu appears on the screen with the correct
items checked and enabled.

Your application, document, and pane each have a function called
Updat eMenus, which needs to enable each menu item. To make
sure that item enabling happens from the general (application) to the
specific (pane), be sure to call inherited Updat eMenus first in your
own Updat eMenus function.

You can use the bureaucrat member functions Set Di mOpt i on and
Set Unchecki ng in your application Set UpMenus function to
modify this behavior. Set Di mOpt i on lets you specify whether the
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bartender should dim all, some, or none of the items when you click
on the menu bar. For Font menus, for instance, dimming all the font
names does not make sense if they are only going to be re-enabled
again.

Global Variables and Data Members

The global variable gBar t ender points to the single instance of the
bartender. When you want to manipulate menus, call this object’s
functions. The bartender uses its data members to maintain the
mapping between command numbers and menu items. You should
not need to access or alter the data members.

Global variable

Variable Type Description
gBart ender CBartender  The global bartender

Data members

Data member Type Description

nunmvenus short The number of
menus available

t heMenus MenuEntryH A table with an entry
for each available
menu

chor eAssi gned Bool ean TRUE if there's a

pending chore to

redraw the menu bar
f orceMBar Updat e Bool ean TRUE if

Updat eMenuBar

always draws the

menu bar

Member Functions

To use these functions to manipulate menus and menu items, call
the functions of the bartender object stored in the global
gBart ender.

For example, to disable the Open command, you would write:

gBar t ender - >Di sabl eCnd( cndQpen) ;
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To change the name of the Copy command to Copy Picture, you
might write:

gBart ender - >Set CdText ( cndCopy,
"\ pCopy Picture");

In the rare case when you need the actual menu handle or other
information about the menu, use the Fi ndMacMenu or
Fi ndMenul t emfunctions.

Creation and destruction

CBartender
CBartender (short MBARI d = 0);

Constructor. The application’s Set UpMenus function creates the
bartender and stores a pointer to it in the global variable

gBart ender. MBARi d is the ID of the ' MBAR resource that the
bartender uses to build its menu tables. The default Set UpMenus
uses 1 as its MBARi d.

CBartender
CBartender ();

Default constructor. Implicitly called when an object is created by
new by nane. It can also be used in combination with
| Bar t ender for backward compatibility.

~CBartender
~CBar t ender () ;

Destructor. The bartender's destructor doesn't do anything, as the
bartender is never deleted.

IBartender
void | Bartender (short MBARi d);

Initialization function provided for backward compatibility.
| Bar t ender may only be called if no constructor arguments are
specified.
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Insertion and deletion

AddMenu
voi d AddMenu (short MENU d, Bool ean install,

short beforel D);
This function adds a menu to the bartender’s list. MENUi d is the
resource ID of the menu. If i nst al | is TRUE, install it into the
menu bar as well as into the bartender’s list. Bef or el D specifies the
menu before which this menu is installed. If bef or el Dis 0, the
menu is added to the end of the menu bar. A beforel Dof-1is a
hierarchical or pop-up menu.

RemoveMenu
voi d RenoveMenu (short MENUI d);

If nothing else is using the specified menu, remove it from the menu
bar and from the bartender’s list. Call RenbveMenu on all the
hierarchical menus it uses. MENUI d is the resource ID of the menu.

To know when it can remove a menu, the THINK Class Library
keeps a use count for each menu. AddMenu increments a menu’s
use count each time it adds a menu. RenmoveMenu decrements the
use count and removes the menu only if the count is zero.

InsertinBar
void InsertlnBar (short MENU d, short beforel D);

Inserts a menu in the menu bar and in the bartender’s list. This
function is the same as AddMenu( MENUI d, TRUE, beforel D).

DeleteFromBar
voi d Del et eFronBar (short MENUI d);

Removes the specified menu from the menu bar, but leaves it in the
list. After deleting the menu, this function creates a chore of class
CWvBar Chor e and sends it to gAppl i cati on as an urgent chore.
The chore will redraw the menu bar the next time through the event
loop.

InsertHierMenu

voi d InsertH erMenu (short hMENUI d, | ong cndNo,
short inMENUI d, short afterlten);

Inserts a hierarchical menu in another menu. hMENUI d is the menu

ID of the hierarchical menu. If you want to be able to dim a

hierarchical menu, provide a command number in cndNo; if you're
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not going to dim the hierarchical menu, pass in cndNul | for
cndNo. i nMENUI d is the menu ID of the menu that will contain the
hierarchical menu. aft er |t emis the item number after which the
hierarchical menu should be inserted. The title of the menu is used
as the item name for the hierarchical menu.

Item manipulation

EnableCmd
voi d Enabl eCnd (| ong cndNo) ;

Enables the menu item associated with cndNo.

DisableCmd
voi d Di sabl eCnd (1 ong cndNo) ;

Disables the menu item associated with cndNo.

EnableMenu
voi d Enabl eMenu (short MENUI d);

Enables the menu with resource ID MENUI d.

DisableMenu
voi d Di sabl eMenu (short MENUI d);

Disables the menu with resource ID MENU d.

EnableMenuBar
voi d Enabl eMenuBar () ;

Enables all the menus currently in the menu bar.

DisableMenuBar
voi d Di sabl eMenuBar () ;

Disables all the menus currently in the menu bar.

SetCmdText
voi d Set CndText (|l ong cndNo, Str255 theText);

Changes the text of the menu item associated with cndNo to
t heText .
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GetCmdText
voi d Get CndText (Il ong cndNo, Str255 theText);

Stores the text of the menu item associated with cnrdNo int heText .
If cndNo is not associated with a menu item, the contents of
t heText are unchanged.

CheckMarkCmd
voi d CheckMarkCnd (| ong cndNo, Bool ean checked);

Places (or removes) a check mark next to the menu item associated
with cndNo.

Item insertion and deletion

InsertMenuCmd

void I nsert MenuCnd (1 ong crmdNo, Str255 theText,
short MENU d, short afterlten);

Inserts a new item in a menu. cnmdNo is the command number of

the new item. t heText is the text of the new item. MENUI d is the

ID of the menu into which you're inserting the new item.

af t er | t emspecifies after which item to insert the new item.

RemoveMenuCmd
voi d RenoveMenuCnd (1 ong cndNo) ;

Removes the menu item associated with the command cndNo from
its menu.

Look-up

These functions let you know which command number is associated
with which menu item and which menu contains the menu item
associated with a particular command number.

FindCmdNumber
| ong Fi ndCndNurber (short MENUI d, short itenmNo);

Return the command number associated with the menu MENUI d and
i t emNo. If the item has no command associated with it, this
function returns MENUI d in the high word and i t enMNo in the low
word.

This is the function called by the desktop and switchboard on the
bartender to convert a menu selection or a menu key into a
command number. Some menu items, like font menus, don’t have
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commands associated with them. For these menus,
Fi ndCrdNunber returns the menu ID and item number.

FindMenultem

voi d Fi ndMenultem (1 ong cndNo, short *MENUI d,
MenuHandl e *rmacMenu, short *itenmNo);

Returns the menu ID, the handle to the menu, and the item number

associated with a given command number. If the command number

isn’t associated with a menu item, all three items are set to zero.

FindltemText
short FindltenText (short MENU d,

Str255 itenttr);
Returns the item number in MENUI d with the specified text. Return
zero if the menu doesn’t have an item called i t enfst r. This function
is useful for keeping track of items that don’t have command
numbers associated with them.

FindMacMenu
MenuHandl e Fi ndMacMenu (short MENUI d);

Returns a handle to the Macintosh menu with ID MENUI d. If the
menu is not in the bartender’s table, return NULL.

FindMenulndex
short Fi ndMenul ndex (short MENUI d);

Returns the index of the menu MENUI d in the bartender’s table. This
is an internal function. You should not use this function.

Appearance

SetDimOption
void SetDi mOption (short MENU d,
D nOpti on abDi nmi ng) ;
Sets the dim option for the specified menu. By default, all the items
in the menu are dimmed when you click the menu bar. The
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Updat eMenus function of each of your bureaucrats needs to enable
the appropriate items.

If aDimming is... The bartender will...

di n\NONE Never dim any of the menu items.

di nSOVE Dim only the menu items that have
command numbers associated with them.

di mALL Dim all of the menu items. Each bureaucrat’s

Updat eMenus function must enable the
items for the commands it handles. This is
the default.

Table 23-8 Menu-dimming options

SetUnchecking
voi d Set Unchecki ng (short MENUI d,

Bool ean anUnchecki ng) ;
Sets the checking option for the specified menu. By default, all items
are checked when you click the menu bar. If you set this option to
TRUE, all the items will be unchecked, and your Updat eMenus
functions must check the appropriate menu items.

If anUnchecking is... The bartender will...

TRUE Uncheck all the menu items at menu
selection. Your Updat eMenus function
should check the appropriate items. Set
this option for menus such as Font or
Style menus.

FALSE Not uncheck any menu items at menu
selection. This is the default because most
menu items never need to be checked.

Table 23-9 Menu-unchecking options

UpdateAllMenus
voi d Updat eAl | Menus() ;

This function of the bartender is called before menu selection. First it
disables and unchecks all the items in the menus according to the
dimming and unchecking options. Then it calls the gopher’s

Updat eMenus function to enable the appropriate menu items. You
should not use or override this function.
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UpdateMenuBar
voi d Updat eMenuBar () ;

Call Dr awenuBar if the menu bar needs to be redrawn, . The
menu bar needs to be redrawn if the f or ceMBar Updat e flag is
TRUE, or if the enabled state of any menu in the menu bar doesn’t
match the last recorded state.

SetMenuBarState

| ong Set MenuBar St at e(| ong bar St ate) ;

Enables or disables all the menus in the menu bar and returns the
former state. If bar St at e is 0, it disables all the menus. If

bar St at e is - 1, it enables all the menus. This function has no
effect on hierarchical menus.

Command extraction

These are three internal functions that the bartender uses to find
commands associated with menu items and to build its internal data
structures. You should not use these functions. These are THINK
Class Library functions:

voi d Extract Conmands (MenuEntryP theEntry);

void ParseltenString (Str255 itenStr,
| ong *cndNo) ;

voi d Extract Hi er Menus (MenuHandl e nacMenu,
short index);

Visual Architect and THINK Class Library Guide 393



23 CBartender

394 Visual Architect and THINK Class Library Guide



CBitMap

To learn more about
transfer modes, see Inside
Macintosh Volume |,
Chapter 6, “QuickDraw.”

24

Introduction

CBitMap is a class you use to work with Macintosh bitmaps. You
should be familiar with QuickDraw bitmaps before using this class.

Heritage
Base Class None
Derived Classes None

Using CBitMap

CBitMap gives you member functions to draw into a bitmap, to
stamp a bitmap on the current drawing port, and to get a bitmap
from the current drawing port. This class doesn’t provide a drawing
function because it is only intended for manipulating bitmaps. The
class CBitMapPane gives you a pane for drawing bitmaps.

Use the CopyFr ommember function to copy bits from your bitmap
object to the bitmap of the current QuickDraw port. To copy bits
from the current port to your bitmap object, use the CopyTo
member function. The transfer mode determines how the bitmap is
copied. Use the Get Xf er Mode member function to examine the
current transfer mode and the Set Xf er Mode member function to
set the transfer mode. The default transfer mode is sr cCopy.

To draw into an off-screen bitmap, bracket your drawing routines
with calls to Begi nDr awi ng and EndDr awi ng. When you create
the bitmap object, you have the choice of creating a drawing port for
it. If you create a port, your bitmap will have a complete QuickDraw
environment when you draw to it. If you don't, the drawing routines
use the drawing environment of the current port.
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In general, you should create a port for a bitmap whenever you
intend to draw to a bitmap. If you use a bitmap only to hold an
image that you copied from or want to copy to the current port, you
don’t need to create a port.

For example, this procedure draws a diagonal line in an off-screen

bitmap:

voi d Drawl nt oOf f Scr eenBi t Map(voi d)

{
CBi t Map *nyBi t Map;
nyBi t Map = new CBi t Map(300, 300, TRUE );
nyBi t Map- >Begi nDr awi ng;
MoveTo(10, 10);
Li neTo( 200, 200);
myBi t Map- >EndDr awi ng;

b

Once you finish drawing into your bitmap, you can use the
Copy Fr ommember function to stamp it into the current port. To
save the bitmap as a paint (' PNTG ) file, you use the CPNTGFile
class.

Data Members

CBitMap defines these data members:

Data member Type Description

mac Por t GafPtr Grafport for the bitmap if
requested.

savePort GafPtr Used internally to save the
original drawing port if
necessary.

macBi t Map Bi t Map The bitmap.

saveBit Map Bit Map Used internally to save the

original drawing port’s bitmap
if necessary.

xf er Mode short Bitmap transfer mode. Initially
sr cCopy.
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Member Functions

Creation and destruction

CBitMap
CBitMap (short width, short height,

Bool ean nakePort);
Constructor. CBitMap allocates memory for the bitmap. The origin is
set to (0,0) and the transfer mode is set to sr cCopy. If makePort is
TRUE, CBitMap creates a QuickDraw grafport whose port bits point
to the bitmap. In general, you should pass TRUE for makePor t if
you intend to draw to the bitmap and FALSE if you use the bitmap
only to hold an image.

CBitMap
CBi t Map ();

Default constructor. Implicitly called when an object is created by
new_by namne. Can also be used in combination with | Bi t Map for
backward compatibility.

~CBitMap

~CBi tMap ();

Destructor. Releases memory allocated to the bitmap and closes
macPor t if it was opened.

IBitMap
void IBitMap (short wi dth, short height,
Bool ean nakePort);
Initialization function provided for backward compatibility.
| Bi t Map may only be called if no constructor arguments are
specified. Arguments are same as for the constructor.

Dispose

voi d Di spose ();

Disposal function provided for backward compatibility. Di spose
simply calls operator delete. This function is only available if
TCL_USE_DI SPCSE is defined in the project.
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Accessing

GetBounds
voi d Get Bounds (theBounds *LongRect);

Stores the bounding rectangle of the bitmap in t heBounds. This
rectangle describes the size and coordinate system of the bitmap.

SetBoundsOrigin
voi d Set BoundsOrigin (short hOrigin,
short vOrigin);
Sets the coordinates of the upper-left corner of the bitmap. This
function changes the coordinate system of the bitmap.

SetXferMode
voi d Set Xfer Mode (short aXferMde);

Sets the transfer mode of the bitmap.

GetXferMode
short Get XferMde ();

Returns the transfer mode of the bitmap.

PixellsBlack
Bool ean Pi xel | sBl ack (LongPt pixel Pos);

Returns TRUE if the pixel specified by pi xel Pos is black. Returns
FALSE if it isn't or if the specified position is not in the bitmap.

Image copying

CopyTo
voi d CopyTo (LongRect *fronRect,

LongRect *toRect, RgnHandl e maskRgn);
Copies bits to this bitmap from the current QuickDraw port
(t hePort). fronRect is arectangle int hePort’s bitmap, and
t oRect is a rectangle in this bitmap. If maskRgn is NULL, this
function does no clipping. Otherwise, the transfer is clipped to
maskRgn, a region in this bitmap’s coordinates. The transfer mode is
stored in the xf er Mode data member.
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CopyFrom
voi d CopyFrom (LongRect *fronRect,

LongRect *toRect, RgnHandl e maskRgn);
Copies bits from this bitmap to the current QuickDraw port
(t hePort). FronRect is a rectangle in this bitmap, and t oRect is
a rectangle in t hePor t ’s bitmap. If naskRgn is NULL, this function
does no clipping. Otherwise, the transfer is clipped to maskRgn, a
region in t hePor t s coordinates. The transfer mode is stored in the
xf er Mode data member.

Drawing preparation

BeginDrawing

voi d Begi nDrawi ng ();

Prepares for drawing to this bitmap. If the bitmap doesn’t have its
own port, set the port bits of the current QuickDraw port to this
bitmap. If the bitmap has its own port, this function saves the current
port and sets the bitmap’s port as the current port.

EndDrawing
voi d EndDrawi ng ();

Resets the port to the state before drawing. If the bitmap doesn’t
have its own port, restores t hePor t ’s port bits from saveBi t Map.
Otherwise, resets the port to savePort .

Object I/0

PutTo
void PutTo (CStream& aStrean;

Writes to the stream.

GetFrom
void GetFrom (CStreanm& aStrean);

Reads from the stream.

Member Functions: Private

CBitMapX
void CBit MapX ()
Performs common constructor initialization.
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Friend Functions

The following friend functions overload operator << and >> to
provide alternatives to the Put and Get functions.

operator <<
friend CStream & operator << (CStrean& s,
CBit Map *p)

operator >>
friend CStream & operator >> (CStrean& s,
CBit Map *p)
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For static images, a picture
pane is easier to use. See
Chapter 78, “CPicture.”

25

Introduction

CBitMapPane is a derived class of CPanorama for drawing bitmaps in
a pane.

Heritage
Base Class CPanorama
Derived Classes None

Using CBitMapPane

CBitMapPane is a pane with an associated bitmap. The drawing
member function of a bitmap pane copies from the bitmap to the
pane’s drawing port. Your program should therefore draw into the
bitmap pane’s bitmap before the drawing member function gets
called. The Art Class demonstration program, which uses a derived
class of CBitMapPane, draws directly on the screen and on the
associated bitmap in a mouse task. When the Macintosh generates an
update event, the pane’s drawing function copies the associated
bitmap right on the screen, giving a very smooth update.

Though you can use CBitMapPane directly, you will probably want
to use a derived class of it so you can add data members and
member functions tailored for your application. Your program can
use whatever technique is appropriate to fill the bitmap with an
image. If the image doesn’t change, your program can just read the
bitmap from a file and rely on the update event to stamp the image
on the screen. If it's an interactive image, you might use a mouse
task as Art Class does. If it's a complex image and you want to give
the illusion of a quick update, you do the drawing to the bitmap in
your derived class’s Dr aw function with CBitMap’s Begi nDr awi ng
and EndDr awi ng functions, and then call the inherited Dr aw
member function to stamp the image on the screen.
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Data Members
CBitMapPane defines this data member:

Data member Type Description
itsBitMap CBi t Map* The bitmap to stamp on the pane

Member Functions

Creation and destruction

CBitMapPane
voi d CBit MapPane (CVi ew *anEncl osur e,
CBur eaucr at *aSuper vi sor,
short aWwdth, short aHei ght,
short aHEncl, short aVEncl,
Si zi ngOpti on aHSi zi ng, Sizi ngOption aVSi zi ng,
LongRect *aBounds,
CBit Map *aBit Map, Bool ean nmakePort);
Initializes a panorama. The first eight arguments to this routine are
identical to those for CPane.

The aBounds rectangle is a long rectangle that defines the bounds
of the panorama. The bounds define the height and width of
aBi t Map as well as its coordinate system.

If aBi t Map is NULL, CBitMapPane creates a new bitmap object for
the pane; otherwise, it uses aBi t Map as the pane’s bitmap. When
you use an existing bitmap, be sure to pass the correct bounds to
CBitMapPane. Call the bitmap’s Get Bounds function to get its
bounds, and pass the results to CBitMapPane.

CBitMapPane passes the makePor t parameter to CBitMap’s
constructor. If aBi t Map is not NULL, this parameter is ignored. The
makePor t parameter specifies whether the bitmap should have a
drawing environment. In general, you should always pass TRUE for
this parameter.

Note
The other arguments are described in Chapter 71,

“CPane.”
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CBitMapPane
CBi t MapPane ();

Default constructor. Implicitly called when object is created by
new_by_name. Can also be used in combination with
| Bi t MapPane for backward compatibility.

IBitMapPane
voi d | Bi t MapPane (CVi ew *anEncl osure,
CBur eaucr at *aSupervi sor,
short aWwdth, short aHei ght,
short aHEncl, short aVEncl,
Si zi ngOpt i on aHSi zi ng, Si zi ngOpti on aVSi zi ng,
LongRect *aBounds,
CBit Map *aBit Map, Bool ean nmakePort);

Initialization function. Arguments are the same as in the
CBitMapPane constructor. | Bi t MapPane may not be called if any
arguments are specified in the constructor.

~CBitMapPane
~CBi t MapPane ();

Destructor. Deletes the bitmap. Releases memory allocated to the
bitmap and closes the nacPor t if one was opened.

Accessing

SetBitMap
void SetBitMap (CBit Map *aBit Map);

Stores the bounding rectangle of the bitmap in aBi t Map. This
rectangle describes the size and coordinate system of the bitmap.

GetBitMap
CBitMap *CGetBitMap ();

Returns the bitmap associated with this pane.

Drawing

Draw
void Draw (Rect *area);

Draws the bitmap. Copies the bits in the bitmap to the bitmap of the
current port.
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Object I/0

PutTo
void PutTo (CStream& aStrean;

Writes to the stream.

GetFrom
void Get From (CStream& aStrean);

Reads from the stream.
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Introduction

CBuffering Stream improves the performance of CStream by adding
buffering. Buffering speeds up I/0 by reducing the number of times
the operating system is called and the number of times the disk is
accessed for a given sequence of operations.

Heritage
Base Class CStream
Derived Classes CFileStream

CHandleStream

Using CBufferedStream

Since CBufferedStream is an abstract class, you never use it directly.
CBufferedStream does most of the work for the CHandleStream class
and speeds up CFileStream 1/0 significantly. CBufferedStream
implements the actual transfer of data to and from a stream.
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Data Members

The following are protected data members that only derived classes

may use.

Data member Type Description

buf Position |ong Position in the stream of the first
byte in the buffer.

buf Pos | ong Current read/write position in
the buffer.

buf Max | ong Size of the buffer.

buf val i d | ong The highest valid byte in the
buffer.

itsBuffer Handl e Handle to the buffer.

changed Bool ean TRUE if buffer has been put to

since last written to disk.

Member Functions

Creation and destruction

CBufferedStream
CBuf f eredSt rean(l ong bufferSize =

kTCLDef aul t St r eanBuf f er Si ze,

Bool ean check = TRUE);
Constructor. buf f er Si ze specifies the number of bytes to be used
for the buffer. check controls whether the stream checks for
duplicate objects. The value of kTCLDef aul t St r eanBuf f er Si ze
is 2048. See CSt r eam : CheckDupl i cat es.

CBufferedStream
CBuf f er edSt rean() ;

Default constructor. Implicitly called when an object is created by
new_by_name. Can also be used in combination with
| Buf f er edSt r eamfor backward compatibility.

~CBufferedStream
~CBuf f eredStrean() ;

Destructor. Frees the buffer memory.
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SetBufferSize
voi d SetBufferSize(long aBufSi ze);

Sets the number of bytes to be used by the buffer. This function
should be called before the stream is first opened.

Open and close

Open
voi d Open(TCLSt reamvbde node);

Opens stream for ReadSt ream Wit eSt r eam or
ReadW i t eSt r eamaccess.

Close
void O ose ();

Closes stream, returning it to Cl osedSt r eammode. The same
stream may be opened and closed multiple times, such as for writing
and then reading.

Positioning

Position
I ong Position ();

Returns the current stream position. The stream position is a long
integer ranging from zero to the number of bytes in the stream
minus one. The first byte of the next Get or Put will come from or
go to the current position.

MoveTo
voi d MoveTo(l ong newPosition);

Changes the current stream position.

Size
long Size ();
Returns the number of bytes in the stream.

Truncate
voi d Truncate(l ong newSi ze);

Reduces the number of bytes in the stream.
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Writing

Put
void Put(constvoid *bytes, long n);

Puts n bytes to the stream.

PutThru
voi d Put Thru(constvoid *bytes, char c);

Puts data to the stream starting with the first character of bytes and
ending with the first occurrence of the character c.

PutChar
voi d Put Char (char val ue);

Puts a single character to the stream.

Reading

Get
void Cet(void *bytes, long n);
Gets n bytes from the stream.

GetThruN

Il ong GetThru (void *bytes, char ¢, long n);

Gets data from the stream starting with the first character of byt es
and ending with the first occurrence of the character ¢, the end of
the stream or the first n characters, whichever is first.

Get Thr uN, unlike most get functions, does not fail if it is called at
the end of a stream. Instead, it returns a length of zero.
Get St r AsLi ne, which calls Get Thr uN, also works in this way.

GetChar
char Get Char();

Gets a single character from the stream.
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Member Functions: Protected

Fill

void Fill ();

CBufferedStream calls this function when it reaches the end of the
buffer while reading a stream. The derived class must refill the buffer
or fail.

Drain

void Drain ();

CBufferedStream calls this function when it reaches the end of the
buffer while writing a stream. The derived class must empty the
buffer or fail.

Bracket
voi d Bracket (1 ong aPosition);

CBufferedStream calls this function when it is asked to Posi ti on
outside the data currently in the buffer. The derived class must drain
the buffer, if necessary, and reposition it so that the requested
position is inside the buffer. The resulting buffer may be empty.

GetPhysicalSize
| ong Get Physi cal Si ze();

CBufferedStream calls this function when it needs to know the actual
physical size of the data in the stream, independent of buffering.

SetPhysicalSize
voi d Set Physi cal Si ze(l ong newSi ze) ;

CBufferedStream calls this function in response to Tr uncat e. The
derived class must reduce the actual physical size of the stream—for
example, the size of a file—to the requested size.
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CBureaucrat

27

Introduction

CBureaucrat is an abstract class that implements a link in the chain
of command. Any object in the THINK Class Library that responds to
a menu command or a mouse click is a bureaucrat.

A bureaucrat can either respond to a command, or it can pass the
command to its supervisor. All of the default member functions for
bureaucrats pass the command on to the supervisor. If a particular
derived class cannot handle the command, therefore, calling the
inherited member function causes it to be passed on up the chain of
command.

Heritage
Base Class CCollaborator
Derived Classes CDirectorOwner
CView
CPopupMenu

Using CBureaucrat

You generally won't need to create a derived class of CBureaucrat
because most of the objects you use are already descendants of this
class. However, if you do need to create a class that is a link in the
chain of command, CBureaucrat is the class to derive from.

The global variable gGopher points to the current bureaucrat,
which is the first object in the chain of command. Whenever the
switchboard responds to an event, it calls an appropriate member
function of the gopher. For instance, in response to a key-down
event, the switchboard calls the gopher’s DoKey Down member
function.
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If gGopher cannot “handle” the command, it passes the command

up the chain of command until it reaches an object that does handle

the command, or until it reaches the end of the chain of command—
the application.

When no documents are open, gGopher points to the application.
When you open a document, gGopher points to it. Your document
derived class should use the BeconeGopher member function to
change gGopher to point to the main pane.

Use the BecomeCGopher member function to change the gopher
instead of setting the gGopher variable yourself. BecomeGopher
uses CCollaborator’'s provider/dependent mechanism to let
dependent objects know that the gopher has changed.

Global Variables and Data Members

Global variable

CBureaucrat uses this global variable.

Variable Type Description
gCGopher CBur eaucrat  The current bureaucrat

Data member
CBureaucrat defines only one data member.

Data member Type Description
i t sSupervi sor CBureaucrat* The supervisor

Member Functions

Creation and destruction

CBureaucrat
CBur eaucr at (CBureaucrat *aSupervisor);

Constructor. Sets the bureaucrat’s supervisor.

~CBureaucrat
~CBur eaucrat () ;

Destructor. If this object is the gopher, the function changes the
gopher to the object’s supervisor.
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IBureaucrat
voi d | Bureaucrat (CBureaucrat *aSupervisor);

Initialization function provided for backward compatibility.
| Bur eaucr at may be called only if no constructor argument is
specified. The argument is the same as the constructor's.

Accessing

GetSupervisor
CBur eaucr at *Get Supervi sor () ;

Returns the bureaucrat’s supervisor.

Command

The following are the commands that every bureaucrat recognizes.
Unless a bureaucrat (or one of its ancestors) overrides one of these
functions, it passes the command to its supervisor. If you follow the
chain of supervisors—the chain of command—all the way to the
end, you'll end up at your application class.

Notify
void Notify (CTask *theTask);

Calls the Not i fy function of the bureaucrat’s supervisor to inform
the supervisor that t heTask has been completed.

NotifyClean
void Notifyd ean (CTask *theTask);

In CBureaucrat, Not i f yCl ean operates the same way as Not i fy.
In CDocument, Not i f yCl ean operates the same way as Not i fy,
except that Not i f yd ean doesn’'t mark the document dirty.

IsTaskWindowlInFront
Bool ean | sTaskW ndowl nFront () ;

Returns TRUE if the current undo/redo task belongs to the frontmost
window.

SetChanged
voi d Set Changed (Bool ean i sChanged);

Propagates the change notification up the chain of command. If
there is no document in the chain of command, the notification is
discarded.
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GetChanged
Bool ean Get Changed ();

Returns any changed state from the document in the chain of
command.

DoKeyDown

voi d DoKeyDown (char theChar, Byte keyCode,
Event Record *nacEvent);

Calls the DoKeyDown function of the bureaucrat’s supervisor to

handle a key-down event.

DoAutoKey

voi d DoAut oKey (char theChar, Byte keyCode,
Event Record *nacEvent);

Calls the DoAut oKey function of the bureaucrat’s supervisor to

handle an auto-key event.

DoKeyUp
voi d DoKeyUp (char theChar, Byte keyCode,
Event Record *nacEvent);
Calls the DoKey Up function of the bureaucrat’s supervisor to handle
a key-up event.

Note
By default, the Toolbox Event Manager masks out
key-up events.

ToggleChanged
voi d Toggl eChanged();

Toggles the flag that indicates that the document has changed.
Toggl eChanged is called when an Undo task is performed.

DoCommand
voi d DoComrand (| ong t heComand) ;

Calls the DoComand function of the bureaucrat’s supervisor to
handle a command.
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Dawdle
voi d Dawdl e (|l ong *naxSl eep);

Performs periodic actions at idle time. The default function does
nothing. CApplication’s | dI e function calls the Dawdl e function of
every bureaucrat in the chain of command.

If your bureaucrat requires periodic actions, perform them in the
Dawdl e function. Set the value of naxSl eep to the largest number
of ticks that your application can tolerate between calls to the
Dawdl e function. If your application’s Dawdl e function doesn’t
have any time constraints, you can ignore maxSl eep.

The application class uses the value of maxSl eep to let

Wai t Next Event know that it should yield an event at least once
every maxSl eep ticks. For instance, the Dawdl e function for
CEditText calls TEI dl e to blink the insertion point and sets
max Sl eep to Get Car et Ti ne, which is the number of ticks
between blinks.

Another use for the Dawdl e function would be to update an
on-screen clock. You would update the display from your
document’s Dawdl e function. If your clock displays seconds, set
max Sl eep to 60, since you need to update the display at least every
60 ticks.

On a null event, CApplication’s | dl e function calls the Dawdl e
function of every bureaucrat in the chain of command. | dl e sets the
global variable gSI eepTi ne to the smallest sleep time that all
bureaucrats requested. The switchboard uses this global variable in
its call to Wi t Next Event .

UpdateMenus
voi d Updat eMenus ();

Updates the menus that relate to this bureaucrat. Your bureaucrat
(usually a document or a pane) should override this function to
enable the menu items that pertain to it. When you write an

Updat eMenus function, be sure to call inherited Updat eMenus
before you enable your own menus. As a result, your supervisor’s
menus will be updated first. See Chapter 23, “CBartender,” especially
the section “Dimming and checking menu items,” for a discussion of
menu updating.
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BecomeGopher
Bool ean BeconeGopher (Bool ean fBeconi ng);

If f Becomi ng is TRUE, make this bureaucrat the gopher and call
Br oadcast Change with bur eaucr at | sGopher as the reason. If
f Becomi ng is FALSE, call Br oadcast Change with

bur eaucr at | sNot Gopher as the reason.

If the current gopher refuses to relinquish control, this function
returns FALSE and does not call Br oadcast Change at all.

Change notification
The following member functions override functions in CCollaborator.
To learn how to use them, see Chapter 33, “CCollaborator.”

BroadcastChange
voi d Broadcast Change (|l ong reason, void* info);

In addition to notifying this bureaucrat’s dependents of a change,
this function notifies its supervisor. r eason is an integer that
describes the type of change. You must define reasons for your
derived class. i nf o is a pointer to any additional information
needed to respond to the change. If you want objects that aren’t in a
collaborator’s list of dependents to know about a change, override
this function.

ProviderChanged
voi d Provi der Changed (CCol | aborator *aProvi der,

| ong reason, void* info);
One of this bureaucrat’s providers has just changed. This function
passes the change natification to the bureaucrat’s supervisor. If you
want your derived class to respond to change notifications, override
this function. aPr ovi der is the provider that changed. r eason is
an integer that describes the type of change. You must define
reasons for your derived class. i nf o is a pointer to any additional
information that your derived class might need.

Object I1/0

PutTo
void PutTo (CStream& aStrean;

Writes to the stream.
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GetFrom
voi d Get From (CStream& aStrean;

Reads from the stream.
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28°

Introduction

CButton implements a standard Macintosh push button. You can use
a button in any pane or window.

Heritage
Base Class CControl
Derived Classes CCheckBox

CRadioControl

Using CButton

CButton implements a standard Macintosh push button. You should
not override this class unless you want to implement a push button
that works differently from the default button. (The other kinds of
Macintosh buttons, check boxes, and radio buttons are derived
classes of this class.)

To create graphic elements that act like buttons but are not based on
a Macintosh control, use CSwissArmyButton and its derived classes.

The CButton class handles all mouse tracking for you. When you
click and release the mouse within a button, the button calls its
supervisor’s DoCommrand function. To specify which command
number the button passes to the DoCommand function, call its
Set C i ckCnd function.

When you click a button, the DoCl i ck member function that
CButton inherits from CControl calls the Macintosh Toolbox routine
TrackContr ol to highlight the button and track mouse movement.
When you release the mouse within a button, the DoCl i ck member
function calls the control’s DoGoodd i ck function. The

DoGoodd i ck member function calls the DoConmand function of
the button’s supervisor.
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Data Members

CButton defines these instance data members:

Data member Type Description

clickCmd | ong Command number to send after a
click. The default is cndNul | .

procl D short The procl D used to create this
button.

Member Functions

Although CButton implements only the member functions listed
here, you can use the member functions it inherits from CControl
and CView to manipulate a button’s title and location.

Creation and destruction

CButton
CButton (short CNTLid, CView *anEncl osure,

CBur eaucr at *aSupervi sor);
Constructor. CNTLi d is the resource ID of the ' CNTL' resource.
CButton places the control at the location specified in the * CNTL'
resource. If you want to position the button from your program, call
its Pl ace function (inherited from CPane). The last two arguments
are the same as those used for CPane.

CButton
CButton (short awdth, short aHei ght,

short aHEncl, short aVEncl,

StringPtr title, Boolean fVisible,

short proclD, CView *anEncl osure,

CBur eaucr at *aSupervi sor);
Constructor. The first four and last two arguments are the same as
those used for CPane. ti t | e is the button title. f Vi si bl e controls
the initial visibility of the button. pr ocl D specifies what type of
button to create. Its possible values are defined in Control s. h and
include pushBut Pr oc, checkBoxPr oc, and r adi oBut Pr oc.

Note
The other arguments are described in Chapter 71,
“CPane.”

420 Visual Architect and THINK Class Library Guide



Member Functions

*

CButton
CButton ();

Default constructor. Implicitly called when an object is created by
new_by_ name. Can also be used in combination with | But t on for
backward compatibility.

IButton

void I Button (short CNTLid, CView *anEncl osure,
CBur eaucr at *aSupervi sor);

Initialization function provided for backward compatibility.

| But t on may be called only if no constructor arguments are

specified.

INewBuUtton
void | NewButton (short awdth, short aHeight,
short aHEncl, short aVEncl, StringPtr title,
Bool ean fVisible, short proclD,
CVi ew *anEncl osure, CBureaucrat *aSupervisor);
Initialization function provided for backward compatibility.
I NewBut t on may be called only if no constructor arguments are
specified.

Visual state and click response
GetClickCmd
long GetdickCmd ();

Returns the command that is sent to a button’s supervisor when the
user clicks a button.

SetClickCmd
void SetdickCnd (long adickCnd);

Sets the command number to be sent when the user clicks a button.

SetDefault
voi d SetDefault (Boolean fDefault);

Specifies whether the button is the default button. The default button
has a 3-pixel-thick rounded rectangle as a border.
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SimulateClick
void Sinulatedick ();

Simulates a click in this button. Use this function when you want to
provide visual feedback for a Command key shortcut. This function
highlights the button momentarily, and then calls the button’s
DoGoodd i ck function.

DoGoodClick
voi d DoGoodd i ck (short whichPart);

When you press and release the mouse within the button, this
function calls its supervisor’s DoComrand function.

Object I/0

PutTo
void PutTo; (CStrean& Strean;

Writes the button to the stream.

GetFrom
void GetFrom (CStrean& Strean);

Reads the button from the stream.

Member Functions: Private

CButtonX
void CButtonX ();

Performs common initialization.

IButtonX
void | ButtonX (short CNTLi d);

Completes initialization from a ' CNTL" resource.

INewButtonX

void | NewButtonX (StringPtr title,
Bool ean fVisible, short proclD);

Completes initialization from a pr ocl D.
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Introduction

CCharGrid is a derived class of CGridSelector that displays characters
in a table and lets you choose one. CCharGrid is useful for
implementing tool palettes like those in MacPaint(] and
HyperCard(.

Heritage
Base Class CGridSelector
Derived Classes None

Using CCharGrid

The CCharGrid class lets you create panes that display characters in
a table. The most common use for this kind of table is a tool palette.
You can use a CCharGrid as a tool palette that's part of a window or
as a custom tear-off menu. The Art Class demonstration program
uses CCharGrid to display its Tools tear-off menu.

=
O
AlO
O

=
O
AlO
-

Figure 29-1 Art Class uses CCharGrid as a palette and as a menu

To use a CCharGrid, you create a special font that contains your
tools. You can use ResEdit to create the font, or you can use a
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commercial bitmap font editor. Apple recommends that the family ID
for these kinds of fonts be in the range 32256 to 32767. Check the
Font Manager chapters in Inside Macintosh | and Inside Macintosh IV
for detailed information about working with fonts.

Unlike other derived classes of CPane, which give you the option of
initializing an object from a resource, you must use a resource to
initialize a CCharGrid. The first argument to the constructor,

CChar Gri d, is the resource ID of a' ChGd' resource. That resource
contains the values that CChar Gri d passes to CGridSelector’s
constructor.

CCharGrid defines this data member:

Data member Type Description

theCharacters Handle Handle to a Pascal string of
the characters to display in
the grid

Member Functions

Creation and destruction

CCharGrid
CCharGrid (short ChGdld, CView *anEncl osure,

CBur eaucr at *aSupervi sor);
Constructor. ChGdl d is the resource ID of the ' ChGd' resource that
describes the location of the pane and the size and name of the font
to use for the grid. See the section “Using CCharGrid” earlier in this
chapter for details on ChGd resources. CCharGrid creates a text
environment object of class CTextEnvirons to maintain the text
characteristics whenever the characters are drawn. The text transfer
mode is initially sr cOr. The last two arguments are the same as
those used with CPane.

CCharGrid
CCharGid ();
Default constructor. Implicitly called when an object is created by

new_by_nane. Can also be used in combination with | Char Gri d
for backward compatibility.

~CCharGrid
~CCharGid ();

Destructor. Deletes t heChar act er s handle.
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ICharGrid
void I CharGid (short ChGdid, CView *anEncl osure,
CBur eaucr at *aSupervi sor);

Initialization function provided for backward compatibility.
| Char Gri d may be called only if no constructor arguments are
specified.

Drawing

Drawltem
void Drawitem (short theltem Rect *theBox);

Draws character numbered t hel t emso that it is centered within
t heBox. Characters are numbered starting at 1.
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Introduction

CCheckBox implements a standard Macintosh check box. You can
use a check box in any pane or window.

Heritage
Base Classes CButton
CGroupButton
Derived Classes None

Using CCheckBox

You should not override this class unless you want to implement a
check box that works differently from the default. To implement a
graphic element with the behavior of a check box, see Chapter 111,
“CSwissArmyButton.”

The CCheckBox class handles all mouse tracking. When you click
and release the mouse button within a check box, it toggles the
value of the check box and calls its supervisor's DoComand
function. To specify which command number the check box calls in
the DoConmmand function, call its Set Cl i ckCnrd function.

Note
CCheckBox inherits the Set C i ckCnd member

function from CButton.

When you click a check box, the Dod i ck member function that
CCheckBox inherits from CControl calls the Macintosh Toolbox
routine Tr ackCont r ol , highlights the check box, and tracks mouse
movement. When you release the mouse within a check box, the
Dod i ck function calls the control’s DoGoodd i ck function. The
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DoGoodd i ck function toggles the value of the control and calls
the check box’s supervisor’'s DoComrand function.

To find out whether the check box is checked, call its | sChecked
function. You can set the value of the check box from your program
by calling its Set Val ue function. Use the values BUTTON_ON and
BUTTON_COFF to specify whether to check or uncheck the check
box.

Note
Setting the value with Set Val ue will not call the
check box’s supervisor’'s DoConmand function.

A CCheckBox object can participate in a button group along with
CRadioControl, CSwissArmyButton, and ClconButton objects. Setting
the value of a CCheckBox control to 1 sets all radio-style buttons in
the group to 0. Other check box-style buttons are unaffected. As a
result, you can construct button groups that behave like the
following button group:

3 Mone [ Mustard [ Tomato
] Mayo (=] Pickle
[ Lettuce []Sardine

Figure 30-1 Example of a button group

Data Members

This class has no data members.

Member Functions

Although CCheckBox implements only the functions listed here, you
can use the functions it inherits from CControl and CView to
manipulate a check box’s title and location.

You should use the Set C i ckCnd function that CCheckBox inherits
from CButton to specify the command that the check box sends to
its supervisor when you click it.
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Creation and destruction

CCheckBox
CCheckBox (short CNTLid, CView *anEncl osure,

CBur eaucr at *aSupervi sor);
Constructor. CNTLi d is the resource ID of the ' CNTL' resource.
CCheckBox places the control at the location specified in the
" CNTL" resource. If you want to position the check box from your
program, call its Pl ace function (inherited from CPane). The last
two arguments are the same as those used for CPane.

CCheckBox
CCheckBox (short awWdth, short aHei ght,

short aHEncl, short aVEncl,

StringPtr title, Boolean fVisible,

short procl D, CView *anEncl osure,

CBur eaucr at *aSupervi sor);
Constructor. The first four and last two arguments are the same as
those used for CPane. ti t| e is the check box title. f Vi si bl e
controls the initial visibility of the check box. pr ocl D specifies what
type of check box to create. Its possible values are defined in
Control s. h and include pushBut Pr oc, checkBoxPr oc, and
r adi oBut Proc.

CCheckBox
CCheckBox ();

Default constructor. Implicitly called when an object is created by
new_by nane. Can also be used in combination with | CheckBox
for backward compatibility.

ICheckBox

voi d | CheckBox (short CNTLid, CView *anEncl osure,
CBur eaucr at *aSupervi sor);

Initialization function provided for backward compatibility.

| CheckBox may be called only if no constructor arguments are

specified.
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INewCheckBox
I NewCheckBox (short aW dth,
short aHei ght, short aHEncl, short aVEncl,
StringPtr title, Boolean fVisible,
CVi ew *anEncl osure, CBureaucrat *aSupervisor);
Initialization function provided for backward compatibility.
I NewCheckBox may be called only if no constructor arguments are
specified.

Mouse

DoGoodClick
voi d DoGoodd i ck (short whichPart);

When you press and release the mouse within the check box, this
function toggles the state of the check box and calls its supervisor’s
DoConmand function.

Accessing

IsChecked
Bool ean | sChecked ();

Returns TRUE if the check box is checked.

TurnOff
void TurnOf ();

Called by CGr oupBut t on: : Tur ni ngOn when a radio button in
the same button group is turning on. Tur nOf f calls Set Val ue(0) .

SetValue

voi d SetVal ue (short aVal ue);

Sets the value of the button to aVal ue, which is one of
BUTTON_OFF, BUTTON_ON. This function will also notify other
CGroupButton controls in the same button group if the check box is
being turned on.

Object I/0

PutTo
void PutTo (CStream& aStrean;

Writes to the stream.
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GetFrom
voi d Get From (CStream& aStrean;

Reads from the stream.
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Introduction

CChore is an abstract class for implementing periodic or urgent
actions. The THINK Class Library executes periodic chores at idle
time and urgent chores after processing the current event.

Heritage
Base Class None
Derived Classes CMBarChore

CTearChore

Using CChore

Use this class to create chores that run at idle time or at the next
possible opportunity. Your application maintains a list of chores and
implements the member functions to install and remove them.

Using chores

Chores are attached to the application and not to any particular
document. The tasks that a chore performs, then, should pertain to
the entire application.

To implement a chore, define a derived class of this class. In your
derived class, override the Per f or mmember function. That function
implements the action you want your chore to take.

Note
If you need your chore to run at a specific interval,
use the Macintosh Toolbox routine Ti cks to store
the last time the chore was performed.
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For periodic tasks that apply to a particular document or pane, use
the Dawdl e member function. All bureaucrats, including documents
and panes, inherit a Dawdl e function. The application calls the
Dawd| e function of each bureaucrat in the chain of command. For
example, you would use a Dawdl e function to blink an insertion
point in a pane.

Idle chores

To install an idle chore, call the application’s Assi gnl dl eChor e
function. Your application calls the Per f or mfunction of all idle
chores at idle time. To remove an idle chore, call the chore you want
to remove within the application’s Cancel | dl eChor e function.
This example shows how to install an idle chore:

gAppl i cati on- >Assi gnl dl eChor e(t heChore);

Note
To remove an idle chore, keep it in a data member,
because Cancel | dl eChor e requires a reference
to a CChore object.

Urgent chores

An urgent chore is one that gets executed immediately after the
application processes the current event. Typically, it's the same event
that caused the urgent chore to be installed. Urgent chores are
executed only once. They're removed from the urgent chore list
immediately after they're executed. To install an urgent chore, call
the application’s Assi gnUr gent Chor e function.

Data Members

This class has no data members. Your CChore derived class may
define its own data members. For example, if you want an idle chore
to run at specified intervals, use a data member to store the time
period.

Member Functions

CChore implements only one member function, which you must
override. Your CChore derived class may implement additional
member functions.
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Perform
void Perform (I ong *nmaxSl eep);

This is the function that executes your chore. You must override this
function in your CChore derived class. The default function does
nothing.

The max Sl eep parameter specifies how many ticks your chore can
tolerate passing before it gets a Per f or mfunction call. For example,
if you need to do a chore at least once every tenth of a second, you
would set nax S| eep to 6. (Each tick is 1/60 of a second.)

For a more detailed discussion of max$Sl eep, see the description of
the Dawdl e member function “CBureaucrat” in Chapter 27.

Visual Architect and THINK Class Library Guide 435



31 CChore

436 Visual Architect and THINK Class Library Guide



CClipboard

32°

Introduction

CClipboard implements a standard Macintosh clipboard, or scrap.
The default clipboard handles TEXT and PI CT scraps. To deal with
other kinds of scraps or to implement a private scrap, create a
derived class of this class.

Heritage
Base Class CDirector
Derived Classes CStyleTEClipboard

Using CClipboard

This class implements a standard Macintosh clipboard. CClipboard
uses the desk scrap to store its data and supports a window to
display the contents of the scrap. This implementation supports only
TEXT and PI CT data.

When you initialize your application, its constructor calls the
Maked i pboar d function of your application class. That function
creates an instance of CClipboard and stores it in the global variable
gd i pboard.

The default application DoCommand member function handles the
cndToggl ed i p command, which shows and hides the Clipboard
window. When you’re running under System 7 or MultiFinder, the
Clipboard window is hidden when your application is suspended.
When the application resumes, the Clipboard window becomes
visible again.
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Note
In the THINK Class Library, desk accessories behave
as if they were in their own layer, even if your
application isn’t running under System 7 or
MultiFinder. When a desk accessory window is
frontmost, the Clipboard window is hidden. When
one of the application windows is frontmost, the
Clipboard window becomes visible again.

Implementing a CClipboard derived class

If you want your application to support a private scrap, or if you
want to display other types of data, you need to derive a class from
CClipboard. You also need to override the MakeC i pboard
member function in your application class.

Note
If you create a derived class of this class, be sure
you understand how the Macintosh scrap
mechanism works. See Inside Macintosh: More
Macintosh Toolbox, Chapter 2, “The Scrap
Manager.”

In your CClipboard-derived class, you need to override these
member functions:

Member Function Action

Put Dat a Place data in the private scrap.
Get Dat a Retrieve data from the private scrap.
Convert d obal Place the contents of the desk scrap into the

private scrap.

ConvertPrivate Place the contents of the private scrap into
the desk scrap.

MakeC i pVi ew Create a view to display data other than
plain text of pictures.

Table 32-1 CClipboard member functions to override
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Global Variables and Data Members

Global variables

The global g i pboar d contains a pointer to the single instance of
the clipboard object. The value of this variable is set in the
application member function MakeC i pboar d.

Data member Type Description
gd i pboard Cd i pboard The global clipboard

Data members
CClipboard defines these data members:

Data member Type Description

itsContents CPanor ana* Pane for displaying
contents

itsScrol | Pane CScrol | Pane* Contents can be scrolled

theLength | ong Length from last get
operation

theO f set | ong Offset from last get
operation

| ast ScrapCount short Count at the last

conversion between
global and private
scraps

pri vat eNewer Bool ean TRUE if the private scrap
has changed since the
last conversion to the
desk scrap

wi ndowVi si bl e Bool ean TRUE if the Clipboard
window is visible

Member Functions

Creation and destruction

CClipboard
Cd i pboard (Bool ean hasW ndow = TRUE);

Constructor. hasW ndow controls whether the Clipboard displays
its contents in a window. The application’s MakeCl i pboar d
member function creates the clipboard and stores a pointer to it in
the global gCl i pboar d.
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Note
If you derive from CClipboard, be sure to override
the Maked i pboar d function in your application
class so it creates an object of the derived clipboard
derived class. See the implementation of
Maked i pboar d in CApplication for an example.

IClipboard

void | Cipboard (CApplication *aSupervisor,
Bool ean hasW ndow) ;

Initialization function provided for compatibility with previous

release. | O i pboar d may only be called if no constructor

arguments are specified.

Suspend and resume

The following functions handle scrap conversion when your
application moves from foreground to background under System 7
or MultiFinder. In most cases, you won’t need to use or override
these functions.

Suspend
voi d Suspend ();

The application is about to be switched into the background under
System 7 or MultiFinder. If the application’s private scrap is newer
than the desk scrap, this function calls the clipboard’s

Convert Privat e and Scr apConvert ed functions, then calls the
clipboard window’s Hi deSuspend function.

Resume
voi d Resune ();

The application is about to be brought to the foreground under
System 7 or MultiFinder. If the desk scrap is newer than the private
scrap, this member function calls the clipboard’s Convert @ obal ,
ScrapConvert ed, and Updat eDi spl ay functions to update the
contents of the clipboard. Then it calls the window's ShowResue
function to make the window visible.

Appearance
The following functions handle the appearance of the clipboard
window and how the contents of the clipboard appear in the
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window. If you implement your own clipboard class, you'll need to
override the Updat eDi spl ay function.

Close
Bool ean Cl ose (Bool ean quitting);

The user chose Close from the File menu. Cl ose calls the
Cl oseW nd function and returns TRUE.

CloseWind
void C oseWnd (CW ndow *t heW ndow) ;

The user clicked in the window’s close box. This function hides the
Clipboard window and changes the text in the menu item.

Toggle
void Toggle ();
This function opens the Clipboard window if it's closed or closes it if

it's open. The application’s default DoConmand function calls this
function.

UpdateDisplay

voi d UpdateDisplay ();

Displays the contents of the scrap in the Clipboard window. This
function supports only TEXT and PI CT types of data. It works
correctly with a private scrap, but if you want to display other kinds
of data, you need to override this function.

Accessing

Uses the following functions to place data in and retrieve data from
the desk scrap. If your application implements a private scrap, use
the Put Dat a and Get Dat a member functions instead.

PutGlobalScrap

voi d Put d obal Scrap (ResType theType,
Handl e t heDat a) ;

Puts t heDat a of type t heType into the desk scrap. Be sure to call
the Enpt yd obal Scr ap function before you call this function.
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GetGlobalScrap
Bool ean Get d obal Scrap (ResType theType,

Handl e t heDat a) ;
Gets data of type t heType from the desk scrap and puts it in the
block to which t heDat a is a handle. Returns TRUE if it was able to
fulfill the request, FALSE otherwise.

t heDat a must be an allocated handle. The size of the allocated
memory grows as needed to fit the data.You get TEXT data from the
desk scrap in the following manner:

Handl e nyDat a;

/* Create a zero-sized handle */
myDat a = NewHandl e(0);
gd i pboar d- >Get G obal Dat a(' TEXT', nyData);

DataSize
| ong Dat aSi ze (ResType theType);
Returns the number of bytes of data in the Clipboard of type

t heType. If the Clipboard doesn’t contain any data of the specified
type, this function returns zero.

Status
ScrapStatus Status ();

Returns the status of the scrap. This function returns a value that
describes the relationship between the private scrap and the desk
scrap.

Value Meaning

PRI VATE_SCRAP_NEWER The information in the private scrap is
newer than the information in the
desk scrap.

GLOBAL_SCRAP_NEVER  The information in the desk scrap is
newer than the information in the
private scrap.

SCRAPS THE_ SAME The information in both scraps is the
same.

Table 32-2 Scrap status values
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ScrapConverted
voi d ScrapConverted ();

Sets the internal flags after the scrap has been converted.

Scrap conversion

Uses the Put Dat a and Get Dat a functions to implement Cut,
Copy, and Paste commands for your application. If your application
uses only the desk scrap, you can use the Put G obal Scr ap and
Get @ obal Scr ap functions.

PutData
voi d PutData (ResType theType, Handl e theData);

Put t heDat a of type t heType into the scrap. The default function
puts the data in the desk scrap. If your derived class supports a
private scrap, you must override this function. After you store your
data in the private scrap, call the Pri vat eChanged function.
Before you call this function, be sure to call an Enpt yScr ap
function to clear your scrap.

GetData
Bool ean Get Data (ResType theType,

Handl e *t heDat a) ;
Gets t heDat a of type t heType and puts it into a newly created
handle. This function returns TRUE if the request was successful,
FALSE otherwise. If your application supports a private scrap, you
must override this function.

Unlike with Get @ obal Scr ap, you should not allocate the handle
to t heDat a. This function will allocate the memory. You get data of
type ' TEXT' in this way:

Handl e nyDat a;
gCI i pboar d->Cet Dat a(' TEXT', &myDat a);

ConvertGlobal
voi d Convertd obal ();

Converts data in the desk scrap and puts it in the private scrap. The
default function does nothing. If your application supports a private
scrap, you must override this function.
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ConvertPrivate
void ConvertPrivate ();

Converts data in the private scrap and puts it into the desk scrap.
The default function does nothing. If your application supports a
private scrap, you must override this function.

EmptyGlobalScrap
voi d Enpt yd obal Scrap ()

Clears the contents of the desk scrap.

EmptyScrap

void EnptyScrap ()

Clears the contents of the scrap that is the destination of Put Dat a.
You should call this function before you call Put Dat a. The default
function clears the global scrap.

PrivateChanged
void PrivateChanged ();

The data in the private scrap has changed. If you implement a
private scrap, be sure to call this function of the clipboard object
after you put new data in your private scrap. This function sets the
internal flags and calls the clipboard’s Updat eDi spl ay function.
Your derived class should not override this function.

MakeClipView
CPanor ana *MakeC i pVi ew (| ong dat aType,

Handl e dat aHandl e)
Makes a view to display the Clipboard data dat aHandl e of type
dat aType. This function disposes dat aHandl e when appropriate.
Updat eDi spl ay calls this function to create the right kind of pane
for the data you want to display in the Clipboard window.

If you create a derived class of CClipboard, override this function to
create the kind of pane needed to display your data. If dat aType is
PI CT or TEXT, you can call the inherited function.
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Member Functions: Protected

IClipboardX

voi dl d i pboardX (CApplication *aSupervi sor,
Bool ean hasW ndow) ;

Performs common construction.

Class Resources

The ' WND' resource for the Clipboard window is in the file TCL
Resour ces, which contains all the resources the THINK Class
Library requires.

Resource Description
"WND 200 Window template for Clipboard window

Apple Event Support

For information regarding Apple event member functions, please
refer to the supplemental information provided in the file Appl e
event info in the folder Appl e Event C asses.
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Introduction

CCollaborator is an abstract class that implements objects that
depend on one another. This class provides a mechanism for an
object to announce changes to other objects.

Heritage
Base class None
Derived classes CBureaucrat

CCollection

Using CCollaborator

This class implements a mechanism that lets an object announce
changes to other objects. The object that announces the changes is
called the provider. The objects that depend upon announcements
from the provider are called dependents.

For example, suppose that your program displays the contents of a
file as different kinds of graphs in different windows. Whenever the
data in the file changes, the windows that display the data need to
change also. The data file is the provider. The graph display
windows are the dependents.

To specify a dependency, call DependUpon for the dependent
object with the provider as the argument. When the provider
changes, call the provider’s Br oadcast Change function. That
member function calls each of the dependents’ Pr ovi der Changed
functions.

The Br oadcast Change function takes a parameter called r eason
that lets the dependents know why they’re being notified. Reasons
are implemented as long integers. You can use const values,
#def i ne directives, or enumtypes.
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Reason names follow three conventions. First, reason names begin
with the name of their class, without the C. For example,the names
of CArray's reasons are entered as “array”. Second, the reason codes
for each THINK Class Library class begin with a unique four-
character OSType value, for example, 'TABO' for the CTable class.
Additional reason codes in the same class are formed by adding 1 to
the preceding code, such as 'TABO', 'TABL', etc. Third, each
collaborator subclass has a reason named

cl assnanelLast Change. For example, CArray defines a reason
named ar r ayLast Change.

Using these conventions, you can ensure that the reason codes you
define are unique. You can define your own four-character
OSTypes as reason codes. Reason codes consisting entirely of
uppercase letters and numbers are reserved for the THINK Class
Library. Your own reason codes should contain at least one
lowercase letter or special character, such as Myn0, to ensure that all
reason codes are globally unique. The reason codes currently in use
by the THINK Class Library are:

Reason Class

ABSO- 1 CAbst ract Text
ARRO- 1 CArray

BURO- 1 CBur eaucr at
CONO CContr ol

DI AO CDi al ogText
Pl CO CPICTGid
POPO CPopupMenu
RADO CRadi oCont r ol
RUNO- 1 CRunArr ay
TABO CTabl e

Note that the fourth character of all codes is the digit '0".
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Alternatively, in each of your derived classes you can set the derived
class’s first reason code to be equal to its base class’s Last Change
plus 1. For example, if you derive a class CMyArray from CArray,
you might define reason codes in CMyArray as:

enum

myar r aySwapEl ements = arraylLast Change +

myar r ayScr anbl ed,
myar r ayLast Change = nyArrayScranbl ed

This technique ensures that your reason codes are unique in a
particular branch of the class hierarchy, but not unique overall. With
multiple inheritance, a class can inherit reason codes from multiple
branches of the class hierarchy. Thus, this technique does not, in
general, guarantee unique reason codes even with respect to a single
object.

Either approach, using OSType or Last Change values, is
compatible with previous releases of the THINK Class Library.

The following examples illustrate how you might implement the
graphing program described earlier in this chapter. When the data in
the data file changes, the data file’'s Updat eDat a member function
calls the Br oadcast Change function with the reason
dat aUpdat ed. The Br oadcast Change function calls a
Pr ovi der Changed function on each of the data file’s graphs, the
data file’s dependents. This updates the picture of the data in each
graph.
This is what the implementation might look like:
enum
{ nyFileUpdated = WFO,
myFi | ePoi nt Added,
nyFi | ePoi nt Del et ed,

myFi | eLast Change = nyFi | ePoi nt Del et ed

Visual Architect and THINK Class Library Guide 449



33 CCollaborator

void CWFile:: UpdateData (
MyDat aPtr ol dDat a,
MyDat aPtr newbDat a)

{

Br oadcast Change( nyFi | eUpdat ed,
(void *) newbData );

}

voi d CWG aphPane: : Provi der Changed (
CCol | abor at or *aPr ovi der,
| ong reason, void *info)

Usually, you should check if (aProvider == itsDataFile)
that the provider is a switch (reason)

known object before {
acting on a reason code.

If you use unique reason

case nyFil eUpdat ed:
Updat eGr aphDat a(i nf o) ;
br eak;

COde.s’ checking the case nyFi | ePoi nt Added:
provider for class AddGr aphDat a(i nf 0) ;
membership is never br eak;
necessary, as any one class case nyFi | ePoi nt Del et ed:
can broadcast the code. Del et eG aphDat a(i nf o) ;

br eak;

}
}

Data Members
CCollaborator defines the following protected data members:

Data Member Type Description

itsProviders CColl aboratorlList* The objects
this collaborator
depends upon

i t sDependents CCol | aboratorList* The objects
that depend
upon this
collaborator
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Member Functions

Creation and destruction

CCollaborator
CCol | aborator () ;

Constructor. This function sets both i t sPr ovi der s and
i t sDependent s to NULL.

~CCollaborator
~CCol | abor at or () ;

Destructor. Remove this object from each of its provider’s list of
dependents and from each of its dependent’s list of providers. Then
dispose of its own lists of providers and dependents.

Copy
voi d *Copy ();

Provided for backward compatibility.

ICollaborator
void | Col l aborator ();

Initialization function provided for compatibility with previous
releases. Does nothing.

Dispose

voi d Di spose ();

Provided for compatibility with previous release. Calls oper at or
del et e. TCL_USE DI SPCSE must be defined to use this member
function.

Creating dependency

DependUpon
voi d DependUpon (CCol | abor at or *aProvi der);

This collaborator depends on aPr ovi der. Add this collaborator to
aPr ovi der s list of dependents, and add aPr ovi der to this
collaborator’s list of providers. If either of those lists is NULL, this
function creates them before adding to them.
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CancelDependency
voi d Cancel Dependency (CCol | abor at or

*aProvi der) ;
This collaborator no longer depends upon aPr ovi der . Remove this
collaborator from the provider’s dependent list and remove the
provider from this collaborator’s provider list.

Object I/0

PutTo
void PutTo (CStream& aStrean;

Writes to the stream.

GetFrom
voi d Get From (CStream& aStrean;

Reads from the stream.

Member Functions: Protected

Change notification

BroadcastChange
voi d Broadcast Change (|l ong reason, void* info);

Notifies this object’s dependents that this object has changed.

r eason describes the type of change. You must define reasons for
your derived class. i nf o is a pointer to any additional information
needed to respond to the change.

If you want objects that aren't in a collaborator’s list of dependents
to know about a change, override this protected member function.
For example, CBureaucrat overrides this function to notify the
bureaucrat’s supervisor, in addition to its dependents, of the change.

ProviderChanged
voi d Provi der Changed (CCol | aborator *aProvi der,

| ong reason, void *info);
This informs you that one of this object’s providers has just changed.
Your derived class must override this protected member function to
respond to each reason it can handle. The default function does
nothing. aPr ovi der is the provider that changed. r eason
describes the type of change. You must define reasons for your
derived class. i nf o is a pointer to any additional information that
your derived class might need.
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Dependent_Update
static void Dependent Update
(CCol | abor at or *aDependent, |ong aProvider);

Internal function. Called by Br oadcast Change.

Member Functions: Private

CCollaborator uses the following member functions internally to
maintain the lists of dependents and providers, and they may be
made private or protected members. Whenever possible, use the
DependUpon member function instead of these. When a dependent
is added or removed, DependUpon updates both the dependent’s
list of providers and the provider’s list of dependents. Similarly, it
updates both lists when a provider is added or removed. If you use
the functions below, you might damage the collaborators’ lists so
that they don’t match. If these functions are made private, they will
not be accessible.

AddDependent
voi d AddDependent (CCol | aborator *aDependent);

Adds aDependent to this collaborator’s list of dependents.

RemoveDependent
voi d RenoveDependent (CCol | aborator *aDependent);

Removes aDependent from this collaborator’s list of dependents.

AddProvider
voi d AddProvi der (CCol | aborator *aProvider);

Adds aPr ovi der to this collaborator’s list of providers.

RemoveProvider
voi d RenoveProvi der (CCol | aborator *aProvider);

Removes aPr ovi der from this collaborator’s list of providers..

Provider_Remove

static void Provider_ Renove
(CCol | aborat or *aProvi der, |ong aDependent);

This internal function removes dependencies.
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Dependent_Remove

static void Dependent Renove
(CCol | abor at or *aDependent, |ong infoAddr);

This internal function removes dependencies.
Friend Functions

The following friend functions overload oper at or s << and >>.

operator <<

CStream & operator <<
(CStream& s, CCol | aborator* p);

Puts a CCollaborator object.

operator >>

CStream & operator >>
(CStrean& s, CColl aborator* p);

Gets a CCollaborator object.
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Introduction
CCollection is an abstract class for implementing collections.

Heritage
Base Class CCollaborator
Derived Classes CArray

Using CCollection

This class doesn’t provide the implementation of the collection. In
your derived class, you specify the data structures that implement
the list.

Data Members

The only data member in this abstract class is the number of items in
the collection. Your derived class needs to add at least a data
member that contains or points to the memory which holds the items
in your collection.

Data member Type Description
num t ens | ong The number of items in the
collection
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Member Functions

Creation and Destruction

CCollection
CCol | ection();

Constructor. Sets the initial number of items to 0. Also, implicitly
called when an object is created by new_by nane. Can also be
used in combination with | Col | ect i on for backward
compatibility.

~CCollection
~CCol l ection ();

Destructor.

Copy
voi d *Copy ();

Provided for backward compatibility.

ICollection
| Collection ();

Initialization function included for backward compatibility. Should
not be called if arguments are passed to the constructor.

Accessing

GetNumltems
|l ong GetNumtens ();

Returns the number of items in a collection.

ISEmpty
Bool ean | sEnpty ();

Returns TRUE if the collection has no items.

Object I/0

PutTo
void PutTo (CStream& aStrean;

Writes to the stream.

GetFrom
void Get From (CStream& aStrean);

Reads from the stream.
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Introduction

CColorTextEnvirons extends CTextEnvirons by remembering the
foreground and background color, the pen mode, height and width,
and the foreground and background pattern of an object.

Heritage
Base Class CTextEnvirons
Derived Classes None

Using CColorTextEnvirons

Use CColorTextEnvirons to control more completely the drawing
environment for panes. Consistent use of CColorTextEnvirons
ensures that drawing styles do not “bleed” from one object to the
next, and it eliminates the need to set up and restore the drawing
environment in your own code.
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Data Members

Data member Type Description

penSi ze Poi nt The pen height and
width.

penMbde short The pen drawing mode.

forePatl D short The foreground pattern
' PAT#' resource ID.

backPat | D short The background pattern
' PAT#' resource ID.

forePatlnd short The foreground pattern

index. If non-zero, the
foreground pattern is
obtained from the
resource. If zero, the
black pattern is used.
backPat I nd short The background pattern
index. If non-zero, the
background pattern is
obtained from the
resource. If zero, the
black pattern is used.
changeFor ePattern Bool ean  TRUE if foreground
pattern has been
changed.
changeBackPat t ern Bool ean  TRUE if background
pattern has been

changed.
f or eCol or RGBCol or  The foreground color.
backCol or RGBCol or  The background color.

changeFor eCol or Bool ean  TRUE if restore
foreground color from
f or eCol or. FALSE if
set foreground color to
black.

changeBackCol or Bool ean  TRUE if restore
background color from
backCol or. FALSE if
set background color to
white.
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Member Functions

Creation and destruction

IColorTextEnvirons
| Col or Text Envi rons() ;

Initialization function. Calls the | Text Envi r ons function of
CTextEnvirons. Sets f or ePat | D, backPat | D, f or ePat | nd, and
backPat | nd to 0. Sets changeFor ePat t er n,

changeBackPat t er n, changeFor eCol or, and
changeBackCol or to FALSE. Sets penSi ze. v and penSi ze. h
to 1, and penMode to pat Copy. Sets f or eCol or to pure black,
and backCol or to pure white.

Restore and capture

Restore
void Restore ();

Restores the environment. Called by the THINK Class Library before
the pane’s Dr aw member function is called.

Capture

void Capture ();

Replaces the contents of the environment with the settings from the
current grafport. This function is similar to the eyedropper tool of a
paint program.

CaptureText
static void CaptureText (TextlnfoRec *rec);

Fills in the Text | nf oRec argument with the text settings from the
current grafport. This is a static member function.

Access

SetColorinfo
voi d Set Col orlI nfo (RGBCol or *fore,

RGBCol or *back);
Sets the foreground and background color in the environment. If
either pointer is NULL, the corresponding Boolean,
changeFor eCol or or changeBackCol or is set to FALSE.
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GetColoriInfo
voi d Get Col orl nfo (Bool ean *changeFore,
Bool ean *changeBack,
RGBCol or *fore, RGBCol or *back);
Gets the foreground and background color settings from the
environment.

SetForePatRes
voi d Set ForePat Res (short resl D, short index);

Sets the resource ID and index of a pattern from a' PAT#' resource

to be used as the foreground pattern. If the index is O,
changeFor ePat is set to FALSE.

SetBackPatRes
voi d Set BackPat Res (short resl D, short index);

Sets the resource ID and index of a pattern from a' PAT#' resource
to be used as the background pattern. If the index is O,
changeBackPat is set to FALSE.

GetPatInfo
void CGetPatlnfo (short *forel D,
short *forel ndex,
short *backl D, short *backl ndex);
Gets the foreground and background resource ID and index from
the environment.

SetPeninfo

voi d Set Penlnfo (short penhbde,
short penHei ght, short penWdth);

Sets the pen mode, height, and width in the environment.

GetPenlInfo

voi d CGetPenlnfo (short *penMode,
short *penHei ght, short *penWdth);

Gets the pen mode, height, and width from the environment.

GetChangeBack
voi d Get ChangeBack ();

Returns changeBackCol or.
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PutTo
void PutTo (CStream& aStrean;

Writes to the stream.

GetFrom
voi d Get From (CStream& aStrean;

Reads from the stream.
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Introduction

CControl is an abstract base class for implementing Macintosh
controls. The two built-in derived classes, CButton and CScrollBar,
implement the standard Macintosh controls.

Heritage
Base Class CPane
Derived Classes CButton

CScrollBar

Using CControl

This class describes the common functions for all controls. Scroll
bars, buttons, check boxes, and radio buttons are derived from
CControl. Although you won't be creating derived classes of
CControl (unless you define your own kind of control), you should
become familiar with these functions.

Data Members

The only data member for this class is a handle to the actual
Macintosh control.

Data member Type Description
macControl Control Handl e Handle to the Macintosh
control

Member Functions

You can use these member functions with any kind of control, but
some functions don't really apply to all controls. For example, it's
possible to set the value of a push button or to give a title to a scroll
bar, but in most cases these actions don’t make sense.
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Creation and destruction

CControl

CControl (CVi ew *anEncl osur e,
CBur eaucr at *aSuper vi sor,
short awdth = 0, short aHeight = 0,
short aHEncl = 0, short aVEncl = O,
Si zi ngOpti on aHSi zi ng = si zFI XEDSTI CKY,
Si zi ngOpt i on aVSi zi ng = si zFI XEDSTI CKY) ;

Constructor. Sets macCont r ol to NULL. Most initialization is done
by classes derived from CControl.

CControl
CControl ();

Default constructor. Implicitly called when an object is created by
new by nane.

~CControl
~CControl ();

Destructor. Disposes macContr ol .

Accessing

SetValue
voi d SetVal ue (short aVal ue);
Sets the value of a control. This member function calls the

Br oadcast Change function of all of this object’s dependents, with
cont r ol Val ueChanged as the reason.

GetValue
short GetVal ue ();

Gets the value of a control.

SetMaxValue
voi d Set MaxVal ue (short aMaxVal ue);

Sets the maximum value for a control. For push buttons, check
boxes, and radio buttons, this value should be 1.

GetMaxValue
short Get MaxVal ue ();

Gets the maximum value a control can take on.
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SetMinValue
voi d Set M nVal ue (short aM nVal ue);

Sets the minimum value for a control. Note that for push buttons,
check boxes, and radio buttons, this value should be 0.

GetMinValue
short Get M nVal ue ();

Gets the minimum value a control can take on.

SetTitle
void SetTitle (Str255 aTitle);

Sets the title of a control. Scroll bars can have titles, but the title is
not displayed.

GetTitle
void GetTitle (Str255 aTitle);

Gets the title of a control.

SetActionProc
voi d Set ActionProc (ActionProcPtr anActionProc);

Sets the action proc of a control. The action proc is called repeatedly
while the mouse is held down in a control. The control manager dis-
tinguishes between an action proc called when the mouse goes
down in a moving indicator (like a scroll box) and one called when
the mouse goes down in a stationary part of a control. The default
Dod i ck member function uses the action proc only for mouse hits
that are not in a moving indicator. In the THINK Class Library, you
must declare the action proc as follows:

voi d pascal MyAction (
Cont rol Handl e macContr ol ,
short whichPart);

If you want an action proc called when the mouse is in a moving
indicator, you'll need to override the DoCl i ck function.

Note
Be sure you understand action procs and the
control manager before you use this function.
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Appearance

The following functions affect the appearance of controls on the
screen. They hide and show the control, draw it, move it, and
change its size.

Hide
void Hide ();
Hides the control.

Show
voi d Show ();

Shows the control.

Activate
void Activate ();

Makes the control active. The control’s Act i vat e function is called
automatically when its enclosure’s Act i vat e function is called. In
CControl, this function calls Ref r esh so that the control will be
redrawn as active on the next Update event.

Deactivate
voi d Deactivate ();

Makes the control inactive. The control’s Deact i vat e function is
called automatically when its enclosure’s Deact i vat e function is
called. In CControl, this function calls Dr awAl | to immediately
redraw the control as inactive.

Offset
void Offset (long hOfset, long vOfset,
Bool ean redraw);
Moves the control by hOf f set , vOF f set pixels. If r edr awis
TRUE, redraws the control after the move.

ChangeSize
voi d ChangeSi ze (Rect *delta, Bool ean redraw);

Changes the size of a control. Each component of the rectangle
specifies the number of pixels by which to offset each point. Positive
numbers indicate down and to the right. Negative nhumbers indicate
up and to the left. If r edr aw is TRUE, the function redraws the
control after the change.
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GetHelpBalloonState
short Get Hel pBal |l oonState ();
Returns one of the balloon help states:
kHMEnabledltem (0) Enabled (or, for buttons, off)
kHMDisabledItem (1) Disabled (dimmed)
kHMCheckedltem (2) Enabled and checked (or, for
buttons, on)
kHMMarkedltem (3) Enabled and marked (for any other

purpose)

Controls typically implement only the first two or three of the above
states.

There is not necessarily a one-to-one correspondence between
balloon help states and THINK Class Library variable states. The
dimmed state is the most complex. Dimmed means that the view
would normally accept user interaction but currently does not. Note
that a view must normally want clicks or allow editing in order to be
considered dimmed when it does not want clicks or allow editing.
Classes for which dimmed or marked states are meaningful, or that
want to use the marked state, must override this function.

Draw
void Draw (Rect *area);

Draws the control. The ar ea parameter is ignored.

DrawAll
void DrawAl | (Rect *area);

Draws the control and all its subviews.

Prepare
void Prepare ();

Prepares the port and the coordinate system before drawing.
Generally, you don’t need to use or override this function.
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PrepareToPrint
void PrepareToPrint ();

Sets up the coordinate system and the clipping region for printing.
The origin is set to (0,0). The clipping region is set as specified by
the print C i p data member, inherited from CPane, whose
possible values are cl i pAPERTURE, cl i pFRAME, and cl i pPAGE.

RefreshLongRect
voi d RefreshLongRect (LongRect *area);

Adds the intersection of ar ea and the pane’s aperture to the update
region of the pane. Redrawing does not actually take place until the
next update event is processed.

Click response

The CControl class takes care of all the mouse tracking within a
control.

DoClick
void Dodick (Point hitPt, short nodifierKeys,

| ong when);
Handles a click in a control. hi t Pt is the point in frame
coordinates. nodi fi er Keys is the same as the modifier field of an
event record. The argument when is the time in ticks that the mouse
went down.

The default function handles both simple controls and controls with
moving indicators. It behaves a little differently in each case.

If the mouse goes down in a part other than a moving indicator:

« The default function calls the Toolbox routine
TrackCont r ol with the action proc you specified with
the Set Act i onPr oc function.

e If TrackCont rol returns TRUE (the user clicks and
releases the mouse in the same part of the control), this
function calls the control’'s DoGoodd i ck function.

If the mouse goes down in a moving indicator, such as the thumb of
a scroll bar:

= The default function calls the Toolbox routine
TrackCont r ol with no action proc.
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« If the value of the control has changed (the user moved
the indicator to a new place), this function calls the
control’s DoThunbDr agged function.

DoThumbDragged
voi d DoThunbDr agged (short delta);

Called when an indicator in a control has been moved. The
Dod i ck function calls the control’'s DoThunbDr agged function
when the user changes the position of a control’s indicator.

The default function does nothing. Controls with indicators should
override this function. For an example, see Chapter 95, “CScrollBar.”

DoGoodClick
voi d DoGoodd i ck (short whichPart);

Called when the mouse went down and up in the same part of a
control.

The default function does nothing. Derived classes should override
this member function. See Chapter 28, “CButton,” for an example.
Object I/0

PutTo
void PutTo (CStreanm& aStrean;

Writes to the stream.

GetControl

void CGetControl (CStream& aStream
short control Def);

Reads and initializes a CControl from the stream. Derived classes use
this function to implement their Get Fr omfunctions.
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37*

Introduction

CCountingStream is a stream class whose instances—counting
streams—count the number of bytes put to them, but don’t actually
write anything. If the same sequence of Put operations is done to a
handle or file stream, the number of bytes written will be the same
as determined by the counting stream.

Get operations have no effect.

Heritage
Base Class CStream
Derived Classes None

Using CCountingStream

Counting streams are used to preflight stream output operations to
determine the number of bytes that will be written. Before
performing a sequence of Put operations to a handle stream or a file
stream, perform the same sequence to a counting stream, then call
the counting stream’s member function Si ze to determine the
number of contiguous bytes the output will occupy.
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Data Members
Although these data members are public, they should not be directly

manipulated.
Data member Type Description
count | ong The number of bytes put
to the stream
pos | ong The current position in
the stream

Member Functions

Creation and destruction

CCountingStream
CCount i ngSt ream (Bool ean check = TRUE);

Constructor. Calls the CStream constructor with argument check,
then initializes count and pos to 0. check controls whether the
stream checks for duplicate objects. See the description of
CheckDupl i cat es in Chapter 104, “CStream.”

Open

Open
voi d Open (TCLStreaniVbde node);
Opens stream for writing. mode must equal Wit eStream

Positioning

Position
| ong Position ();

Returns pos, the current stream position. The stream position is a
long integer ranging from zero to the number of bytes in the stream
minus one. The first byte of the next Put operation will go to the
current position.

MoveTo
voi d MoveTo (long newPosition);

Changes the current stream position. Sets pos to newPosi ti on,
which must not be greater than count .
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Size
long Size ();
Returns count , the number of bytes in the stream.

Truncate

void Truncate (long newSi ze);

Reduces the number of bytes in the stream by setting count equal
to newSi ze, which must not be greater than the existing value of
count . If pos is greater than the new value of count , it is set equal
to that value.

Writing

Put
void Put (void *bytes, |long n);

Puts n bytes to the stream, starting at position pos. pos is increased
by n; if pos then exceeds count , count is set equal to pos.

PutThru
void Put Thru (void *bytes, char c);

Puts data to the stream starting with the first character of byt es and
ending with the first occurrence of the character c. pos is increased
by the number of bytes written; if pos then exceeds count, count
is set equal to pos.

Reading

Get
void Get (void *bytes, long n);
Does nothing.

GetThruN
I ong Get ThruN (void *bytes, char ¢, long n);

Returns 0.
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38°*

Introduction

This class implements the functions you need to work with a
Macintosh data file. You can use this class without creating a derived
class if you need to read or write raw bytes. If you require a
structured file, you should create a derived class of CDataFile.

Heritage
Base Class CFile
Derived Classes CPNTGFile

CPictFile

Using CDataFile

You can use this class without creating a derived class to read and
write the data fork of a Macintosh file. After creating an instance of
CDataFile, use one of the specification member functions inherited
from CFile to indicate which file you're working with. Then use the
Open member function to open the file, and use the reading and
writing member functions to read and write the file.

Some CDataFile functions use the THINK Class Library’s Exception
handling library if something goes wrong in a file operation. For
more information on exception handling, see Chapter 9, “Exception
Handling and RTTI.”

Note
This version of CDataFile handles errors differently
than the original version which has been renamed
ODataFile and moved to the Conpati bility
folder.
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Data Members

The only data member for this class is the r ef Numof the file. The
Macintosh file system uses this number to identify the volume,
directory, and file on disk. To learn more about the Macintosh file
system, see Inside Macintosh IV, Chapter 19, “The File Manager.”

Data member Type Description
ref Num short The file’s r ef Numwhen the file
is open

Member Functions

These functions let you open and close data files, read and write
data, and get information about a file. You need to use the functions
inherited from CFile to specify which file you want to work with.

Creation and destruction

CDataFile
Chat aFi | e();

Initializes the data file. This function sets r ef Numto 0.

IDataFile
void | DataFile();

Provided for backward compatibility.

Accessing

SetLength
voi d SetLength(long aLength);

Sets the end-of-file marker for this file at aLengt h.

GetLength
| ong GetLength();

Returns the length of the file. The file must be open already.

SetMark
voi d Set Mark(long howFar, short fromere);

Specifies where subsequent read/write operations will take place.
This position is called the “mark.”
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howFar specifies how far in bytes from the f r omMher e parameter
to set the mark. Positive values are offsets toward the end of the file.
Negative values are offsets toward the beginning of the file. The
argument f r omher e is one of the following:

FromWhere value Meaning

fsFrontt art From the beginning of the file
f sFronLECF From the end of the file
f sFromvar k From the current position

Table 38-1 Values for FromWhere in CDataFile::SetMark

GetMark
| ong Get Mark();

Returns the current position of the mark in mar kPos.

Open and close

Open

voi d Open( Si gnedByte perm ssion);

Opens the file with the given permission. The per mi ssi on
argument can be one of the following:

Permission Meaning

f sCur Perm Same as the current permission
f sRdPerm Read permission

fSWPerm Write permission

f sSRAW Per m Read/write permission

f sSRAW ShPer m Shared read/write permission

Table 38-2 Values for permission in CDataFile::Open

See Inside Macintosh 1V, Chapter 19, “The File Manager,” for a
discussion of permissions.

Close

void C ose();

Closes the file and calls FI ushVol to cause any buffered data to be
written to disk.

IsOpen
Bool ean 1sOpen ();

Returns TRUE if the file is open, FALSE otherwise.
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Read and write

ReadAll
Handl e ReadAll ();

Reads the entire contents of the file into a handle. This function
allocates the handle. Here’s an example of how to use ReadAl | :

Handl e t heDat a;
theData = myDat aFi | e- >ReadAl | () ;

ReadSome
voi d ReadSone(Ptr info, |ong howMuch);

Reads howMuch bytes into a buffer i nf 0. You must allocate the
buffer prior to calling this function. Here’s an example of how to use
ReadSone:

char nyBuffer[128];
Fﬁ./Dat aFi | e->ReadSone( nyBuffer, 128L);

WriteAll
void WiteAll (Handl e contents);

Writes the contents of the handle to the file.

WriteSome
void WiteSonme(Ptr info, | ong howMuch);

Writes howMuch bytes from the buffer pointed to by i nf o.
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Introduction

CDecorator implements an object that arranges windows on the
screen. There is only one instance of this class.

Heritage
Base Class None
Derived Classes None

Using CDecorator

CDecorator gives you member functions for arranging windows on
the screen. There is only one instance of CDecorator which is stored
in the global variable gDecor at or .

After creating and initializing a new window, call CDecorator’s
Pl aceNewW ndow function. The decorator makes the window
somewhat smaller than the main screen and offsets it down and to
the right of any previous window. Using the decorator is optional.

You can derive from CDecorator if you like. For instance, you might
want a decorator that implements window tiling. To do this, override
the MakeDecor at or function in your application class. Your
override should create and initialize an object of your decorator
derived class, and set the global variable gDecor at or to point to it.
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Data Members

Global variable

The global decorator object, created in the application member
function MakeDecor at or, is stored in the global variable
gDecor at or.

Data member  Type Description
gDecor at or  CDecorator The window-dressing object

Instance data members
CDecorator defines these data members.

Data member Type Description

wCount short The number of new windows
placed

i ndex short Index for offsetting windows

WW dt h short Width of a window in pixels

wHei ght short Height of a window in pixels

hLocat i on short Horizontal location for next
window

vLocation short Vertical location for next
window

Member Functions

Construction and Destruction

CDecorator

CDecorator();

Constructor. The application member function MakeDecor at or
creates the global decorator.

~CDecorator
~CDecor at or

An empty destructor.

PlaceNewWindow
voi d Pl aceNewW ndow ( CW ndow *t heW ndow) ;

Places a window specified by t heW ndow on the screen. The
default function makes it fill up most of the screen and calls
St agger W ndow to position it.
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StaggerWindow
voi d St agger W ndow ( CW ndow *t heW ndow) ;

Positions a new window specified by the window on the screen.
Positions it offset down and to the right of the last window the
decorator placed.

CenterWindow
voi d Cent er Wndow ( CW ndow *t heW ndow) ;

Centers the window specified by t heW ndow on the main screen. If
t heW ndow is a modal dialog, this function tries to put it in the top
third of the main screen. This function does not increment wCount
or change any of the data members.

GetWCount
short Get WCount () ;

Returns the number of windows the decorator has put on the screen.
You can use the returned value to give your untitled windows
sequential numbers such as Untitled-1.

IDecorator
void | Decorator();

Provides for backward compatibility. This function is not needed.
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Introduction

CDesktop implements a view that occupies the entire screen. This
view serves as the top of the visual hierarchy and as the enclosure
for all windows. Normally, there is only one instance of CDesktop.

Heritage
Base Class CView
Derived Classes CFWDesktop

Using CDesktop

The most common way you'll use the desktop is as the enclosure for
your windows. Your application should not call desktop functions.
Instead, you should rely on higher level objects like windows and
directors to call desktop functions.

The desktop is stored in the global variable gDeskt op. The
CApplication function MakeDeskt op creates an instance of the
CDesktop and stores a pointer to it in that variable.

Global Variables and Data Members

Global variable

The global gDeskt op holds a pointer to the single instance of the
desktop. Use this variable to specify the enclosure for your
application’s windows.

Global variable Type Description
gDeskt op CDeskt op The single instance of the desktop
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Data members
CDesktop defines these data members:

Data member Type Description

bounds Rect Boundaries of the desktop
itswWndows CW ndowlList* List of windows

topW ndow  CW ndow* Topmost application window
itsFloats CW ndowLi st*  Floating application windows
t opFl oat CW ndow* Topmost floating window

Member Functions

Creation and destruction

CDesktop
CDeskt op() ;

Constructor. This function opens a grafport that your application
uses as its desktop. The desktop’s supervisor is set to the application,
stored in the global variable gAppl i cati on.

~CDesktop
~CDeskt op();

Destructor. It destroys all of the desktop’s windows.

IDesktop
voi d | Desktop (CBureaucrat *aSupervisor);

Provides for compatibility with previous releases. This function may
only be called if the constructor was called with no arguments.

Appearance

Show
voi d Show();

Makes a desktop visible by showing all of its windows. This function
calls the Show function of all of the desktop’s windows.

Hide
voi d Hide();

Hides a desktop by hiding all of its windows. This function calls the
Hi de function of all of the desktop’s windows.
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Activate
void Activate();

Activates the desktop by activating the top window. This function
calls the Act i vat e function of the desktop’s top window.

Deactivate
voi d Deactivate();

Deactivates the desktop by deactivating its top window. This
function calls the Deact i vat e function of the desktop’s top
window.

ReallyVisible
Bool ean Real | yVi si bl e();

Returns TRUE if the desktop is visible.

Mouse

DispatchClick
voi d Di spatchd ick (EventRecord *macEvent);

Processes a mouse click. If the user clicks the mouse,

Di spat chd i ck determines where the mouse went down, and
call, the appropriate function of the object the click is intended for. If
the top window is modal, and the mouse did not go down in the
menu bar, this function beeps and does not process the click.

This function uses what is returned by the Macintosh Toolbox
routine Fi ndW ndow returns to determine what function to call on
which object.

Part Action

i nDesk If the mouse goes down in the desktop,
this member function calls the desktop’s
Dod i ck function. The default Dod i ck
function does nothing.

i nSysW ndow If the mouse goes down in a system
window, this function calls the Toolbox
routine Syst ent i ck.

Table 40-1 How CDesktop dispatches events
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Part
i nMenuBar

i nCont ent

i nDr ag

i NG ow

i nGoAway

i nZoom n,
i nZoomQut

Action

If the mouse goes down in the menu bar,
this function calls the Toolbox routine
MenuSel ect . This function then calls the
bartender’s Fi ndCndNunber function to
convert the menu selection to a command
number. This command number is sent to
the gopher via a DoConmand function
call.

If the mouse goes down in the content
region of a window and the window is not
active, this function calls the window’s
Sel ect function. If the window is active
and can receive clicks, this function calls
the window’s Di spat chd i ck function,
which eventually calls the Dod i ck
function of a pane or the window itself.

If the mouse goes down in the drag region
(the title bar), this function calls the
window’s Dr ag function.

If the mouse goes down in the window’s
grow region (the lower right corner), this
function calls the window's Resi ze
function.

If the mouse goes down and up in the
window’s close box, this function calls its
Cl ose function.

If the mouse goes down and up in the
window’s zoom box, this function calls its
Zoomfunction.

Table 40-1 How CDesktop dispatches events (Continued)

DoMouseUp

voi d DoMbuseUp( Event Record *macEvent);

Handles a mouse up event in the desktop. The default function does

nothing.
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DispatchCursor
voi d Di spat chCursor (Point where,

RgnHandl e nmouseRgn) ;
Sets the cursor for the view the cursor is in. If the cursor is over an
active window, this function calls the window’s Di spat chCur sor
function. If the cursor is in the menu bar, this function sets it to the
arrow. If the cursor is not in the menu bar or in an active window,
this function calls the desktop’s Adj ust Cur sor function. You
should not override this function.

AdjustCursor
voi d Adj ust Cursor (Point where,
RgnHandl e nouseRgn);
Adjusts the cursor shape when the mouse is in an insignificant part
of the desktop. The default function sets the cursor to an arrow.

Contains
Bool ean Cont ai ns(Poi nt thePoint);

Returns TRUE if t hePoi nt is within the bounds of the desktop.

HitSamePart
Bool ean Hit SamePart (Poi nt pointA, Point pointB);

Returns TRUE if poi nt A and poi nt B are reasonably close together.
Reasonably close means that the two points are within
REASONABLY _CLCSE pixels.

Window

You do not have to use any of the following functions yourself.
Directors, the objects that manage the interaction between windows
and the desktop, take care of most of these function calls.

AddWind
voi d AddW nd (CW ndow *t heW ndow) ;

Adds t heW ndow to the desktop’s window list.

RemoveWind
voi d RenoveW nd ( CW ndow *t heW ndow) ;

Removes t heW ndow from the desktop’s window list.
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SelectWind
voi d Sel ect Wnd (CW ndow *t heW ndow) ;

Selects t heW ndow and brings it to the front.

ShowWwind
voi d ShowW nd (CW ndow *t heW ndow) ;

Makes t heW ndow visible on the desktop.

Hidewind
voi d H deW nd (CW ndow *t heW ndow) ;

Hides t heW ndow.

DragWind
voi d DragWnd (CW ndow *t heW ndow,
Event Record *nacEvent);

Drags t heW ndow on the desktop.

UpdateWindows
voi d Updat eW ndows ();

Calls Updat e for each of the desktop’s windows.

Accessing

GetTopWindow
CW ndow* Get TopW ndow () ;

Gets the frontmost window.

Nthwindow
CW ndow* Nt hW ndow( | ong i ndex);

Returns the non-floating window at the specified index.

GetWindowlndex
| ong Get W ndowl ndex( CW ndow *w nd) ;

Returns the index number of the specified index.

GetNumWwindows
| ong Get NumW ndows() ;

Returns the number of non-floating windows.
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DoForEachWindow

voi d DoFor EachW ndow weachFuncl fun, |ong param;
Applies the function pointed to by f un to each non-floating window
by calling DoFor Each1(fun, paranj. For each such window,
par amis passed as a single parameter to f un.

FirstSuccessWindow
CW ndow* Fi rst SuccessW ndow( wTest Funcl fun,

| ong paran;
Applies the test function pointed to by f un to each window by
calling Fi ndl t emL(fun, paran). For each window, par amis
passed as a single parameter to f un. This function returns a pointer
to the first window that passes the test, or it returns NULL if none do.

Setlndex
Bool ean Set | ndex(CW ndow *w nd, |ong index);

Changes the index of a non-floating window. This function allows
you to move a window up or down in the non-floating layer. Returns
FALSE if the window can’t be moved as specified by i ndex. For
example, trying to move a non-modal window in front of a modal
one would make Set | ndex return FALSE.

GetLastModal
CW ndow* Get Last Mbdal (Bool ean *anyVi si bl e);

Returns the bottommost modal window if there is one; if there are
no modal windows, returns NULL. Also, if any modal window is
visible, sets anyVi si bl e to TRUE; otherwise, sets anyVi si bl e to
FALSE.

GetBounds
voi d Get Bounds(Rect *theBounds);

Gets the bounds of the desktop.

GetAperture
voi d Get Aperture (LongRect *theAperture);

Gets the visible portion of the desktop. This function returns the
bounds of the desktop since all of the desktop is always visible.
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CalcTopFloat
voi d Cal cTopFl oat () ;

Sets t opFl oat to the first visible window in i t sf| oat s if the list
iS nonempty.

Calibration

Prepare
void Prepare ();

Sets the port to the desktop port. You should not use or override this
function.

Member Functions: Protected

IDesktopX
voi d | DesktopX ();

Internal initialization member function.
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Introduction

CDialog is an abstract class for modal and modeless dialog windows.

Heritage
Base Class Cwindow
Derived Classes CDLOGDialog
Using CDialog

CDialog is the fundamental dialog class. It is a derived class of
CWindow that has additional member functions to provide typical
dialog services. You can use CDialog anywhere you would use
CWindow. A dialog is usually supervised by a dialog director, which
takes care of creating the dialog, handling its commands, and
closing it.

CDialog defines behavior that's useful for most dialogs, including:

= Validation. Before the dialog is closed, the dialog director
calls Val i dat e for all its CDialogText items. The items
return TRUE only if the item is valid according to the
constraints you set. The dialog is closed only if all items
return TRUE.

« Default button. You can set a default button, which is
highlighted with a bold border.

= Keyboard shortcuts. Press Command-Period or Escape to
select the Cancel button. Press Enter or Return to select
the default button if there is one.

= Tabbing. Use Tab to move though the fields in your
dialog, and use Shift-Tab to move backward.
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« Scrolling. If you create a large dialog, the THINK Class
Library handles scrolling for you.

CDialog can be the basis of a modal or modeless dialog. It can even
be a document window; for example, the document window for a
database program may need the validation and tabbing support that
CDialog provides.

Unless you explicitly define a CDialog derived class, code generated
by Visual Architect will use the CDialog class itself as the dialog
window class. CDialog can be used out of the box because all
initialization for the window and its panes is performed by Get Fr om
member functions called to read the dialog from the ' CVue'
resource created by Visual Architect. Supervisory functions are
performed by your CDialogDirector derived class, which Visual
Architect always generates.

If you define a dialog without using Visual Architect or
CDLOGDialog, you'll probably want to create a derived class of
CDialog. Your derived class needs to have a constructor that builds
the dialog and all the elements inside it. Unless you need to override
standard dialog behavior, your derived class doesn’t need to define
any other member functions.

The THINK Class Library also includes a derived class,
CDLOGDialog, which builds a dialog from ' DLOG and ' DI TL'
resources, which can be defined using ResEdit or THINK Rez.

A dialog usually belongs to a dialog director, which takes care of
creating the dialog, handling its commands, and closing it. Your
program doesn’t generally need to manipulate the dialog directly,
but instead sends commands to the dialog’s director. To create a
director for a CDialog, you should derive CDialogDirector. To create
a director for a CDLOGDialog, you should derive from
CDLOGDirector.

If the dialog is a documents only window, its director should be the
document. If the dialog is one window for a multi-window
document, its director should be a dialog director.

Every item in a dialog is a derived class of CPane. You can use any
pane in a dialog plus any of your own pane derived classes. There
are two special derived classes of CEditText — CDialogText and
ClntegerText — that you should use for text items. CDialogText and
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ClntegerText cooperate with the dialog to ensure that validation and
tabbing work correctly.

In most windows, the document or director is the supervisor of a
window’s panes. However, in dialogs, the dialog itself must be the
supervisor of the dialog’s panes, because the CDialog class handles
special keys, such as Return, Enter, Command-Period, and Escape.
Since the dialog’s director is the direct supervisor of the dialog, the
director still receives commands and events from the dialog’s panes.
The dialog just gets them first.

Data Members

CDialog defines the following protected data members.

Data member Type Description

defaultBtn CButton* Current default button.

i t sPanorama CPanor ana* Panorama that encloses all
dialog items.

scrol | abl e Bool ean TRUE if auto-scrolling is

enabled. Set TRUE if
i t sPanor ama is enclosed in
a scroll pane.

Member Functions

Creation

CDialog
Chi al og (short WNDi d,

CDi rector *aSupervisor);
Constructor. Initializes a dialog window from a' W ND' resource.
W NDi d is the ID of the ' W ND' resource. aSuper vi sor is the
window’s supervisor. A window’s enclosure is always gDeskt op.

CDialog
Chi al og (Rect *bounds, Bool ean fVisible,
short procl D, Bool ean fHasGoAway,
CDi rector *aSupervisor);
Constructor. Initializes a dialog from the parameters in the argument
list.

Bounds is a rectangle that describes the size and position of the
window. aProcl Dis a short that describes the type of the
window. If f Vi si bl e is TRUE, the window is drawn immediately
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after it's created. If f HasGoAway is TRUE, the window has a close
box. aSuper vi sor is the window’s supervisor.

CDialog

Chi al og ();

Default constructor. Implicitly called when an object is created by
new_by_nane. It also can be used in combination with IDialog for
backward compatibility.

IDialog
void I Dialog (short WNDid,

CDeskt op *anEncl osur e,

CDi rector *aSupervisor);
Initialization function for backward compatibility with previous
release. May not be called if constructor has arguments. Arguments
are the same as the constructor’s with the addition of
anEncl osure.

INewDialog
voi d | NewDi al og (Rect *bounds, Bool ean fVisible,
short procl D, Bool ean fHasGoAway,
CDeskt op *anEncl osur e,
CDi rector *aSupervisor);
Initialization function for backward compatibility with previous
release. May not be called if constructor has arguments. Arguments
are the same as constructor with the addition of anEncl osur e.

Close
void Cose ();

Closes the dialog, if all the fields have valid entries. The function
calls Val i dat e to check the fields.

Validate
Bool ean Validate ();

Returns TRUE if all the fields in the dialog have valid entries. Returns
FALSE otherwise. This member function validates the values in the
CDialogText fields.
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Accessing

FindButton
CButton *FindButton (long aCnd);

Returns the first button in the view hierarchy associated with the
command aCnd.

SetDefaultCmd
void SetDefaultCnd (long aCnd);

Sets the default button to the one associated with aCnd. This
member function finds the button associated with aCnd, and then
calls Set Def aul t But t on with the button.

SetDefaultButton

voi d Set Defaul tButton (CButton *aButton);

Sets the default button to aBut t on. CDialog draws the button’s
border by calling its Set Def aul t function with TRUE. If there is

already a default button, CDialog removes the border by calling its
Set Def aul t function with FALSE.

Commands

DoKeyDown
voi d DoKeyDown (char theChar, Byte keyCode,

Event Record *macEvent);
Handles a key-down event that none of the dialog’s panes can
handle. It takes care of Tab, Return, Enter, Escape, and Command-
Period, as in Table 41-1

Key Description

Tab Moves to the next dialog item.

Shift-Tab Moves to the previous dialog item.

Return or Enter Selects the default command, usually cmdOK
or cnmdCancel .

Command-Period  Selects cndCancel .

or Escape

Table 41-1 How CDialog handles keys

CDialog handles Tab and Shift-Tab by calling DoTab.
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DoTab
voi d DoTab (Bool ean fForward);

Handles a Tab. If f For war d is TRUE, it moves to the next dialog
item. Otherwise, it moves to the previous dialog item. CDialog calls
Fi ndGopher s to determine the item to which to move.

FindGophers
voi d Fi ndGophers (tGopherlnfo *gopherlnfo);

Returns what the next, previous, last, and first potential gophers are,
by setting the fields in gopher I nf 0. You must set the

current Gopher field to the current gopher if it's a dialog item,; if
not a dialog item, set it to NULL.

Table 41-2 lists the fields in gopher | nf o that you use. They are all
of type CView*.

Field Description

cur rent Gopher The current gopher, if it's a dialog item. NULL,
otherwise. You must set this item before
calling Fi ndGophers.

first Gopher The first dialog item that can be a gopher.

| ast Gopher The last dialog item that can be a gopher.

next Gopher The dialog item after cur r ent Gopher that
can be a gopher. If cur r ent Gopher is NULL
or there is no next gopher, then next Gopher
issettofirstGopher.

pr evGopher The dialog item before cur r ent Gopher that
can be a gopher. If cur r ent Gopher is NULL;
or there is no previous gopher, then
prevGopher is set to | ast Gopher.

Table 41-2 What FindGophers returns in gopherinfo

This function uses the same order in which you created the panes as
the tabbing order. It scans through all the panes within the dialog.
Panes that return TRUE to both the Real | yVi si bl e and
CanBeGopher functions are considered part of the tabbing
sequence for the dialog.
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Appearance

SetCmdEnable
voi d Set CndEnabl e (I ong aCnd, Bool ean fEnabl e);

Activates the button associated with aCnd, if f Enabl e is TRUE.
Otherwise, it deactivates the button.

Scrolling

ScrollToPane
voi d Scrol | ToPane (CPane *aPane);

Ensures that the pane aPane is visible by scrolling it into view if
necessary. This function does nothing if the dialog is not scrollable.

Change notification

ProviderChanged
voi d Provi der Changed (CCol | aborator *aProvi der,

| ong reason, void* info);
Responds to a change in a provider. This function attempts to scroll
a dialog item into view by calling Scr ol | ToPane, if r eason is
bur eaucr at | sGopher and aPr ovi der is a dialog item.

Object I/0

PutTo
void PutTo (CStream& aStreamn;

Writes to the stream.

GetFrom
void Get From (CStream& aStrean);

Reads from the stream.

Member Functions: Protected

MakePanorama
voi d MakePanor anma (Bool ean fHasHScrol |,
Bool ean fHasVScroll, Bool ean fHasSi zeBox);

Creates a panorama object to act as a background for all the dialog
items. If either f HasHScr ol | or f HasVScr ol | is TRUE, this
function also creates a scroll pane for this dialog.

Visual Architect and THINK Class Library Guide 497



41 CDialog

Set f HasHScr ol | to TRUE if you want horizontal scroll bars. Set
f HasVSr ol | to TRUE if you want vertical scroll bars. Set
f HasSi zeBox to TRUE if you want a size box.

You should not have to call this member function.

Member Functions: Private

CDialogX
voi d CDi al ogX():
Performs common initialization.
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Introduction

CDialogDirector is a base class for a director that manages a dialog
window.

Heritage
Base Class CDirector
Derived Classes CDLOGDirector

Using CDialogDirector

CDialogDirector is an abstract class that manages a dialog, which can
be modal or modeless.

Even though CDialogDirector has no pure virtual functions, you
need to create or use a derived class of CDialogDirector. At a
minimum, you need to write a constructor that creates your dialog
window. You may also want to override DoConmand to handle the
commands your dialog produces and override Pr ovi der Changed
to handle changes to dialog panes.

Visual Architect generates a CDialogDirector derived class for each
dialog you define. The dialog window is initialized at run-time by
reading the ' CVue' resource for the dialog. Any run-time
initialization of the dialog or its panes should be done by overriding
the Get Fr ommember function for the appropriate pane or dialog
class, or by overriding the Set Dat a function of the generated dialog
director. A pointer to the window created from the ' CVue' resource
is set in the i t SW ndow data member after initialization from the
resource is complete. The generated code also initializes a pointer to
each pane in the dialog.
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The THINK Class Library includes a derived class, CDLOGDirector,
which creates and manages a dialog object of type CDLOGDialog,
which is initialized from a ' DLOG resource.

A dialog director validates its dialog contents before closing the
dialog. It calls its dialog’s Val i dat e member function, which then
calls Val i dat e for all CDialogText panes. If a pane doesn’t meet all
the constraints you've set, Val i dat e returns FALSE. If any pane
returns FALSE, the director doesn’t close the dialog. To provide
other types of validation, such as checking for conflicting
combinations of control settings, you can define a derived class of
CDialogDirector and override Val i dat e. Make sure that the
inherited Val i dat e function succeeds, then perform your own
validation.

If your dialog is a modal dialog, read the next section, “Modal dialog
loop,” to find out how to use the modal dialog in your program. If
your dialog is modeless or is a document window, create it and use
it like any other window. You can take advantage of tabbing and
validation support. When the user tries to close the dialog, either by
clicking the close box or by quitting the application, it's closed only
if validation succeeds. For a modeless dialog, if you need to do
something after the window is closed but before it's disposed,
override EndDi al og, and call the inherited EndDi al og function. If
it returns TRUE, you know that the dialog will close and your
EndDi al og function can take the appropriate action before
returning.

Modal dialog loop

To use a modal dialog, you need to create a derived class of
CDialogDirector. If you're using ' DLOG resources, you need to
derive from CDLOGDirector. Extremely simple dialogs can even be
handled by instantiating CDLOGDirector directly, because it creates
the window automatically.
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Here’s an example:

voi d CW/Di al ogDi rector:: Tal kToUser (voi d)
| ong di sm ssComand;

/1 Before calling

/1 Begi nMbdal Di al og

/1 you should setup the dialog
/1 with the desired settings

di sm ssConmmand=DoMbdal Di al og( cnmdCX) ;
i f (dism ssCommand == cndOK)

/1 The dial og was confirned and
/! validated. Process the
/'l input.
}
}

The dialog director’'s DoMbdal Di al og function sets the dialog to
modal and processes events until the user issues a command to
dismiss the dialog. Usually the command is cndOK or cndCancel ,
but you can have other commands exit the modal dialog loop. At
this point, you can exit the dialog or call DoMbdal Di al og again to
continue the dialog.

The dialog director’'s EndDi al og function sets the data member

di sm ssCd to the given command. This signals DoModal Di al og
to return after processing the current event. If the f Val i dat e flag is
TRUE, it also validates the dialog. If validation fails, di sm ssCnd is
not set, so DoModal Di al og does not return.

When DoMbdal Di al og exits, it restores the changed state of any
supervising document by calling Set Changed with the value
returned by Get Changed on entry to DoModal Di al og.

During the call to DoMbdal Di al og, your application is running its
event loop and processing events. However, most of the menus are
disabled and the dialog window is the only window available. Any
buttons or panes that call DoComand functions continue to work.
CDialogDirector recognizes only cmdOK and cndCancel . To handle
other commands, you must derive a class from CDialogDirector (or
CDLOGDirector), override DoConmand, and check for your own
command numbers. If one of your own command numbers
dismisses the dialog, call the dialog director’s EndDi al og function.
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Pass it the command number and a flag indicating whether or not to
validate. You don't need to perform validation if the user cancels the
dialog.

Here is an example of DoConmand for a CDialogDirector-derived
class:

voi d CWDi al ogDi rector:: DoConmand (| ong
t heComand)

switch (theCommand)

case cndOQ her Cnd1:
DoCt her Cnd1() ;
/!l This one doesn’t dism ss
/1 the dial og
br eak;

case cndOQ her Cnd2:
EndDi al og(cmdQ her Cd2, TRUE) ;
/1l This one does dismiss it

br eak;
def aul t:
CDi al ogDi rect or: : DoCommand(
t heComand) ;
br eak;

}
}

Data Members
CDialogDirector defines these protected data members:

Data member Type Description

di smissCnmd | ong The command that dismissed
the dialog

bar St at e | ong The state of the menu bar

(enabled or disabled) when
DoMbdal Di al og began
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Member Functions

Creation

CDialogDirector
CDi al ogDi rector (CDirectorOnner
*aSupervi sor = NULL);
Constructor. aSuper vi sor is the director, document, or application
that owns the dialog.

CDialogDirector
CDhi al ogDirector ();

Default constructor. Implicitly called when object is created by
new_by name. Can also be used in combination with
IDialogDirector for backward compatibility.

IDialogDirector

void I D al ogDirector (CDirectorOnner
*aSupervi sor) ;

Initialization function compatible with previous release. Must not be
called if constructor has an argument.

Command

DoCommand
voi d DoConmand (| ong aCnd);

Handles the standard OK and Cancel commands. OK closes the
dialog if Val i dat e returns TRUE; Cancel always closes the dialog.

Close
Bool ean Cl ose (Boolean fQuitting);

Handles the Close command. This function closes the dialog if
Val i dat e returns TRUE. Returns TRUE if the dialog was closed,;
returns FALSE otherwise.

BeginDialog

voi d Begi nDi al og ();

Starts using the dialog. This function selects the window, activates
the first dialog item that’s a gopher and, if the item is a text field,
selects all its text. Begi nDi al og should not be called for a modal
dialog.
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BeginModalDialog
voi d Begi nModal Di al og();

Provides backward compatibility. Use DoModal Di al og instead.

DoModalDialog
| ong DoMbdal Di al og (| ong defaul t Cnd) ;

Enters a modal loop until the user dismisses the dialog. It returns the
command that dismissed the dialog, usually cndOK or cndCancel .
The dialog encloses def aul t Cnd, the default command button, in a
thick border. It usually is cmdOK or cndCancel .

DoChangeableModalDialog

| ong DoChangeabl eModal Di al og (| ong def aul t Cnd,
Bool ean changeDoc) ;

Similar to DoMbdal Di al og, except that changes in the dialog may

dirty the document. The changed state is reset to its original

condition if the command that ends the dialog is cndCancel .

EndDialog
Bool ean EndDi al og (1 ong wi t hCnd,

Bool ean fValidate);
Tries to stop using the dialog. If f Val i dat e is TRUE, the function
validates the dialog’s items by calling Val i dat e. If Val i dat e
returns TRUE or f Val i dat e is FALSE, it sets di sm ssCnd to
wi t hCnd, which is the command the user selected to close the
dialog. This function does not close the dialog.

Validation

Validate
Bool ean Validate ();

Returns TRUE if this director’s dialog is valid, according to the
constraints you set; otherwise returns FALSE . This function calls the
Val i dat e function of the director’s dialog.

Member Functions: Protected

DisableTheMenus
voi d Di sabl eTheMenus ();

Disables all menus except the Edit menu. Called just before bringing
up a modal dialog.
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EnableTheMenus
voi d Enabl eTheMenus ();

Enables all menus. Called after a modal dialog is dismissed.
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Introduction

CDialogText is a derived class of CEditText for text fields in dialogs.

Heritage
Base Class CEditText
Derived Classes ClntegerText

Using CDialogText

This class adds some enhancements to text panes that are especially
useful in dialogs. The features include:

= Validating a field before closing the dialog.

= Drawing a rectangular border around the text field.

= Passing special keys to the dialog such as Tab, Return,
Enter, Command-Period (Command-.) and Escape.

= Enabling the Edit menu in a modal dialog when a text
field is active.

= Visually disabling by graying out the border and
suppressing the text.

= Making a field uneditable by removing the border and
making it not want clicks.

The most useful feature is validation. After you create the field, you
specify constraints; for example, the field must be filled in and
contain fewer than 25 characters. Before the dialog closes, it calls the
Val i dat e function of all its CDialogText items. If a constraint isn’t
met in a field, it returns FALSE. The dialog isn’t closed if any field
returns FALSE, and it displays an alert describing the problem.

This class lets you specify these constraints, with
Set Constraints:
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« Required. A required field is valid if it's not empty.
= Maximum length. A field is valid if it contains no more
than the maximum number of characters.

If you want to add move constraints, define a derived class of
CDialogText and override Val i dat e to specify your new
constraints. Add strings to the ' STR#' resource

STRdI gVal i dat i on to describe the new errors.

If the text is changed, a di al ogText Changed is broadcast to its
dependents. The info parameter is a shor t * to the Pane ID.

CintegerText is a derived class for numeric fields in dialogs. It lets
you specify a minimum and maximum value.

Data Members
CDialogText defines these protected data members:

Data member Type Description

i sRequi red Bool ean TRUE if must contain
some text

maxVal i dLengt h | ong Maximum number of
characters

val i dat eOnResi gn Bool ean TRUE if validate on
resigning gopher

Member Functions

Creation

CDialogText
CDi al ogText ();

Default constructor.

CDialogText

CDi al ogText (CVi ew *anEncl osur e,
CVi ew *aSupervi sor, short aWdth,
short aHei ght, short aHEncl, short aVEncl,
Si zi ngOpti on aHSi zi ng = si zFI XEDSTI CKY,
Si zi ngOpti on aVSi zi ng = si zFI XEDSTI CKY,
short alLineWdth = -1, Bool ean
aScrol | Hori zv = 0, Bool ean al sRequired,
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| ong aMaxVal i dLengt h = MAXLONG,

Bool ean aVal i dat eDnResi gn = TRUE) ;
Constructor. Most of the arguments to this member function are
identical to those for CEdi t Text . al sRequi r ed TRUE makes
entry required; the default is FALSE. aMaxVal i dLengt h specifies
the maximum number of characters allowed; the default is MAXLONG
(no limit). If aValidateOnResign is TRUE, the text is validated when it
is no longer the gopher. This function creates a non-stylable border
(styl abl e is FALSE) around the field:

To change whether the field is stylable, use Speci fy, described in
“Specify” in Chapter 14, “CAbstractText.” To change whether the
field is validated when it's no longer the gopher, your derived class
must set val i dat eOnResi gn.

~CDialog Text
~CDi al ogText () ;

Destructor.

IDialogText

voi d | Di al ogText (CVi ew *anEncl osur e,
CVi ew *aSupervi sor, short aWdth,
short aHei ght, short aHEncl, short aVEncl,
Si zi ngOpt i on aHSi zi ng, Si zi ngOpti on aVSi zi ng,
short aLi neWdth);

Initialization function compatible with the previous release. Must not
be called if constructor arguments are used.

IViewTemp

voi d | Vi ewTenp( CVi ew *onEncl osure, CBureaucrate
*aSupervi sor, Ptr *viewData);

Used to initialize a CDialogText from a resource template.

Accessing

SetConstraints
voi d Set Constraints (Bool ean fRequired,

| ong aMaxChars);
Specifies how to validate this field. If f Requi r ed is TRUE, the field
is required and must contain at least one character. aMaxChar s is
the maximum number of characters the field may hold.
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GetTextString
void GetTextString (StringPtr aString);

Returns the contents of the dialog text field as a string. If the text is
longer than 255 characters, only the first 255 will be returned.

GetHelpBallonState
short GetHel pState();

Returns the balloon help state:
kHMEnabledltem (0) - Enable (or, for buttons, off)

kHMDisabledltem (1) -  Disabled (dimmed)

KHMCheckITem (2) - Enabled and checked (or, for buttons,
on)

kHMMarkedItem (3) - Enabled and marked (for any other
purpose)

Controls and edit panes typically implement only the first two of
three of the above states.

There is not necessarily a one-to-one correspondence between
balloon help states and THINK Class Library variable states. The
dimmed state is the most complex. Dimmed means the view would
normally accept user interaction but currently does not. Note that a
view must normally want clicks or allow editing to be considered
dimmed when it does not want clicks or allow editing. Classes for
which dimmed or marked states are meaningful, or that want to use
the marked state, must override this function.

Command

DoKeyDown
voi d DoKeyDown (char theChar, Byte keyCode,

Event Record *nmacEvent);
Handles a key-down event in a dialog text field. It passes keys that
have a special meaning to dialogs, including Tab, Return, Enter,
Escape, and Command-. (Command-Period), to i t sSuper vi sor. It
passes all other keys through to the base class.
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BecomeGopher
Bool ean BeconeGopher (Bool ean fBeconing);

If f Becomi ng is TRUE, this dialog text field is becoming the
gopher. This function enables the Edit menu if the field is in a modal
dialog. If f Becomi ng is FALSE, this field is no longer the gopher.
This function disables the Edit menu, if this field is in a modal
dialog. It also validates the field if val i dat eOnResi gn is TRUE.

Drawing

Draw
voi d Draw( Rect *);

Draws the text unless disabled.

Validation

Validate
Bool ean Validate ();

Returns TRUE if the field is valid, according to the constraints you
set. Returns FALSE otherwise. You set the constraints with the
function Set Constrai nts. To be valid the field must contain no
more than the maximum number characters, and, if the field is
required, it must contain at least one character. Override this
function if your derived class adds validations.

Enabling and disabling

SetEnabled
voi d Set Enabl ed (Bool ean i sEnabl ed);

By default, a CDialogText object is enabled and ready for users to
edit. Calling Set Enabl ed( FALSE) makes the field uneditable,
visually disables the field by drawing its border in gray and
suppresses the drawing of its text value. The text value itself is not
affected. Set Enabl ed( TRUE) restores the field to its default state.

SetEditable

voi d Set Edi t abl e (Bool ean i sEditable);

Calling Set Edi t abl e( FALSE) makes the field uneditable and
removes the border. In other words, it temporarily turns it into a
static text field. Calling Set Edi t abl e( TRUE) restores the field to
its default state.
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Object I/0

PutTo
void PutTo (CStream& aStrean;

Writes to the stream.

GetFrom
void Get From (CStream& aStrean);

Reads from the stream.

Member Functions: Protected

IDialogTextX
void | D al ogText X ();

Protected function. Performs common initialization.

DoSetEnabled
voi d DoSet Enabl ed (Bool ean i sEnabl ed);

Protected function called by Set Enabl ed and Set Edi t abl e.
Does the work for Set Enabl ed.

DoSetEditable
voi d DoSet Edi t abl e (Bool ean i sEditable);

Protected function called by Set Enabl ed and Set Edi t abl e.
Does the work for Set Edi t abl e.

MakeBorder
voi d MakeBorder ();

Protected function creates a pane border for the dialog text field.
Override this function to change the border’s appearance.

ReportinvalidText

voi d ReportlnvalidText (short strlndex);

Protected function reports that the field is invalid by displaying an
alert with string st r I ndex in' STR#' resource

STRdI gVal i dat i on. If your derived class needs to report more
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validation errors, add the error string to the ' STR#' resource
STRdI gVal i dati on.

You cannot enter more than 10
characters in this field.

Figure 43-1 Invalid text alert

SetStatic
void SetStatic (Boolean isStatic);

Protected function called by Set Enabl ed and Set Edi t abl e
which does common processing for both functions.
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Introduction

CDirector is a base class for supervising a window that can handle
commands. Directors can act as an intermediary between the
application data represented in a window and the panes in the
window.

Heritage
Base Class CDirectorOwner
Derived Classes CDialogDirector
CDocument
CClipboard
CTearOffMenu

CFloatDirector

Using CDirector

A director is a base class that manages the communication between
the application and a window. Anytime you want to display a
window, it must be supervised by a director. The supervisor of a
director must be the application or another director.

In most cases, you'll derive from the CDocument class to display and
manipulate data stored in a file in a window. You'll derive the class
from CDialogDirector to manage a dialog, or from CTearOffMenu to
implement a tear-off menu. The only time you'll create a direct
derived class of CDirector is when you need a special kind of
window such as a status window or a subwindow.

When a window belonging to a director becomes the active window,
the gopher points to the bureaucrat specified by the director’s

i t sGopher data member. When the window becomes inactive, the
gopher points to the application. When the user chooses a command
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from the menu, the switchboard calls the gopher’s DoConmand
member function.

When the switchboard processes a window-related event (such as an
activate event), it calls the appropriate window member function
which in turn notifies the director.

Global Variables and Data Members

Global variables

The global variable gGopher points to the current bureaucrat. When
a window becomes active, gGopher points to the bureaucrat
specified in the director’s i t sGopher data member. When there are
no active directors, gGopher points to the application.

Data member Type Description
gCGopher CBur eaucr at* The current
bureaucrat

The data member i t sGopher usually points to the main pane of a
window. When the director becomes active, the bureaucrat specified
ini t sGopher becomes the gopher.

Data member Type Description

i tsWndow CW ndow* Window that
the director
controls

i t sGopher CBur eaucr at * Bureaucrat to
become the

gopher when
the director is
activated

acti vat eW ndOnResune Bool ean TRUE, if the
director
activates its
window when
the program is
resumed

dirty Bool ean TRUE if
document has
been altered

wasDirty Bool ean TRUE if it was
dirty prior to
command
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Data member Type Description

cTaskW ndow CW ndow* Pointer to
window from
which the last
task originated

al readyd osi ng Bool ean TRUE while
attempting to
close the
director

Member Functions

Creation and destruction

CDirector
CDi rector (CDirectorOmer *aSupervisor);

Constructor. Adds the director to aSuper vi sor s list of directors.
By default, the director has no window and is not active. The

i t sGopher data member is initialized to point to the director. Your
director derived class should create the window for the director.

CDirector
CDhirector ();
Default constructor. Implicitly called when object is created by

new_by name. Can also use in combination with IDirector
compatibly with previous release.

~CDirector
~CDirector ();

Destructor. ~CDi r ect or deletes the director’s window (if it has
one) and removes the director from the supervisor’s list of directors.

IDirector
void IDirector (CDirectorOaner *aSupervisor);

Initialization function compatible with the previous release. Must not
be called if constructor argument is used.

Accessing

GetWindow
CW ndow* Get W ndow () ;

Returns the window that the director controls.
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FindViewByID
CVi ew* FindViewBylD (I ong aView D);

Within the director’s window, locate the view with ID aVi ew D.

OwnsWindow
Bool ean OmsW ndow ( CW ndow *aW ndow) ;

Returns TRUE if this director owns aW ndow. The director owns the
window if the window’s supervisor is this object.

Commands

DoCommand
voi d DoComand (I ong t heComand) ;

Handles a command. The default function handles this command:

Command Description
cmdd ose Call C ose( FALSE)

Your director class will usually override this function. You should
handle your own commands first, then call the inherited
DoCommand function to get the generic effects.

UpdateMenus

voi d Updat eMenus ();

If a window is associated with the director, this function enables the
Close command (cndd ose).

Notify

void Notify (CTask *theTask);

A subordinate has completed a task. Not i fy stores i t sSW ndow in
cTaskW ndow, calls Set Changed( TRUE) and calls the
application’s Not i f yCl ean function.

NotifyClean
voi d Notifyd ean(CTask *theTask);

This function operates the same as Not i fy, except that it doesn’t
call Set Changed.
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SetChanged

voi d Set Changed (Bool ean i sChanged);

This function saves the current value of di rty inwasDi rty and
sets di rty to TRUE. It then calls its inherited Set Changed function
to pass the change on to its director supervisors, if any.

GetChanged
Bool ean Get Changed ();

If di rty is TRUE, Get Changed returns TRUE; otherwise, it returns
the value returned by its inherited Get Changed function.

Set Changed and Get Changed work as they do to allow windows
to be individually dirty. When a director is supervised by a
document, if the director is dirty, the document is dirty, but the
document may be dirty and the director not. By default, the only
class that calls Get Changed is CDocument. If you want a non-
document director to behave differently based on its di rt y flag,
you will have to add this behavior to your own director derived
class.

ToggleChanged
voi d Toggl eChanged ();

This function calls Set Changed(wasDi rty) . The application calls
Toggl eChanged when it accepts an undo or redo command. The
point of Toggl eChanged is to ensure that if a user undoes the first
change to a window, the director’s di rty flag will be correctly set.

IsTaskWindowInFront
Bool ean | sTaskW ndow nFront ();

This function returns TRUE if the director’s window is the front
window and the last task originated from this window and the
window is visible. The undo command is enabled only if the first
director in the chain of command returns TRUE.

Appearance

Activate

void Activate ();

A director is becoming active. If the director’s window is not a
floating window, the function calls the BeconeGopher ( TRUE)
function of the bureaucrat pointed to by the director’'s i t sGopher
data member. This is how the gopher gets set when a new director is
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first activated, and when an active director is resumed. Acti vat e
then sets gSl eepTi ne to O to force an idle event and calls its
supervisor’s Act i vat eDi r ect or function.

Deactivate
voi d Deactivate ();

A director is becoming inactive. If the director is the gopher, this
function calls the supervisor’'s BecomeGopher ( TRUE) function to
move the gopher outside the inactive director; it then calls the
supervisor’s Deact i vat eDi r ect or function.

ActivateDirector
void ActivateDirector (CDirector *aDirector);

A director owned by this director is becoming active. This function
calls CDi rect or Oamner: : Acti vat eDi rect or to make

aDi rect or the frontmost director and to set act i ve to TRUE.
Then it calls the supervisor's Act i vat eDi r ect or function to
ensure that the entire chain of command up to the application has
active set TRUE

DeactivateDirector
voi d DeactivateDirector (CDirector *aDirector);

A director owned by this director is becoming inactive. This function
calls CDi rect or Onner : : Deacti vat eDi rector to setactive
to FALSE, then calls the supervisor’s ActivateDirector function to
ensure that the entire chain of command up to the application has
acti ve set FALSE.

RemoveDirector
voi d RenoveDirector (CDirector *aDirector);

Remove a director from the directors list.

Suspend
voi d Suspend ();

Suspends the application. This function calls

CDi r ect or Oaner : : Suspend to suspend all of the directors
supervised by this director. If this director is active, and if it owns an
active window, it calls the window's Deact i vat e function. The
director remains active even though the application is suspended.
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Resume
voi d Resune ();

The application is being resumed. This function calls

CDi r ect or Omner : : Resune to resume all of the directors
supervised by this director. If the director is active and the director
owns a window, the function calls the window’s Acti vat e
function. The window, in turn, calls the director’s Act i vat eW nd
function, which calls Act i vat e for the director.

Close

Bool ean Cl ose (Bool ean quitting);

Closes a director. This function calls CDi al ogDi rector: : d ose
to close all of the directors supervised directly or indirectly by this
director. If all of the directors are closed, Cl ose returns TRUE,
otherwise it returns FALSE.

Windows

CloseWind
void C oseWnd (CW ndow *t heW ndow) ;

Cl oseW nd calls Cl ose( FALSE) ift heW ndowis it sW ndow or
if the director has no windows and supervises no other directors. If
t heW ndow is not the window owned by this director, Cl oseW nd
calls that window’s virtual destructor.

Cl oseW nd is called by a window’s C ose function, which in turn
is called when the user clicks in the window's close box. If a click in
the window’s close box is to mean something other than closing the
director, override this function. For instance, you might want to hide
the window instead of closing it. See the Cl oseW nd function in
Chapter 32, “CClipboard.”

ActivateWind

voi d ActivateWnd (CW ndow *t heW ndow) ;

Act i vat eW nd is called by the director’s window when the
window is activated. For example, if the user clicks in the window, it
calls Act i vat e. To perform specific actions at activate time,
override Act i vat e.
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DeactivateWind
voi d DeactivateWnd (CW ndow *t heW ndow) ;

Deact i vat eW nd is called by the director’s window when the
window is becoming inactive, for example, if the user clicks in
another window it calls Deact i vat e. To perform some specific
actions at deactivate time, override Deact i vat e.

IsActive
Bool ean | sActive ();

Returns TRUE if the director is active; FALSE otherwise. You should
not override this function.

ChangeName
voi d ChangeNane(str 255 newnane);

Changes the window name to newNane

Change notification

ProviderChanged

voi d Provi der Changed (CCol | aborator *aProvi der,
| ong reason, void* info);

One of this director’s providers or subordinates has just changed.

This function handles the reason bur eaucr at | sGopher by

updating the data member i t sGopher . If your derived class

handles other reasons, it should override this function and call

CDi rector: : Provi der Changed to deal with reasons your

derived class doesn’t handle.

aPr ovi der is the provider or subordinate that changed. In this
case, it is the bureaucrat that is becoming the gopher. r eason is a
| ong that describes the type of change. bur eaucr at | sGopher is
the only reason handled by this function. i nf o is a pointer to any
additional information that a derived class might need.

For more information, see Chapter 33, “CCollaborator.”

Apple events

DoCloseEvent

voi d Do oseEvent (CAppl eEvent *theEvent,
AEDesc *theResult);

Acts on the close Apple event. Calls Cl oseW nd on i t sSW ndow.
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Clone

CloneWindow

voi d C oneW ndow (cW ndow *aW ndow,
CAppl eEvent *theEvent, AEDesc *result);

Responds to clone window Apple event. Derived class must override
for anything to be done.
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Heritage
Base Class CBureaucrat
Derived Classes CApplication

CDirector

Using CDirectorOwner

CDirectorOwner is an abstract class for objects that own directors. A
director is an object that manages the communication between an
application and a window.

CDirectorOwner has two derived classes: CApplication and
CDirector. An application needs to inform its directors when the
application is suspending, resuming, or quitting. If your application
implements multi-window documents, use an object of class
CDocument as the main document and objects of class CDirector as
the subwindows. The subwindows should be owned by the
document object.

Data Members
CDirectorOwner defines the following data members.

Data member Type Description

itsDirectors CDirectorlList* List of the directors
this object owns

active Bool ean TRUE if any director
is active
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Member Functions

Creation and destruction

CDirectorOwner

CDi rect or Omer (CDi rect or Omner
*aSupervi sor = NULL);

Constructor. This function setsi t sDi rect ors to NULL.

~CDirectorOwner
~CDi rect or Oamner ();

Destructor. Dispose of all the directors this object owns.

IDirectorOwner
void I DirectorOaer (CDirectorOnner

*aSuper vi sor) ;
Initializes the owner. This member function setsi t sDi rect or s to
NULL. Provided for backward compatibility. Must not be called if
constructor was called with arguments.

Insertion and deletion

AddDirector
void AddDi rector (CDirector *aDirector);

Adds a new director to the director list.

RemoveDirector
void RenoveDirector (CDirector *aDirector);

Removes a director from the director list.

Appearance

ActivateDirector
voi d ActivateDirector (CDirector *aDirector);

Called when a director that this object owns has been activated. Sets
active to TRUE.

DeactivateDirector
voi d DeactivateDirector (CDirector *aDirector);

Called when a director that this object owns has been deactivated.
Sets acti ve to FALSE.
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Suspend
voi d Suspend (void);

Calls the Suspend function of all the object’s directors. Notifies this
object’s directors that the application is suspending.

Resume
void Resume ( );

Calls the Resun®e function of all the object’s directors. Notifies this
object’s directors that the application is resuming.

Quit

Bool ean Quit ( );

The application is about to quit. Calling this member function is the
same as calling Cl ose( TRUE) .

Close

Bool ean Cl ose (Bool ean fQuitting);

Attempts to close all the directors that this object owns. If they all
close, this member function returns TRUE. If any director doesn’t
close, this member function stops closing directors and returns
FALSE. Set f Qui tti ng to TRUE if you are quitting the application.
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Introduction

CDLOGDialog creates a dialog window from ' DLOG and ' DI TL'
resources. It represents standard dialog items by their closest analogs
in the THINK Class Library.

Heritage
Base Class CDialog
Derived Class None

Using CDLOGDialog

CDLOGDialog is a derived class of CDialog that creates a dialog
window from DLOGand DI TL resources. It reads the items from the
DI TL resource and converts them into the analogous pane types.

After it creates the window, CDLOGDialog creates a CPanorama to
act as a background for all the dialog items. If you specify horizontal
or vertical scroll bars, it also creates a CScrollPane. The dialog must
have both scrollbars for auto-scrolling to be enabled. CDLOGDialog
examines the window pr ocl D specified in the ' DLOG resource to
determine whether the dialog should have scroll bars. If the pr ocl D
is docunent Pr oc or zoonDocPr oc, the dialog has vertical and
horizontal scroll bars and a size box; otherwise, it has none.

CDLOGDialog can create pane types that have no analog in the
dialog manager. If a' DI TL' item is static text and begins with @
CDLOGDialog passes the text to AddOver | oadedl t em which
interprets it as a pane type.
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Data Members
CDLOGDialog defines the following protected data members:

Data member Type Description

st ati cText Font short Default font for static text
items

staticTextSi ze short Default size for static text
items

edi t Text Font short Default font for edit text items

edi t Text Si ze short Default size for edit text items

def aul t Border Pen short Default border thickness for
user items and
CRadioGroupPanes

Member Functions

Creation and destruction

CDLOGDialog
CDLOGDI al og (short DLOG d,

CDi rector *aSupervisor);
Constructor. Initialize a dialog window from the ' DLOG resource
DLOG d, and create the dialog items from its associated ' DI TL'
resource. aSuper vi sor is the dialog’s supervisor. The enclosure is
always gDeskt op.

This member function creates a panorama object to act as a
background for all the dialog items by calling MakePanor ama. It
gives the dialog scroll bars if the dialog’s pr ocl Dis

docunent Proc or zoonmDocPr oc. It adds the dialog items by
calling AddDI TLI t ens.

CDLOGDialog
CDLOGDI al og ();

Default constructor. Implicitly called when object is created by
new_by_namne. Can also be used in combination with IDLOGDialog
for backwards compatibility.

CDLOGDialogX
voi d CDLOGDI al ogX();

A private member function called by CDLOGDialog.
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IDLOGDialog

void | DLOGDI al og (short DLOG d,
CDeskt op *anEncl osur e,
CDi rector *aSupervisor);

Initialization member function for backward compatibility. May not be
called if constructor has arguments. anEncl osur e should always be
gDeskt op. The other arguments are the same as for the constructor.

IDLOGDialogX

voi d | DLOGDI al ogX (short DLOG d, CDirector
*aSupervi sor) ;

Private initialization function called by IDLOGDialog and provided

for backward compatability.

AddDITLItems
voi d AddDI TLItens (short DI TLid, |ong baselD);

Creates panes for the dialog items in the ' DI TL' resource DI TLi d.
This function calls a different member function for each type of item.
If the item is enabled, it calls Set s\W\ant sCl i cks so it can respond
to mouse clicks. To change how your derived class creates an item,
override the appropriate member function of that item.

This table shows the panes that this function creates. For more
information on how it creates an item, see the documentation on the
member function it calls.

For this item... It creates... By calling...

User item CPane AddDI TLUser | tem

Push button CButton AddDI TLPushBt n

Check box CCheckBox AddDI TLCheckBox

Radio button CRadioControl AddDI TLRadi oBt n

Static text CEditText, AddDI TLSt at Text
CRadioGroupPane,

ClntegerText,
CDialogText, or some

other pane
Edit text CDialogText AddDI TLEdi t Text
Icon ClconPane AddDI TLI con
Picture CPicture AddDI TLPi cture
Resource control  Nothing AddDI TLResCont r ol

Table 46-1 How AddDITLItems creates dialog items
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FindEnclosingView
CVi ew *Fi ndEncl osi ngVi ew (Rect *boundsRect);

Returns the view that completely encloses the rectangle Rect .
Rect must be in window coordinates. CDLOGDialogs lets you nest
the pane for one dialog item within another. If no dialog item
completely encloses Rect , this function returns the dialog.

Dialog item creation member functions

AddDITLPushBtn

CPane *AddDl TLPushBtn (short aW dth,
short aHei ght, short hEncl, short vEncl,
CView *enclosure, tDITLItem *ditllten);

Adds a push button to the dialog by creating a CButton.

AddDITLRadioBtn

CPane *AddDl TLRadi oBtn (short aW dth,
short aHei ght, short hEncl, short vEncl,
CView *enclosure, tDITLItem*ditlltem
| ong anl D);

Adds a radio button to the dialog by creating a CRadioControl.

AddDITLCheckBox

CPane *AddDl TLCheckBox (short aW dth,
short aHei ght, short hEncl, short vEncl,
CView *enclosure, tDITLItem *ditllten);

Adds a check box to the dialog by creating a CCheckBox.

AddDITLResControl
CPane *AddDI TLResControl (short aWdth,

short aHei ght, short hEncl, short vEncl,

CView *enclosure, tDI TLItem *ditllten);
Adds a resource control to the dialog. This function is a stub that
does nothing. If your derived class handles resource controls, it must
override this function.

AddDITLStatText

CPane *AddDl TLSt at Text (short aWdth,
short aHei ght, short hEncl, short vEncl,
CView *enclosure, tDITLItem *ditllten);

Adds a static text item or an overloaded item to the dialog. If the
item text begins with the character @ it is an overloaded item and
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the rest of the text is passed to the AddOver | oadedl t em
member function. If the item starts with any other character, it is a
static text item and this function creates a CEditText object. It

sets the font and font size for the item to edi t Text Font and

edi t Text Si ze. It also sets the texts’ attributes to kNot Edi t abl e,
kNot Sel ect abl e, and kNot St yl abl e.

AddDITLEditText
CPane *AddDI TLEdi t Text (short aWdth,
short aHei ght, short hEncl, short vEncl,
CView *enclosure, tDITLItem *ditllten);
Adds an editable text item to the dialog by creating a CDialogText. It
sets the font and font size for the item to edi t Text Font and
edi t Text Si ze.

AddDITLIcon

CPane *AddDl TLIcon (short aWdth, short aHei ght,
short hEncl, short vEncl, CView *encl osure,
tDITLItem *ditlltem;

Adds an icon to the dialog by creating a ClconPane.

AddDITLPicture

CPane *AddDl TLPi cture (short aWdth,
short aHei ght, short hEncl, short vEncl,
CView *enclosure, tDITLItem *ditllten);

Adds a picture to the dialog by creating a CPicture.

AddDITLUserltem

CPane *AddDl TLUserltem (short aWdth,
short aHei ght, short hEncl, short vEncl,
CView *enclosure, tDITLItem *ditllten);

Adds a user item to the dialog. It creates a CPane object with a
border of def aul t Bor der Pen thickness.
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AddOverloadedltem

CPane *AddOver |

short awWdt h,

short vEncl,

oadedltem (StringPtr itenfText,
short aHei ght, short hEncl,
CVi ew *encl osure,

tDITLItem *ditlltem;

Add a pane to the dialog that has no analogue in the Dialog
Manager. An overloaded item is a static text item that begins with @
This function supports these types:

To create...
Any Pane resource

CRadioGroupPane

CintegerText with
no limits

CintegerText with
limits

Required
CDialogText

CDialogText with
maximum length

Required
CDialogText with
maximum length

Set the text to...
@ClassName$ResType$ResID

For example,
@CPopupMenuPane$Popnt1000 creates a
CPopupMenuPane from the template in the
resource ' Pop' #1000. The size and location
of the pane are taken from the dialog item
rect, not from the resource.

@radi oGr oupPane
@

@min#max

For example, @100#200 creates a field that
must be between 100 and 200.

!

@ num

For example, @ 10 creates a field with a
maximum length of 10, but that’s not required.

@ ! num

For example, @ ! 10 creates a required field
with a maximum length of 10.

Table 46-2 Overloaded items

To create other types of overloaded items, override this function in

your derived class.
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Member Functions: Private

CDLOGDialogX
voi d CDLOGD al ogX ();

Performs common initialization.

IDLOGDialogX
voi d | DLOGDI al ogX (
short DLOG d,
CDi rector *aSupervisor);
Initialization function called by IDLOGDialog and provided for
backward compatibility.
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Introduction

CDLOGDirector is a dialog director that creates its dialog from
"DLOG and ' DI TL' resources.

Heritage
Base Class CDialogDirector
Derived Class none

Using CDLOGDirector

CDLOGDirector is a derived class of CDialogDirector. It creates and
manages a dialog object of type CDLOGDirector, which creates a
dialog from ' DLOG and ' DI TL' resources.

You can implement a simple dialog from your application class with
CDLOGDirector. For example:

CDLOGDi rect or di al og(kMyDLOG d, this);

I ong result = dial og. DomMbdal D al og( cndCXK) ;
if (result == cndOK)

/1 do something if user OK' d the dialog

Ise if (result == cndCancel)

D

/1 do sonething if user cancel ed the dial og

If your dialog needs to handle any commands other than cnmdOK and
cndCancel , you need to derive a class from CDLOGDirector and
override DoConmand.
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Data Members

CDLOGDirector defines no data members.

Member Functions

Creation and Destruction

CDLOGDirector
CDLOGDi rector (short DLOG d,
CDi r ect or Omner *aSupervi sor);
Constructor. Creates a CDLOGDialog from a ' DLOG resource
DLOG d.

CDLOGDirector
CDLOGDi rector ();

Default constructor. Implicitly called when an object is created by
new by nane. Can also be used in combination with
IDLOGDirector for backward compatibility.

IDLOGDirector

void | DLOGDi rector (short DLOG d,
CDi r ect or Owmner *aSupervi sor);

Initialization function may not be called if constructor has arguments.

Member Functions: Private

IDLOGDirectorX
void | DLOGDi rector X (short DLOG d);

Performs common initialization.

538 Visual Architect and THINK Class Library Guide



CDocument

48*

Introduction

CDocument is the main class for presenting and manipulating
information. You can think of a document as the association of a
window, a file, and a set of panes.

The CSaver document class uses object I/0 to automatically read and
write object-based documents. If you do not use CSaver, your
application must create a derived class of CDocument.

Heritage
Base Class CDirector
Derived Classes CAppleEventObject

CSaver <template>

Using CDocument

You can think of a document as a file that you view through a
window. A document can contain anything that you can display and
manipulate inside a window.

The document is where your application draws and displays its data.
Since documents are descendants of CDirector, all documents have
windows associated with them. Most documents also have an
associated file. Neither the window nor the file is created
automatically. You must create them yourself by overriding the
appropriate member functions.

In addition to defining its own constructor and destructor, your
document class should override these member functions:

DoCommand DoSave
NewFi | e DoSaveAs
OpenFil e Revert

Visual Architect and THINK Class Library Guide 539



48 CDocument

Your document class must have a constructor. If your derived class
defines new data members, the constructor sets them up.

If your application allocates memory, you should also define a
destructor to deallocate it.

Note
You do not need to delete the window or file
associated with a document. The virtual destructor
does that for you.

Your document class’s DoComrand function does most of the work
in your application. When a window is active, the switchboard sends
all commands to the gopher; if the gopher can’t “handle” it, a
command is passed up the chain of command to the document. If
the document can't handle it, the application class tries to handle it.
Your document class should handle all the commands it knows
about, and call the inherited DoComrand function when it can't.

Usually, a command that changes a document is performed by
creating an appropriate task object (derived from CTask) and calling
Not i fy with the task as an argument. When Not i f y reaches a
director, the director calls Set Changed( TRUE) (which sets its

di rty data member to TRUE). The document later decides whether
it needs to be saved by calling Get Changed. Because the dirty
flag is managed automatically as a side effect of Not i fy, you
seldom need to think about it. However, if some document
command changes the state of a document without creating and
notifying a task, and only in this circumstance, your command
function needs to call Set Changed( TRUE) to ensure that the
document is saved.

If a command that changes a document is undone and if the di rty
flag was set for the first time as a result of the command, the
director’s Toggl eChanged function resets the di rt y flag. Do not
call Set Changed( TRUE) if you do not need to, as this interferes
with the operation of Toggl eChanged.

When the user chooses New from the File menu, your application’s
Cr eat eDocunent function is called. Cr eat eDocument should
allocate a new document object and call the document’s NewFi | e
function. Newfi | e must create a window by calling

540 Visual Architect and THINK Class Library Guide



Using CDocument

*

MakeNewW ndow. NewFi | e does not need to create a file; this is
done when the user first tries to save the document.

When the user chooses Open from the File menu, your application’s
OpenDocunent function is called. OpenDocunent should allocate
a new document object and call the document’s OpenFi | e
function. OpenFi | e has one argument: a Macintosh SFRepl y
record. When OpenFi | e is called, you can be sure that the
SFRepl y record is properly filled in. Your GpenFi | e function
needs to create an instance of a file object (usually of class
CDataFile). To facilitate revert processing, it helps to do the actual
file reading in a separate ReadDocunent member function.
ReadDocunent can call any of several read functions on your file
to get its contents. ReadDocunent also needs to create a window
to display the contents of the file, just as your Newfi | e function
does, by calling MakeNewW ndow. Finally, ReadDocunent should
create any panes in the window required to represent the contents
of the file.

Your MakeNewW ndow function should create a new, empty
window and store a pointer to the window in the document’s
i t sSW ndow data member.

When the user chooses Save from the File menu, your document’s
DoSave function is called. Your DoSave function should write the
contents of its file to disk. The file object is stored in the data
member i t sFi | e. If the document does not currently have a file,
your DoSave function should call SaveAs to ask the user for a new
file name.

When the user chooses Save As from the File menu, your
document’s DoSaveAs function is called. This function takes an
SFRepl y record, which is already filled in. Your DoSaveAs
function should create a new file object (usually of class CDataFile)
and store a pointer to the file in the document’si t sFi | e data
member. Once this is done, DoSaveAs can call DoSave to write the
document to disk. If the user chose Save from the File menu to
create a new file, the call to DoSave is recursive. This is not a
problem, because the document now has a file and DoSave
proceeds to write to it.
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To support the Revert command, your application should override
the DoRevert member function. Your implementation might close
the file without saving, and then call ReadDocunent to open the

file again and recreate the window.

Global Variables and Data Members

Global variables

The global variable gGopher points to the current bureaucrat. When
a window becomes active, gGopher points to the pane pointed to
by the document’s i t sGopher data member or to the document
itself. When there are no active documents, gGopher points to the
application.

The supervisor of every document is the application.

Global variable  Type Description

gCGopher CBur eaucrat*  The current bureaucrat
gApplication CApplication* The application

gWat chCur sor Cur sHandl e Watch cursor for waiting
gBart ender CBart ender Manages all menus

Data members
CDocument defines the following data members:

Data member Type Description

i t sMai nPane CPane* The document’s main pane.
NI L if the document has no
main pane. The main pane’s
enclosure should be
i t sSW ndow, a data member
inherited from CDirector.

itsFile CFil e* The file associated with this
document. NI L if
document has no file.

itsPrinter CPrinter* The printer object
associated with this
document. NI L if document
is not printable.

pageW dt h short The width of a page.
pageHei ght short The height of a page.
savePrint Pane CPane* Saved print pane while a

subdirector is printing.
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Data member Type Description
savePrinter CPrinter* Saved printer while a
subdirector is printing.
askToSave Bool ean TRUE if the user is always
asked whether to save dirty
documents.
SaveOpti on static One of the following:

DescType  kAEAsk (ask before saving
dirty documents), KAEYes
(save without asking),
kAENo (don't save).
SaveType CSType File type to use when saving
a document.

Member Functions

Creation and destruction

CDocument

CDocunent ( Bool ean printable);

Constructor. If the value of pri nt abl e is TRUE, CDocunent calls
MakePr i nt er to create an instance of CPrinter and stores it in the
i t sPrint er data member. The supervisor of a document is always
gApplicati on.

CDocument
CDocunent ();

Default constructor. Implicitly called when object is created by
new_by_nane. Can also be used in combination with | Docurnent
for backward compatibility.

~CDocument
~CDocunent ();

Destructor. Deletes it sFil e and i t sPri nt er if they were
allocated.

IDocument

voi d | Docunent (CAppl i cati on *aSupervi sor,
Bool ean printable);

Initialization function provided for backward compatibility. Must not
be called if constructor has arguments.
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Commands

DoCommand
voi d DoCommrand (| ong t heCommand) ;

Handles a document-related command. The default function handles
these commands:

Command Action

cndd ose Calls C ose.

cndSave Sets the cursor to the watch cursor and calls
DoSave.

cndSaveAs Calls DoSaveFi | eAs. The default

DoSaveFi | eAs function sets the cursor to a
watch, lets the user enter a file name by using
a standard file dialog, and calls DoSaveAs.

cmdRevert Displays a “Do you really want to revert?”
alert. If the user responds OK, sets the cursor
to the watch cursor and calls DoRevert .

cmdPageSet up If the document is printable, calls
DoPageSet up.

cmdPri nt If the document is printable, calls DoPri nt .

Table 48-1 How CDocument handles a command
Your document class usually overrides DoConmrand. You should

handle your own commands first, and then call
CDocunent : : DoCommand to handle the default commands.

UpdateMenus
voi d Updat eMenus ();

Updates the menu items just before they appear on the screen. The
default function enables the following commands:

Command Enabled if...

cndSaveAs Always

cndSave The document has changed

cndRevert A file is associated with the document and it

has changed
cndPageSet up The document is printable
cmdPri nt The document is printable

Table 48-2 How CDocument updates menus
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Your document class should override this function to enable the
appropriate commands for your document. Be sure you call
CDocunent : : Updat eMenus before you enable your document’s
commands.

Appearance

Close
Bool ean C ose (Bool ean quitting);

Calls the document’s Conf i r nCl ose function. If the result is TRUE,
it calls the C ose function of i t sFi | e (if it has one). The

qui tti ng parameter tells the Conf i r nCl ose function whether to
ask to save before “closing” or “quitting.” If the document was
actually closed, this function returns TRUE. Otherwise it returns
FALSE.

ConfirmClose
Bool ean ConfirnC ose (Bool ean quitting);

Displays a “Save before closing?” or “Save before quitting?” dialog. If
the user answers yes, this function sends a DoSave to the document
and returns TRUE. If the user answers no, it returns TRUE. If the user
answers Cancel, it returns FALSE.

File creation

NewrFile
void NewFile ();

Opens a new file. Your application’s Cr eat eDocunent function
should create a new document and call NewFi | e. Your document
class should override Newfi | e to call MakeNewW ndow in order to
create a new, empty window.

OpenFile

voi d OpenFile (SFReply *nmacSFReply);

Opens an existing file. Your application’s OpenDocunent function
should create a new document object and call OpenFi | e. Your
document class should override OpenFi | e and do the following:

= Call MakeNewW ndow to create a new, empty window.

= Open the file specified in mac SFRepl y and assign it to
itsFile.

= Call ReadDocunent to read the file.
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Note
To learn how to specify a file, see the class CFile. To
learn how to read and write from a data file, see the
class CDataFile.

MakeNewWindow
voi d MakeNewW ndow () ;

Creates a new, empty window. You must override this function to do
the following:

= Create a new window and assign it to i t SW ndow.
= Create the panorama and assign it to i t sMai nPane.

ReadDocument
voi d ReadDocunent ();

Reads the file and displays its contents in the window. You must
override this function.

Printing

MakePrinter
voi d MakePrinter ();

Makes the printer object for this document. For more information on
printer objects, see CPrinter. If you create a derived class of CPrinter,
you should override this function to create an object of your class.

SetupPrinter
voi d SetupPrinter ();

Sets up the printer parameters and calls MakePr i nt er.

Paginate
voi d Paginate ();

Calls the Pagi nat e function of i t sMai nPane if it is not NULL.
Otherwise, calls the Reset Pagi nat i on function of i t sPri nter.
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PageCount
short PageCount ();

Returns the number of pages in the document. This function calls the
Get Stri pCount function of i t sPri nt er to find out how many
pages the document occupies. If the document has more than 999
pages, PageCount raises an exception.

If the document doesn’t have a CPrinter object associated with it, this
function returns 0 (zero).

AboutToPrintSubDirector

voi d About ToPri nt SubDi rect or (CPane *aPri nt Pane,
CPrinter *aPrinter);

Sets which pane to print and which printer to use for the next print

command, instead of the default i t sMai nPane and it sPrinter.

A subdirector of this document should call this function before

passing a cndPr i nt or cndPageSet up command. The subdirector

must call DonePri nti ngSubDi r ect or when it's finished printing.

A subdirector is a director that another director owns. For example,
if your application supports multiple views of a document, the
document owns a director for each view.

DonePrintingSubDirector
voi d DonePrintingSubbDirector();

Restores the values of the document’s i t sMai nPane and
i tsPrinter data members to the values they had before you
called About ToPri nt SubDi rector.

AboutToPrint
voi d About ToPrint (short *firstPage,

short *| ast Page);
Checks the range of pages to be printed. The default function
changes | ast Page to be equal to PageCount . Your document
class should override this function to do whatever is appropriate for
your application. This is the place where the document can request
information about the page size fromitsPrinter.
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PrintPageOfDoc

voi d PrintPageO Doc (short pageNum;

Prints the specified page. The default function calls the Pr i nt Page
function of i t sMai nPane if it's not NULL.

DonePrinting
voi d DonePrinting ();

Calls the DonePr i nt i ng function of i t sMai nPane. The
Pri nt PageRange function in CPrinter calls this function when
printing is done.

Filing

DoSave
Bool ean DoSave ();
Saves the document under its current name and returns TRUE if

successful. The current file is available through the data member
i tsFil e. Your document class must override this function.

DoSaveAs
Bool ean DoSaveAs (SFReply *macSFReply);

Saves the document under a new name and returns TRUE if
successful. The mac SFRepl y record specifies where to write the
file. Your document class must override this function.

DoRevert
voi d DoRevert ();

Reverts to the last saved version of this document. Your document
class must override this function.

DoSaveFileAs
Bool ean DoSaveFil eAs ();

Responds to a Save As command and returns TRUE if successful.
This function calls the document’s Pi ckFi | eNane function. If you
provide a good file name, it calls the document’s DoSaveAs
function. Since this function implements the standard Save As
command through two other functions, you don’t need to

override it.
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PickFileName

voi d Pi ckFi |l eNane (SFReply *macSFReply);

Displays a standard file dialog to get a new file name.

Pi ckFi | eNane uses the Get Nanme function to specify the default
name.

GetName
voi d Get Narme (Str255 theNane);

Returns the name of the document in t heNane. If there is a file
associated with the document, this function returns the name of the
file. If there is no file associated with the document, but there is a
window associated with it, this function returns the title of the
window. If there is neither a file nor a window associated with the
document, this function returns a null string.

SetAskToSave
voi d Set AskToSave (Bool ean ask);

Sets the data member askToSave equal to ask. If askToSave is
TRUE, the user is asked before saving di rt y documents. Otherwise,
they are saved automatically.

SetSaveOption
voi d Set SaveOpti on (DescType option);

Sets the data member saveOpt i on equal to opt i on, which is one
of KAEAsk, kAEYes, KAENoO.
Apple Event Support

For information regarding Apple event member functions, please
refer to the supplemental information provided in the file Appl e
event infointhe Appl e Event O asses folder.
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Class Resources
Resource
STRpronpt 150
ALRTrevert 150
ALRTsaveChanges 151

STRt askNames 130

STRcommn 128
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STR resource 1D for

Pi ckFi | eName prompt
string

Reverts to saved alert

Saves changes before close/
quit alert

' STR#' resource ID for task
names
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CEditText

49

Introduction

CEditText implements a pane that displays text. This class uses the
Macintosh TextEdit routines.

Heritage
Base Class CAbstractText
Derived Classes CDialogText
CStaticText
CStyleText

Using CEditText

Use CEditText whenever you need to display unformatted text. An
edit text pane is usually the panorama in a scroll pane, so you can
scroll through the text. The DoComand function of an edit text
pane handles all the common text-editing commands such as cutting
and pasting, font selection, line spacing, and so on. The Speci fy
function, inherited from CAbstractText (see Chapter 14), lets you
choose whether the user can edit and copy your text pane’s text.

CEditText does not use the Styled Text Edit routines described in
Inside Macintosh Volume V. To create a pane of styled text, use
CStyleText.

To make sure that the edit text pane responds to commands, you
must place it in the chain of command. The best way to do this is to
set the value of your document’s i t sGopher data member to the
edit pane.

Because CEditText is based on the Macintosh TextEdit (TE) routines,
it has some limitations. It's designed to edit small amounts of text.
The maximum number of characters you can store in a CEditText

Visual Architect and THINK Class Library Guide 551



49 CEditText

record is around 32,000, but you notice performance degradation
long before it gets that big. To create a pane to display more text,
create a derived class of CAbstractText, described in Chapter 14.
Data Members

CEditText defines the following data members:

Data member Type Description

nmacTE TEHandl e TextEdit record handle

spaci ngCrd | ong Line spacing command
number

al i gnCnd | ong Alignment command number

Member Functions

Creation and destruction

CEditText
CEdi t Text (CVi ew *anEncl osur e,

CBur eaucr at *aSupervi sor,

short awdth, short aHei ght,

short aHEncl, short aVEncl,

Si zi ngOpti on aHSi zi ng, Sizi ngOption aVSi zi ng,

short alLi neWdth, Bool ean aScroll Hori z);
Constructor. By default aw dt h, aHei ght , aHEnc! , and aVEncl
have a value of 0 (zero). By default, aHSi zi ng and aVSi zi ng
have a value of si ZELASTI C. Most of the arguments are identical to
the CPanorama constructor. aLi neW dt h specifies how wide the
lines should be. If aLi neW dt h is less than 0 (zero), the width is
the same as the Macintosh TextEdit record’s vi ewRect . The default
value is -1. aScr ol | Hor i z is TRUE if the text should scroll
horizontally when the line width is greater than the frame width and
the cursor moves outside the frame. The default value is FALSE.

Note
The other arguments are described in Chapter 74,
“CPanorama.”

CEditText
CEdi t Text () ;

Default constructor. Implicitly called when object is created by
new_by nane. Can also be used in combination with IEditText for
backward compatibility.
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~CEditText
~CEdi t Text () ;

Destructor. Disposes of the TextEdit record macTE.

IEditText
void | Edit Text (CVi ew *anEncl osure,
CBur eaucr at *aSupervi sor,
short aWwdth, short aHei ght,
short aHEncl, short aVEncl,
Si zi ngOpt i on aHSi zi ng, Si zi ngOpti on aVSi zi ng,
short aLi neWdth);

Initialization function provided for backward compatibility. Must not
be called if constructor has arguments.

IViewTemp
void | ViewTenp (CVi ew *anEncl osure,

CBur eaucr at *aSupervisor, Ptr ViewData);
Initializes a VCEditText object from a resource template. The data
members are set using the resource template pointed to by
Vi ewDat a. Each derived class of CView overrides this function to
use its own resource template.

IEditTextX
void | EditText ();

Performs common initialization.

MakeMacTE
voi d MakeMacTE ();

Creates a TextEdit record and sets nacTE to it.

Mouse and keystrokes

DoClick

void Dol ick (Point hitPt, short nodifierKeys,
| ong when);

Handles a mouse down in an edit text pane. This function calls
Sel ect i onChanged after processing the click.
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Commands

PerformEditCommand
voi d PerfornEdi t Command (1 ong theComrand);

Performs the standard cut, copy, paste, and clear commands on the
text. The task classes call this function to undo an edit command.

TypeChar
voi d TypeChar (char theChar, short theModifiers);

Processes a keystroke. This function does not need to set up for an
Undo command and should handle the key directly. The task classes
call this function to undo key strokes.

Display

Draw
void Draw (Rect *area);

Draws the text pane.

Scroll
void Scroll (long hDelta, long vDelta,
Bool ean redraw);
Scrolls the text within the pane by hDel t a characters and vDel t a
lines.

GetSteps
voi d Cet Steps(short *hStep, short *vStep);

Returns the scrolling step values appropriate to the text font.

Activate
void Activate ();

Activates the text pane. This function enables the editing commands
and either highlights the selection or shows the text insertion caret.

Deactivate
voi d Deactivate ();

Deactivates the text pane. This function disables the editing
commands and either unhighlights the selection or hides the text
insertion caret.
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SetSelection

voi d SetSelection (long sel Start, |ong sel End,
Bool ean f Redraw);

Sets the selection to the range corresponding to character positions

sel Start through sel End.

GetSelection
void CGetSelection (long *sel Start, |ong *sel End);

Returns the start and end of the current selection.

HideSelection
voi d Hi deSel ecti on(Bool ean hi de, Bool ean redraw);

If hi de is TRUE, hides the current selection or insertion point.
Otherwise, shows it.

Text specification

SetTextPtr
void SetTextPtr (Ptr textPtr, |ong nuntChars);
Uses the first nunChar s characters that t ext Pt r points to as the

text for this abstract text object. This function makes a copy of the
text.

GetTextHandle
Handl e Get Text Handl e ();

Returns a handle to the text of the CEditText object. This function
returns a handle to the actual text, not to a copy of the text.

CopyTextRange
Handl e CopyText Range (long start, |ong end);

Returns a copy of the range of text specified by st art and end.

InsertTextPtr
void InsertTextPtr (Ptr text, long |ength,

Bool ean f Redraw);
Inserts a copy of the given text and length at the start of the current
selection. If f Redr aw is TRUE, redraws the pane at the next update
event.
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Checklnsertion
voi d Checklnsertion (long insertlLen,

Bool ean useSel ection);
Checks whether an insertion of i nsert Len characters would
exceed TextEdit's capacity. If useSel ect i on is TRUE, this function
deducts the size of the selection from the total length. If the insertion
would fail, this function calls Fai | ur e.

Text characteristics

SetFontNumber
voi d Set Font Nunber (short aFont Nunber);

Sets the font for this text pane by font number.

SetFontStyle
void SetFontStyle (short aStyle);

Changes the font style for this text pane. aStyl e may be one or
any additive combination of: normal , bol d,itali c,
underl i ne, outli ne, shadow, condense, or ext end.

SetFontSize
voi d SetFont Si ze (short aSize);

Sets the font size for this text pane to the specified size.

SetTextMode
voi d Set Text Mode (short aMbde);

Sets the text mode for this text pane to the specified mode. aMbde
can be set to: srcCopy, srcQOr, srcXor, srcBi ¢, not SueCopy,
not SrcQOr, not Sr cXou, or not SrcBi c.

SetAlignCmd

void Set AlignCrd (long anAl i gnCnd);

Sets the text alignment for this text pane. This function uses the
THINK Class Library’s names for the alignment choices:

crmdAl i gnLeft, cndAl i gnRi ght, or cndAl i gnCent er. To use
TextEdit's alignment names, call Set Al i gnrent .
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GetAlignCmd
long GetAlignCmd ();

Returns the current alignment for this text pane. It can be set to
cndAl i gnLeft, cndAl i gnRi ght, cndAl i gnCent er, or
crmdNul | .

SetAlignment
void Set Alignnent (short anAlignnent);

Sets the text alignment for this text pane. This function uses
Text Edi t 's names for these alignment choices:

t eFl ushDef aul t, t eFl ushLeft, teCenter, or

t eFl ushRi ght . To use the THINK Class Library’s alignment
commands, call Set Al i gnCnd.

SetSpacingCmd
voi d Set Spaci ngCnd (1| ong aSpaci ngCmd) ;

Sets the space between lines of text. aSpaci ngCnd can be set to
cnmdSi ngl eSpace, cnd1Hal f Space, or cndDoubl eSpace.

GetSpacingCmd
| ong CGet Spaci ngCmd ();

Returns the space between lines of text. This function can be set to
cndSi ngl eSpace, cnd1Hal f Space, or cndDoubl eSpace.

GetTEFontInfo
voi d Get TEFontI nfo (Fontlnfo *macFont| nfo);

Returns a QuickDraw Font | nf o record for the font that this text
pane uses. As a side effect, this member function changes the font,
size, and style of the pane’s port to that used by the Text Edi t
record.

GetHeight
| ong Get Height (long startLine, |ong endLine);

Returns the total height in pixels of the indicated lines of text.

GetCharOffset
| ong Get Char O fset (LongPt *aPt);

Returns the character position nearest the coordinate aPt . aPt must
be in frame coordinates.
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GetCharPoint
voi d Get Char Poi nt( |ong offset, LongPt *aPt);

Returns the coordinate of the character position of f set. aPt isin
frame coordinates.

GetCharsStyle

void GetCharStyle (long char O fset,
Text Style *theStyl e);

Returns style information for the character at position char O f set .

GetTextStyle
void Get Text Style (short *whi chAttri butes,

Text Style *aStyle);
Returns current style information for this text pane.
whi chAt tri but es is a flag that indicates which text attributes to
report on. The attribute flags and Text St yl e record are described
in Inside Macintosh VI, Chapter 15, “TextEdit.”

Calibrating

ResizeFrame
voi d Resi zeFranme (Rect *delta);

Resizes the text’s frame when the size of its pane changes. The
del t a rectangle specifies how each side changes. Positive values
mean down and to the right. Negative values mean up and to the
left.

CalcTERects
voi d Cal cTERects ();

Determines the destination and view rectangles for this text pane’s
Text Edi t record.

AdjustBounds
voi d Adj ust Bounds ();

Adjusts the bounds of this text pane to match its TextEdit record.
When you do something that could change the line width or the
number of lines, call this function.
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FindLine
short FindLine (long charPos);

Returns the line number containing the specified character position.
Both line and character numbering start at 0 (zero). If the character
position is before the start of the text (a negative number), this
function returns 0 (zero). If the character position is beyond the end
of the text, this function returns the number of the last line.

GetLength
| ong GetlLength ();

Returns the length in bytes of this text pane’s text buffer.

GetNumLines
| ong Get Nuniines ();

Returns the total number of lines in this text pane’s text buffer.

Printing

AboutToPrint
voi d About ToPrint (short *firstPage,

short *| ast Page);
When the specified range of pages is about to be printed, this
function deactivates the text pane to unhighlight the current
selection.

PrintPage

void PrintPage (short pageNum short pageW dth,
short pageHeight, CPrinter *aPrinter);

Prints the specified page.

DonePrinting
voi d DonePrinting ();

When printing is over, this function rehighlights the current selection
if the edit pane is active.
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Cursor

Dawdle
void Dawdl e (|1 ong *maxSl eep);

This function flashes the insertion point when the edit text pane is
active. This function sets maxSl eep to the value of

Get Car et Ti me, which is the rate at which the insertion point
blinks. Setting this value ensures that WAi t Next Event generates a
null event at least that often.

Note
To learn more about “sleep time,” see the
description of the Dawdl e function in Chapter 27,
“CBureaucrat.”

Object I/0

PutTo
void PutTo (CStream& aStrean;

Writes to the stream.

GetFrom
voi d Get From (CStream& aStrean;

Reads from the stream.

Member Functions: Private

CEditTextX
void CEditTextX ();

A private member function called by the constructor to initialize
CEditText.
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Introduction

CEnvironment maintains a drawing environment for any pane.

Heritage
Base Class None
Derived Classes CTextEnvirons

Using CEnvironment

Every pane has a data member i t sEnvi r onment that points to its
drawing environment. If i t SEnvi r onnment is non-NULL, the pane’s
Pr epar e function calls i t sEnvi r onnent - >Rest or e() to set up
its QuickDraw drawing environment.

You can use this class to make sure that the drawing environment is
set up correctly. Or you might want to change the drawing
environment according to some saved settings.

Data Members

This class has no data members.

Member Functions

Creation and Destruction

Dispose

voi d Di spose ();

Provided for backward compatibility. Calls oper at or del et e. This
function can be used only if TCL_USE_DISPOSE is defined for the
project.
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Environment

Restore
void Restore ();

Restores the drawing environment in the current port. The default
function just calls the QuickDraw routine PenNor mal .

Object I/0

PutTo
void PutTo (CStream& aStreamn;

Writes to the stream.

GetFrom
void Get From (CStream& aStrean);

Reads from the stream.

Friend Functions

operator <<

friend CStream operator << (CStream &s,
CEnvi ronment *p);

Writes the environment to the stream s.

operator >>

friend CStream operator >> (CStream &s,
CEnvi ronment *p);

Reads the environment from the stream s.
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Introduction

CError is an error-handling class. You can use the global error
handler object gEr r or to report errors.

Most error handling in the THINK Class Library uses the exception
handling mechanism described in Chapter 9, “Exception Handling
and RTTL.”

Heritage
Base Class None
Derived Classes None

Using CError

The application constructor CAppl i cat i on creates an instance of
CError and stores a pointer to it in the global variable gEr r or.

The CError member function Post Al ert provides a convenient
way to show an alert displaying a string from a STR# resource.

Global Variables and Data Members

Global variables
There is one global CError object:

Variable Type Description
gError CError Global error handler

Data members
This class has no data members.
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Member Functions

Error reporting

PostAlert
void PostAlert (short STRid, short index);

Posts a general alert and return. STRi d is the resource ID of a
" STR#' resource. i ndex is the index into the ' STR#' resource.
The string is displayed in a generic alert box.

MissingResources
voi d M ssi ngResources ();

Posts an alert announcing that the application can’t find its resources,
and exits the application. The alert suggests that your project doesn’t
have an associated resource file. The alert can’t be in a resource,
since this function is called only if the resource file is unavailable.

Global Function

Note that a global function is not a member function.

GrowZoneFunc
pascal |ong G owZoneFunc (Size bytesNeeded);

The application member function | ni t Menor y installs this function
as the application’s G owZone function, which is called in low-
memory conditions. This function calls the application’s

G owMenor y member function. See Chapter 18, “CApplication.

Class Resource

Resource Description

"ALRT' /" DI TL' 128 Generic alert box used by
Post Al ert . Contains 20 for use
with Par anTText .

564 Visual Architect and THINK Class Library Guide



CException

50 *

Introduction

When the THINK Class Library throws an exception, the thrown
exception object is of class CException. The simplified exception-
handling macros also throw exceptions of this class. See Chapter 9,
“Exception Handling and RTTI,” for a thorough description of
exception handling.

Heritage
Base Class None
Derived Classes None
Note

CException is declared a TCL_EXCEPTI ON_CLASS,
which, in the current implementation of exception
handling, causes it to be derived from _BR_Exception.
When exception handling is supported by the
compiler, this derivation no longer exists, because
the deliberately undocumented class _BR_Exception
is removed from the THINK Class Library.

Using CException

The THINK Class Library throws exceptions by calling the Fai | ur e
function, described in Chapter 9, “Exception Handling and RTTL.”
The exception objects thrown by Fai | ur e are of class CException.
The simplified exception-handling macros also throw exceptions of
this class.

Visual Architect and THINK Class Library Guide 565



52 CException

Data Members

CException defines these private data members:

Data member Type Description

err short An error code, usually
an OSErr value
returned by a Toolbox
function.

neg | ong A resource ID of a
' STR#' resource, and
an index into that
resource, packed into a
single long value. See
the description of
ErrorAlert in
Chapter 127, “TCL
Utilities,” to learn how
this value is interpreted.

Member Functions

Creation and destruction

CException
CException (short err, long nsg);

Constructor. Sets this object’s er r and nmsg data members equal to
the corresponding arguments.

Error reporting

GetErr
short GetErr ();

Returns err.

GetMsg
| ong Get Msg ();

Returns nsg.

SetErr
void SetErr (short err);

Sets this object’s er r data member equal to the parameter err.
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SetMsg
voi d Set Msg (| ong nsgQ);

Sets this object’s msg data member equal to the parameter nsg.
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Introduction

CFile is an abstract class for implementing classes that deal with disk
files.

Heritage
Base Class None
Derived Classes CDataFile
CResFile
Using CFile

CFile is an abstract class for dealing with Macintosh disk files. Most
often you use a CDataFile derived class to work with regular data
files.

Before you open a file, you must specify it. Specifying a file means
identifying it to the Macintosh File Manager. This class gives you
three ways to specify a file depending on the type of information
you provide. The most common specification function, SFSpeci fy,
lets you use an SFRepl y record from the standard file dialogs to
identify a file.

Some CFile member functions use the THINK Class Library’s
exception-handling library ifa problem occurs during in a file
operation. For more information on exception handling, see Chapter
9, “Exception Handling and RTTL.”
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Data Members

CFile defines these data members:

Data member Type Description

name Str63 File name

vol Num short Volume containing the file
dirlD | ong Directory within the volume

Member Functions

Creation and destruction

CFile
void CFile ();

Constructor.

~CFile
~CFile ();
Destructor.

IFile
void IFile ();

Initialization function for backward compatibility. Does nothing.

Dispose

voi d Di spose ();

Disposal function for backward compatibility. Calls operator

del ete this. TCL_USE DI SPOSE must be defined to use this
function.

Specification

Specify

voi d Specify (Str63 aName, short aVol Nun;
Specify a file by its name and volume reference number. Use this
function to specify files on MFS volumes.

SpecifyHFS
voi d Speci fyHFS (Str63 aNane, short aVol Num
long abDirlD);

Specify a file by its name, volume number, and directory ID. If the
specification is for an alias, this function resolves it.
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SpecifyFSSpec

voi d Speci f yFSSpec (const FSSpec *aFil eSpec);
Specifies the file using a File Manager FSSpec record. If the
specification is for an alias, this function resolves it.

SFSpecify

voi d SFSpecify (SFReply *macSFReply);

Specifies a file from the information in a mac SFRepl y record. If the
specification is for an alias, this function resolves it. Use this function
to specify a file that the user selects through a Standard File dialog.

ResolveFileAlias
voi d ResolveFileAias ();

If the current file specification is an alias, this function resolves it.

Open and close

Open

voi d Open (SignedByte perm ssion);

Opens the file with the specified permission. This function does
nothing. Derived classes must override this function. For an example
of how to write an Open function, see Chapter 38, “CDataFile,” and
other classes derived from this class.

Close
void Cose ();

Closes this file. This function does nothing. Derived classes must
override this function.

IsOpen
Bool ean 1sOpen ();

Returns TRUE if the file is open, r et ur ns FALSE otherwise.

Accessing

GetName
void Get Name (Str63 theNane);

Gets the name of the file.
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GetFSSpec
voi d Get FSSpec (FSSpec *aFil eSpec);

Gets an FSSpec record for this file.

ExistsOnDisk
Bool ean Exi stsOnDi sk ();

Returns TRUE if there’s an existing file that matches the current file
specification.

GetMacFilelnfo
void GetMacFilelnfo (FInfo *filelnfo);

Returns the Finder information for this file. The information includes
the file's type, creator, and icon position.

Filing

CreateNew
voi d CreateNew (OSType creator, OSType fType);

Creates a new file with the specified creator and file type. This
function uses the name and volume information you set up with one
of the specification functions. You can use the application signature
in gSi gnat ur e for the creator.

ThrowOut
voi d ThrowQut ();

Closes the file and deletes it.

ChangeName
voi d ChangeNane (Str63 newNane);

Renames this file to newNane.
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Introduction

CFileStream provides streaming, buffered object 1/0 to and from
CDataFile objects.

Heritage
Base Class CBufferedStream
Derived Classes None

Using CFileStream

See Chapter 8, “Using Object 1/0,” to learn how to use streams and
files.

A CFileStream object is associated with a file; it is not the file itself.
Moreover, the association is not permanent. You can create a
CFileStream object, attach it to an existing file object, read or write
the file stream, and destroy the CFileStream, leaving the file intact.
This is useful for reading and writing documents; the stream needs
to exist only when you actually do 1/0.

The easiest way to set up a file stream is through its two utility
functions, New nput Fi | eSt r eamand NewCut put Fi | eSt r eam
These functions create, initialize, configure and open the stream
(and, if necessary, the file) in the appropriate mode. Often, all that is
left for your program to do is to call Get Cbj ect or Put Cbj ect for
the object data structure you wish to read or write, and to destroy
the stream.
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Data Members
CFileStream defines the following protected data members:

Data member Type Description

itsFile CDat aFi | e* The data file used by the stream.

ownsFi | e Bool ean TRUE if the file was created and
disposed of by the stream.

wasOpen Bool ean TRUE if the file was open when

attached to the stream.

Member Functions

Creation and destruction

CFileStream
CFileStream (ChataFile *theFile = NULL,
| ong bufferSize = kTCLDef aul t StreanBufferSi ze,
Bool ean check = TRUE);
Constructor. Initializes a file stream to read or write the file
argument. If t heFi | e is NULL, a new CDataFile is created for use
by the stream and must be further initialized by SFSpeci fy before
the stream is opened. The buf f er Si ze argument is the same as for
CBufferedStream. The value of kTCLDef aul t St r eanBuf f er Si ze
is 2048. The check argument is the same as for CStream.

~CFileStream
~CFileStream ();

Destructor. Closes the stream. If the file is owned by the stream, it
deletes the file.

Open and close

Open

void Open (TCLStreanivbde node);

Opens the stream for ReadSt ream Wit eStreamor

ReadW i t eSt r eamaccess. If the file was created by the stream or
was attached to the stream but is not already open, the file is opened
at the same time as the stream. If the file was open when attached to
the stream, it must already be open in the appropriate mode.
CFileStream will not close a non-owned file, even temporarily.
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Close
void Cose ();

Closes the stream, returning it to Cl osedSt r eammode. If the file

was opened by the stream, the file is also closed. If the file was not
opened by the stream, it is left open, but all outstanding writes are

forced to disk.

File Operations

SFSpecify

voi d SFSpecify (SFReply *macSFReply);

Points the attached file object to a file on disk. This is the only file
operation provided by CFileStream; for all others, including other
forms of Speci fy, use Get Fi | e to call the file object directly.

GetFile
CDataFile *GetFile ();

Returns a pointer to the file object attached to the stream.

Member Functions: Protected

Fill
void Fill ();
Fills the buffer from disk when the buffer is empty.

Drain
void Drain ();

Writes the buffer to disk when the buffer is full.

Bracket
voi d Bracket (long aPosition);

Repositions the buffer by draining it, if necessary, and resetting the
buffer variables so that the buffer is an empty buffer starting at the
desired position. The next Get or Put operation will read the buffer
from disk, or write to an empty buffer, as appropriate.

GetPhysicalSize
| ong Get Physical Size ();

Returns the size of the file.
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SetPhysicalSize
voi d Set Physi cal Si ze (|l ong newSi ze);

Sets the size of the file to newSi ze bytes by calling the Macintosh
Toolbox function Set EOF.

Utility Functions

NewOutputFileStream
CFi | eStream *NewQut put Fi | estream (

CDhataFil e *theFile);
Creates a new file stream, turns duplicate checking on, opens the
stream for Wi t eSt r eamand returns a pointer to the stream. If
t heFi | e is NULL, a new CDataFile object is created for use by the
stream.

NewlnputFileStream
CFil eStream *Newl nput Fi | estream (
ChataFile *theFile);
Creates a new file stream, turns duplicate checking on, opens the
stream for ReadSt r eamand returns a pointer to the stream.
t heFi | e may not be NULL.
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Introduction

CFloatDirector is an abstract class that supervises a Macintosh
floating window.

Heritage
Base Class CDirector
Derived Class CTearOffMenu

Using CFloatDirector

CFloatDirector controls a floating window. Your CFloatDirector
derived class must set i t sW ndow to a window you create.

CFloatDirector provides a number of services common to all
standard Macintosh floating windows. The THINK Class Library
assumes that all floating windows are created when the application
is initialized and that they exist throughout the life of the program.
Usually, a global variable is set to point to the floating window’s
director. Floating windows are hidden offscreen before they are first
opened and while they are closed. Floating windows are temporarily
hidden when the application is suspended, and displayed again
when the application is resumed. A floating window should be
hidden when it does not pertain to the topmost non-floating, non-
modal window. Floating windows are allowed to go behind modal
windows and are not hidden while modal windows are frontmost.

CFloatDirector makes this easy to implement. For each floating
window, call CFloatDirector’'s ShowwW ndow function in the

Act i vat e function of each non-floating, non-modal window to
which the floating window applies. Call H deW ndow in the
Deact i vat e function of each non-floating, non-modal window to
which the floating window does not apply. ShowW ndow will not
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show the window unless it has been opened and then was hidden
by H deW ndow. Suspend and resume behavior is handled
independently; your program logic does not need to be concerned
about it.

Data Members

CFloatDirector defines these protected data members:

Data member Type Description

i tsPane CPane* The pane being displayed in the
window. Used by CTearOffMenu.

cor ner Poi nt Upper left of torn-off window

mar gi ns Rect Space between window bounds
and the pane in the window

opened Bool ean TRUE if window has been opened

hi dden Bool ean TRUE if window has been hidden

by H deW ndow

Member Functions

Creation and destruction

CFloatDirector
CFl oatDirector ();

Constructor. A float director’s supervisor is always the application.
CFloatDirector sets i t sSW ndowand i t sPane to NULL. The
window’s margins are initialized to one pixel on each side. To
conform to Macintosh Human Interface Guidelines, call

Set Fi xedMar gi ns to set the margins for a top or left drag bar.

Hidelnitially
void Hidelnitially ();

Completes initialization by hiding the window offscreen so that it
will only appear onscreen when opened or torn off.

Accessing

GetMacWindow
W ndowPt r Get MacW ndow () ;

Returns the window record for the floating window.
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IsOpen
Bool ean 1sOpen ();

Returns TRUE if the floating window is currently open—that is, it
was opened by OpenW nd or MoveToCor ner .

Open and close
OpenWind
voi d OpenW nd (Point where);

Opens the floating window by moving its upper-left corner to the
global coordinates specified by wher e.

CloseWind
void C oseWnd (CW ndow *t heW ndow) ;

Closes the floating window by moving t heW ndow off the screen.
t heW ndow must be the same as i t sSW ndow. The argument is
provided for backward compatibility.

MoveToCorner
voi d MoveToCorner ();

Moves the window to the corner stored by the Tor nOf f member
function.

Hide and Show

ShowWindow
voi d Showw ndow () ;

Shows the floating window. Does nothing if the window is not open
or was not previously hidden by Hi deW ndow.

HideWindow
voi d Hi deW ndow ();

Hides the floating window if it is currently open and not hidden.

Suspend and resume

Suspend
voi d Suspend ();

Hides the floating window when the application is suspended. You
should not have to call this function.
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Resume
voi d Resune ();

Shows the floating window when the application is reactivated. You
should not have to call this function.

Commands

DoCommand
voi d DoCommrand (| ong t heCommand) ;

Overrides DoCommrand to forward all commands received by the
director to the gopher, provided the gopher is not in the director’s
window. This makes it simple to implement floating palettes; every
selection can become a command received by the front window.

Margins

SetFixedMargins
voi d Set Fi xedMargins (tDragBar dragBar);
Sets the margin for a top or left drag bar. The value of dr agBar

must be either kTopDr agBar or kLef t Dr agBar. The drag bar is
ten pixels high or wide.

SetMargins

voi d Set Margi ns(Rect *aMargi ns);

Sets the margin between the window outline and the pane in the
window. The margin is not a rectangle; it is the amount by which the
pane’s frame should be enlarged to create the gray outline of the
floating window.

GetMargins
voi d Get Margi ns(Rect *t heMargins);

Returns the margins in t heMar gi ns.

580 Visual Architect and THINK Class Library Guide



CFWDesktop

56

Introduction

CFWDesktop is obsolete, and provided only for backward
compatibility.

Heritage
Base Class CDesktop
Derived Classes None

Using CFWDesktop

All the functionality of CFWDesktop is now included in CDesktop.
Unless you have existing code which depends on CFWDesktop, you
will never need to use this class.

For information on CDesktop, see Chapter 40.

Data Members

CFWDesktop defines no data members.

Member Functions

Creation and destruction

IFWDesktop
voi d | F\\Deskt op ( CBureaucrat *aSupervisor);

Initializes the desktop. Provided for backward compatibility. Does
nothing.
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Introduction

CGridMDEF overrides CSelectorMDEF to do a more standard job of
highlighting the current menu selection. CGridMDEF highlights by
inverting, rather than by constantly flashing.

Heritage
Base Class CSelectorMDEF
Derived Classes None

Using CGridMDEF

Use CGridMDEF exactly as you would use CSelectorMDEF. See
Chapter 69, “CMenuDefProc,” for detailed coding hints.

Data Members

This class has no data members.

Member Functions

Creation and destruction

CGridMDEF
CG i dVMDEF (short NMDEFi d, CPane *aPane,

CTear O f Menu *aTear O f Menu) ;
Constructor. Initializes the object with the resource 1D of the dummy
' MDEF' and the associated ' MENU resource. aPane must be a
CSelector-derived class object. aTear Of f Menu is the director that
manages a torn-off menu and must be a CTearOffMenu object.
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Drawing

Chooseltem

voi d Chooseltem ( MenuHandl e macMenu,
Rect *menuRect, Point hitPt,
short *whichlten);

Handles menu selection.

DrawMenu

voi d DrawMenu (MenuHandl e macMenu,
Rect *menuRect);

Draws the pane specified as aPane in | G i dMDEF as a menu.
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Introduction

CGridSelector is an abstract class for drawing a pane with several
items arranged in a table.

Heritage
Base Class CSelector
Derived Classes CCharGrid
CPatternGrid
CPICTSelector
CPICTGrid

Using CGridSelector

CGridSelector is a derived class of CSelector that lets you display
items in a table. To use CGridSelector, all you have to do in any class
you derived from it is override the Dr awl t emmember function.
CGridSelector takes care of everything else.

The THINK Class Library includes two derived classes of
CGridSelector. CPatternGrid displays a pattern palette. CCharGrid
displays a set of characters. You can use CCharGrid with a special
font to display tool palettes.

Items in a grid are numbered in row-column order starting with 1.
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Data Members
CGridSelector defines the following data members:

Data member Type Description

r ows short The number of rows in the grid

col ums short The number of columns in the grid
boxW dt h short The width in pixels of each box
boxHei ght short The height in pixels of each box
gridon Bool ean TRUE if the grid lines should be drawn

Member Functions

Creation and Destruction

CGridSelector

CGidSel ector ();

Default constructor. Implicitly called when object is created by
new_by nane. Can also be used in combination with

| Gri dSel ect or for backward compatibility.

CGridSelector
CGri dSel ector (CVi ew *anEncl osur e,
CBur eaucr at *aSuper vi sor,
short aHEncl, short aVEncl,
Si zi ngOpt i on aHSi zi ng, Si zi ngOpti on aVSi zi ng,
short aSel ection, short aConmmandBase
short aRows, short aCol umms,
short aBoxW dth, short aBoxHei ght);

See the description of Constructor. aSel ect i on is the initial item to select.
CSelector’s DoClick aCommuandBase is the base value for converting the selected item
function in Chapter 97to  into a command number. aRows and aCol urms determine how
learn how selectors many boxes are in the grid. aBoxW dt h and aBoxHei ght
generate command determine the size of each box in pixels. CGridSelector sets the
numbers. vertical and horizontal scales to the size of the boxes.

Note

The other arguments are described in Chapter 71,
“CPane.”
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IGridSelector
void | GidSel ector (CView *anEncl osure,
CBur eaucr at *aSupervi sor,
short aHEncl, short aVEncl,
Si zi ngOpti on aHSi zi ng, Sizi ngOption aVSi zi ng,
short aSel ection, short aConmandBase
short aRows, short aCol unms,
short aBoxW dth, short aBoxHei ght);

Initialization function for backward compatibility. May not be called
if constructor has arguments.

Drawing

Draw
void Draw (Rect *area);

Draws the grid selector. If gri dOn is true, this function first draws
the grid. Then it uses Dr awl t emto draw each box. Finally, it
highlights the current selection.

Since most of the work is done in the Dr aw t emfunction, you
probably won't need to override this function.

DrawGrid

void DrawGid ();

Draws the grid lines between items. The Dr aw function calls
Draw i d if gri dOn is TRUE

Drawltem
void Drawitem (short theltem Rect *theBox);

Draws the item. t hel t emis the number of the item to draw, and
t heBox is the rectangle to draw it in. Your derived class must
override this function.
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Accessing

Hiliteltem
void Hiliteltem (short theltem
HliteState state);
Highlights the specified item. Hi | i t el t emcan take one of three
values for the st at e parameter:

Hilite state value Behavior
hiliteOFF Invert the item’s box
hiliteON Invert the item’s box

hiliteDYNAM C Flash the edges of the item’s box
Table 58-1 How CGridSelector highlights items

If you want to highlight an item differently, you can override this
function.

Findltem
short Findltem (Point hitPt);

Determines which item corresponds to a mouse down at a specified
point. If the hi t Pt isn't in the grid, Fi ndl t emreturns zero. Grid
selector items are numbered in row-column order starting with 1, as

in Figure 58-1.
1123
4 | 5|6
7189

Figure 58-1 Item numbering in grid selectors

FindltemBox
voi d FindltenBox (short theltem Rect *theBox);

Returns the box that corresponds tot heltem Hiliteltemuses
this function to figure out what box to highlight.
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SetGridOn
void SetGidOn (Boolean aGi dOn);

Sets the data member gri dOn to aG i dOn. If gri dOn is TRUE, the
Dr aw function calls Dr awGr i d to draw grid lines between items.

Object I/0

PutTo
void PutTo (CStream& aStrean;

Writes to the 